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読み方ガイド

このマニュアルの読み方

本マニュアルの各項目は同じ構成になっています。左側には操作経路と 技術的な詳細が、右
側には常に温かい色のサイドバーで簡単な説明が 記載されています。行頭の小さなアイコン
を見れば、これからどのような 種類の情報が続くかを一目で把握できます。

4  つのアイコン

どこにあるか？ アプリ内の具体的なクリック経路 —— メニューバー、 Inspector の
セクション、または初心者モードのステップです。関連する キーボードショートカッ
トもここに記載されています。アイコンは 地図のピンで、この機能がユーザーイン
ターフェイスのどこにあるかを 示しています。

詳細。 既定値、値の範囲、コードパスです。特にメニュー項目では なく数値パラ
メータであるトレーニング設定でよく登場します。 アイコンは小さな仕様カード
です。

技術詳細。 この機能が内部で何を行うか、どのパラメータが影響し、 何に反応し、
どのような副作用があるかを説明します。背後で何が 起こっているかを理解したい読
者向けです。アイコンはスライダー ブロックで、ボンネットの下にあるつまみを象徴
しています。

簡単に言うと。 専門用語やコードなしで、主旨を明確な言葉で 伝えます。機能の用
途や使うべきタイミングを素早く知りたい場合は、 まずこのセクションから読んでく
ださい。アイコンは吹き出しで 「要点をまとめると」を意味します。この欄は常に温
かい砂色で 塗られているため、目がすぐに見つけられます。

章の色

各章には独自のアクセントカラーがあり、ID マーク （例えば M1 ） が各項目タイトルの左
に、また小さなアイコンの前にあるので識別できます。 ページをめくるとき、現在どの章に
いるかが一目でわかります。

1 メニュー 2 インスペクター 3 設定 4 補助ウィンドウ 6 トレーニング

7 プリセット 8 エクスポート 9 SfM 10 初心者モード



ナビゲーションのヒント

クイックスタート。 操作方法だけに興味がある場合は、直接 第 10 章 —— 初心者モー

ド に進んでください。これは 4 ステップの ガイド版で、事前知識は一切必要ありませ
ん。

より深く学ぶ。 第 2 章 —— インスペクター と 第 7 章 —— プリセット では、エキス
パートモードで使用できる操作要素と事前設定された品質 プロファイルを説明してい
ます。

参照する。 目次と PDF 全文検索を使えば、特定の機能を見つけられます。 マニュア
ルを最初から最後まで読む必要はありません。



R A D I A N C E K I T

章

はじめに — 知っておくべきこと

RadianceKit とは？

RadianceKit はネイティブ macOS アプリで、通常の写真群またはビデオから 歩き回れ
る 3D 再構築を作成します。入力は例えば、被写体の周り、室内、 あるいは風景の上を撮影
した 50 〜 500 枚のショットです。出力は Gaussian Splatting シーンと呼ばれるもの —— 
Mac 上でリアルタイムに あらゆる視点から見られる 3D モデルで、エクスポートして Web 
サイトに 埋め込むことも可能で、主要な側面においてフォトリアルに見えます。

このアプリは Mac 上で完全にローカルで動作します —— 画像は一切クラウドに アップロー
ドされず、ログインも要求されず、サブスクリプションもありません。 Apple Silicon Mac 
(M シリーズ) の GPU を集中的に活用します。完全な トレーニングはシーンとプリセット
に応じて 2 分から数時間かかることが あります。計算中も Mac で通常通り作業を続けられ、
RadianceKit は バックグラウンドで実行され、結果が完成すると通知します。

操作モードは 2 種類あります。初心者モード (Simple Mode) は、 インポート → プリセッ
ト選択 → トレーニング → エクスポートのワークフローを 4 ステップで案内します。エキス
パートモード (Expert Mode) では、 全ての設定項目を備えた大きな Inspector、ライブプレ
ビューウィンドウ、 診断チャートが開きます。モード間はいつでも切り替え可能で、シーン
の データは保持されます。

Gaussian Splatting とは？

Gaussian Splatting (しばしば略して 3DGS または単に Splatting) は、2023 年にグラーツ
と INRIA の論文で発表された 比較的新しいフォトリアリスティックな 3D 表現手法です。ア
イデアは シンプルです。シーンを古典的なポリゴンメッシュ (三角形) や ボクセルグリッド
としてモデル化する代わりに、何百万もの小さく柔らかい 3D 雲から構成します —— 一つひ
とつの雲は 3D ガウス分布 (それが名前の 由来) で、位置、サイズ、形状、色、透明度を独自
に持っています。 これらの雲は、入力写真のあらゆる視角から組み合わさったときに正しい 
画像が得られるように学習されます。

実際に言うと、Gaussian Splatting は反射、ハイライト、柔らかな葉、 髪の毛、カーテンと
いったものを、古典的な 3D モデリングでは不可能、 もしくは多大なコストでしか実現でき
ない方法で表現できます。その代わり、 結果は古典的な意味で編集可能な 3D モデルでは
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ありません —— 単一の壁を 動かしたり花瓶を置き換えたりすることはできません。むしろ、
自由に 歩き回れる空間の 凍結されたショット のようなものです。建築 ビジュアライゼー
ション、製品プレゼンテーション、バーチャルツアー、 鑑識、文化遺産といった多くの用途
では、まさにこれが適切な強みです。

入力画像から 3D シーンを作成するには、2 つのステップが必要です。 まず、アプリは 
Structure-from-Motion (SfM) と呼ばれる手法で、 各写真撮影時のカメラ位置を計算しま
す。その過程で、シーンの粗い点群が 副産物として生成されます。次に、実際の Gaussian 
Splatting トレーニングが 開始されます。この粗い点群から出発して、何百万もの 3D 雲が
徐々に 分布、拡大、洗練され、位置と色が調整されて、すべての入力視角から 一致する画像
が得られるようになります。

RadianceKit を使用するにあたって、これらの仕組みを知っている必要は ありません。初心
者モードはこれらのステップを完全に隠します。しかし、 エキスパートモードの診断数値 
(Iteration、Loss、Gaussians、SSIM …) が 何を意味するか、なぜ一部のシーンが他より美
しくなるかを理解したい場合は、 マニュアルの後半の章で答えが見つかります。
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章

第 1章 — メニューバー

RadianceKit のメニューバーは、メインウィンドウや Inspector に直接ない すべての機能を
整理します。主にシーン全体に影響するアクション (開く、保存する、 新規プロジェクト)、
トレーニングを制御するアクション (開始、一時停止、再開)、 ビューポートを操作するアク
ション (自動回転、スクリーンショット、背景色)、 さまざまな 3D およびメディア形式への
エクスポートをトリガーするアクションです。 また、すべての補助ウィンドウ (User Guide、
Pareto Dashboard、Holdout Analysis、 BayesOpt Console) へのジャンプポイントも含ま
れます。

キーボードショートカットは、各メニュー項目の右側に表示されます。規約: ⌘  は コマンド
キー (Apple キー)、 ⇧  は Shift、 ⌥  は Option (Alt)、 ⌃  は Control を 意味します。例
えば、 ⇧⌘T  は Shift+Command+T を表します。ここに記載された すべてのショートカット
は、Help → Keyboard Shortcuts (⌘/​) 経由で独自の 概要ウィンドウにも追加でリストされ
ます。

以下の 42 のエントリは、インベントリの順序 (M1〜M42) で記載され、関連する トップレ
ベルメニューごとにグループ化されています。すべてのエントリは現在の コード状態 (175〜
477 行) に対して検証されています。インベントリから削除または 時代遅れになったエント
リはありません。新しい Edit メニュー項目 (Cmd-Z による 「Remove Image」) は、システ
ム NSUndoManager フレームワーク経由で記録され、 そのため RadianceKitApp コードに
は表示されません (章末の注を参照)。
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File メニュー

図 1:  File メニューが展開された状態 — エントリ M1 から M6

File メニューは Apple の標準「New Window」エントリをプロジェクト固有のアクションで 
置き換えます。シーンの読み込み/保存、動的な最近のリスト、Workspace インポート、 空
の状態へのハードリセットを含みます。

M1 File > Open Scene…

場所

メニューバー → File → Open Scene… (⌘O)。

技術詳細

RadianceScene  バンドル、 .ply 、 .splat 、 .spz  
形式の ファイルダイアログを開きます。単一選択で、
ファイルとディレクトリ (バンドル形式用) の両方を
表示できます。選択が成功した後、パスは最近のリス

トに 登録され、シーンは非同期で読み込まれます — 前
のシーンは置き換えられ、 トレーニングパイプライン
は読み込まれた状態で初期化されます。PLY/SPZ/Splat 
ファイルは、それぞれの形式ローダーで読み込まれ

ます。 .radiancescene  バンドルは、 マニフェスト、
Cloud スナップショット、SfM 結果を含むディレクト
リです。

簡単に言うと

これは、すでにトレーニング済み

のシーンをアプリに再度読み込

む方法です。 RadianceKit 独自の
形式、および他の Splatting プロ
グラムが生成する標準形式 PLY、 
SPLAT、SPZ で機能します。例え
ば、夜通しトレーニングしたシー

ンを翌日に続行したり エクスポー
トしたいときに使用します。開く

と、メインウィンドウの以前の状

態が 置き換えられます — 現在の
シーンがまだ重要な場合は事前に

保存してください。 パスは自動的
に「Open Recent」(M3) に保存さ
れ、次回より早くアクセスできま

す。
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M2 File > Save Scene…

場所

メニューバー → File → Save Scene… (⌘S)。

技術詳細

コンテンツタイプ RadianceScene  バンドルと事前入
力されたファイル名 scene.radiancescene を持つファ
イル保存ダイアログを開きます。 manifest.json 、 シ
リアライズされた Gaussian Cloud (PLY スナップ
ショット)、SfM 結果のダンプを 含むディレクトリ
パッケージを書き込み、再度開いた後も Continue ト
レーニングが 機能します。Gaussian がまだ存在しな
い場合、このエントリは無効化されています。 保存先
はトレーニングログパスではなく、保存ダイアログが

示す場所 — 通常は ~/​Documents/​ 以下です。

簡単に言うと

現在のシーンをファイルとして保

存します (正確には、ファイルの
ように 見えるパッケージフォル
ダ)。これを行ってからのみ、後
で「Open Scene…」(M1) で この
シーンを再度開けます。パッケー

ジには Gaussian Cloud と SfM 結
果の両方が 含まれるため、後
で Continue トレーニング (M12〜
M14) を追加することもできま
す。 トレーニングをまだ完了
していない限り、エントリはグ

レーアウトされます。 標準名は 
scene.radiancescene ですが、
保存ダイアログで独自の名前を指

定できます。

M3 File > Open Recent > [シーン名]

場所

メニューバー → File → Open Recent → (リスト)。

技術詳細

最近開いたパスのリスト (設定に保存) から生成される
動的サブメニュー。 各リストエントリはファイル名で
名付けられ、クリックで読み込まれます。リストが 空
の場合、無効化されたラベル「No Recent Scenes」が
代わりに表示されます。 Apple 風に、リストは最近
開いた N 個のシーンを保持します — 制限は、設定への 
書き込み時に行われ、メニュービルダー自体ではあり

ません。

簡単に言うと

ここでは最近開いたシーンが表示

され、ファイルダイアログを経由

せずに クリックして再び開けま
す。最近始めたばかりの場合、リ

ストは空でメニューには グレー
で表示されます。「Open Scene…」
(M1) で開く各シーンは、自動的に
この リストに保存されます。リ
ストが多すぎる、またはプライバ

シー上の理由でクリアしたい 場合
は、「Clear Recent」(M4) を使用
してください。
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M4 File > Open Recent > Clear Recent

場所

メニューバー → File → Open Recent → Clear Recent。

技術詳細

設定の最近のリストをクリアします。確認ダイアログ

なしですぐに動作します。 このエントリは、最近のリ
ストにエントリが存在する場合にのみサブメニューに

表示 されます (パスの後、区切り線の下にあります)。

簡単に言うと

最近開いたシーンのリストを削除

します。テストデータセットで遊

んでいた 後、パスを表示したく
ない場合に便利です。シーンファ

イル自体は削除されません — メ
ニュー内のリンクのみです。アク

ションは確認なしですぐに動作し

ます。その後、 サブメニューに
は「No Recent Scenes」が表示さ
れます。このエントリは、リスト

に シーンが存在する場合にのみ表
示されます — リストが空の場合
は見えません。

M5 File > Import COLMAP / Metashape Workspace…

場所

メニューバー → File → Import COLMAP / Metashape 
Workspace… (⇧⌘I)。

技術詳細

フォルダピッカーを開きます。COLMAP Workspace 
レイアウト (例えば sparse/​0/​cameras.{bin,txt} + 
images/​) を持つフォルダを期待します。 選択後、
Workspace の事前チェックが実行されます — これ
は 3 つのレイアウト (sparse/​0/​、sparse/​、ルート) 
と、再構築がバイナリ ( cameras.bin ) または ETH3D 
テキスト ( cameras.txt ) として存在するかどうかを
検出します。成功した場合 Workspace がインポート
されます。それ以外の場合はアプリログに警告のみが

表示 されます。完全なパイプラインロジックについ
ては第 9 章「SfM バックエンド」Q6 も 参照してくだ
さい。

簡単に言うと

Metashape、
COLMAP、RealityCapture、または同
様のカメラ再構築用 ソフトウェア
を使用し、エクスポートを持って

いる場合、フォルダをここで読み

込みます。 RadianceKit は SfM ス
テージをスキップして、直接ト

レーニングを開始します — 大き
なシーンで時間を節約します。メ

インウィンドウへのドラッグ＆

ドロップも同じ ように機能しま
す。COLMAP レイアウトを持つ
フォルダが期待されます (つまり 
cameras.*  を持つ sparse/​0/​ 
と images/​ フォルダ)。サポート
されている レイアウトとワークフ
ローの詳細は、第 9 章「SfM バッ
クエンド」にあります。
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M6 File > New Project

場所

メニューバー → File → New Project (⇧⌘N)。

技術詳細

未保存の作業があるかどうかをチェックします。あ

る場合、何かが失われる 前に確認ダイアログが表示
されます。保存するものがない場合、リセットは直

接実行 されます — インポートされた画像、SfM 結
果、Gaussian Cloud、トレーニング状態、 すべての依
存 UI インジケータをクリアします。注意: ユーザーが
作成したプリセット ライブラリは保持されます。これ
はアプリ設定にあり、プロジェクト状態にはない から
です。

簡単に言うと

すべてを空のスタートにリセット

します — まるでアプリを開いた
ばかりの ように。未保存の作業が
まだある場合、アプリは事前に尋

ねます。まったく異なる シーンで
開始したい場合に使用します。イ

ンポートされた画像、SfM 結果、 
Gaussian Cloud、トレーニング状
態は完全にクリアされます。しか

し、独自のプリセットは アプリ設
定にあるため保持され、シーンに

属しません。

Mode メニュー

図 2:  Mode メニュー、Simple モードと Expert モードのスイッチ付き

ガイド付き Simple モード (ウィザード風、4 ステップ) とフル Expert モード (すべてのコン
トロールを持つ古典的な Inspector レイアウト) の間のシンプルな 2 つのスイッチです。
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M7 Mode > Simple Mode

場所

メニューバー → Mode → Simple Mode (⌘1)。

技術詳細

アプリ状態を Simple モードに切り替えます。アプリの
メイン領域は Expert レイアウトの代わりにガイド付き
ワークフローを表示します。モード状態は 設定に保存
されます (第 3 章 Settings の S1「Default Mode」参
照)。

簡単に言うと

インポート、処理、プレビュー、

エクスポートにアプリがあなたを

ガイドする ステップバイステップ
のバリアントに切り替えます。始

めたばかり、または素早く結果が 
必要な場合に推奨されます。ほと

んどの詳細コントロールは非表示

で、適切なプリセットで 作業し
ます。後でより深く入りたい場合

は、Expert モード (M8) に切り替
えるだけです。 アプリ起動時にど
のモードがアクティブかは、設定 
(第 3 章、S1) で設定できます。

M8 Mode > Expert Mode

場所

メニューバー → Mode → Expert Mode (⌘2)。

技術詳細

アプリ状態を Expert モードに切り替
えます。これにより、すべてのセク

ション (Presets、TrainingConfig、Enhancements、
Metrics、LossChart、ProjectNavigator) を 持つフル 
Inspector レイアウトが表示されます。Expert モード
では、すべての トレーニングパラメータ、COLMAP 
ピッカー、Mid-Compact トグル、診断にアクセス で
きます。ライブプレビューもこのモードでのみ機能し

ます。

簡単に言うと

すべてのコントロールを持つフル

ビューに切り替えます。ここでは 
Loss チャートをリアルタイムで見
て、すべてのパラメータを微調整

し、プリセット経由で 複数の比較
構成を並行して管理できます。ト

レーニングが内部で何をしている

かを理解 したい、または的を絞っ
た実験をしたい場合に推奨されま

す。ライブプレビュー、 COLMAP 
ピッカー、診断もここでのみア

クセス可能です。圧倒されてい

ると感じたら、 M7 経由で Simple 
モードに戻ってください — シー
ンは保持されます。
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Training メニュー

図 3:  Continue サブメニュー付き Training メニュー — エントリ M9 から M14

トレーニング実行に関する 4 つのアクション: 開始、一時停止、キャンセル、指定した 反復
数だけ延長。3 つの Continue エントリはすべて IAP でゲートされています (Free Trial バー
ジョンではクリック不可)。

M9 Training > Start Training

場所

メニューバー → Training → Start Training (⇧⌘T)。

技術詳細

トレーニングパイプラインを非同期で開始します。前

提条件: SfM 結果が 存在し、他のパイプラインが
現在実行されていないこと。両方の条件は、満たさ

れない 場合にエントリをブロックします。開始時
に、現在の構成値が読み取られ、新しい JSONL ログ
が ~/​Documents/​RadianceKit/​Logs/​training_​YYYY-
MM-DD_​HHmmss.jsonl に 作成され、戦略選択に応じて
クラシックまたは MCMC パスが実行されます。トレー
ニング 状態は「idle」から「training」に変わります。

簡単に言うと

大きな緑のボタンを押します — 
写真をインポートしてカメラ再

構築が 完了するとすぐに、実際
の Gaussian Splatting トレーニン
グが開始されます。アプリを 動
作させ続けてください。プリセッ

トに応じて、1 分 (Quick) から数
時間 (MCMC Quality) かかります。
SfM 結果がまだ存在しない、また
は他のパイプラインが現在 実行
されている限り、エントリはグ

レーのままです。各実行は同時

に ~/​Documents/​RadianceKit/​
Logs/​ にログを書き込みます。
これは後で Pareto Dashboard 
(M40) 経由で評価できます。
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M10 Training > Pause Training

場所

メニューバー → Training → Pause Training。

技術詳細

実行中のトレーニングを一時停止します。トレーニン

グ状態が「training」の 場合にのみ有効になります。
一時停止は反復ループを次の安全同期ポイントで停止

し、 完全な GPU 状態 (Gaussian バッファ、Optimizer 
モーメント、Scheduler 位置) を 保持し、「paused」
に切り替えます。再開は再度押すことで行われます (エ
ントリ タイトルは静的ですが、アプリは実際のロジッ
クで Pause/Resume を切り替えます)。 一時停止され
たトレーニングはアプリ終了を生き残りません。その

場合は代わりに シーンを保存し、後で Continue ト
レーニングエントリ (M12〜M14) で拡張します。

簡単に言うと

進行を失うことなく、トレーニ

ングを短期間停止します。コン

ピューターを より重要なことに
短期間必要な場合に便利です。も

う一度クリックすると再開しま

す。 アプリ再起動を超えて機能
しません — 本当に後で続行し
たい場合は、Cancel (M11) でト
レーニングを終了し、Save Scene 
(M2) でシーンを保存し、その後 
Continue Training (M12〜M14) を
使用してください。一時停止中、

GPU は完全に休止します。 ただ
し、メモリは占有されたままで

す。

M11 Training > Cancel Training

場所

メニューバー → Training → Cancel Training。

技術詳細

実行中のトレーニングを中止します。トレーニング状

態が「idle」でない 場合にアクティブです。トレーニ
ングエンジンのキャンセルフラグを設定します。 これ
は次の同期ポイントで反復ループをクリーンに終了し、

最終サマリーエントリを JSONL ログに書き込み、状
態を「idle」にリセットします。これまでトレーニング
された Cloud は保持されます (保存またはエクスポー
ト可能) が、「cancelled」とマークされます。

簡単に言うと

実行中のトレーニングを最終的に

中止します。これまでの状態は保

持されます — 数千の反復後にす
でに見せられる結果がある場合、

それでもエクスポートできます。 
短期間だけ中断したい場合は、代

わりに Pause (M10) を使用して
ください。 トレーニングログで
は、実行が「cancelled」とマー
クされ、最終 Loss 値は同様に 書
き込まれます。中止されたシーン

は、アプリがその間に終了されて

いない限り、 Continue Training 
(M12〜M14) 経由で後で続行する
こともできます。
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M12 Training > Continue Training > +5 000 iterations

場所

メニューバー → Training → Continue Training → 
+5,000 iterations。

技術詳細

トレーニングを 5 000 反復続行します。完了したト
レーニングが続行可能で、 フルバージョンがアンロッ
クされている場合にアクティブです。続行可能性は、

完了した トレーニングが存在し、完全な Optimizer 状
態がまだメモリにある場合に有効です。 Continue で
は、Adam モーメントと LR スケジューラが続行され、
続行は新規開始の 代わりに、連続的な 25K/45K/60K 
実行のように動作します。JSONL ログは、増分セット 
アップを含む新しい構成エントリを取得します。フル

バージョンでのみ利用可能。

簡単に言うと

さらに 5 000 のトレーニングス
テップを追加します。最初の実行

後に結果が 近いがまだ完全に鮮明
でない場合に使用してください。

有料のフルバージョンでのみ 機
能します。完全に新しい実行とは

異なり、Optimizer の状態は保持
されるため、 続行は連続的な実
行のように感じられます。5 000 
ステップ以上必要な場合は、 直
接 M13 (+10 000) または M14 (+20 
000) を使用してください。

M13 Training > Continue Training > +10 000 iterations

場所

メニューバー → Training → Continue Training → 
+10,000 iterations。

技術詳細

M12 と同じですが、10 000 の追加反復を持ちます。同
じ前提条件、同じ LR スケジューラパス。初期トレーニ
ングが中位のプリセットで実行され、実行を 完全に新
規開始することなく重要な品質向上を見たい場合に推

奨されます。

簡単に言うと

トレーニングを 10 000 ステップ
延長します — 利用可能な 3 つ
の Continue 値の中間値。最初の
実行は問題なかったが、明らかに

より良くしたい場合に 良い選択で
す。M12 と M14 と同様に、新規開
始の代わりに学習率の進行がシー

ムレスに 続行されます。フルバー
ジョンでのみ利用可能。
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M14 Training > Continue Training > +20 000 iterations

場所

メニューバー → Training → Continue Training → 
+20,000 iterations。

技術詳細

M12 / M13 と同じですが、20 000 の追加反復を持ち
ます。最大の指定された Continue ジャンプ。MCMC 
トレーニングでは、これは「フィット」と「ベンチ

マーク 対応」の違いをもたらすことが多いです。
Classic では 35〜40K から、経験的に ほとんど追加さ
れません。

簡単に言うと

さらに 20 000 のトレーニング
ステップを追加します、最大の 
Continue 値。 本当に品質の最後
の一滴を絞り出したい場合に使

用してください。クラシック ト
レーニングでは 40 000 ステップ
後に大した違いはありません — 
MCMC では 逆に、収束が遅れて始
まるため、しばしば価値がありま

す。シーンに応じて顕著な 追加実
行時間を見込んでください。M12 
と M13 と同様に、このエントリも
フルバージョンで のみ利用可能で
す。

Viewport メニュー

図 4:  Edit モード、カメラコントロール、Background サブメニュー付き Viewport メニュー

3D ビューポートを制御します: Gaussian 選択とクリーンアップ用の Edit モード、 カメラコ
ントロール (自動回転、再生、録画)、スクリーンショット、背景色、リセット。
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M15 Viewport > Enter/Exit Edit Mode

場所

メニューバー → Viewport → Enter Edit Mode (または
「Exit Edit Mode」、 状態に応じて)。⇧⌘E。

技術詳細

エントリタイトルは動的で、状態に応じて「Exit Edit 
Mode」または 「Enter Edit Mode」を表示します。押
すと、Edit モードが Viewport レンダラーで 切り替
わります。Edit モードを終了するとき、現在の選択
も追加でリセットされます。 Edit モードは、Gaussian 
のクリック選択、Box 選択、マークされた Gaussian 
の削除を 有効にします (UI の Editor 領域参照)。
Viewport レンダラーが接続されていない 限り無効化さ
れます。

簡単に言うと

通常の 3D ビューと、個々の 
Gaussian (例えば Floater や背景
の外れ値) を マークして削除でき
る編集モードを切り替えます。終

了時、選択は自動的にリセット さ
れます。Viewport にまだシーン
が表示されていない限り、エント

リはグレーの ままです。ラベルは
状態に応じて「Enter Edit Mode」
と「Exit Edit Mode」の間で 切り
替わります — したがって、現在
どのモードかが常にわかります。

M16 Viewport > Toggle Auto-Rotation

場所

メニューバー → Viewport → Toggle Auto-Rotation 
(⌘⌥T)。

技術詳細

シーン中心を通る垂直軸を中心としたビューポートカ

メラの連続回転を オン/オフします。軸と速度はカメ
ラコントロール構成から取得されます。Auto-Rotation 
は 純粋なビューポート効果で、トレーニングや録画に
は影響しません — Turntable Video レコーダー (M18) 
を並行して使用する場合、Auto-Rotation はレコー
ダーがキャプチャ する正確なパスを提供します。

簡単に言うと

マウスをドラッグせずにすべての

側面からシーンを見られるよう

に、カメラを ゆっくりと連続的に
シーンの周りに回転させます。も

う一度クリックすると回転が 停
止します。完成したトレーニング

済みシーンを評価したり、ライ

ブデモのバック グラウンドアニ
メーションとして実用的です。並

行してビデオを録画する (M18) 場
合、 Auto-Rotation はレコーダー
がキャプチャする正確な動きを提

供します。
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M17 Viewport > Toggle Camera Playback

場所

メニューバー → Viewport → Toggle Camera 
Playback。

技術詳細

カメラパス再生を切り替えます。記録された

カメラパス (例えば以前の録画から、 または 
transforms.json  が読み込まれたため) が存在する場
合、パスが実行されます — ビューポートカメラはマウ
ス/トラックパッド入力で移動しなくなり、フレームご
とに 軌跡を再現します。再度押すと再生が一時停止し
ます。

簡単に言うと

以前に記録またはインポートされ

たカメラ走行を実行します。これ

により、 シーンが記録された元
のパスをたどったり、ビデオエク

スポート前に計画された Orbit の
動きを確認したりできます。再生

中、マウスとトラックパッド入力

は無効化 されます — カメラは厳
密にパスに従います。再度クリッ

クすると再生が一時停止 します。
カメラパスを読み込んだり記録し

たりしていない場合、何も起こり

ません。

M18 Viewport > Record Turntable Video

場所

メニューバー → Viewport → Record Turntable Video。

技術詳細

ビューポート録画を切り替えます。最初に押すと一

時パスへのフレーム録画が 開始されます。2 回目に
押すと録画が終了され、エンコードされて MP4 パスに 
書き込まれます (パスは保存ダイアログ経由で尋ねられ
ます)。Export → Media → Orbit Video (M31) が固定 
360° パスを設定可能な長さで生成するのとは異なり、
Turntable レコーダーはビューポートで見ているものを 
ライブ で録画します — したがって、手動カメラ走行も
録画できます。

簡単に言うと

Viewport で直接ビデオを録画し
ます。カメラが自動的に回転す

るか、マウスで 自分で動かすか
に関係なく — 見るすべてが MP4 
ファイルに保存されます。「Orbit 
Video」エクスポート (M31) とは
異なり、カメラ走行を自分で指定

します。最初の クリックで録画
が開始され、2 回目のクリックで
終了され、保存場所が尋ねられま

す。 例えば、固い Orbit の動きで
は不可能な特定の詳細パンを示し

たい場合に便利です。
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M19 Viewport > Save Screenshot

場所

メニューバー → Viewport → Save Screenshot 
(⇧⌘S)。

技術詳細

フルレンダリング解像度の単一ビューポートフレーム 
(つまり、ウィンドウ ピクセルレイアウトではなく、フ
ルレンダーターゲットコンテンツ) を PNG ファイル
として キャプチャします。パスは保存ダイアログ経
由で尋ねられます。背景色 (M21〜M23) は 焼き込まれ
ます。Enhancements (I27/I28 参照) の MetalFX/MPS 
アップスケーリング 設定は、アクティブな場合に影響
します — スクリーンショットはアップスケールされた 
出力を表示します。

簡単に言うと

現在の 3D ビューのスナップ
ショットを PNG 画像として保存
します。 マーケティング資料や素
早い比較に実用的です。注意: 背
景は画像の一部です — 透明度が
必要な場合は、シーンファイルを

エクスポートしてください。解像

度は ウィンドウサイズではなく
内部レンダーターゲットに対応し

ます — 画像はしばしば ウィン
ドウで見るよりも鮮明です。アッ

プスケーリング設定 (Inspector → 
Enhancements) も含まれます。

M20 Viewport > Copy Camera Info

場所

メニューバー → Viewport → Copy Camera Info。

技術詳細

現在のビューポートカメラのポーズ (位置、Look-At ポ
イント、Up ベクトル) と FOV 値をカメラコントロー
ルから読み取り、クリップボードに複数行テキストと

して 書き込みます。形式は人間が読める形式 (行ごと
にラベル = 値) で、JSON では ありません。デバッグ
目的で特定のビューを再現したり、サポートと共有し

たりするのに 実用的です。

簡単に言うと

現在のカメラ位置と視線方向をテ

キストとしてクリップボードにコ

ピーします。 例えば、共同開発者
にシーンのどの位置から奇妙に見

えるかを示したい場合、テキスト

を メールやチャットウィンドウに
簡単に貼り付けます。形式は人間

が読める形式 (値ごとに 1 行) で、
JSON ではありません。主にバグ
レポートやサポートリクエスト用

に 意図されています。
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M21 Viewport > Background > Dark Gray

場所

メニューバー → Viewport → Background → Dark 
Gray。

技術詳細

ビューポート背景色を暗いグレー (RGB 0.1/0.1/0.1) に
設定します。 レンダラーは、Gaussian がコンポジッ
トされる前の背景としてこの色を使用します。 アプ
リ起動時のデフォルト色は、Settings オプション S3
「Default Viewport Background」で制御されます。

簡単に言うと

3D ビューポートの背景を暗いグ
レーに着色します。ほとんどの

シーン用の 標準選択 — 明るい 
Gaussian と暗い Gaussian の両方
に対して良いコントラストを 提
供し、目が純粋な黒や白の表面に

固定されません。色はスクリー

ンショット (M19) と Orbit ビデオ 
(M31) にも引き継がれます。Dark 
Gray が地味すぎる場合は、比較
のため Black (M22) または White 
(M23) も試してください。アプリ
起動時にどの色が アクティブか
は、設定 (S3) で設定できます。

M22 Viewport > Background > Black

場所

メニューバー → Viewport → Background → Black。

技術詳細

ビューポート背景色を純粋な黒 (RGB 0/0/0) に設定し
ます。シーンに多くの 明るい Floater があり、それら
を識別したい場合、または暗いルックアンドフィール

の マーケティング資料に役立ちます。

簡単に言うと

黒い背景。非常に明るいシーンに

適しており、または Edit モードを
見て、 グレーで埋もれる小さな明
るい Gaussian (Floater) を探した
い場合。暗くドラマチックな ルッ
クのマーケティング資料にも理想

的です。色はスクリーンショット

と Orbit ビデオに 焼き込まれます 
— 後でコンポジットするための透
明度が必要な場合、黒は最悪の 選
択です。暗い Floater には、反対
方向の White (M23) に再度切り替
えてください。

18 / 227



R A D I A N C E K I T 第 1章 — メニューバー

M23 Viewport > Background > White

場所

メニューバー → Viewport → Background → White。

技術詳細

ビューポート背景色を純粋な白 (RGB 1/1/1) に設定しま
す。シーンが 主に暗いコンテンツを持ち、暗い Floater 
(典型的な屋外背景ノイズ) を見たい場合に 便利です。

簡単に言うと

白い背景。被写体が明るい背景で

より良く表示される、または後

で Edit モード (M15) で削除できる
暗い外れ値を見つけるために実用

的です。屋外シーンでは、 典型的
な屋外 Floater がむしろ暗いため、
白がしばしば黒より便利です。他

の背景 オプションと同様に、色は
スクリーンショットとビデオに引

き継がれます。

M24 Viewport > Reset Camera

場所

メニューバー → Viewport → Reset Camera。

技術詳細

ビューポートカメラをリセットし、Training Camera 
ビューを離れ、 Auto-Rotation を停止します。これに
より、カメラは初期位置 (典型的: シーンの前、 わずか
に上から見下ろす) に戻り、Auto-Rotation はオフにな
り、レンダラーが現在 Training Camera (SfM ポーズの 
1 つ) を表示していた場合、Free Camera に戻ります。

簡単に言うと

ビューポートカメラを開始位置

に戻します。回転中に迷ったり、

シーンを 画像から押し出したりし
た場合 — ここを一度クリックす
ると、見るべきものが再び 見え
ます。同時に Auto-Rotation がオ
フになり (実行中の場合)、固定され
た Training カメラから自由ビュー
に戻ります。これにより、どのよ

うな場合でも、ビューの クリーン
な再起動が得られます。
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Export メニュー

図 5:  3 つのサブメニューグループ付き Export メニュー — 3D Formats、Media、 
Photogrammetry

3 つのセクション (3D Formats、Media、Photogrammetry) にグループ化された 8 つの エ
クスポート先と 2 つの Photogrammetry エクスポート。最初の 6 つは、それぞれ 保存ダイ
アログを開いて形式カタログでエクスポートを登録する共通ヘルパー ルーチンを介し
て構築されます。Photogrammetry エントリは個別のロジックを持ちます。 すべての 
Photogrammetry エクスポートと一部の 3D エクスポートは、フルバージョンで のみ利用可
能です。

M25 Export > 3D Formats > Export PLY…

場所

メニューバー → Export → 3D Formats → PLY (⌘E)。

技術詳細

事前指定ファイル名 gaussians.ply  を持つ保存ダ
イアログを開きます。 OK で、現在の Gaussian Cloud 
が標準化された ASCII/Binary PLY 形式に書き込まれま
す — SuperSplat、PolyCam、PlayCanvas、すべての
一般的な 3DGS ビューアーと互換性が あります。フ
ル SH 係数、フル精度 (フィールドごとに Float32)。≥ 
500K Gaussian で ファイルサイズはしばしば数百 
MB。

簡単に言うと

3D シーンを標準 PLY ファイル
として保存します。これは最も

普遍的な 形式です — SuperSplat、
PolyCam、PlayCanvas など、ほぼ
すべてのソフトウェアが これを
読み込めます。しかし、ファイル

は大きくなり、しばしば数百メガ

バイトに なります。フル品質で
続行またはアーカイブしたい場合

は PLY を使用してください。 Web 
経由でシーンを共有したい場合

は、代わりに SPZ (M27) または 
Compressed PLY (M26) をご覧く
ださい — これらは大幅に小さい
です。
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M26 Export > 3D Formats > Export Compressed PLY…

場所

メニューバー → Export → 3D Formats → 
Compressed PLY。

技術詳細

位置、スケール、回転、SH フィールドのカスタム量
子化を持つ Compressed PLY 形式で Gaussian Cloud 
を書き込みます。圧縮されていない PLY (M25) よ
り 5〜10 倍 小さいファイル、最小限の視覚的損
失。SuperSplat (Compressed PLY 標準を読み込む) 
と PlayCanvas と互換性があります。標準ファイル名 
gaussians_​compressed.ply。

簡単に言うと

通常の PLY と同じですが、5〜
10 倍小さくなります。品質はほぼ
同じ ままです。オンラインで共
有したり、メールで送信したりす

るためのファイルが必要な 場合
に使用してください。SuperSplat 
と PlayCanvas で直接機能します。
ただし、 ターゲットシステムが
さらに小さいファイルを必要とす

る場合 (モバイル、ブラウザデモ)、 
代わりに SPZ (M27) を使用してく
ださい — これはさらに積極的に
圧縮されます。 フル編集品質に
は、圧縮されていない PLY (M25) 
を使用してください。

M27 Export > 3D Formats > Export SPZ…

場所

メニューバー → Export → 3D Formats → SPZ。

技術詳細

SPZ 形式で Gaussian Cloud を書き込みます — 
Niantic がリリースした、 積極的な量子化を持つ圧
縮された Splat 形式 (圧縮されていない PLY より ~90 
% 小さい)。主に Web ビューアーとモバイルアプリ用
に最適化されています。Niantic Splatt3R、gsplat.js、
Niantic ブラウザビューアーと互換性があります。

簡単に言うと

最小の形式の 1 つ。通常の PLY よ
り約 10 倍小さい。特にブラウ
ザで シーンを表示する、または
携帯アプリで表示したい場合に

使用してください。最大品質に

は PLY がより良い選択です。SPZ 
は Niantic が開発し、gsplat.js、
Splatt3R、Niantic Web ビューアー
で直接機能します。強い圧縮のた

め、SPZ ファイルをそのまま再 ト
レーニングすることはできません 
— 編集には PLY を使用してくださ
い。
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M28 Export > 3D Formats > Export glTF…

場所

メニューバー → Export → 3D Formats → glTF。

技術詳細

KHR_gaussian_splatting 拡張付きの .glb  ファイ
ル (Binary glTF) を 書き込みます。標準準拠で、
Babylon.js や Three.js などの glTF エンジンを使用し、 
KHR_gaussian_splatting 拡張を実装するパイプライ
ンに適しています。

簡単に言うと

多くの 3D プログラムや Web エ
ンジンが理解する glTF 形式で
シーンを 保存します — ただし、
Gaussian Splatting 拡張をサポー
トする場合に限ります。 特定の 
3D パイプライン (例えば Three.js 
または Babylon.js) がそれを理解
する 場合、これはあなたの形式で
す。ファイルはバイナリ .glb  
として出力されます — すべてを
含む単一のパッケージ。古典的な 
Splatting ワークフローには、よ
り多くの ツールがそれを直接理解
するため、通常 PLY や SPZ がより
良い選択です。

M29 Export > 3D Formats > Export .splat…

場所

メニューバー → Export → 3D Formats → .splat。

技術詳細

Antimatter15 .splat  形式を書き込みます — 
Gaussian あたり固定サイズ 32 バイト (位置は 3× 
Float32、スケールは 3× Float32、回転は 4× Uint8 正
規化 クォータニオン、RGB+Opacity は 4× Uint8)。
DC より高い SH 係数はありません。 ブラウザの直接
互換性を持つ最小ファイル。gsplat.js と antimatter15 
のオンライン デモビューアー用。

簡単に言うと

最もシンプルな Web ビューアー
形式。小さく、すぐにどのブラウ

ザでも 表示可能。ただし、ディ
テール照明を失います (より高い 
SH 係数が失われます — 光に反応
する代わりに、Splat はすべての
視点から同じに見えます)。最大の 
Web パフォーマンスには良いです
が、フォトリアリズムには SPZ ま
たは PLY の方が 適しています。
antimatter15 オンラインビュー
アーと gsplat.js で機能します。 
各 Gaussian は固定 32 バイトを占
有し、形式をシンプルかつ互換

性のあるものに します — ただし、
ディテールの深さを犠牲にして。
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M30 Export > 3D Formats > Export SOG…

場所

メニューバー → Export → 3D Formats → SOG。

技術詳細

SOG 形式で Gaussian Cloud を書き込みます。SOG 
(「Self-Organizing Gaussian」) は、Texture Atlas レ
イアウトと量子化されたデータの WebP 圧縮を持つ 
PlayCanvas 形式です。PLY より 15〜20 倍優れたサイ
ズ比率でスケーリングします。 エクスポートは内部で 
cwebp  を外部ツールとして呼び出します — そのため、 

Sandbox バリアント (App Store) では潜在的に制限さ
れます。

簡単に言うと

PlayCanvas ワークフロー用の
非常に小さい形式。データが 
Texture Atlas レイアウトにパッ
クされて WebP 圧縮されるた
め、PLY より約 15〜20 倍小さ
くなります。 PlayCanvas ワーク
フローがない場合は、SPZ また
は Compressed PLY が通常より良
い 選択です。エクスポートは内部
で cwebp  を外部ツールとして呼
び出します — App Store バージョ
ン (Sandbox) では、このステップ
が制限される可能性があります。

M31 Export > Media > Export Orbit Video…

場所

メニューバー → Export → Media → Orbit Video。

技術詳細

シーン中心の周りに 360° Orbit をレンダリングし、
MP4 (H.264) または MOV (HEVC、システムデフォル
トによる) としてエンコードします。M18 (ライブ録
画) と 異なり、パスはここで固定されています — 長さ
は Settings または Simple モード エクスポートステッ
プで選択されます。

簡単に言うと

シーンの周りに自動的に回転ビデ

オを生成します。手動移動は不要

です。 ソーシャルメディアや素早
いデモに適しています。カメラを

自分で制御したい場合は、 代わり
に Record Turntable Video (M18) 
を使用してください。パスは固定: 
シーン 中心の周りに完全な 360° 
Orbit、長さは設定または Simple 
モードエクスポート ステップで
選択します。ビデオはシステムに

応じて H.264-MP4 または HEVC-
MOV として 出力されます。
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M32 Export > Media > Export Web Viewer…

場所

メニューバー → Export → Media → Web Viewer。

技術詳細

スタンドアロン HTML ビューアー (gsplat.js ベース) 
と base64 エンコード された Gaussian データを単一
の .html  ファイルにパッケージ化します。このファ
イルは 最新のブラウザでオフラインで実行されます — 
サーバー依存性なし、外部 URL なし。 ファイルサイズ
は SPZ バリアントの約 1.3 倍 (base64 オーバーヘッ
ドのため)。

簡単に言うと

シーンを自己起動 Web ページと
して保存します。HTML ファイル
をダブル クリック → ブラウザ
が開く → 完成したインタラクティ
ブな 3D シーン。インターネッ
ト なしで機能し、メールで送信
可能で、結果を友人やクライアン

トと共有する最も簡単な 方法で
す。ファイルには完全な gsplat.js 
ビューアーと Gaussian データが
単一の ドキュメントに含まれてい
ます — Web から何もリロードさ
れません。ファイルサイズは SPZ 
エクスポートの約 1/3 大きいです
が、受信者側で追加のソフトウェ

アは不要です。

M33 Export > Photogrammetry > Export SfM (transforms.json)…

場所

メニューバー → Export → Photogrammetry → Export 
SfM (transforms.json)。

技術詳細

独自のエクスポートパス (共通ヘルパールーチンを
介していません)。 Gaussian Cloud ではなく SfM 結
果がエクスポートされるためです。事前指定とし

て transforms.json  とコンテンツタイプ json  を
持つ保存ダイアログを開きます。 OK で、カメラ
内部パラメータ、ポーズ (NeRF 規約の 4×4 マトリ
クスとして)、フレーム パスを持つ nerfstudio 互換 
transforms.json  が書き込まれます。UI のヘルプ テ
キストは、トレーニング画像を兄弟フォルダ images/​ 
として一緒にコピーする必要が あることを指摘してい
ます。SfM 結果が存在し、フルバージョンがアンロッ
クされて いる場合にのみアクティブです。

簡単に言うと

SfM 結果を nerfstudio、Brush、
gsplat、OpenSplat などの別の ソフ
トウェアで再利用したい場合、こ

こでカメラ位置をエクスポート

します。 トレーニング画像を 
transforms.json  ファイルの
横の images/​ フォルダに追加で 
配置してください — そうしない
と、ターゲットプログラムは画像

を割り当てられません。 SfM 結果
がまだ存在しない限り、エントリ

はグレーアウトされ、Free Trial 
バージョンで ロックされます。
COLMAP Workspace ワークフロー
には、代わりに M34 を使用して 
ください。
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M34 Export > Photogrammetry > Export SfM (COLMAP Workspace)…

場所

メニューバー → Export → Photogrammetry → Export 
SfM (COLMAP Workspace)。

技術詳細

事前指定名 colmap-workspace  (フォルダのため拡張
子なし) を持つ保存 ダイアログを開きます。sparse/​

0/​cameras.bin、 images.bin 、 points3D.bin  を 持
つ標準 COLMAP Workspace を書き込みます。
RadianceKit で計算またはインポートされた SfM 再
構築を Postshot、Nerfstudio、Meshroom などの他の
ツールで開いたり、A/B 再実行で RadianceKit 自体に
既に計算された入力として (M5 経由で) 再度読み込ん
だり することができます — 計算時間を節約します。
SfM 結果が存在し、フルバージョンが アンロックされ
ている場合にのみアクティブです。

簡単に言うと

M33 と同じですが、nerfstudio 
の代わりに COLMAP 形式です。
Postshot、 Meshroom、Nerfstudio、
または COLMAP ワークフローを持
つ他のツールを使用する場合、 こ
れがあなたのエクスポートです。

実用的な副作用: このフォルダを
後で M5 経由で RadianceKit に再
度読み込んで、次の実行で SfM 計
算時間を節約できます — 特に
大きなシーンでは数時間の時間

節約。M33 と同様に、SfM 結果が
存在し、Free Trial バージョンで
ロックされていない場合にのみ利

用可能です。

Help メニュー

図 6:  ドキュメント、フォルダ、分析エントリ付き Help メニュー

7 つのエントリ: 2 つのドキュメントウィンドウ (User Guide、Keyboard Shortcuts)、 3 
つのフォルダショートカット (Training Logs、Exports、Storage)、3 つの分析 ウィン
ドウ (Pareto Dashboard、Holdout Analysis、BayesOpt Console)。Apple 風に、 Help メ
ニューは右端に表示されます。標準 Help メニューは、RadianceKit 独自の バリアントで完
全に置き換えられています。
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M35 Help > User Guide

場所

メニューバー → Help → User Guide (⌘?)。

技術詳細

User Guide ウィンドウを開きます。トピックサイド
バーとスクロール詳細 領域を持つナビゲーションを、
デフォルトサイズ 860×640 で表示します。コンテン
ツは 静的に保存されています (Markdown から解析さ
れていません)。

簡単に言うと

アプリ内部のガイドを開きます。

このマニュアル全体を読みたくな

い場合、 そこでプログラム内に
最も重要なステップが見つかりま

す。ガイドは、トピックサイド

バーを 持つ独自のウィンドウと
して構築されています — 個々の
トピックに的を絞って ジャンプ
できます。コンテンツはこのハン

ドブックより短く、最も一般的な 
ワークフローに焦点を当てていま

す。

M36 Help > Keyboard Shortcuts

場所

メニューバー → Help → Keyboard Shortcuts (⌘/)。

技術詳細

Keyboard Shortcuts ウィンドウを開きます — すべて
のアプリショートカットを トップレベルメニューご
とにグループ化したシンプルなスクロールレイアウト。

デフォルト サイズ 440×560。コンテンツも静的に保
存されています。

簡単に言うと

すべてのキーボードショートカッ

トの完全なリストを持つウィンド

ウを 開きます。例えば、どのキー
でトレーニングを開始するか思い

出せない場合、そこを 見てくだ
さい。要約はこの章の最後にもあ

ります。リストはトップレベルメ

ニュー ごとにグループ化されてお
り、適切なエリアに素早くジャン

プできます。マウス スタイルから
キーボードスタイルに移行してい

る場合に役立ちます。
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M37 Help > Open Training Logs…

場所

メニューバー → Help → Open Training Logs… 
(⇧⌘L)。

技術詳細

ログフォルダを ~/​Documents/​RadianceKit/​Logs とし
て計算し、必要に 応じて作成し、Finder で開きま
す。各トレーニング実行は、独自の JSONL ファイ
ル training_​YYYY-MM-DD_​HHmmss.jsonl をそこに書き
込みます。

簡単に言うと

これまでのトレーニングプロトコ

ルすべてを含むフォルダを Finder 
で 開きます。何かがうまくいか
なかった、またはトレーニングが

正確にいつどの値に収束 したか
を確認したい場合、ここで JSONL 
ファイルとして見つけられます。

トレーニング 実行ごとに、タイム
スタンプ付きで正確に 1 つのファ
イルが作成されます — これを 他
のツールに読み込んだり、サポー

トにメール送信したりすることも

できます。 グラフィカルな評価が
必要な場合は、Pareto Dashboard 
(M40) がより良い入り口です。

M38 Help > Open Exports Folder…

場所

メニューバー → Help → Open Exports Folder…

技術詳細

M37 と類似していますが、~/​Documents/​RadianceKit/​

Exports を使用します。 最初の Auto-Test 実行または
最初のクリックで作成されます。その後、すべての 
Auto-Test エクスポートの標準パス (例えば autotest_​
<timestamp>.ply) がそこに 配置されます。保存ダイア
ログ経由で手動で選択されたエクスポートは、必ずし

も ここに行くのではなく、ユーザーが保存する場所に
行きます — そのため、このフォルダは 主に Auto-Test 
に興味深いです。

簡単に言うと

アプリが独自のエクスポートを

配置するフォルダ (主に Auto-Test 
実行) を 開きます。保存ダイアロ
グで手動でエクスポートを別の場

所に置いた場合、それは そこに
あり、このフォルダにはありませ

ん。クリーンアップしたり、以前

のテスト エクスポートがどれくら
いのスペースを占有しているかを

確認したりするのに実用的 です。
ログとシーンバンドルを含む完全

な概要が必要な場合は、代わりに 
Manage Storage (M39) を使用し
てください。
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M39 Help > Manage Storage…

場所

メニューバー → Help → Manage Storage…

技術詳細

Storage ブラウザを開きます (第 4 章 Auxiliary 
Windows、IDs W7〜W12 参照)。 ~/​Documents/​
RadianceKit/​ フォルダ内のすべての永続化されたシー
ン、トレーニング ログ、エクスポート、キャッシュを
サイズとともにリストし、エントリごとに Reveal-in-
Finder と Move-to-Trash を可能にします。

簡単に言うと

ディスク上で RadianceKit がどれ
くらいのスペースを占有してい

るかを — シーン、ログ、エクス
ポートごとに — 示すウィンドウ
ブラウザを開きます。Finder に 
移動することなく、個別のものを

直接削除できます。長時間使用

後、ディスクが いっぱいになる
ときに実用的です — 以前のログ
と Auto-Test エクスポートは 数ギ
ガバイトに合計される可能性が

あります。Reveal-in-Finder 経由
で、古典的な ビューにいつでもア
クセスできます。

M40 Help > Pareto Dashboard…

場所

メニューバー → Help → Pareto Dashboard… (⇧⌘D)。

技術詳細

Pareto Dashboard を開きます (第 4 章、IDs W13〜
W22 参照)。Dashboard は ~/​Documents/​RadianceKit/​
Logs/​ からすべての JSONL トレーニングログを読み込
み、 シーンとプリセットごとにソートし、Pareto 
Scatter Plot (デフォルト: Loss vs Gaussian、オプ
ションで Loss vs Wallclock または PSNR vs 反復) を
描画します。

簡単に言うと

これまでのトレーニング実行すべ

ての概要を図として開きます。ど

の実行が 品質とサイズの最良の
バランスを提供したかがすぐに

わかります。さまざまなプリセッ

トを 互いに比較したい場合に実
用的です。デフォルトでは、図は 
Loss 対 Gaussian 数を 表示します 
— ただし、Wallclock 時間または 
PSNR に切り替えることもできま
す。 データは JSONL トレーニン
グログ (M37) から来ます。実行が
多いほど、評価がより 意味のある
ものになります。
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M41 Help > Holdout Analysis…

場所

メニューバー → Help → Holdout Analysis… (⇧⌘H)。

技術詳細

Holdout 分析ウィンドウを開きます (第 4 章、IDs 
W23〜W29 参照)。 transforms.json  を読み込み、
カメラを 3D Globe として描画し、Train/Test fold 分
割 (角度または線形、2〜8 fold) を許可します。出力
は fold-assignment.json で、トレーニングはそれぞ
れのトレーニング構成でテストセットとして使用でき

ます。

簡単に言うと

カメラ撮影をトレーニングセッ

トとテストセットに分割するの

に役立ちます — シーンの品質を
客観的に測定できます (トレーニ
ングが見ていない画像で)。むし
ろ 研究およびベンチマークツー
ルです。カメラは 3D Globe とし
て表示されます。 2 から 8 fold の
間で、角度で均等または順序にわ

たって線形に選択できます。結

果は 小さな JSON ファイルで、ト
レーニングはこれをテストセット

として使用します。

M42 Help > BayesOpt Console…

場所

メニューバー → Help → BayesOpt Console… (⇧⌘B)。

技術詳細

BayesOpt Console を開きます (第 4 章、IDs W30〜
W39 参照)。事前定義された 検索空間 (例えば
「MCMC scale-reg + opacity-reg + ssim」) を読み込
み、ベイズ 最適化トライアルを非同期で実行し、収束
曲線とトライアルログをライブで表示します。

簡単に言うと

組み込み自動チューナーコンソー

ル。さまざまなパラメータを手動

で試す 代わりに、アプリは夜通し
自分で実行し、最後にシーンに最

適な値を提案できます。 非常に
高度なツール — ほとんどのワー
クフローでは良いプリセット (第 7 
章参照) で 十分です。事前定義
された検索空間 (例えば「MCMC 
scale-reg + opacity-reg + ssim」) 
を 選択し、収束曲線とトライア
ルログをライブで見ます。セット

アップに応じて、数時間 から数日
を計画してください。

注意: Edit メニューの Cmd-Z

2026 年 5 月以降、Expert モードの Project Navigator は、マイナスボタンまたは バックス
ペースキーによるインポート画像の削除、および Cmd-Z  経由の取り消しを サポートします。
この Cmd-Z アクションは、削除された画像がまだ復元可能である限り、 macOS Edit 
メニュー (SwiftUI から提供) に「Undo Remove Image」として表示 されます。これは標準
準拠の NSUndoManager システム経由で登録され、RadianceKitApp にはありません。した
がって、インベントリに独自の M-ID エントリはありません。
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キーボードショートカット概要

メニュー項目 ショートカット

File > Open Scene… ⌘O

File > Save Scene… ⌘S

File > Import COLMAP / Metashape Workspace… ⇧⌘I

File > New Project ⇧⌘N

Mode > Simple Mode ⌘1

Mode > Expert Mode ⌘2

Training > Start Training ⇧⌘T

Viewport > Enter/Exit Edit Mode ⇧⌘E

Viewport > Toggle Auto-Rotation ⌘⌥T

Viewport > Save Screenshot ⇧⌘S

Export > 3D Formats > PLY ⌘E

Help > User Guide ⌘?

Help > Keyboard Shortcuts ⌘/

Help > Open Training Logs… ⇧⌘L

Help > Pareto Dashboard… ⇧⌘D

Help > Holdout Analysis… ⇧⌘H

Help > BayesOpt Console… ⇧⌘B

Edit メニュー (システム提供、Project Navigator 選択がアクティブな Expert モード):

アクション ショートカット

Undo Remove Image ⌘Z

Remove Selected Image Backspace / Delete
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章

第 2章 — Inspector (エキスパート

ビュー)

図 7:  エキスパートモード空 — 左に Project Navigator (Images 0、Cameras、 Log)、中央
に空のビューポート、右に Inspector (Presets/Training Configuration/Enhancements/Training 

Metrics セクション)

インポート前の空の Inspector: 左サイドバーには Images カウンター 0 と、 ドロップヒン
ト「Drop images here / or tap + to import」が表示されます。右の Inspector は完全に機
能しますが、プリセットは情報提供のみ (アクティブな トレーニングはありません)。デフォ
ルトプリセット「Preview」(5K 反復) が マークされています。Camera-Alignment は Apple 
Photogrammetry、Densification は Classic、SSIM Weight 0.20、Render Scale 50 %。
Training Metrics の空状態 (「Start training to see live metrics」) と Loss History (「Loss 
curve will appear during training」) も表示されます。
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図 8:  60 枚の flowers 画像をロードした Inspector — Image サイドバーに 最初のファイル名 
frame_0001.jpg ff、ヘッダー「60 images ready」

インポート後の Inspector: ヘッダーステータス「60 images ready」。 Image サイドバーに
インポートされた 60 枚のフレームすべて ( frame_0001.jpg  から frame_0945.jpg  まで、
960 カメラのブーケデータセットから 16 フレームごとの サブセットを高速反復用にしたも
の) がリストされます。Auto-Render-Scale ロジックは 画像解像度 (1536×2048 = 3.1 MP) 
を確認し、それに応じて Render Scale を調整します。 Play ボタン (緑色、左下) はアクティ
ブになり、アクティブなプリセットで トレーニングを開始します。

図 9:  トレーニング中の Inspector — ライブビューポートに flowers ブーケの 再構築、下のメト
リックバー (Loss / LR / Gaussian カウント / 反復)、 パラメータが調整された場合「Modified」

バッジ付きの「Preview」プリセットカード

トレーニング中の Inspector: タイトルバーには全体進捗 「RadianceKit — Training NN 
%」が表示されます。Viewport は実行中の Gaussian 再構築をリアルタイムでレンダ
リングします (50 反復ごとに更新 — Live Preview 間隔は Settings → General → Training 
→ Live Preview で調整可能)。Viewport の 下のメトリックバー: 現在の Loss、Learning 
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Rate、Gaussian カウント、反復カウンター (例えば Preview プリセットで 1,600/5,000)。
Inspector プリセットカード「Preview」は、 組み込みデフォルトからパラメータが逸脱
するとすぐに「Modified」バッジが付きます。 サイドバー「Log」は SfM とトレーニングス
テージのイベントを収集します。

図 10:  トレーニング完了後の Inspector — Viewport に完成した flowers ブーケ 再構築 (5K 反復
後 2,991 Gaussian、13 秒)、タイトルバー「Training Complete — 2,991 Gaussians」

トレーニング後の Inspector: タイトルバーには最終 Gaussian 数 (ここでは 2 991 — 非常に
コンパクト。合成 Blender ブーケシーンが明るい背景上の単純な 形状を持つため) が表示さ
れます。Viewport は完成した点群を表示します — オービット型ドラッグナビゲーションが
アクティブです (シーン中心の周りに回転)。 Training Metrics セクションは最終値で満たさ
れ、Loss History チャートは 5 000 反復全体の経過を示します。下のエクスポートセクショ
ンがアクティブになります (すべての形式ボタンが有効化)。

Inspector はエキスパートモード (⌘2) の右サイドバーです。すべての トレーニング関
連パラメータを 7 つの折りたたみ可能なセクションにまとめます。 初回起動時の上
から下へのデフォルト順序は次のとおりです: Look、Presets、 トレーニング構成、メ
トリック、Loss チャート、Enhancements、Export。 「Look」セクション (トレーニン
グ後の画像調整) は、以前の「Finishing」セクションの 実際の UI 上の改称です — そ
の内部 Enum の rawValue  は永続性の理由から 「Finishing」のままで、表示される見出し
は「Look」です。各セクションは ヘッダーをクリックして折りたたみ、順序はドラッグ

＆ドロップで並べ替え可能です (InspectorView.swift:81-97)。初回起動時はすべての 7 つ

の セクションが折りたたまれています (inspectorCollapsedSections のデフォルトは 
Set(InspectorSection.allCases))。アプリ状態はその後、折りたたみと順序の設定を ア
プリ起動を超えて保存します。

Inspector の操作要素の一部は、設定 (第 3 章) にもほぼ同じ形で表示されます — 典型的に
は SfM バックエンド、Sky-Masking、および同様のデフォルトです。分離は 意図的です: 設
定は新しいプロジェクト用のアプリ全体テンプレートを提供し、Inspector は 現在開いてい
るプロジェクトのこれらの値を上書きします。一度どちらかの操作ロジックを 知れば、もう
一方は目をつぶって使えます。

33 / 227



R A D I A N C E K I T 第 2章 — Inspector (エキスパートビュー)

エキスパートモードの左カラム — Project Navigator — は Inspector の一部では ありません
が、その直接の隣にあります。そこではインポートされた画像をクリックで 選択し、スペー
スキーでクイックルックで表示し、マイナスボタンまたは Delete キーで 削除 (Cmd-Z で取
り消し可能) できます。Inspector は現在のサイドバー選択に従って コンテキスト固有の詳細
情報を表示しますが、7 つのメインセクションは常に 利用可能です。

Look セクション (L1〜L5)

Look セクション (内部 rawValue  は引き続き「Finishing」) は最上部の Inspector セク

ションで、トレーニング後の画像調整を一箇所に 集約します。すべてのスライダーは非破

壊的に動作します: 各スライダーは FinishingPass  を変更されていない Pristine スナップ
ショット (オリジナルの DC カラー、Opacity、スケーリング) に対して改めて適用します — 

この調整は したがって冪等 (idempotent) であり、累積しません。結果は Viewport にライ

ブで (WYSIWYG、後のエクスポートとまったく同じ) 表示され、 すべてのエクスポートに焼

き込まれます。このセクションは トレーニング実行の完了後にのみ利用可能です (それ以前

は 「Available after a training run completes.」と表示)。その値は 新しいトレーニングの

たびにリセットされます。エクスポートが実行されて いる間、すべてのスライダーはロック
されます — ロックヒント 「Locked while exporting — the file uses the current settings.」
が表示され、 GroupBox は無効化されます。

L1 Saturation スライダー

場所

Inspector → Look セクション → GroupBox → 
Saturation。

技術詳細

スライダー 0.5〜1.2、表示は小数 2 桁 (例えば
「1.00」)。各 Splat の SH-DC クロマを輝度値の周りで
スケーリングします: 1.0 = 変更なし、< 1.0 = 彩度を 
下げる (色をグレースケールへ引き寄せる)、> 1.0 = よ
り鮮やか。数学的には DC カラーは Pristine スナッ
プショットから逆算されるため ( desaturateDC )、繰
り返しスライドしても 累積しません。DJI ドローン素
材 (Pensford 高架橋) で検証済みで、これは色が過剰
に なりがちです — ドローンのデフォルトは 0.82 です。
色の基礎 (SH 次数 0) にのみ 作用し、より高次の SH 
係数は手付かずのままです。

簡単に言うと

完成した Splat の色がどれだけ鮮
やかかを決めます。1.00 はすべて
を トレーニングされたままにし、
それ未満の値は色をグレー方向へ

引き寄せます — しばしば過飽和
で出力されるドローンやビデオ素

材に最適です。1.0 を超える値は 
より鮮やかにします。アプリは常

に変更されていないオリジナルの

状態から計算し直す ため、何か
が「増幅」することなく自由に行

き来できます。Viewport にライ
ブで 表示され、エクスポートでも
まったく同じです。
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L2 Splat length スライダー

場所

Inspector → Look セクション → GroupBox → Splat 
length。

技術詳細

スライダー 0.3〜1.0、表示は小数 2 桁。各 Gaussian 
の 3 つの スケーリング軸を対数空間で平均値へ引き寄
せます ( shortenScale 、係数 alpha ): 1.0 = 変更な
し、より小さい値は細長い「針」状の Splat をより丸
くし、0 で純粋な 球になります。針状の過度に引き伸
ばされた Splat に作用し、全体のサイズを変えずに 典
型的な「コンフェッティ」アーティファクトを減らし

ます。Pristine スナップショット (オリジナルの対数ス
ケーリング) から適用されるため冪等です。両方とも対
数空間で 動作するため Splat size (L3) と可換です。

簡単に言うと

長すぎる、ささくれ立った Splat 
をより丸くします。1.00 は形状を 
トレーニングされたままにし、よ

り低い値は引き伸ばされた「針」

をより丸い斑点に 押し縮めます 
— これがコンフェッティアーティ
ファクトに悩まされた粒状の再構

築を 落ち着かせます。全体のサイ
ズは同じままで、長さだけが対象

です。Splat size (L3) と 安全に組
み合わせられます。

L3 Splat size スライダー

場所

Inspector → Look セクション → GroupBox → Splat 
size。

技術詳細

スライダー 0.5〜2.0、表示は小数 2 桁。各 Gaussian 

を 3 つ すべての軸で一様にスケーリングします 
( sizeScale ): 1.0 = 変更なし、 < 1.0 = より小さく/密
に/鮮明に、> 1.0 = より大きく/「ふわふわ」に (Splat 
間の 隙間を埋める)。スケーリングは対数空間にあるた
め、乗算は加算的な log(factor)  オフセットとして
実現されます — 一定のオフセットは平均からの偏差を 
手付かずのままにするため、これは Splat length (L2) 
と可換です。Pristine スナップショットから適用される
ため冪等です。このバージョンで新規。

簡単に言うと

すべての Splat を一様により大き
くまたは小さくスケーリングしま

す。 1.00 はトレーニングされた
状態で、それ未満の値は点群をよ

り密で鮮明にし、それを 超える値
は Splat 間の隙間を覆います (よ
り柔らかく/「ふわふわ」に見えま
す)。 穴だらけの再構築を視覚的
に閉じる、あるいは逆により多く

の詳細を引き出すのに 便利です。
Splat length (L2) と問題なく共存
します — 両方のスライダーは互
いに 影響しません。
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L4 Fade far region (サブスライダー付き)

場所

Inspector → Look セクション → GroupBox → トグル
「Fade far region」 およびサブスライダー「Fade start 
×radius」と「Fade floor」。

技術詳細

カメラ重心からの距離とともに放射状の Opacity 
減衰を有効化する トグルです — 背景の弱く
観測された「Far コンフェッティ」をフェー

ドアウトさせます。 オービット撮影専用: 
finishingContext.fadeEligible が false の場合 (直
線飛行、カメラが少なすぎるまたは退化している)、
トグルは無効化されます。 その場合、サブスライ
ダーの代わりにヒント「Far-fade applies only to orbit 
captures (not this scene).」が表示されます。適格性
はカメラ位置の方位角カバレッジで 判定されます 
(オービットは重心を周回し多くのコンパスセクター
を埋め、直線飛行は ~2 つだけ)。2 つのサブスラ
イダーがジオメトリを制御します: Fade start ×radius 
(1.0〜3.0) はオービット半径の倍数として内側半径を 
設定し、その内側ではフル Opacity が適用されます。
Fade floor (0.0〜1.0) はフェード半径のはるか彼方で

の Opacity 係数です。重要: フェードは Sky-Dome 領

域をスキップします (インデックス [0, frozenCount) 
の frozen Gaussian)。これにより意図的な背景ドーム
が一緒に暗くならないようにします。

簡単に言うと

シーンの外縁にあるぼやけた残り

をフェードアウトさせます — ま
さに 全周撮影で遠く後方に浮か
ぶ「Far コンフェッティ」の塊で
す。本物のオービット/ 周回撮影
でのみ機能します。直線的なド

ローン飛行やカメラが少なすぎる

場合、 スイッチはグレーアウト
し、理由を説明するヒントが表示

されます。アクティブな場合、 2 
つの微調整スライダーが追加され

ます:「Fade start ×radius」はど
の距離から (周回半径の倍数とし
て) フェードが始まるかを設定し、
「Fade floor」は遠くの Splat が 最
終的にどれだけ見えたままにな

るかを設定します (0 = 完全に消え
る、1 = 変更なし)。 意図的に再構
築された Sky-Dome (I44) はその
際決して手を付けられません — 
空は保持されます。
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L5 Reset finishing ボタン

場所

Inspector → Look セクション → GroupBox →「Reset 
finishing」(下の 小さいボタン)。

技術詳細

すべての Look 設定をデフォルトにリセットし 
(FinishingPass.Settings() = Saturation 1.0、Fade 
オフ、Splat length 1.0、 Splat size 1.0)、ただちに 
再 Finishing をトリガーするため、Viewport は変更
されていないトレーニング済みの 状態に戻ります。
controlSize(.small)。Look スタック全体が Pristine 
スナップショット から冪等に計算するため、「デフォル
トに戻す」はまさに元のトレーニング出力です — 何度
も行き来しても品質劣化はありません。セクションの

すべてのスライダーと同様に、 実行中のエクスポート
中はロックされます。

簡単に言うと

ワンクリックですべての Look 
スライダーを標準に戻します 
(Saturation 1.00、Fade オフ、両方
の Splat スライダーを 1.00)。その
後 Viewport は 再び新しくトレー
ニングされた結果をまったくその

まま表示します。いじりすぎて き
れいにゼロから始めたいときに便

利です。アプリは常にオリジナル

の状態から計算する ため、その際
に品質劣化はありません。エクス

ポートが実行されている間、ボタ

ンは (スライダーと同様に) ロック
されます。

Presets セクション (I1〜I11)

Presets セクションは、テストされた構成を適用する最も速い方法です。組み込み プリセッ
ト (Capture Class、Classic、MCMC、Hybrid) は、560+ の文書化された実験から再現可能
な 開始点を提供します。独自のプリセットは保存、エクスポート、インポート、共有が 可能
です。リストはカテゴリ別 (Capture Class、Classic、MCMC、Hybrid、Custom) にグルー
プ化され、 複数のカテゴリを同時に展開できます。コンテキストメニュー機構 (行を右ク
リック) を 介して、Export、Duplicate、— 独自プリセットの場合 — Delete にアクセスでき
ます。
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I1 Save…ボタン

場所

Inspector → Presets セクション → Save…ボタン (下
のアクションバー)。

技術詳細

テキストフィールドと Save/Cancel ボタンを持つポッ
プオーバーを開きます。 現在の TrainingConfig 状態が
新しいユーザー定義プリセットとして永続化されま

す (JSON エンコード、アプリ全体に保存)。Save 操作
は、現在の Densification 戦略を 含む 81 のトレーニン
グパラメータすべてをコピーします。プリセットは、

派生元の 組み込みプリセットに関係なく、自動的に 
Custom カテゴリに配置されます。空の名前と 純粋な
空白入力は破棄されます。すでに存在する名前は拒否

されません — 各プリセットには独自の内部 ID があり、
重複名は技術的に許可されていますが、 実際には混乱
を招きます。

簡単に言うと

現在の構成を再利用可能なプリ

セットとして保存します。ボタン

を押して、 ポップオーバーに名
前を入力し、Save をクリックし
ます — Densification 戦略を 含む 
81 のパラメータすべてが、選択さ
れた名前で Custom カテゴリに配
置されます。 苦労して、次のプロ
ジェクトで再びゼロから調整した

くない場合に必要です。 「ドロー
ン 4K」や「室内 高速」などの繰
り返しのセットアップに特に実用

的です。 重複名は技術的に許可さ
れていますが、実際には混乱を招

きます — 何か分かりやすい 名前
を選んでください。

I2 Preset Name テキストフィールド

場所

Save ポップオーバー → テキストフィールド「Preset 
Name」。

技術詳細

角丸境界線を持つシンプルなテキストフィールド、幅

広い形状。値は Save ボタンクリック時にプリセット
名として引き継がれます。UI には長さ制限は ありま
せんが、保存される名前は JSON エンコード可能で、
UI リストで表示可能で ある必要があります — 絵文字
とウムラウトは機能します。コンテンツは ポップオー
バーが開かれるときに自動的に空の文字列にリセッ

トされます。Save ボタンは、 トリム後にフィールドが
空である限り無効です。自動候補もアクティブなプリ

セット名の 事前入力もありません。

簡単に言うと

ここでプリセットの名前を入力し

ます。Custom カテゴリで後で見
つけやすい ように、「ドローン 4K 
30fps」や「室内 高速」など何か
分かりやすい名前を選んで くださ
い。絵文字とウムラウトが許可さ

れており、厳しい長さ制限はあり

ません。 フィールドが空、または
空白のみで構成されている限り、

Save ボタンはグレーアウト され
ます。ポップオーバーを再度開く

とフィールドは再び空になります 
— アクティブなプリセット名によ
る事前入力はありません。
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I3 Cancel ボタン (Save ダイアログ)

場所

Save ポップオーバー → Cancel ボタン (左)。

技術詳細

保存せずにポップオーバーを閉じます。テキストフィー

ルドのコンテンツを 破棄します — 次回開くと、
Save…ボタンロジック (I1) で再び空にリセットされま
す。 標準ボタンスタイル、確認ダイアログなし、ホッ
トキーなし。Save パスが実行 されなかったため、現
在の TrainingConfig は変更されません。

簡単に言うと

何も保存せずに Save ポップオー
バーを閉じます。考え直したり、

入力ミスを したり、ダイアログ
を誤って開いた場合 — 単純に 
Cancel をクリックしてください。 
何もまだ書き込まれていないた

め、現在のトレーニング構成は変

更されません。 ポップオーバーを
再度開くと、名前フィールドは再

び空で開始されます。 確認なし、
ホットキーなし — クリックして
消えます。

I4 Save ボタン (Save ダイアログ)

場所

Save ポップオーバー → Save ボタン (右、目立つスタ
イル)。

技術詳細

実際の永続化をトリガーします。空でない名前

を再度検証 (防御的チェック) してから、現在の 
TrainingConfig を JSON としてアプリストレージに書
き込みます。 その後ポップオーバーを閉じます。青で
強調表示され、テキストフィールドが空である 限りグ
レーアウトされます。保存が失敗した場合 (例えばアプ
リストレージが いっぱい — 非常にまれ)、現在表示さ
れるエラーダイアログはありません。 プリセットは次
回アプリ起動時に単に表示されなくなります。

簡単に言うと

Save をクリックすると、名前
が引き継がれ、現在のセット

アップが新しい プリセットと
して書き出されます。ポップ

オーバーが閉じ、プリセットは 
Preset リストの Custom カテゴ
リにすぐに表示され、これから

クリックでアクティブ化できま

す。 ボタンは青で強調表示さ
れ ( borderedProminent )、名前
フィールドが空である限り グレー
アウトされたままです。保存が失

敗した場合 (例えば UserDefaults 
が いっぱい)、表示されるエラー
ダイアログはありません — プリ
セットは次回アプリ 起動時に単に
表示されなくなります。
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I5 Export…ボタン

場所

Inspector → Presets セクション → アクションバー → 
Export…ボタン。

技術詳細

現在選択されているプリセットを .radiancepreset  
ファイル (内部 JSON) として エクスポートします。プ
リセットが選択されていない場合は無効化されます。

クリック すると、アプリは事前指定ファイル名 (プ
リセット名 + .radiancepreset  拡張子) を 持つ Save 
ダイアログを開きます。保存される形式には、完全な 
TrainingConfig と メタデータ (名前、カテゴリ、ID、
組み込みフラグ) が含まれます。Finder で ダブルク
リックするとアプリが開きますが、自動的にインポー

トは しません。 ユーザーは Import ボタン (I6) を使用
する必要があります。

簡単に言うと

リストでプリセットを選択して 
Export をクリックします — その
後、 .radiancepreset  ファ
イルとして保存し、同僚に送信し

たり、2 台目の Mac に 転送したり
できます。受信者は Import…ボタ
ン (I6) で再度ロードします。組み
込み プリセットと独自の Custom 
プリセットの両方で同じように機

能します。リストで何も クリッ
クされていない限り、ボタンはグ

レーアウトされます。ヒント: コ
ンテキスト メニュー (I8) 経由では
さらに高速です — プリセットを
最初に選択する必要は ありませ
ん。

I6 Import…ボタン

場所

Inspector → Presets セクション → アクションバー → 
Import…ボタン。

技術詳細

.radiancepreset  ファイルのみを許可するファイル
ダイアログを開きます (複数選択無効)。選択時、JSON 
ファイルが読み込まれ、検証され、Custom カテゴリ
に 新しい内部 ID で挿入されます — 組み込みとの衝突
を防ぐためです。インポートは、 エクスポートされた
プリセットが元々組み込みであった場合でも、カテゴ

リを 自動的に Custom に設定します。破損したファイ
ル、または古いスキーマバージョンと 互換性のない
ファイルは、エラーダイアログなしで暗黙的に拒否さ

れます (ただし コンソールログには情報が表示され
ます)。

簡単に言うと

ディスクから 
.radiancepreset  ファイルを
読み込みます。誰かが テスト済み
のセットアップを送ってきた場合

や、複数の Mac で自分のお気に入
りの プリセットを同期したい場合
に便利です。インポートされたプ

リセットは、元々が 組み込みから
エクスポートされたものであって

も、常に Custom カテゴリに 配置
されます。破損したファイルや古

いファイルは暗黙的に無視されま

す。 コンソールログに理由が表示
されます。ダイアログでの複数選

択は無効化されているため、 ク
リックごとに 1 つのファイルで
す。
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I7 プリセット行 (クリックアクティブ化)

場所

Inspector → Presets セクション → 各カテゴリの各プ
リセット行。

技術詳細

プリセット行をクリックすると、TrainingConfig の
すべてのフィールドが プリセットの値で置き換えられ、
アクティブなプリセットの ID が記憶され、Modified 
ステータスがリセットされます。行の前のアクティ

ブチェックマークは、プリセットが 選択されてお
り、変更されていない場合にのみ表示されます。他

の Inspector セクションの TrainingConfig の値 (スラ
イダー、ステッパー、トグル) が変更されるとすぐに、 
名前の後にオレンジの「Modified」バッジが表示され
ます。組み込みプリセットは 上書きできません — 変更
の場合は Save ボタン (I1) で独自のコピーを作成する 
必要があります。

簡単に言うと

行をクリックするとプリセットが

アクティブになり、そこに保存さ

れている すべての値が現在のト
レーニング設定に引き継がれま

す。名前の前のチェックマーク

は、 現在どのプリセットがアク
ティブかを示します。その後、他

のセクションでスライダー、 ス
テッパー、トグルを調整すると

すぐに、名前の後にオレンジの

「Modified」バッジが 表示されま
す — セットアップがプリセット
から逸脱したからです。組み込み 
プリセットは上書きできません。

変更を保持したい場合は、Save…
ボタン (I1) で 独自のコピーを作成
するか、プリセットを複製 (I9) し
てください。

I8 コンテキストメニュー「Export…」

場所

各プリセット行を右クリック → 最初のエントリ
「Export…」。

技術詳細

I5 (Export…ボタン) と同じ機能ですが、より便利にア
クセスできます — プリセットを事前に選択する必要は
ありません。行で直接クリックされたプリセットを エ
クスポートします。すべてのプリセットカテゴリ (組み
込みまたは Custom) で 同じように機能し、制限はあ
りません。エクスポートには組み込みフラグと元の カ
テゴリが含まれますが、再インポート時には I6 で説明
したようにカテゴリは Custom にマッピングされます。

簡単に言うと

素早くエクスポートする方法 — 
希望のプリセットを右クリックし

て 「Export…」を選択します。事
前にクリックして Export…ボタン
を押す回り道を 節約します。す
べてのカテゴリで同じように機

能し、組み込みでも同じです。

生成された .radiancepreset  
ファイルは I5 のものと同じです。
後で再インポートすると 自動的に 
Custom カテゴリに配置されます。
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I9 コンテキストメニュー「Duplicate」

場所

各プリセット行を右クリック → 2 番目のエントリ
「Duplicate」。

技術詳細

プリセットを Custom カテゴリに複製します。新しい
内部 ID を生成し、 名前に「 Copy」を追加し、コピー
を保存します。組み込みプリセットでも機能します — 
クローンは編集可能になります。オリジナルはそのま

まです。TrainingConfig は値ごとに コピーされ (JSON 
ラウンドトリップ)、オリジナルとコピー間に参照バイ
ンディングは 存在しません。

簡単に言うと

Custom カテゴリにプリセットの
編集可能なコピーを作成します。

例えば、 組み込み「Quality」プ
リセットを出発点として、SSIM 
スライダーを少しだけ動かしたい 
場合に実用的です。ワークフロー: 
複製、名前変更 (コンテキストメ
ニューまたは 新規 Save…実行)、調
整、完了。オリジナルはそのままで

す — いつでも戻れます。 組み込
みでも機能します。これは、その

値をベースとして引き継ぎながら

同時に編集可能に する唯一の方法
です。

I10 コンテキストメニュー「Delete」

場所

独自プリセット行を右クリック → 最後のエントリ
「Delete」 (赤、破壊的)。

技術詳細

Custom プリセットでのみ表示されます。組み込みは
削除できません。 エントリは破壊的とマークされ、コ
ンテキストメニューに赤で表示され、誤って クリック
しないように区切り線の後に配置されています。確認

ダイアログは ありません — クリックでプリセットがす
ぐに削除されます。削除された プリセットは復元でき
ません (Cmd-Z はここでは機能しません — 現在のビ
ルドでは Undo は画像リストでのみ機能し、プリセッ
ト操作では機能しません)。削除された プリセットが現
在アクティブだった場合、現在の TrainingConfig は変
更されず、 アクティブなプリセット選択のみがクリア
されます。

簡単に言うと

独自プリセットを削除します。組

み込み (Quick、Preview、Balanced、 
Quality、Ultra Detail、Drone / Aerial、
360° Walkaround、Photo / Object 
など) では、「Delete」がそもそも
表示 されません — 誤って kill す
ることはできません。注意: 確
認ダイアログや Undo は なく、
クリックでプリセットが消えま

す。確信がない場合は、事前に 
Export… (I5/I8) で ディスクに安全
コピーを保存してください — い
つでも再インポートできます。 
プリセットがアクティブだった

場合、TrainingConfig は変更され
ず、チェックマークのみが 消えま
す。
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I11 カテゴリヘッダー (展開/折りたたみ)

場所

Inspector → Presets セクション → 各カテゴリ
ヘッダー (Capture Class、Classic、MCMC、Hybrid、
Custom)。

技術詳細

異なるデフォルトを持つカテゴリごとの折りたたみ

状態: キュレーションされた Capture Class グループは 

展開 で開始し、Classic、MCMC、Hybrid、Custom 

は 折りたたみ で 開始します。状態は永続化されませ
ん — アプリ再起動時にすべてのカテゴリは デフォルト
状態に戻ります。Chevron 矢印はアニメーション付き
で回転します。 ヘッダーの右側の数字は、このカテゴ
リのプリセットの数を示します。クリック ヒット領域
はヘッダー全体に及びます。

簡単に言うと

プリセットリストを見やすく保

つために、カテゴリを展開およ

び折りたたみ ます。アプリ起動
時、Capture Class グループは開
いており、Classic、MCMC、Hybrid、
Custom は 閉じています。ヘッ
ダー (全領域がクリック可能) を
クリックすると、リストが短い 
Chevron アニメーションで開閉し
ます。右側の小さな数字は、カテ

ゴリに含まれる プリセットの数を
示します。アプリの再起動後、デ

フォルト状態が再び表示されます 
— アプリはこの折りたたみ設定を
意図的に保存しません。

トレーニング構成セクション (I12〜I22)

図 11:  トレーニング構成セクションのみのクロップ — Camera Alignment (Apple 
Photogrammetry アクティブ、Native (Beta) 非アクティブ)、Densification (Classic アクティ
ブ)、Link シンボル付き Max Iterations 5,000 / Densify Until 3,500、SSIM Weight スライダー 

0.20、Render Scale スライダー 100 % (1,536×2,048 = 3.1 MP)

ここに中心的な制御要素があります: どの SfM バックエンドが計算するか、Densification の 
動作、反復数、SSIM 重みです。MCMC 戦略では、Classic モードで非表示になる 2 つの
追加トグル (「MCMC Quality」と「Auto-scale by scene」) が表示されます。 Native SfM 
バックエンドでは、EXIF 焦点距離のないビデオフレーム用の FOV オーバーライド フィール
ドが追加されます。
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I12 Camera Alignment ピッカー

場所

Inspector → トレーニング構成 → Camera Alignment 
(上部のセグメンテッドピッカー)。

技術詳細

2 つのオプションを持つセグメンテッドピッカー: 
Apple Photogrammetry と Native (Beta)。選択は次の
カメラ再構築で使用される SfM バックエンドを決定
します。 同時に、他のどの Inspector 要素が表示さ
れるかにも影響します: Native は、EXIF の ないビデオ
フレームでのみ必要な FOV オーバーライド (I13) を
追加で表示します。 ヒント: 非常に大きな屋外撮影で
は、外部ツール (Metashape または COLMAP) の結果
を Workspace インポート経由で読み込めます — 第 1 
章 (M5) と第 9 章 (Q3、Q6) 参照。

簡単に言うと

ここでカメラ位置がどのように再

構築されるかを選択します — 最
終品質の 最も重要なスイッチ。
Apple Photogrammetry は高速な
標準で、ほとんどのオブジェク

ト スキャンに完全に十分です。
Native (Beta) は App Store 準拠の
独自開発で、オービットや ター
ンテーブルシーンに適しており、

EXIF のないビデオフレームでは 
FOV オーバーライド (I13) が必要
です。非常に大きな屋外セット

では、Metashape や COLMAP で
カメラを 代替計算し、結果を 
Workspace インポート経由でロー
ドできます。シーンタイプ別の 詳
細と推奨事項は第 9 章にありま
す。

I13 FOV Override フィールド (Native SfM)

場所

Inspector → トレーニング構成 → FOV Override 
(Camera Alignment = Native の場合にのみ表示)。

技術詳細

数値テキストフィールド (Range 0-170°)、デフォル
ト 0 = EXIF または ヒューリスティックからの自動決
定。手動入力は、焦点距離メタデータを含まない ビデ
オから抽出された入力画像の場合に必要です。典型値: 
iPhone Wide ≈ 73°、 DJI Mavic Wide-Crop ≈ 70°、
フルフォーマットセンサー付きドローン ≈ 84°。値は 
[0, 170] にクランプされます — 範囲外の値は直接戻さ
れます。ネイティブ SfM パイプライン (Q4/Q5) のみ
に影響します。Apple Photogrammetry はこの値を完
全に 無視します。

簡単に言うと

画像に EXIF がない場合 (抽出され
たビデオフレームに典型的)、ここ
に カメラの水平視野を度単位で
入力します。経験値: iPhone Wide 
≈ 73°、DJI Mavic Wide-Crop ≈ 70°、
フルフォーマットセンサー付き

ドローン ≈ 84°。0 はアプリ自身
に 推測させます — しばしばうま
くいきますが、まれなレンズでは

うまくいかないことが あります。
170° を超える値は自動的に戻さ
れます。フィールドは Native を 
Camera Alignment (I12) として選
択した場合にのみ表示され、有効

です — Apple Photogrammetry は 
完全に無視します。
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I15 Densification ピッカー

場所

Inspector → トレーニング構成 → Densification (セグ
メンテッドピッカー、常に表示)。

技術詳細

2 つの Densification 戦略間で切り替えます: 
Classic (オリジナル 3DGS プロシージャ、Clone/
Split/Prune と勾配閾値付き) と MCMC (Stochastic 
Gradient Langevin Dynamics with Relocation、
NeurIPS 2024)。Classic から MCMC への切り替え
時、 アプリは MCMC 固有のフィールドを自動的にテ
スト済みのデフォルト値 (Reg-Weights = 0、 MCMC-
Cap-Multiplier 3.0、Sample/Noise スケジュール) に
設定します。この自動初期化なし では、古いプリセッ
トのセッションが 1.4.4 MCMC-Collapse バグ (460K 
→ 5 Gaussian、 ウォッチドッグキル) に苦しみまし
た。ピッカーの選択は、表示される Inspector 要素
も 追加で決定します — MCMC では I16/I17 が表示さ
れます。詳細なフィールド効果は 第 6 章 T11〜T16 
(Classic) と T61〜T73 (MCMC)。

簡単に言うと

Gaussian 数の成長のための中心
的な戦略選択。Classic は 459 の
実験から よくチューニングされ、
高速で高品質な結果を生成し、

MCMC フィールドを知る必要は あ
りません。MCMC は新しいアプ
ローチ (NeurIPS 2024)、より再現
可能で、手動の閾値 調整を不要に
します — 代わりに、同等の品質
で約 6 倍長く計算します。MCMC 
への 切り替え時、アプリは自動的
に安全なデフォルトを設定し、ト

レーニングが 1.4.4 Collapse に陥
らないようにします。戦略フィー

ルドの詳細は第 6 章 (T11〜T16 
Classic、T61〜T73 MCMC) にあり
ます。

I16 MCMC Quality トグル

場所

Inspector → トレーニング構成 → MCMC Quality 
(Densification = MCMC の場合のみ)。

技術詳細

勾配累積を 2 ステップ (アクティブ) または 1 ステッ
プ (非アクティブ) に 切り替えます。Optimizer ステッ
プが実行される前に、連続する 2 つのカメラビュー
からの 勾配を累積します。経験的に (Session 33、
V544a)、最終 L1 エラーが約 6% 減少します (Horse-
Full-MCMC の 3 試行平均で Quality 付き 0.0246 vs 
Quality なし 0.0261)。 コスト: 倍のトレーニング時
間。非常に長いトレーニング (200K 反復) では、これ
により 10+ 分の追加待ち時間が発生します — 最後の
数パーセントの品質が本当に必要な場合に のみ価値が
あります。トレーニングのみに影響し、エクスポート

形式や Viewport 表示には 影響しません。

簡単に言うと

2 ビューにわたる勾配累積付き 
MCMC の Quality モード。経験的
に最終結果が 約 6% 良くなり 
(Horse テストで L1 0.0261 の代わ
りに 0.0246)、その代わり倍の時
間が かかります。すでに 200K 
MCMC トレーニング (簡単に 2 時
間) を実行している場合、 さら
に 1 時間弱が追加されます。最
終ショーケースレンダリングま

たは Quality Sweep セッションの
終わりに価値がありますが、日々

のワークフローではむしろそうで

はありません。 Densification が 
MCMC (I15) に設定されている場合
にのみ表示されます。
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I17 Auto-scale by scene トグル

場所

Inspector → トレーニング構成 → Auto-scale by 
scene (MCMC の場合のみ)。

技術詳細

アクティブな場合、実効最大 Gaussian 上限は SfM 初
期点数 × MCMC-Cap Multiplier (デフォルト 3.0) でス
ケーリングされます。例: SfM は 250K 初期点を 提
供し、基本上限 = 150K、Multiplier 3.0 → 実効上限 = 
max(150K、750K) = 750K。 非アクティブの場合、基
本のみが厳密に適用されます。1000 フレーム以上で対
応する高い SfM 点密度を持つ大規模な屋外撮影が、固
定 150K キャップデフォルトで Densification を 飢え
させていたため、v1.4.5 で導入されました — 余分な点
が残り、新しい点は発生 できませんでした。Custom 
プリセットでデフォルト OFF、MCMC 組み込みで 
ON。 トレーニング時にのみ影響し、エクスポートに
は影響しません。

簡単に言うと

Gaussian の最大数をシーンサイ
ズに合わせて成長させます (より
正確には: SfM 初期点の数ととも
に)。小さなシーンではほとんど違
いに気づきませんが、大きな 屋外
シーンでは品質にしばしば決定的

です — そうでなければ、デフォ
ルトの上限 150K がシーンに対し
て低すぎるため、トレーニングが

「窒息」します。非常に大きな 屋
外セット (1000 フレーム以上) が
目に見えてキャップに引っかかっ

た後、v1.4.5 用に 特別に導入され
ました。MCMC 組み込みプリセッ
トではすでに事前に有効化されて

います。 独自のプリセットではデ
フォルトでオフです。

I18 Max Iterations ステッパー

場所

Inspector → トレーニング構成 → GroupBox → Max 
Iterations。

技術詳細

Range 1 000〜100 000、ステップ幅 1 000 の
ステッパー。Optimizer 反復の 総数を決定し
ます。トレーニング時間と線形に相関 (半
減 = 約 50% 時間)。経験的 スイートス
ポット: 20K (Classic Balanced、L1≈0.028)、40K 
(Classic Quality、 L1≈0.023)、200K (MCMC Full、
L1≈0.0246)。40K を超える Classic は平均してほとん
ど 改善をもたらしません — 収益逓減。変更時、Link 
機能 (I19) がアクティブな場合、 Densify Until が比例
して引き寄せられます (デフォルト比: 0.5、つまり 
Densify-Until = Max/2)。

簡単に言うと

何回のトレーニングステップが実

行されるか — 多いほど良いが、
線形に 時間もかかります。経験
則: 良い品質には 20 000、Classic 
戦略の最適値には 40 000 (それを
超えると平均してほとんど何もも

たらしません)。MCMC はかなり
多くを必要とし、 200 000 がここ
での標準です。反復を倍にする

と、トレーニング時間がほぼ倍に

なります。 アクティブな Link ボ
タン (I19) では、Densify Until が
比例して引き寄せられます — ほ
とんど常にあなたが望むもので

す。
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I19 Link/Unlink ボタン (Densify ↔ Iterations)

場所

Inspector → トレーニング構成 → GroupBox → Max 
Iterations と Densify Until の間の小さな Link ボタン。

技術詳細

Densify Until と Max Iterations の比率を固定するトグ
ルボタン。アクティブ (Link アイコンが強調表示) で
は、Max Iterations の変更ごとに Densify Until が 比
例して引き寄せられます。Unlink (Link-Plus アイコン) 
では、値は独立したままです。 これが典型的な相関を
反映するため、デフォルトはリンクされています — 反
復を倍に すると、通常 Densification も比例して長く
実行したいです。比率は Link ボタンの 設定時に現在の
値から計算されます。典型的な比率は 0.5 (Densify-
Until = 反復数の半分) です。

簡単に言うと

Max Iterations と Densify Until の
間の小さなクランプスイッチ。ア

クティブ (Link アイコンが強調表
示) の場合、2 つの値は一緒に移
動します — Iterations を 倍にす
ると、Densify Until も同じ比率で
倍になります。そうでない場合 
( link.badge.plus  アイコン)、
独立して設定できます。これが典

型的な相関を反映するため、 標
準ではリンクされています — 
長いトレーニングは通常、長い 
Densification 段階も 必要としま
す。99% のケースでは、ロックさ
れたままにしてください。

I20 Densify Until ステッパー

場所

Inspector → トレーニング構成 → GroupBox → 
Densify Until。

技術詳細

Range 500〜50 000、ステップ幅 500 のステッパー。
Clone/Split (Classic) や Relocation (MCMC) を介して
新しい Gaussian が追加されなくなる反復インデック
スを 決定します。到達後、位置と色のみが洗練されま
す。高い値 = より多くの Gaussian = より大きなファ
イル、長い反復あたりの時間 (ステップあたり +30〜
60% GPU 時間)。 典型値: 15K (30K Max-Iter の場
合)、20K (40K の場合)、100K (200K MCMC の場
合)。 アクティブな Link (I19) では自動的にスケーリン
グされます。Classic vs MCMC で 異なる効果: Classic 
は成長を完全に停止し、MCMC は Relocation ロジッ
クを停止 しますが、Sample/Noise 適応は続行されま
す。

簡単に言うと

どの反復まで新しい Gaussian 
が追加されるか — Classic で
は Clone/Split で、 MCMC では 
Relocation で。その後は、既存の
点の色と形の改善のみ。高い = よ
り多くの 詳細、しかしファイル
サイズも大きく、ステップあたり 
+30〜60% GPU 時間。典型値: 15K 
(30K Max-Iter の場合)、20K (40K 
の場合)、100K (200K MCMC の場
合)。通常は Link (I19) 経由で Max 
Iterations に依存します — 手動で
切り離すことはほとんど 意味があ
りません。
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I21 SSIM Weight スライダー

場所

Inspector → トレーニング構成 → GroupBox → SSIM 
Weight。

技術詳細

スライダー 0.0〜1.0、0.05 ステップ、「0.20」として表
示。L1 Loss (0.0) と SSIM Loss (1.0) をミックスしま
す。L1 はピクセルごとの明るさを引き締め、SSIM は 
構造的類似性 (エッジ、ローカル統計) を引き締めます。
デフォルト 0.2 はオリジナル 3DGS 論文 (Kerbl 2023) 
の値で、多くのセッションで堅牢な妥協点としてリ

バース エンジニアリングされました。高い値 (0.5+) は
詳細保持を優先しますが、ローカルの 明るさエラー
を無視する可能性があります。低い値 (< 0.1) は鋭い
エッジでの詳細 損失を引き起こします。SSIM 計算は
シェーダーで 11×11 ガウシアンウィンドウで実行 され
ます。パフォーマンス: 0.0 (L1 のみ) では、SSIM 計算
がシェーダーでスキップ されるため、トレーニングは
約 8〜12% 高速になります。

簡単に言うと

純粋な明るさ比較に対して、構造

的画像類似性 (エッジ、ローカル
パターン) が どの程度重み付けさ
れるか。0.2 はオリジナル 3DGS 
論文の標準で、ほぼすべてのシー

ンで 十分です。髪、毛皮、植生な
どの細かい構造には高く (0.5+) — 
そこではより多くの 構造重みが
役立ちます。低く (0.0) するとト
レーニングが約 8〜12% 高速にな
ります。 シェーダーで SSIM 計算
がスキップされるためですが、鋭

いエッジでの詳細を犠牲にしま

す。 変更する正当な理由がない人
は、0.2 のままにしてください。
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I22 Render Scale スライダー

場所

Inspector → トレーニング構成 → GroupBox → 
Render Scale。

技術詳細

スライダー 0.25〜1.0、0.25 ステップ、「100%」とし
て表示。ソース画像 サイズに対するトレーニングレ
ンダリング解像度をスケーリングします。パフォー

マンス への最大のレバー: 50% は GPU 時間を約 75% 
削減し (ピクセルが 4 倍少ないため)、 25% は約 94% 
削減します。Gradient Threshold は自動的にスケーリ
ングされます。 スライダーの下に、ライブ解像度表
示が MP で表示されます (例えば 「2304×1296 (3.0 
MP)」)。現在の値が推奨値から逸脱している場合、オ
レンジの文字で 「— recommended: 50%」が表示さ
れます。推奨は ~3 MP の実効解像度を目指します — 
Apple Silicon GPU が最も効率的に処理できる領域で
す。例えば、4K ソース画像には 自動的に 25% が推奨
され、FullHD 画像には 100% が推奨されます。変更に
より Buffer の 再割り当てもトリガーされます。

簡単に言うと

トレーニングがどの解像度でレ

ンダリングするか — 最大のパ
フォーマンス レバーの 1 つ。フ
ル (100%) は最高品質を提供しま
すが、大きな画像では多くの GPU 
時間を 消費します。半分 (50%) は
ピクセルが 4 倍少なく計算される
ため、約 75% の GPU 時間を 節約
します — 4K ソースに最適。スラ
イダーの下には、メガピクセル単

位の実効解像度が 表示されます。
アプリは約 3 MP を目指します。
これは Apple Silicon で最も効率
的に 実行されるためです。値がこ
れから逸脱する場合、アプリはオ

レンジの「recommended」 ヒン
トを表示します — ほとんどの場
合、それに従うことが価値があり

ます。
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Enhancements セクション (I26〜I29、I42〜I44)

図 12:  Enhancements セクションのみのクロップ — 3 行: Post-Training Compactification (トグ
ルオン)、Viewport Scaling (セグメント化ピッカー Off/MetalFX/Lanczos)、Perceptual Loss (ス

ライダー 「Off」)。各行にサブタイトルで機能を説明

Enhancements セクションは、コアトレーニングループ自体を変更することなく画像品

質を 改善する 3 つの機能をグループ化します。最初の 2 つ (I26-I27) は ポスト トレーニン

グ または ビューポートステージ です: Compactification は トレーニング終了後にクリーン
アップし、Viewport Scaling は実行中のトレーニングに 影響しない純粋なビューポートレン
ダラーです。Perceptual Loss (I29) はセクション所属 にもかかわらずトレーニングコンポー
ネントです — トレーニング中に追加の Loss 項として 有効化されるため、ビューポートトグ
ルとは区切り線で分離されています。 v1.6 以降、このセクションには Outdoor グループ 
(I42〜I44: Sky Masking、 Mid-Training Floater Cleanup、Reconstruct Sky Dome) もあり
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ます — 以前は 設定ウィンドウにあった、空の Floater に対するトレーニングオプションで、 
現在はプロジェクトごとにここに置かれています。

I26 Post-Training Compactification トグル

場所

Inspector → Enhancements → Post-Training 
Compactification。

技術詳細

V443 ポスト処理を有効化します: トレーニング
反復完了後、Opacity が 0.01 (1% 可視性) 未満の 
Gaussian は削除されます。経験的に、ファイルサイズ
が ~55-58% 削減され、視覚的品質損失はゼロです — 
これらの Gaussian は視覚的にとにかく寄与 しないか
らです。Compactification は GPU Compact パスとし
て実行され、Gaussian カウントに 応じて秒の何分の 1 
か、または数秒かかります。トレーニングパフォーマ

ンスには 影響しません。このトグルがオフの場合、非
表示の Gaussian もエクスポートされます — 形式を別
のトレーニングステージ (Continue Training) で使用し
たい場合にのみ関連します。 そうでなければストレー
ジの無駄です。

簡単に言うと

トレーニング後、とにかく見えな

い Gaussian (Opacity 1% 未満) を 
クリーンアップします。エクス

ポートファイルを約半分小さくし 
(~55-58% のサイズ削減)、 視覚的
品質損失はありません。最後の反

復後に短い GPU パスとして実行
され、秒の何分の 1 から数秒しか
かかりません。実質的に常にオン

にすべきです — これをオフにす
る唯一の 理由は、後で Continue 
Training でトレーニングを続行
し、見えない Gaussian も 保持す
る必要がある場合です。通常のエ

クスポートワークフローでは、そ

のままに してください。
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I27 Viewport Scaling ピッカー

場所

Inspector → Enhancements → Viewport Scaling (3 
つのオプションを持つ セグメント化ピッカー: Off、
MetalFX、Lanczos)。

技術詳細

Viewport アップスケーラーを選択する単一のセグメ

ント化ピッカーです — 3 つのオプションは相互排

他的です。トレーニング解像度 (I22 Render Scale 経
由) がビューポートサイズより低い場合、選択され
たモードがレンダリングされた フレームを表示サイ
ズにスケールアップします。Off = 単純な双線形引
き伸ばし。 MetalFX = Apple の ML ベースの Spatial 
Upscaler、最も鮮明なオプション (ML モデルは鋭い
エッジ用に最適化)、M3 GPU でフレームあたり約 1〜
2 ms の オーバーヘッド。Lanczos = Apple の Metal 
Performance Shaders に 8 タップ Sinc リサンプリン
グを使った、ML なしの古典的手法、最小オーバーヘッ
ド (< 0.5ms)、 品質は MetalFX を下回りますが、細か
い線構造の ML 特有の「平滑化」がありません。 レン
ダラーパイプラインは切り替え時にライブで再構成さ

れます — 再起動なしで すぐに表示されます。背景: 以
前はこれが 2 つの別々のトグル (MetalFX + Lanczos) 
で、同時にオンにできました — MetalFX が静かに 
Lanczos を 上書きする矛盾した状態でした。ピッカー
はこの状態を排除します。古いセッションから 継
承された可能性のある「両方オン」状態は、次の切

り替え時に自動的に MetalFX へ 自己修復します。Live 

Viewport にのみ作用し、レンダリングされた エクス
ポート (Orbit ビデオ、スクリーンショット) には影響
しません — これらは フルソース解像度でレンダリング
されます。

簡単に言うと

Viewport のライブ画像を鮮明に
アップスケールします — 特に低
い トレーニング解像度 (Render 
Scale 50%、I22 参照) で作業してい
る場合に便利です。 常に 1 つだけ
がアクティブになる 3 段階:「Off」
は単純にピクセルを引き伸ばし、 
「MetalFX」は Apple の機械学習を
使い最も鋭いエッジを提供 (実質
的に常に最良の選択)、 「Lanczos」
は ML なしの古典的フィルター — 
MetalFX があるシーンで線を平滑
化したり アーティファクトを示
したりする場合のフォールバック

として使ってください。 再起動
なしでライブに作用します。Live 
Viewport にのみ作用し、エクス
ポートされた Orbit ビデオやスク
リーンショットには影響しません 
— これらはフルソース解像度で 
レンダリングされます。以前と異

なり、誤って 2 つのモードを同時
に選ぶことは もうできません。
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I29 Perceptual Loss スライダー

場所

Inspector → Enhancements → Perceptual Loss。

技術詳細

スライダー 0.0〜0.2、0.01 ステップ、0.0 で「Off」と
して表示、それ以外は 「0.05」などとして表示。レ
ンダリングのマルチスケールガウシアンブラーを 
Ground Truth 画像と比較する追加の Loss 項を有効化
します (3 ブラースケール)。L1+SSIM だけでは 認識で
きない構造的差異をキャプチャします。V460 実装。
経験的に、0.05〜0.1 の値は セッションで L1 スコアを
数パーセント改善しますが、~5% のトレーニング時
間 (ブラー カーネルを通る追加の順方向パス) を消費し
ます。0.15 を超えると、トレーニングが 不安定にな
り、L1 が再び悪化します (Loss 項が最適化を支配)。
「Enhancements」 セクション内の位置にもかかわら

ず、トレーニング 中 に効果があり、 後処理では効きま
せん — 純粋な事後アップグレードではありません。

簡単に言うと

3 つの異なる不鮮明レベルにわ
たって構造的画像類似性をチェッ

クする追加の Loss 部分。L1+SSIM 
だけでは見えないパターンをキャ

プチャするため、髪、布、植生 な
どの細かい構造を持つシーンに

特に役立ちます。小さい値の方

が安全です — 0.05〜0.1 がスイー
トスポット、0.15 を超えるとト
レーニングが不安定になり、Loss 
が 再び悪化します。0 (Off) で
は機能は完全にオフで、コスト

はかかりません。アクティブ だ
と、ブラーカーネルを介する追加

の順方向パスのために約 5% のト
レーニング時間を 消費します。
「Enhancements」セクションに
もかかわらず、後処理ではなくト

レーニング 中に直接効果がありま
す。
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I42 Sky Masking

場所

Inspector → Enhancements → Outdoor グルー
プ → トグル「Sky Masking」。バインド: 
AppState.trainingConfig.skyMaskingEnabled (プロ
ジェクトごと、 @DefaultFalse )。デフォルト: 
false 。

技術詳細

pre-training Apple Vision ベースの空ピクセル セグメ
ンテーションを有効化します。トレーニング開始前に、

各入力カメラについて、 Apple Vision フォアグラウン
ドマスク (空 = 背景) を介して空領域が抽出され、 該
当カメラのピクセルごとのマスクとして関連付けられ

ます。トレーニング中、 ピクセルごとの Loss 寄与は
空マスクの補集合と乗算されます — 空ピクセルは 勾配
に 0 を寄与するため、空に投影される Gaussian は最
適化信号を受け取らず、 したがって「より密」または
「より明るく」なりません。屋外/ドローンシーンでの 
Floater (空の暗い小さな塊) を大幅に削減します。クラ
シック 40K トレーニングで ~3% L1 リグレッションの
コスト (memory/​dev_​outdoor-floater-reduction.md 
参照)。明確に識別可能な空がある 屋外シーンでのみ意
味があります。室内シーンや白い背景では、空セグメ

ンテーションは 誤った領域を識別し、有効な Loss 信
号をブロックします。値は現在プロジェクトごとに 保
存され (もはやアプリ全体ではありません)、プリセッ
ト / シーンファイルに 従います。

簡単に言うと

画像内に空がある屋外撮影で

は、しばしば空に黒や色付きの

小さな塊が 発生します — い
わゆる「Floater」です。このオ
プションは自動的に空がどこに

あるかを 検出し、トレーニン
グに「空をそのままにしておい

て」と伝えます。ドローン飛行

や 風景シーンに非常に適してい
ます。室内や暗い背景では画像

が悪化することがあります — し
たがって、本物の空が見える場

合にのみ有効にしてください。

詳細: memory/​dev_​outdoor-
floater-reduction.md。
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I43 Mid-Training Floater Cleanup

場所

Inspector → Enhancements → Outdoor グループ → 
トグル「Mid-Training Floater Cleanup」。バインド: 
AppState.trainingConfig.floaterCleanupEnabled 
(プロジェクトごと、 @DefaultFalse )。デフォルト: 
false 。

技術詳細

クラシック 40K トレーニング (プリセット「P4 
Quality」) で 2 つの追加 Density Control パスを有効
化します: 反復 20,000 と反復 30,000 で。 両パス
は 3 つの基準ですべての Gaussian を検索します: 
(a) 非常に低い Opacity (標準 0.005)、(b) 極小スク
リーン空間サイズ、(c) 直近 1000 反復で Loss 寄与な
し。 3 つの条件すべてを満たす Gaussian は purge さ
れます。効果: トレーニング終了時に ~5〜15% 少ない 
Gaussian、ドローン/屋外シーンの空で暗い小さな塊が
目に見えて 減少。クローズアップ室内シーンで ~1〜
3% L1 リグレッションのコストのため、 デフォルトで
は有効になりません。値は再起動を超えて記憶され

ます (S7 とは異なります)。 2 つのクリーンアップ反復 
(20K、30K) はハードコードされており、現在 UI 経由
で 変更できません。より短いトレーニング (例えば P2 
Preview 5K) では、反復マークに 到達しないため、ト

グルは効果がありません。新規: このトグルは、 アク
ティブなプリセットが Classic デンシファイアを使用
する場合 (densificationStrategy == .classic) に
のみ操作可能になりました。MCMC または Hybrid で

は 無効化 され、インラインヒントが表示されます。こ
れらの 戦略は死んだ Gaussian をそもそも自前で処
理するため (MCMC は Relocation 経由、 Hybrid は組
み合わせた Reloc/Noise ロジック経由)、手動のクリー
ンアップパスは そこでは効果がない、あるいは逆効果
になるからです。コード参照: RadianceKitApp.swift、
General タブ。詳細: memory/​dev_​outdoor-floater-
reduction.md。

簡単に言うと

トレーニング中、画像品質に貢献

しなくなったがメモリを占有す

る 「死んだ」ガウス点が時々発生
します。このオプションは長いト

レーニング中に 2 回 (20K と 30K 
反復で) クリーンアップし、これ
らの死骸を削除します。 そこに
最も多くの Floater が集まるため、
空のある屋外シーンでは特に意味

があります。 小さなトレーニング
や家具の接写では、必要ない場合

が多いです。このスイッチは、 プ
リセットが Classic デンシファイ
アを使用する場合にのみオンにで

きます — MCMC または Hybrid プ
リセットではグレーアウトされま

す (短い説明付き)。 それらは自前
で死んだ点を片付けるからです。

55 / 227



R A D I A N C E K I T 第 2章 — Inspector (エキスパートビュー)

I44 Reconstruct Sky Dome

場所

Inspector → Enhancements → Outdoor グループ 
→ トグル「Reconstruct Sky Dome」。バインド: 
AppState.trainingConfig.skyDomeEnabled (プロジェ
クトごと、 @DefaultFalse )。デフォルト: false 。

技術詳細

pre-training の Sky-Dome 投影を有効化します 
(V549e MVP)。 SfM 後、トレーニング開始前に、各
入力カメラについて、S7 で共有される Apple Vision 
空マスクが画像から抽出され、空ピクセルはカメラ内

部パラメータを使用して 仮想球面 (標準半径 8× シーン
半径) に逆投影されます。この球面上に ~5000 の 新し
い Gaussian が、投影された空ピクセルからの色の平
均値、非常に大きなスケーリング (シーン単位で 1.0)、
初期 Opacity 0.95 で初期化されます。これらの 5000 
Gaussian は 古典的な意味での空マスクではありませ
ん — 他のすべてと同様にトレーニングされますが、 高
い初期 Opacity により薄い殻に残されます。結果: 屋
外/ドローンシーンでの 360° 新規ビューでは、暗いコ
ンフェッティの小さな塊の代わりに実際の空の色と 雲
の構造が表示されます。値は再起動を超えて記憶され

ます。少なくとも 360° カメラ カバレッジを持つ屋外
シーンでのみ意味があります。空が見えない純粋なオ

ブジェクト キャプチャでは効果がありません。ステー
タス: 実験的、追加の屋外セットでの より広範な A/B 
検証はまだ保留中。

簡単に言うと

トレーニングが空をいくつかの見

えるピクセルから「推測」しよ

うとして Floater になる代わりに、
RadianceKit はトレーニング開始
前に空のピクセルを シーンの周り
の仮想球面に直接投影します。完

成したシーンを 360° で回転させ
ると、 黒い塊の代わりに本物の空
が見えます。画像に実際に空が見

える屋外撮影でのみ 機能します。
リビングルームスキャンやスタジ

オショットでは何もしません。
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メトリックセクション (I30〜I38)

図 13:  ブーケでのトレーニング完了後 (5K 反復、最終 2 991 Gaussian) の Training Metrics セ
クションのみのクロップ — トレーニングメトリックのテーブル (Iteration、Loss、SSIM Loss、

Combined Loss、Gaussian Count、 Learning Rate、Elapsed、ETA)

トレーニングが実行されている間、メトリックセクションはトレーニングループから 9 つ
のライブ値を表示します。トレーニングの開始前、セクションは空です (「Start training to 
see live metrics」)。すべての値は ~30 反復ごとに更新 されます (ストリームの更新頻度)。
セクションは読み取り専用です — 要素は クリック可能でも変更可能でもありません。より
深い分析には、 ~/​Documents/​RadianceKit/​Logs/​ の JSONL トレーニングログを使用して
ください (スクリプト python3 scripts/​analyze_​logs.py best 5)。
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I30 Iteration

場所

Inspector → メトリック → Iteration。読み取り専用。

技術詳細

「4523 / 40000」形式の表示 — 計画された総反復に対
する現在の反復。 値を ~30 反復ごとにプッシュする
トレーニングループと同期してカウントします。 2 番
目の数字は、開始時の Max-Iterations 値に対応しま
す。ユーザーが後でステッパーを 調整しても変更さ
れません — 実行中の実行は独自のスナップショット
コピーを使用 します。アプリが Training メニュー経由
で反復を追加する場合 (Continue Training +5K/+10K/
+20K)、分母が増加します。

簡単に言うと

トレーニングが現在どこにある

か。「4523 / 40000」は、40 000 
ステップの うち 4523 が完了し、
つまり約 11% 完了していること
を意味します。左の数字は秒単位

で カウントアップします。数分
間止まっている場合、トレーニン

グが停止しています — ほとんど
の場合、GPU スロットリングや
競合アプリのヒントです。右の数

字はトレーニング 開始時の Max-
Iterations 値 (I18) に対応し、ス
テッパーを後で調整しても変更

されません。 Continue Training 
(+5K/+10K/+20K) では、追加のス
テップ分増加します。

I31 Loss

場所

Inspector → メトリック → Loss。読み取り専用。

技術詳細

小数点以下 6 桁の Float 値 (例えば「0.024385」)。
結合 L1+SSIM Loss (I21 SSIM Weight で制御される
ミックス) と、オプションで Perceptual Loss (I29) と 
他の正則化を測定します。スケールは絶対的ではな

く、シーン依存 — ほとんどの比較に 同じデータ
セットが必要です。良好な構成での典型的な終値: 
- Classic Quality 40K 反復: 0.022〜0.025 (Horse、
Truck、Garden) - MCMC Full 200K 反復: 0.024〜
0.028 - Outdoor ドローン 30K: 0.030〜0.060 (幾何
学的理由で悪い) - Indoor アパート: 0.018〜0.025

5K 反復後の 0.10 を超える値は SfM 問題 (悪いカメラ
ポーズ) を示します — 中止して SfM を再計算してくだ
さい。

簡単に言うと

レンダリングされた画像がオリジ

ナルからどれだけ離れているか — 
L1、SSIM、 オプションで Perceptual 
Loss から結合。小さいほど良い。
0.03 未満はほとんど非常に 良く、
0.05 未満はまだ OK、屋外シーン
は幾何学的理由で 0.03〜0.06 に
あります。 数千の反復後に 0.10 
を超えるのは警告サイン — ほと
んどの場合、カメラ再構築 (SfM 
が うまく機能しなかった) のせ
いです。スケールは絶対的ではな

く、シーン依存です。同じ データ
セット内の比較のみを行ってくだ

さい。値が突然上にジャンプする

場合、ほとんどの 場合 Gradient-
Explosion イベントが発生しまし
た。
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I32 Learning Rate

場所

Inspector → メトリック → Learning Rate。読み取り
専用。

技術詳細

科学表記表示 (例えば「1.60e-04」)。Position パラ
メータの現在の学習率 (3DGS には Position、SH-DC、
SH-Rest、Opacity、Scale、Rotation の 6 つの独立し
た LR があります — ここでは代表値として Position 
LR が表示されます)。デフォルトの 開始値 1.6e-4 
で、Exponential Decay を介してトレーニング終了時
に ~1.6e-6 まで 減少します。減衰はトレーニング構成
の LR-Schedule フィールド (第 6 章の T フィールド) 
で 調整可能です。LR が異常に高いままの場合 (例えば 
10K 反復後の 1e-3 以上)、これは 誤って読み込まれた
構成を示す可能性があります。

簡単に言うと

現在の最適化ステップの大き

さ — 具体的には Gaussian 位
置の学習率。 1.60e-04 で始ま
り、トレーニング終了に向けて

約 1.60e-06 まで指数関数的に
減少 (「1.60e-06」= 0.0000016)。
進行は自動的に実行され、ここで

調整する必要はありません。 値
が 10 000+ 反復後にまだ 1e-3 よ
り大きい場合、おそらく誤った構

成が読み込まれ ました — トレー
ニングを中止してプリセットを再

選択してください。内部的には、 
3DGS は 6 つの独立した学習率 
(Position、SH-DC、SH-Rest、Opacity、
Scale、Rotation) を 持ちます。こ
こでは代理として Position LR の
みが表示されます。

I33 SH Degree

場所

Inspector → メトリック → SH Degree。読み取り専
用。

技術詳細

0〜3 の整数。色表現の球面調和次数。0 (DC コンポー
ネントのみ、つまり Gaussian ごとに方向に依存しな
い色 — 単一の RGB 定数) で開始し、トレーニング
中に 段階的に 3 まで上昇します。標準スケジュール
は、1000/2000/3000 反復で次数を 1 ずつ 上げます。
SH-3 は Gaussian あたり 48 の色係数 (3 RGB チャン
ネル × 16 SH 基底関数) に 対応します。より高い SH 
次数 = より多くの方向依存反射 (光沢のある表面が異
なる 視点から正しく異なる外観) ですが、より多くの
メモリと遅いトレーニング。

簡単に言うと

現在 Gaussian あたりの色表現が
どれだけ複雑か。0 (点ごとに方
向に依存 しない色のみ) で始まり、
段階的に 3 まで引き上げられます 
— 通常、反復 1000、2000、 3000 
で。レベル 3 は Gaussian あたり 
48 の色係数を意味し、方向依存
反射を可能に します。つまり、光
沢のある表面が異なる視点から正

しく異なる外観になります。 ア
クティブに触れる必要はありませ

ん。スケジュールは自動的に実行

されます。より高い 次数はより多
くのメモリを消費し、トレーニン

グをわずかに遅くします — しか
し、 これが現実的なハイライトの
代償です。
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I34 Gaussians

場所

Inspector → メトリック → Gaussians。読み取り専
用。

技術詳細

モデル内の Gaussian の現在の数、ロケール区切り
文字でフォーマット (例えば「524.318」)。成長: 
- Classic: SfM 初期点 (通常 50K-300K) で開始し、 
Densify Until 直前まで Clone/Split を通じて成長し、
その後トレーニング終了まで 静的 (Pruning を除く) 
- MCMC: Sample 点が MCMC キャップまで追加され、
その後 Relocation のみ

健全な終値: - Classic Quality: 400K-700K (Horse 
524K、Garden 800K) - MCMC Full: キャップで正確
に (デフォルト 150K、Auto-Scale Multiplier × SfM-
Count でシーンに 応じて 500K-1.5M)

MCMC で数がキャップの < 60% まで落ちる → 異
常 (Collapse インジケータ、過度に 積極的な正則化を
示唆)。

簡単に言うと

3D モデルが現在持つ Gaussian 点
の数。トレーニング中に成長し、

Densify Until (I20) に達するまで。
その後、数は実質的に一定のま

まです。より多くの点 = より 多く
の詳細、しかしファイルサイズ

も大きく、Viewport でのレンダ
リングも遅くなります。 500.000 
Gaussian は中程度のシーンでの 
Classic Quality の典型的な平均値
です。 MCMC Full は、Auto-Scale 
(I17) に応じて 500K から 1.5M の
間に着地します。MCMC で 数が突
然キャップの 60% を下回る場合、
これは Collapse インジケータで
す — ほとんどの場合、過度に積
極的な正則化。

I35 GPU Memory

場所

Inspector → メトリック → GPU Memory。読み取り専
用。

技術詳細

Gaussian バッファメモリ消費量の推定値、Gaussian 
カウント × 616 バイト (Memory スタイルでフォー
マット) として。616 バイトは、完全装備の Gaussian 
(位置、 スケーリング、回転、Opacity、SH 係数次数 
3、Gradient Accumulator) の経験的サイズです。 表
示にはレンダラーのオーバーヘッド (Tile バッファ、

Sort バッファ、Backward バッファ) は 含まれません 
— 実際の GPU メモリ需要は通常この値の 2-3 倍です。
500K Gaussian で: 表示 ~290 MB、実際 ~700 MB。
1.5M Gaussian で: 表示 ~880 MB、実際 ~2.5 GB。
M3 Max では 64+ GB Unified Memory で問題ありま
せんが、M3 Pro では 18 GB で すでに制限です。

簡単に言うと

Gaussian 自体が占有する GPU メ
モリ量の推定値 — 点あたり約 616 
バイト。 レンダラーが独自の Tile、
Sort、Backward バッファを追加す
るため、実際の GPU 消費は 表
示の 2-3 倍です。16-18 GB の 
Unified Memory を持つ MacBook 
では、500K Gaussian 未満に 留
まるべきです。M3 Max または 
Studio (64+ GB) では、楽に 1.5M 
以上を実行できます。 トレーニン
グが突然クラッシュしたり、シス

テムがスワップしたりする場合、

ほとんどの場合、 ここで制限に達
しています — Render Scale (I22) 
を下げるか、Densify Until (I20) 
を 減らします。
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I36 Speed

場所

Inspector → メトリック → Speed。読み取り専用。

技術詳細

小数点以下 1 桁の秒あたり反復 (「24.3 it/s」)。直近 
~100 反復にわたる 移動平均としてトレーナーによっ
て計算されます。典型値: - Quick プリセット (1K 反
復): 80-120 it/s (短く、定常状態なし) - Classic 20K 
@ 1.0 Render Scale (Truck シーン、M3 Max): 25-35 
it/s - Classic 20K @ 0.5 Render Scale: 80-120 it/
s - MCMC 200K @ 0.5 Render Scale: 25-50 it/s 
(Relocation のため遅い) - 1M+ Gaussian とフル解像
度で: < 10 it/s

トレーニング中の Speed の減少は正常です — より多
くの Gaussian = 反復あたりより 多くの計算。突然の
落ち込み (例えば 30 → 5 it/s) は GPU 熱スロットリン
グまたは 競合アプリを示します。

簡単に言うと

トレーニングがどれくらい速く

実行されているか、秒あたりの

反復で。 通常 20-50 it/s で、低い 
Render Scale (50%) と小さなシー
ンでは 80-120 it/s に なること
もあります。トレーニング中に

自然に減少します。より多くの 
Gaussian = 反復あたりより多くの
作業のため。突然の落ち込み (例
えば 30 → 5 it/s) は GPU 熱 ス
ロットリングや競合アプリを示

します — ビデオ付きブラウザタ
ブ、Time Machine バックアップ、
Photos のインデックス作成。ア
プリを前面に保ち、バックグラウ

ンド プログラムを閉じることがし
ばしば役立ちます。1M+ Gaussian 
とフル解像度では、 10 it/s 未満が
正常です。

I37 Elapsed

場所

Inspector → メトリック → Elapsed。読み取り専用。

技術詳細

「4:23」(m:ss) または「1:23:45」(h:mm:ss) としての
経過時間。1 時間から 形式が切り替わります。純粋な
トレーニング時間のみを測定し、前置段階 (SfM 計算、 
画像インポート) は含まれません。Pause/Resume で
は時計が続行されます — つまり Wall-Clock であり、
CPU 時間ではありません。

簡単に言うと

トレーニングがすでにどれくらい

実行されているか、純粋なストッ

プウォッチ (Wall-Clock 時間) とし
て。形式は 1 時間まで「m:ss」、
その後「h:mm:ss」。「CPU 時間」 
ではなく「すでにどれくらい待っ

ているか」— つまり、Pause 時間
も含まれます。 純粋なトレーニン
グ段階のみを測定し、前置 SfM 計
算や画像インポートは含まれませ

ん。 ETA (I38) との比較に役立ち
ます — Elapsed が元の ETA を大
きく超えて飛び出した場合、 ト
レーニングはどこかで計画より遅

くなりました。
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I38 ETA

場所

Inspector → メトリック → ETA。読み取り専用。

技術詳細

「17:42」または「1:12:35」としての推定残り時間。計
算: (Max Iterations − 現在の反復) / 秒あたりの反
復。Speed がちょうどゼロの場合 (最初または Pause) 
は 「–」を表示します。推定は、トレーニング終了に

向けた典型的な減速に 適応されません — 特に MCMC 
と Densify-Until 値の大きい Classic では、 より多
くの Gaussian が画像に入るため、トレーニングは遅
くなる傾向があります。実際には、 通常初期 ETA より 
10-20% 上に留まります。

簡単に言うと

推定された残り待ち時間 — 残り
の反復と現在の Speed (I36) から
計算。 大まかな推定: Mac が突然
遅くなった場合 (Densify フェーズ
から多くの Gaussian、 熱スロット
リング、他のアプリ)、表示より長
くかかる可能性があります。アプ

リは トレーニング終了に向けた
典型的な減速を含めません。その

ため、実際の終わりは通常、 初
期 ETA を 10-20% 超えます。15% 
を計算に入れると、ほとんどの場

合うまく適合します。 Speed が現
在 0 の場合 (トレーニングの開始
または Pause)、「–」が表示されま
す。
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Loss チャートセクション (I39〜I41)

図 14:  トレーニング完了後の Loss History セクションのみのクロップ — Current 0.0064、Min 
0.0035 (緑)、0.027 (反復 1) から 0.0035 (反復 5K) への青の 経過、反復 200 周辺の特徴的なキ

ンク付き、その下にオレンジの Gaussian Count チャート

Loss チャートセクションは、時間にわたるトレーニングの進行を可視化します。2 つ
の チャートで構成されます: Loss Curve チャート (大、上、青) と Gaussian Count チャー
ト (小、下、オレンジ)。両方ともトレーニング中にライブで構築され、次のトレーニング 開
始まで永続します。最初のトレーニング前、領域は空です (「Loss curve will appear during 
training」)。チャートは純粋な SwiftUI Path 描画です (Swift Charts フレームワークなし) — 
100K+ ポイントでもスムーズにレンダリングします。
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I39 Current Loss (表示)

場所

Inspector → Loss チャート → 左ラベル領域
「Current: 0.0287」。 読み取り専用。

技術詳細

最後の Loss サンプルポイントの Float 値、小数点
以下 4 桁でフォーマット。 I31 (Metrics セクションの 
Loss) と同じ、ここではよりコンパクトにフォーマッ
ト されているだけ。ソースは Loss History — ~30 反
復ごとに 1 エントリを取得する リスト。有限値のみ
がリストに追加されます — NaN/Infinity (非常にまれ、 
Gradient-Explosion バグの場合) はフィルタリングさ
れます。

簡単に言うと

Metrics セクションよりも短い表
記の現在の Loss 値 (小数点以下 
4 桁)。 内容的には I31 と同じです
が、ここでは表示が Loss チャー
トの直接に座っており、 曲線を
観察するときに正確な数値が得ら

れます。すべてのライブメトリッ

クと同様に、 ~30 反復ごとに更新
されます。NaN または Infinity 値 
(Gradient-Explosion バグの 非常
にまれなケース) は、アプリが自
動的にフィルタリングします。図

を見ながら他の セクションにジャ
ンプする必要がないので便利で

す。

I40 Min Loss (表示)

場所

Inspector → Loss チャート → 右ラベル領域「Min: 
0.0245」(緑)。 読み取り専用。

技術詳細

現在のトレーニング実行のこれまでに見られたすべて

の Loss 値の最小値。 Loss History からライブで再計
算されます — 別の永続性なし。緑のフォントで表
示 されます。「Min」=「これまでで最高」だからです。
チャート下部の緑の破線は、この Y 位置を視覚的に
マークします。Continue Training セッションでは、最
小追跡が新規 開始されます — 古い履歴は UI で新しい
ものに置き換えられます (追加されません)。 現在の
トレーニングが前のものより悪く実行されている場合、

Min 表示は前の最終結果 よりも大きい可能性があり
ます。

簡単に言うと

このトレーニングがこれまでに

見た最低の Loss 値 — 緑で表示、
「これまでで 最高」だからです。
チャート下部の緑の破線も、この

位置を視覚的にマークします。 現
在の曲線がそれをはるかに上回る

場合、運があれば改善がありま

す。ほとんどの場合、 Min は後で
関心のある最終結果の指標です。

Continue Training セッションで
は、UI で 古い履歴が新しいもの
に置き換えられるため、Min 追跡
が新規開始されます — Min 値は
前の最終結果よりも悪く見える可

能性があります。
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I41 Gaussian Count チャート

場所

Inspector → Loss チャート → その下の 2 番目の
チャート (オレンジ)。 読み取り専用。

技術詳細

トレーニング反復にわたる Gaussian カウントの線
グラフ。ソース: Gaussian Count 履歴 (トレーナー
から ~30 反復ごとに埋められる (Iter、Count) ペアの
リスト)。 Y スケールは履歴の最小値と最大値の間で動
的。Classic 戦略では、曲線は通常次のように 見え
ます: Densify Until まで安定的に上昇、その後フラッ
ト (小さな Pruning 変動付き)。 MCMC では: キャップ
までの急上昇、その後水平線 (Relocation が数を一定
に保つ)。 アクティブなトレーニングにもかかわらず

曲線が 落ちる 場合、Densification が 過度に積極的に 
Pruning しています — 誤ったデフォルトまたは既知の 
MCMC-Collapse バグ (v1.4.4 ホットフィックステー
マ) の指標。

簡単に言うと

トレーニング時間にわたる 
Gaussian の数がどのように発展
するか — Loss 曲線の下の小さな
オレンジのチャート。Classic 戦
略では、線は Densify Until (I20) 
に 達するまで安定的に上昇し、そ
の後小さな Pruning 変動でフラッ
トなままです。MCMC では、 急に
キャップまで上昇し、その後水

平のままです。Relocation が数を
一定に保つからです。 アクティ
ブなトレーニングにもかかわら

ず曲線が突然下に折れる場合、

Densification が Pruning で過度
に積極的です — v1.4.4 の MCMC-
Collapse バグの典型的な兆候。 
アプリの更新または Classic への
切り替えが役立ちます。

Loss 曲線の読み方

Loss チャートは Inspector の最も重要な診断ツールです — トレーニングが有用に 進んでい
るか停止しているかを、これほど直接示す他のインジケータはありません。 典型的な健康的
な形状は、最初の 1000〜3000 反復での速い低下 (~0.15 から ~0.05 へ)、 続いてトレーニ
ング終了までの遅く均一な低下 (0.020〜0.030 へ) です。対数的には、 曲線はスムーズな対
角線のように見えます。

Loss のプラトーは何を意味するか? 曲線が数千の反復にわたってフラットな ままの場合、2 
つの可能な解釈があります: (a) トレーニングが「収束」した — モデルが与えられたデータ
と設定でなれる限り良いため、Loss はもはや有意に低下できません。 これは望ましいです。
これが「完了」です。(b) トレーニングが「停止」している — Loss は実際にはまだ低下でき
ますが、最適化が停滞しています (ローカル最小値、学習率が 小さすぎる、Densification オ
フ)。区別: Loss 値が典型的に良い範囲 (Indoor/Object で 0.020〜0.030、Outdoor で 
0.040〜0.060) にあり、曲線が 5K 反復から平坦である場合、 収束しています。値が同等の
シーンより大幅に高い場合 (例えば 0.08)、停止しています。

注意 Gaussian プラトー ≠ Loss プラトー。 Gaussian カウントのプラトーは 「トレーニン

グが完了」を意味 しません。Densification が新しい点の追加を 停止したことを意味するだ
けです — (Classic で) に達したため、または MCMC キャップが いっぱいになったためです。
トレーニングはその後も継続し、既存の点のみを洗練します。 実際の「完了」信号は、ここ
ではなく Loss 曲線と Iteration 表示 (I30) で読みます。

中止の経験則: Loss 曲線が 5000+ 反復後に 0.08 を超え、もはやほとんど 低下しない場合、
高い確率で SfM 再構築が間違っています。トレーニングを中止し、 第 9 章で選択され
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た SfM バックエンドがシーンに合っているか確認し、必要に応じて COLMAP/Native に切り
替えてから、再起動してください。悪いカメラ整列で 2 時間の トレーニングよりも、より良
い SfM に 10 分投資する方がよいです。

いつ Inspector を使うか?

クイックリファレンス: 各典型的なユースケースにどのセクションとコントロール?
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共通タスク セクション コントロール ID

完成した Splat の色の彩度を下
げる

Look L1 (Saturation)

針状/コンフェッティ Splat を丸
める

Look L2 (Splat length)

穴だらけの雲を埋める / Splat を
大きくする

Look L3 (Splat size)

オービットで遠い「Far コン
フェッティ」をフェードアウト

Look L4 (Fade far region)

Look 調整を破棄 Look L5 (Reset finishing)

事前準備されたセットアップの

ロード

Presets I7 (行をクリック)

独自セットアップの保存 Presets I1 → I2 → I4

同僚とセットアップを共有 Presets I5 (Export) または I6 (Import)

SfM バックエンドの変更 (例えば 
Apple-PG が 不安定すぎる)

トレーニング構成 I12 (第 9 章参照)

EXIF 焦点距離なしのビデオフ
レーム 処理

トレーニング構成 I13 (FOV Override)

COLMAP パフォーマンス: 古典
の代わりに GLOMAP

トレーニング構成 I14

Classic から MCMC への切り替
え

トレーニング構成 I15

トレーニングを長く実行 トレーニング構成 I18 (Max Iter) + I20 (Densify 
Until) — I19 でリンク

GPU 時間を半分にする トレーニング構成 I22 (Render Scale を 50%)

トレーニング品質 +6% (MCMC) トレーニング構成 I16 (MCMC Quality)

SfM 点が多い屋外 シーン トレーニング構成 I17 (Auto-scale by scene)

COLMAP パスの設定/変更 トレーニング構成 I23 / I24 / I25

エクスポートファイルを小さくす

る

Enhancements I26 (常にオン のまま)

トレーニング時間を増やさず 
Viewport を鮮明にする

Enhancements I27 (Viewport Scaling → 
MetalFX)

MetalFX が過度に平滑化 → 代替 Enhancements I27 (Viewport Scaling → 
Lanczos)

細かい構造での最後の詳細の 一
滴

Enhancements I29 (Perceptual Loss 0.05-0.1)

トレーニングを監視 メトリック I30 (進捗)、I36 (速度)、 I38 (残
り時間)品質の早期評価 メトリック I31 (5K 後 Loss < 0.05 = 良好)SfM 問題の疑い メトリック + Loss 

チャート

I31 + I39 (5K 後 Loss > 0.08 → 
SfM 再計算)

収束 vs 停止の区別 Loss チャート I39 + I40 (Loss プラトーを読む)Densification 問題の認識 Loss チャート I41 (Gaussian 曲線が落ちる → 
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章

第 3章 — 設定

設定ウィンドウは RadianceKit → 設定… または標準ショートカット ⌘,  から 開きます。2 
つのタブを含みます: General と AI Helpers。 第 2 章の Inspector 値と異なり、このウィ

ンドウの設定は アプリ全体 (すべてのプロジェクトにわたって) 適用されます — これらは永
続化され、 アプリ再起動を超えて保持されます。General タブは 3 つの内容領域をグループ
化 しています: Interface、Viewport、Training。(以前ここにあった 3 つの屋外 Floater トグ
ル — Sky Masking、Mid-Training Floater Cleanup、 Reconstruct Sky Dome — は v1.6 で
エキスパート Inspector の Enhancements セクションに移動し、現在はプロジェクトごとに
保存されます。第 2 章 I42〜I44 を 参照してください。) AI Helpers タブは、SfM とトレー
ニングの前処理のための オンデバイス機械学習ヘルパー (Vision、CoreML) を有効化します。

すべての AI Helpers をまとめて有効化/無効化する以前の操作要素は、現在の バージョンに
は存在しなくなりました — それに応じてここでは記載しません。 未提供のヘルパー用の以
前の「Coming Soon」エリアも削除され、ここでは 参照されていません。
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General タブ

図 15:  設定 → General タブ、Interface、Viewport、Training、Experimental セクションを含む
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S1 Default Mode

場所

Settings → General → Interface → Default Mode 
ピッカー。 バインド済み。デフォルト: .simple 。

技術詳細

次回起動時にアプリが 2 つの UI モードのどちらで
開くかを制御します。 「Simple Mode」は 4 ステップ
のガイド付きウィザードワークフロー (インポート → 
処理 → プレビュー → エクスポート、第 10 章 Z1〜Z4 
に記載)、 「Expert Mode」は第 2 章のナビゲーター、
3D ビューポート、エキスパート Inspector を持つ古典
的な 3 パネルレイアウトです。値は再起動を超えて 
記憶されます。メニュー Mode → Simple Mode (⌘1) / 
Mode → Expert Mode (⌘2) と 同じ効果ですが、メ
ニューは現在のセッションを切り替えるのに対し、こ

のピッカーは 将来のセッションのデフォルトを設定し
ます。両モードは同じプロジェクト状態に アクセスし
ます — プロジェクト、カメラ、トレーニング構成は
モード切り替え時に 保持されます。モード固有のツー
ルバーボタンは即座に再レンダリングされます。

簡単に言うと

ここで、次回起動時に 
RadianceKit が開くインターフェ
イスを選択します。 「Simple 
Mode」は初心者モードです: 4 つ
の明確なステップ、事前設定さ

れた プリセット、ほとんどオプ
ションなし。「Expert Mode」は第 
2 章で見るすべての コントロー
ルを持つフルツールボックスレイ

アウトです。画像やトレーニング

の 進行を失うことなく、メニュー
「Mode」を介していつでも切り替
えられます。

S2 Language

場所

Settings → General → Interface → Language ピッ
カー。 バインド済み。デフォルト: .system  (macOS 
の言語に従う)。

技術詳細

macOS システム言語とは独立して、アプリ UI 全体の
表示言語を選択します。 RadianceKit は 17 言語にロー
カライズされています ( de 、 en 、 pl 、 en-AU 、 
ar-SA 、加えて 12 言語)。「System」では、アプリは 

macOS の言語に従います。 明示的な選択の場合、言
語設定は再起動を超えて記憶されます。完全な反映に

は 通常、アプリの再起動が必要です。なぜなら、ロー
カライゼーションバンドルは 起動時にのみ読み込ま
れるからです。プロジェクト内の 298 の文書化され
た ローカライゼーションキーがすべて考慮され、サブ
ビューやヘルプツールチップの すべてのテキストを含
みます。

簡単に言うと

Mac が英語で動作していて、ドイ
ツ語の RadianceKit インターフェ
イスを 好む場合 (または逆)、ここ
で設定します。ほとんどのテキス

トはすぐに切り替わります。 一部
のダイアログは、アプリ再起動後

に新しい言語で表示されます。
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S3 Viewport Background

場所

Settings → General → Viewport → Background ピッ
カー。 バインド済み。デフォルト: .darkGray  (RGB 
0.1、0.1、0.1)。

技術詳細

3D ビューポートの標準背景色を設定します。3 つのオ
プション: 「Dark Gray」(RGB 0.1、0.1、0.1 — デフォ
ルト)、「Black」(0、0、0)、 「White」(1、1、1)。こ
の設定は、新規プロジェクトとセッションのデフォル

トを 再起動を超えて永続化し、同時に実行中の Metal 
レンダラーを即座に更新します。 同じオプションが
メニュー Viewport → Background (M21、M22、M23) 
にもありますが、 Settings ピッカーはデフォルトを設
定し、メニューは現在の表示を切り替えます。 スク
リーンショットとデモビデオに重要: 白い背景は緑/青
の Floater をより強く 強調し、暗い背景はクリーンな
レンダリングショットに適しています。

簡単に言うと

プレビューウィンドウ内の 3D モ
デルの後ろの色。ダークグレー

が 標準で、ほとんどのシーンに
適しています。白はスクリーン

ショットに適しており、 黒はレ
ンダリングショットでより上品に

見えます。メニュー「Viewport → 
Background」 からいつでも現在
のシーンの色を切り替えられます 
— この設定は次回開いたときに 
どの色がアクティブになるかを決

定するだけです。

S4 Auto-Rotate After Training

場所

Settings → General → Viewport → トグル「Auto-
Rotate After Training」。バインド済み。デフォルト: 
false 。

技術詳細

トレーニング終了直後、シーン重心の周りでビュー

ポートカメラの連続 ターンテーブル回転を開始しま
す (標準回転速度 ~0.3 rad/秒)。デモセッション、 A/B 
比較、360° ビューから直接「Floater」がシーン境界
で発生したかを判断するのに 実用的に便利です。視
覚的にはメニュー Viewport → Toggle Auto-Rotation 
(M16、⌘⌥T) と同じ効果ですが、ここのトグルは手動
ではなくトレーニング終了後に 自動的に動作をトリ
ガーします。後でメニューやビューポート内のクリッ

ク (回転を 一時停止) を介して、いつでも中断できま
す。トレーニングパフォーマンスには影響しません — 
回転はトレーニング完了後にのみ実行されます。

簡単に言うと

有効にすると、トレーニング完了

直後に 3D シーンが自動的に回転
します — 回転木馬のようです。
夜通しトレーニング後、自分でク

リックすることなく朝に 結果が
動いているのを見られると素敵で

す。トレーニングを監視するだけ

の長い セッションでは、オフにし
ておく方が良いでしょう。
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S5 Live Preview Interval

場所

Settings → General → Training → Live 
Preview ピッカー。 バインド: 
AppState.trainingConfig.livePreviewInterval。

デフォルト: 0  (Off)。

技術詳細

実行中のトレーニングスナップショットを 3D ビュー
ポートにレンダリング する反復間隔を決定します。4 
つの離散値: 0 (「Off」)、50、250、1000 反復。 Live 
Preview がアクティブな場合、トレーナーは GPU か
ら別のレンダリングバッファに Gaussian バッファをコ
ピーし、ビューポートの再描画をトリガーします。

「Off」では、 ビューポートはトレーニング完了後にの
み更新されます。パフォーマンスコスト: 50 反復ごと
は M3 Ultra で ~5〜10% 遅く、250 反復ごとは ~1〜
2% 遅く、 1000 反復ごとは測定不能です。メモリオー
バーヘッドは間隔に関係なく、 スナップショット
バッファ用に ~2 GB で一定。値は新規トレーニング用
の デフォルトとして機能します。トレーニング開始後、
トレーニング Inspector は このトレーニングの実際の
ライブ値を表示します。間隔 50 では視覚的印象は点
群の スムーズな「成長」、1000 ではぎこちなく感じ
ます。

簡単に言うと

トレーニングが実行されている

間、3D ビューの更新頻度を選
択できます。 「Off」とは、ト
レーニング中に更新しないこと

を意味します (最速)。「Every 50 
Iterations」は、シーンの形成を
ほぼリアルタイムで表示します 
(少し遅い)。 小さなトレーニン
グでのんびり見るには、「Every 
250」が良い妥協点です。
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S6 Throttle Delay

場所

Settings → General → Training → Throttle 
ピッカー。 バインド: 
AppState.trainingConfig.throttleDelayMs。デフォ

ルト: 0  (Off)。

技術詳細

トレーニング反復間にミリ秒単位の人工的な遅延を挿

入します。4 つの 離散値: 0 (「Off」)、2 (「Light」)、
5 (「Moderate」)、10 (「Eco」)。意味: 長いトレーニ
ング (数時間) では、GPU が 100% 使用されない限
り、システム UI が 顕著に遅くなります (マウスカーソ
ルが引っかかり、他のアプリが鈍くなる)。 Throttle 遅
延は、他のタスクが実行できる休憩を GPU に与えま
す。パフォーマンス コストは大きい: 5 ms Throttle で
は、典型的な 40K トレーニングは Throttle なしと 比
較して約 50〜80% 長くかかります。パフォーマンス
モード「Eco」(10 ms) では、 反復あたりの遅延は反
復自体より長くなります — 2〜3 倍遅い係数。Throttle 
が アクティブな場合、ピッカーの下にヒントが表示さ
れます: 「Throttle is on. Training will be slower than 
usual.」アプリ自体は顕著に反応がよくなりません — 
他のアプリだけが恩恵を受けます。

簡単に言うと

長時間のトレーニング中に Mac が
熱くなりすぎたり、他のプログラ

ムが 重くなりすぎたりする場合、
ここでブレーキを入れてくださ

い。「Off」は GPU に 全力を与え
ます (最速)。「Light」は各ステッ
プ間に小さな休憩を入れます (少
し遅いが、 システムの反応が良
い)。「Eco」は最強のブレーキで
す — 熱くなりすぎてはいけない 
MacBook での夜間トレーニング
に適しています。
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AI Helpers タブ

図 16:  設定 → AI Helpers タブ、マスタースイッチとサブトグル
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S11 AI Helpers enabled (Master)

場所

Settings → AI Helpers → 最初のセクション → トグ
ル「AI Helpers enabled」。バインド済み。デフォルト: 
true 。

技術詳細

パイプライン内のすべての AI Helpers 機能のマスター
スイッチ。 オフの場合、インポートと SfM パイプライ
ンはすべての ML ベースの前処理ステージを 完全にス
キップします — Apple Vision 呼び出しなし、CoreML 
モデルロードなし、 NPU 起動なし。オンの場合、個々
のサブトグル (S12〜S13) が参照されます。値は 再起
動を超えて記憶されます。以下のステージに影響しま

す: (a) SfM 前のフレーム 品質事前チェック (S12)、
(b) Loop Closure 検出 (S13)。重要: オフの場合、 2 つ
のサブトグルは無効化され、視覚的にグレーアウト

されます。フッターヒントは、 すべての AI Helpers が 
厳密にオンデバイスで実行されることを強調していま

す — 画像アップロードなし、 クラウド処理なし。デー
タ保護保証は、Apple Vision フレームワーク (Neural 
Engine 上で ローカル) と、アプリバンドルに直接配置
された CoreML モデルのみを使用することで 実現され
ています。

簡単に言うと

内部で AI / 機械学習を使用する
すべての機能のメインスイッチで

す。 標準は「オン」です。なぜな
ら、ヘルパーは画像が Mac を離れ
ることなく多くの時間を 節約する
からです。完全にオフにしたい場

合 (例えば電力を節約したい、ま
たは Mac に NPU がない)、ここでオ
フにします — そうすると、下の 2 
つのサブオプションは 自動的にグ
レーになり、何もしません。
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S12 Frame quality check

場所

Settings → AI Helpers → Available セクション → トグ
ル「Frame quality check」。バインド済み。デフォル
ト: true 。

技術詳細

Frame Quality Screener (Phase 3.11) を有効化しま
す。これは SfM 呼び出し前に各インポートされたフ
レームを分析します。フレームごとの パイプラインス
テップ: (a) Apple Vision からのラプラシアン分散フィ
ルター (ぼけ検出 — 閾値 ~150)、(b) ヒストグラムベー
スの過/低露出チェック (閾値: 0 または 255 で 5% を
超えるピクセル)、(c) 空白フレーム検出 (すべてのピ
クセルにわたって標準偏差 < 5)。3 つすべてのチェッ
クに合格した フレームは直接通過します。少なくと
も 1 つのチェックに失敗したフレームは、 各問題
のあるフレームをサムネイルと理由とともにリスト

し、削除するかどうかを尋ねる モーダル確認ダイア
ログをトリガーします。重要: 自動削除なし — ダイア
ログは 常に必要で、ユーザーが最終決定を保持します。
パフォーマンス: M3 Ultra で フレームあたり ~50 ms、
並列実行。オフの場合、すべてのフレームはチェック

なしで SfM に渡されます。マスター (S11) が無効化さ
れている場合、このトグルは視覚的に グレーアウトさ
れ、効果がありません。メモリに従う出荷ステータス: 
SHIPPED 2026-05-23。

簡単に言うと

実際のトレーニング前に、アプリ

は各写真を確認します: ぶれてい
ますか？ 完全に暗いか白いです
か？ 空ですか？ もしそうなら、
画像を捨てるかどうかを 尋ねます 
— 自動的に削除することはありま
せん。1 つの完全にぶれた画像が 
時々トレーニング全体を台無しに

することがあるため、これにより

後で多くの時間を 節約します。標
準は「オン」です。なぜなら、コ

ストはほぼゼロで利益が大きいか

らです。
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S13 Loop closure detection

場所

Settings → AI Helpers → Available セクション → トグ
ル「Loop closure detection」。バインド済み。デフォ
ルト: true 。

技術詳細

Apple Vision Feature Print ベースの Loop Closure 検
出を 有効化します。各インポートされたフレームに
ついて、画像コンテンツの神経埋め込みを 表す ~768 
次元の特徴量ベクトルが計算されます。次に、すべて

の Feature Print が ペアごとに Cosine Similarity 経由
で比較されます。Similarity > 0.85 でフレーム イン
デックスの距離 > 50 (つまり非隣接フレーム) のペ
アが「Loop Closure 候補」と して識別され、プロジェ
クトフォルダ内のサイドカー JSONL ファイルに書き込
まれます。 情報提供のみ — インポートされた画像シー
ケンスは変更されません。意味: SfM ソルバー (特に 
COLMAP) に、これらのフレームが 3D 空間で一緒に
クラスター されることを示すヒントを与えます。ネ
イティブ SfM では、サイドカー情報は現在 文書化目的
のみです。COLMAP はカスタム matches-file を介し
てヒントを内部的に 使用します (手動統合可能、自動
的にリンクされません)。パフォーマンス: M3 Ultra で
フレームあたり ~200 ms、並列実行。オフの場合、
Feature Print は 生成されません。マスター (S11) が無
効化されている場合は視覚的にグレーアウト。

簡単に言うと

オブジェクトの周りを写真撮影し

て最後に出発点に戻る場合、それ

を知る ことはコンピューターに
とって非常に役立ちます。このオ

プションは、どの写真が 「ほぼ
同じ場所から」撮影されたかを自

動的に検出し、それを小さなヘル

パー ファイルに書き込みます。
SfM ツール (特に COLMAP) はこの
情報を使用して、 よりクリーンな 
3D 再構築を提供できます。標準
は「オン」です。なぜなら、操作

なしで 実行され、画像を変更しな
いからです。

Inspector ミラー設定

インベントリテーブルの他の設定エントリ (S17〜S33) は、エキスパート Inspector か
らの ミラーリングであり、第 2 章 (Inspector コントロール I12〜I29) に記載されています。 
これらは設定ウィンドウに物理的に表示されません。インベントリでは、永続化される 
TrainingConfig  プロパティを介して実行されるため、形式的に設定としての性質を 持つ
という理由でのみ列挙されています。詳細な説明はそこをご覧ください。
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いつ何を？

設定 スコープ 永続性

S1 Default Mode アプリ全体 アプリ再起動

S2 Language アプリ全体 アプリ再起動

S3 Viewport 
Background

アプリ全体 (デフォルト) + ランタイム アプリ再起動

S4 Auto-Rotate 
After Training

アプリ全体 アプリ再起動

S5 Live Preview 
Interval

新規トレーニングの デフォルト アプリ再起動

S6 Throttle Delay 新規トレーニングのデフォルト アプリ再起動

S11 AI Helpers 
Master

アプリ全体 アプリ再起動

S12 Frame quality 
check

アプリ全体 アプリ再起動

S13 Loop closure 
detection

アプリ全体 アプリ再起動

アプリ全体 = すべてのプロジェクトに作用。新規トレーニングのデフォルト = 次に作成され
るトレーニングのみに作用、実行中のセッションは変更されません。 現在のトレーニン
グ = 実行中のトレーニング構成に即座に作用しますが、明示的な 再インポートなしには永続
化されません。
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章

第 4章 — 補助ウィンドウ

メインウィンドウ (3D Viewport と Inspector) に加えて、RadianceKit は Help メニュー 
から開く 7 つの追加ウィンドウを管理します。上から下の順番: User Guide (⌘?)、 
Keyboard Shortcuts (⌘/)、Open Training Logs… (アプリウィンドウではなく Finder 
を 開くため、ここでは扱いません)、Manage Storage…、Pareto Dashboard… (⇧⌘D)、 
Holdout Analysis… (⇧⌘H)、BayesOpt Console… (⇧⌘B)。そのうち 3 つ — Dashboard、 
Holdout、BayesOpt — は独立した分析ツールです。それぞれ独自の ViewModel スタッ
クを 持ち、ディスク上の JSON ファイルを読み書きし、各ウィンドウをアプリ起動時
に特定の ファイルを表示するように指定する CLI 引数があります ( --dashboard-dir 、 
--holdout-file 、 --bayesopt-autorun )。

4 つのシンプルなウィンドウ (User Guide、Keyboard Shortcuts、Manage Storage、加え
て サブメニュー項目 Open Training Logs / Open Exports Folder) は、コントロールごとに 
短いエントリを得ます。3 つの分析ウィンドウはより詳細に記載されています — それぞれ、 
ウィンドウで何を見るか、いつ開くべきか、表示される画像をどのように解釈するかを 説明
する導入付きです。

章末には、メインウィンドウの Inspector へのクロスリファレンスセクションがあります: 実
行中のトレーニング中にライブ Loss チャートと Gaussian Count 表示で意味を持って 読み
取れるもの。
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User Guide (W1〜W4)

図 17:  左にサイドバー、右にレンダリングされた Markdown コンテンツ付き User Guide ウィン
ドウ

何か: アプリに同梱されている guide_<言語>.md  をレンダリングする 組み込みヘルプウィ
ンドウ。言語は設定 (タブ General → Language) から、または そこに「System」がある場
合は macOS 言語設定から導出されます。レイアウトは 古典的: 左にすべての見出しがある
サイドバー、右に本文。

いつ開くか  単一の点について素早いリマインダが必要な場合 — キーワード代替として。詳細
なリファレンスはこのマニュアルです。組み込みヘルプ ウィンドウは、コマンドラインの 
--help  に近いものです。各アプリリリースで 更新されますが、内容的にはより表面的に保
たれています。
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W1 NavigationSplitView (サイドバー + 詳細)

場所

Help → User Guide (⌘?)。

技術詳細

コンテンツツリー用の狭いサイドバー (最小 180 pt 幅) 
と、実際の Markdown コンテンツ用のスクロール可能
な詳細領域を持つ 2 列レイアウト。ウィンドウは 700 
× 500 pt の最小サイズです。最初に開くとき、ウィ
ンドウは適切な guide_<lang>.md  をアプリバンドル
から読み込み (フォールバック guide_en.md )、 ブ
ロックレコード (H1〜H4 見出し、段落、リスト、テー
ブル、区切り線) に解析し、 サイドバー用に見出し構
造を別に抽出します。インラインフォーマット (Bold、 
Italic、Code-Span) は組み込み Markdown エンジンで
レンダリングされます。言語は アプリ設定から読み
取られ、これらのバリアントが zh または pt と異なる
ため、 中国語 ( zh-Hans ) とブラジルポルトガル語 
( pt-BR ) は完全なロケールタグとして 保持される特別
なケースです。

簡単に言うと

組み込みヘルプテキスト。左にト

ピックリスト、右にコンテンツ。

言語は システム設定に従って自動
的に調整されます。オフラインで

機能しますが、意図的に ショー
トバージョンのみです — 完全な
リファレンスはこのマニュアルで

す。

W2 List (見出しサイドバー)

場所

User Guide ウィンドウの左カラム。

技術詳細

現在の Markdown ドキュメントのすべての H2 と 
H3 見出しのリスト。 H2 エントリはインデントなしで 
Medium フォントウェイト、H3 エントリは左に 16 pt 
の インデントと縮小された前景スタイルで表示されま
す。H4 以下は無視されます。 深度がさらに深くなる
とサイドバーが見にくくなるためです。アンカー ID は
見出し テキストから slugification 経由で生成されます 
(小文字 + スペースをダッシュに + 文字/数字/ダッシュ
に対するフィルタリング — GitHub が Markdown アン
カーで使用するのと 同じアルゴリズム。そのため、
ドキュメントへの外部 URL も同じアンカーに到達する 
可能性があります)。リストはネイティブ macOS スタ
イルを使用します。

簡単に言うと

左側のナビゲーションバー。エン

トリをクリックすると、セクショ

ンに ジャンプします。
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W3 Button (見出し → アンカージャンプ)

場所

サイドバーの行ごとに 1 つのボタン。

技術詳細

各サイドバーエントリはボタンで、現在のアンカーを

設定しますが、視覚的には リストエントリのように見
えます。次に Observer 変数が、対応するアンカーへ
の スクロールジャンプを 0.3 秒のソフトアニメーショ
ンでトリガーします。ジャンプ後、 同じアンカーへの
次のクリックが再び発火するように、アンカー値がリ

セットされます (そうでなければ、値が変わっていない
ため、Observer は再度トリガーされません)。

簡単に言うと

クリックすると、右側のテキスト

の適切な場所に移動します。

W4 ScrollView (詳細コンテンツ)

場所

右カラム。

技術詳細

スクロール可能で垂直に積み重なるコンテンツ領域で、

長いガイドが簡単に 200 以上の Markdown ブロック
を持つ可能性があるため、Lazy レンダリングが使用さ
れます — 非 Lazy バリアントはすべてを同時にイン
スタンス化します。各ブロックは独自の ID を 取得しま
す。見出しアンカー (ジャンプ可能な H1〜H3 用) また
はインデックス プレースホルダーのいずれか。最大幅
は 720 pt、パディングは水平 32、垂直 24 で、 長い
行が読みやすいレイアウトを保ちます。テーブルは水

平スタックと区切り線で セル単位でレンダリングされ
ます。インラインコードは組み込み Markdown エンジ
ンに よって。実際のコードブロックは現在段落として
扱われます — Help ウィンドウの 既知の制限。

簡単に言うと

実際のヘルプテキスト。スクロー

ル可能、読みやすい幅、明確な タ
イポグラフィ。
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Keyboard Shortcuts (W5〜W6)

図 18:  Keyboard Shortcuts ウィンドウ — Navigation/Views/Capture/Editor/Training の 5 グ
ループ、左にホットキーカラム、右に説明

画像で見えるもの  5 つのセクションでの静的 リファレンスリスト。Navigation: Mouse 
Drag (Orbit/Fly)、Shift+Drag/Right-Drag (Pan)、 Scroll (Zoom)、WASD (Fly-Through 移
動)、Q/E (Up/Down)、F (Orbit/Fly 切り替え)、 ダブルクリック (再センター)、Cmd+Scroll 
(FoV 調整)。Views: R (Reset Camera)、T (Auto-Rotation)、P (Camera Playback)、B 
(Background-Cycle)、0〜9 (Training-Cam 1=10%/5=50%/0=last にジャンプ)、左/右矢印 
(Prev/Next Cam)。Capture: S (Desktop に Screenshot)、V (Turntable Video)、C (Copy 
Camera Info)。Editor: Tab (Edit モード)、Click/Drag (Paint-Select)、Option+Click 
(Deselect)、X / Delete (選択を削除)、Cmd-Z (最後の削除を取り消し)、[ / ] (ブラシサ
イズの縮小/拡大)、 Esc (選択解除)。Training: Start、Pause/Resume、Cancel、Continue 
+5K/+10K/+20K M9〜M14 のメニューショートカット経由。

83 / 227



R A D I A N C E K I T 第 4章 — 補助ウィンドウ

何か: すべてのキーボードショートカットのシンプルな静的概要 — Navigation、Views、
Capture、Editor、Training。コンテンツはハードコードされており、 Markdown ロードは
ありません。

いつ開くか  Viewport で何かを行う最も速い方法を探している場合。 WASD Fly-Through、カ
メラリセット用 R、背景循環用 B — すべてここにあります。

W5 ScrollView (コンテンツ領域)

場所

Help → Keyboard Shortcuts (⌘/)。

技術詳細

垂直リストが含まれるシンプルなスクロール領域。

20 のパディングが全周囲、 サイドバーナビゲーション
ツリーなし (リストは十分短い)。コンテンツは 5 つの 
セクション (Navigation、Views、Capture、Editor、
Training) にグループ化されています。 キーの組み合わ
せごとに、両カラムに翻訳可能なテキストを持つ 1 行。
左カラム (キーコード) は 180 pt 幅に固定されている
ため、右側の説明は垂直に整列したまま。 スクロール
以外の操作はありません — 行をクリックしても何も
トリガーされません。 ショートカットは、メニューと 
Viewport の実際のキーボード修飾子です。

簡単に言うと

すべてのショートカットキーの

テーブル。素早く参照するための

静的な チートシート。

W6 VStack (ショートカットセクション)

場所

ScrollView 内。

技術詳細

16 pt の間隔で左揃えにスタックされたセクション。
5 つのセクション内に それぞれ見出し + 行のシーケン
ス。見出しはセカンダリサブヘッドラインスタイル

を使用 します — セクションはナビゲート可能であ
る必要がないため、Title フォーマットは 意図的に使用
しません。コンポーネントがすべての macOS バー
ジョンで変更なしで実行され、 ファイルが読みやす
いままになるように、コンテンツは意図的にフラット 
(Disclosure、 Search、Filter なし) です。

簡単に言うと

機能 (Navigation、Views、Editor な
ど) ごとのキーのグループ化。
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Manage Storage (W7〜W12)

図 19:  Manage Storage ウィンドウ — ヘッダーに「693 items · 16.74 GB total」、日付でソート
されたエクスポート PLY ファイルのテーブル、 各々形式ピル + ファイル名 + サイズ + 日付

画像で見えるもの  RadianceKit が管理する すべてのファイルのテーブルビュー。ヘッダー
は 693 アイテム、16.74 GB の合計サイズを カウントします。上部のツールバー: 
「Show in Finder」+ 「Refresh」。各行: PLY アイコン、ファイル名 (例えば training_​
20260527T211321Z.ply)、エクスポート日、 サイズ (7 KB から 218 MB まで変動)、虫眼鏡
アイコン (Reveal)、ゴミ箱アイコン (Move to Trash)。ファイルは日付でソートされ、最新
のものが上にあります。この デモ撮影では、 --benchmark  で多く作業したため、PLY エク
スポートが優勢です。

何か: RadianceKit が ~/​Documents/​RadianceKit/​ 以下に配置するすべての ディスク使用量
概要 — ログ、エクスポート、シーン、キャプチャバンドル (iOS コンパニオンから)、イン
ポート (入力画像のステージングコピー)。エントリごとに バイト単位のサイズと 2 つのボタ
ン: 「Finder で表示」と「ゴミ箱に移動」。自動 クリーンアップは NOT — アプリ自体は何も
削除しません。エントリごとに決定します。
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いつ開くか  ディスクがいっぱいになったとき。特にログが蓄積されます (トレーニング試行ご
とに 1 つの JSONL、加えて _​qualityMetrics.json)。 エクスポートも当然 (PLY 100% 生
データ、エクスポートごとに 1 つ)。クラッシュ後、 インポートステージングディレク
トリがまだ入力画像の古いコピーを保持している場合 にも便利です (dev_​v549f-needle-
reduction.md の「Disk-pressure incident」参照)。

W7 ボタン「Show in Finder」

場所

Storage ブラウザウィンドウの右上のヘッダー。

技術詳細

Finder で RadianceKit ディレクトリ全体 (~/​
Documents/​RadianceKit/​) を 開き、フォルダ構造を直
接見て、Finder 自体で操作することもできます。ア
クションは 新しい Finder ウィンドウを開き、ア
プリ Sandbox コンテナに切り替えません — ~/​
Documents/​RadianceKit/​ はアプリに通常アクセス可
能な Documents ドメインで、 Sandbox コンテナパス
ではありません。

簡単に言うと

Finder でディレクトリを開き、
ファイルを自分で操作できるよう

にします。

W8 ボタン「Refresh」

場所

ヘッダー、Finder ボタンの隣。

技術詳細

大きなディレクトリツリーのスキャンが UI をブロッ
クしないように、ユーザー 開始の非同期タスクで
実行されるバックグラウンドスキャンをトリガーし

ます。実際の ウォークは、各既知のサブフォルダ 
(Logs、Exports、Scenes、Captures、Imports) を 通
過し、直接の子ごとに Storage エントリを生成します。
エントリごとに、再帰サイズが 決定されます — 論理
ファイルサイズへのフォールバックとともに、実際の

ディスク使用量 (APFS ハードリンク共有を含む) を優
先します。

簡単に言うと

Finder で間にあなたが何か削除ま
たは追加した場合、リストを再読

み込み します。
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W9 List (Storage エントリ)

場所

ヘッダー下のメインコンテンツ。

技術詳細

行ごとに次のレイアウトを持つリスト: カテゴリ固有の 
SF Symbol アイコン (Logs 用ドキュメント、Exports 
用アップロード矢印、Scenes 用キューブ、Imports 用 
トレイ)、名前 + サブタイトル (Kind ラベル + フォー
マットされた変更日)、右側の バイトカウンター (右揃
え、monospace)、Reveal ボタン (虫眼鏡シンボル)、
Trash ボタン (ゴミ箱)。ソート: 主に種類別 (最初に 
Scenes、次に Exports、Logs、Captures、 Imports、
Other)、次に変更日降順 (最新が上)。スキャンが実行
中の場合、その場所には 代わりに「Scanning…」進捗
が表示されます。何も見つからない場合、Tray アイコ
ンを 持つ空状態表示。

簡単に言うと

タイプと最新性でソートされたす

べての RadianceKit データのリス
ト。 エントリごとにサイズを確認
し、直接削除できます。

W10 行ボタン「Reveal in Finder」

場所

行ごと、右側の虫眼鏡シンボル。

技術詳細

Finder を開き、特定のアイテム (ファイルまたはフォル
ダ) を選択します。 W7 との違い: W7 はルートディレ
クトリを開きます。W10 はこの 1 つのエントリを 正確
にマークします。実用的なワークフロー: 大きなエン
トリを識別し、虫眼鏡を クリックし、例えば外部ボ
リュームにコピーします。

簡単に言うと

素早く見つけられるように、

Finder で直接このエントリにジャ
ンプします。
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W11 行ボタン「Move to Trash」

場所

行ごと、虫眼鏡の隣の右側のゴミ箱シンボル。

技術詳細

確認ダイアログボックス (W12) をトリガーします。確
認後にのみ、macOS 標準の 「ゴミ箱に移動」操作が
実行されます (つまり、可逆的、直接削除ではありませ
ん)。 ゴミ箱への移動が成功した後、エントリはリスト
から削除され、合計バイトカウンターが 更新されます。
エラーが発生した場合、モーダルエラーダイアログが

表示されます。

簡単に言うと

エントリをゴミ箱に移動します。

ダイアログが事前に尋ねます。

W12 ConfirmationDialog (削除確認)

場所

W11 によってトリガーされ、macOS シートとして表示
されます。

技術詳細

動的タイトル「Delete <name>?」と、エントリがゴミ
箱に着地し、そこから 復元可能であることを明示的に
指摘するメッセージ行を持つ標準確認ダイアログ (ゴミ
箱が空にされるまで)。2 つのボタン: 破壊的アクショ
ンとしての「Move to Trash」 (赤で表示) と自動 Esc 
バインディングを持つ「Cancel」。可逆的削除に対する 
macOS 標準であるため、ダイアログはアプリ全体では
なくこのウィンドウのみをブロックする 意味で非モー
ダルです。

簡単に言うと

削除前の安全質問。「Move to 
Trash」はゴミ箱が空にされない
限り 可逆的です。
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Pareto Dashboard (W13〜W22)

図 20:  Pareto Dashboard — レポートインポート前の空状態

空状態 (最初に開いた後) — 「Open Reports Folder…」コールトゥアクション付き 空状態。
トレーニングレポートが読み込まれるとすぐにデータポイントが表示されます。 次のショッ
ト参照。

図 21:  129 ベンチマークレポートがロードされた Pareto Dashboard — Pareto Front 付き 
Gaussian 対 PSNR、Scene/Strategy/Mip フィルター

画像で見えるもの  ヘッダーツールバーは 「129 reports of 129」を表示します (選択されたフォ
ルダ内のすべてのレポートが 正常に解析されました — 21 の追加ファイルは古いフォー
マットのため解析できません でした。右側のヒントリスト参照)。軸: X 軸ピッカーは 
Gaussians 、Y 軸ピッカーは PSNR (dB)  上。Scatter Plot: 緑のポイント = Classic 戦略、
青のポイント = MCMC。 破線 Pareto Front 線は、最高達成された PSNR 値に沿って実行さ
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れ、約 500K Gaussian から PSNR≈30 dB でプラトーになります。右側のフィルターチップ: 
7 シーン (bicycle、bonsai、family、flowers、kitchen、stump、truck)、2 戦略 (classic、 
mcmc)、3 Mip-Splatting オプション (All、On、Off)。現在、すべてのフィルターが 開いて
いるため、密なポイントクラスター。

何か: マルチ実行比較ツール。過去に複数のシーンまたは同じシーンを異なる プリセット
でトレーニングしました — これらの各トレーニング実行は ( --benchmark  を 渡したか、ベ
ンチマーク機能経由で呼び出した場合) Final PSNR、SSIM、LPIPS、Gaussian カウント、
Wallclock 時間を含む JSON レポートファイルを生成します。Dashboard は そのようなレ
ポートのフォルダ全体を同時に読み込み、選択可能な軸を持つ 2D Scatter としてプロット
します。さらに、Pareto Front (支配されない点のセット) が破線として 描画されます。

いつ開くか  少なくとも 3 つまたは 4 つのトレーニングレポートを作成した後。 少ないポイン
トでは、Frontier ラインは意味がありません。典型的なユースケース: 屋外シーンを再構築
しようとし、順次 P3 Balanced (Classic)、P4 Quality (Classic)、 P7 MCMC Quality、P9 
Outdoor (tuned) を試しました — 今、どの構成が秒あたりの 最良のトレーニング時間 
PSNR を提供するか、または特定の PSNR に必要な最小の Gaussian を提供するかを知りた
いです。

どのように解釈  両軸は自由に選択可能 (X 軸:、、 psnr 、 ssim 、 lpips  など。Y 軸も同じ)。
ParetoFront2D.indices の Pareto Front ロジックは、 メトリックごとに「小さい = 良い」
(例えば LPIPS、Loss、Time) または「大きい = 良い」 (PSNR、SSIM) かを知っています — 
したがって、線は軸の選択に応じて左下から右上、 または左上から右下に実行され、常に最
高達成された組み合わせに沿って。点は、 他の点が両方の次元で少なくとも同じくらい良く
ない場合、Pareto 最適です (つまり、他の点が支配しません)。Pareto 最適点は線上にあり、
他の点は線の右/上 (軸の方向に応じて) にあります。線上の点は「最高のプリセット」の本
当の候補です。 線から遠い点は無駄なトレーニング時間です。

フィルターチップ  選択を特定のシーン (例えば屋外実行のみを比較したい 場合)、特定の戦略 
(Classic または MCMC)、または Mip-Splatting オン/オフ (Phase Q1.5 以降に関連、ここで 
Mip は opt-in Advanced フラグとして残ります) に 制限できます。

ワークフロー例  「truck」シーン用の 3 つのレポートが ~/​Documents/​RadianceKit/​Reports/​ 
の下にあります: Run A (P4 Quality、40K 反復、 524K Gs、105 秒、PSNR 23.4)、Run B 
(P7 MCMC、200K 反復、150K Gs、693 秒、 PSNR 24.6)、Run C (P9 Outdoor、100K 反
復、1.25M Gs、312 秒、PSNR 25.8)。X 軸を trainingTime に、Y 軸を PSNR に設定しま
す。Run B は右上に、Run C はさらに右上に、 Run A は左下にあります。Pareto Front は 
A と C を接続します — 両方とも 支配されていません。Run B は「失われ」ています (C は 
Time と PSNR の両方で より良い)。洞察: 「truck」では MCMC デフォルトは価値がありま
せん。高速 + OK (A) または長く + 非常に良い (C) のいずれか。C からの構成を独自プリ
セットとして保存 (Inspector → I1 Save Preset)。

次のアクション: 最良の構成をプリセットとして保存します。具体的に: Pareto 点を見て 
(Hover でツールチップに PSNR/SSIM/LPIPS/Gs/Time が表示)、 Time vs Quality トレード
オフが最も適しているものを決定し、対応するレポートを 開き (ファイル名に Run タイムス
タンプが含まれます)、そのトレーニング構成を 新しい実行にコピーするか、次のトレーニ
ングセッション後に Inspector 経由で プリセットとして保存します。
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W13 ボタン「Open Reports Folder…」

場所

左上のツールバー。

技術詳細

「Select a folder containing benchmark .json 
reports」プロンプト付き フォルダ選択ダイアログを開
きます。確認後、フォルダ内のすべての .json  ファ
イルを 順次解析するバックグラウンドタスクが実行さ
れます。欠陥のあるレポート (破損 JSON、 誤ったス
キーマ) が収集され、サイドバーの下に「N file failed 
to parse」として 表示されます — クラッシュなし。最
初のロードが実行中の場合に 2 回目のクリックが 発生
すると、以前のタスクが中止され、2 つの結果が同時
に状態に書き込まれないように します。

CLI 経由でも: --dashboard-dir /​path/​to/​reports は
アプリ起動時にフォルダをロード します。

簡単に言うと

ベンチマークレポートが

配置されているフォルダ

を選択します。標準パス

は ~/​Documents/​RadianceKit/​
Reports/​。次に、すべての 
JSON を一度に読み込みます。

W14 ピッカー「X-Axis」

場所

チャートの上、左。

技術詳細

Dashboard モジュールのすべての利用可能なメトリッ
ク軸 (PSNR、SSIM、 LPIPS、Gaussian カウント、ト
レーニング時間など) を持つメニューピッカー。 デ
フォルトは Gaussian カウントです。切り替え時、
Hover ポイントがリセットされます。 以前にハイライ
トされた位置が、軸変更後の古い軸座標系で意味をな

さないためです。 ピッカーはコンテンツ幅に制限され、
幅全体に引き伸ばされないようにします。

簡単に言うと

水平軸にどのメトリックがあるべ

きか。通常「トレーニング時間」

または 「Gaussian カウント」、そ
れらが比較したい「コスト」だか

らです。
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W15 ピッカー「Y-Axis」

場所

チャートの上、X 軸の隣。

技術詳細

W14 と同じですが、デフォルトは PSNR です。軸選択
は独立して保存される ため、ユーザーはナンセンスな
組み合わせ (X=PSNR、Y=PSNR — すべての点を対角
線に 配置します) を選択することもできます。しかし、
そのような組み合わせはキャッチ されません。意図的
な決定です。「SSIM vs PSNR」の比較は、メトリック
がどれだけ 一貫して動作するかを見るために十分興味
深いからです。

簡単に言うと

垂直軸に何があるか。通常、品

質尺度として「PSNR」または
「SSIM」。

W16 トグル「Show Pareto Front」

場所

軸ピッカーの右隣。

技術詳細

標準 macOS トグル。アクティブな場合、Pareto 
チャートでは点群に加えて、 計算された 2D Pareto 
Front の線が描画されます。スタイル: 破線 (ダッシュ
パターン 4–4)、グレー半透明、線太さ 1.5 pt。Pareto 
計算はメインスレッドで実行されます — 典型的なレ
ポート数 (≤ ~50) では問題なく高速です。トグルがオ
フの場合、線は省略 され、生の点のみが表示されます。

簡単に言うと

「これまで最良の」点を通る線を

表示します。線が邪魔な場合 (例
えば、 個々のトレードのみを比較
したい場合)、それをオフにしてく
ださい。
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W17 チップ「Scene」フィルター

場所

Dashboard ウィンドウの右サイドバー。

技術詳細

ロードされたレポートに表示される各シーン用のフィ

ルターチップ。幅が使い 果たされるとすぐに、チッ
プを複数行に自動的に再パッキングする独自の Flow 
Layout。 アクティブなチップはアクセント背景を取得
し、非アクティブなチップは中立的な標準 マテリアル
背景を取得します。複数選択が可能 (Set セマンティク
ス)。チップが選択 されていない場合、すべてのシー
ンが「通過」と見なされます — つまり、Set ロジック
は 「空の選択 = すべて」であり、「空の選択 = 何もな
い」ではありません。

簡単に言うと

シーン名をクリックすると、点が

このシーンのみにフィルタリング

されます。 複数選択可能。空 = す
べてのシーン。

W18 チップ「Strategy」フィルター

場所

サイドバーの Scene フィルターの下。

技術詳細

W17 と同じですが、トレーニング戦略用 — 通常、ベ
ンチマークレポート JSON の Strategy フィールドか
ら導出された 2 つの値「classic」と「mcmc」。両方
の 戦略のレポートを混在させ、1 種類のみを表示し
たい場合 (例えば、Classic を すでに除外しているため
「MCMC 実行のみを表示」) に役立ちます。

簡単に言うと

Classic または MCMC でフィル
ター。デフォルトでは両方がアク

ティブです。
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W19 チップ「Mip-Splatting」フィルター

場所

サイドバーの Strategy フィルターの下。

技術詳細

3 値フィルター (W17/W18 のような Set ではなく): 
「All」/「On」/「Off」。 背景: Mip-Splatting は Phase 
Q1.5 で実験的マルチスケール改善として評価され、 最
終評決は「全体的に良い勝利はない。opt-in フラグと
して保持」でした。Mip on/off 比較を行う場合、しば
しば非常に明確に区別したいです。したがって、状態

「すべて通す」、 「Mip オンのみ」、「Mip オフのみ」を
持つ専用の三値フィルター。サイドバーセクションは、 
データセットに少なくとも 1 つの Mip レポートと少な
くとも 1 つの非 Mip レポートが ある場合にのみ表示さ
れます (そうでなければ、フィルタリングは意味があり
ません)。

簡単に言うと

Mip-Splatting オン/オフを比較し
たい場合、ここに 3 分割フィル
ター。 そうでなければ無視。

W20 ChipButton (フィルタートグル、all/on/off)

場所

ヘルパーコンポーネント、W17/W18/W19 で使用。

技術詳細

ミニマリストのボタンラッパー。コンテンツ: Caption 
フォントグレードの ラベルテキストとパディング水平 
10 / 垂直 5。条件付き背景: アクティブな場合 → 白い
テキストでアプリのアクセント色。それ以外、黒いテ

キストで中立的な標準 マテリアル背景。形状はカプセ
ル (薬丸状)。Capsule マテリアルがシステム境界線で 
オーバーレイされないように、Plain ボタンスタイル。

簡単に言うと

丸いフィルターボタン自体。視覚

的に iOS タグのように。
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W21 チャート (Pareto Scatter)

場所

Dashboard の中央領域。

技術詳細

2 つのレイヤーを持つ Swift Charts ダイアグラム: 1. レ
ポートあたり 1 つの ポイント — 選択された X と Y メ
トリックからの位置、戦略による色、Mip ステータス
に よる Symbol。Symbol サイズ通常 80、ハイライト
された 200 (ID が現在 Hover された レポートに対応
する場合)。2. Pareto Front 用の線、トグルがオンの場
合のみ。

チャートオーバーレイ: 透明な長方形がマウス移動を
登録します。フレームごとに、 プロットフレーム内の
最も近いユークリッドポイント位置が決定され、距離

が 24 px 未満の場合は Hover されたレポートが更新さ
れます (そうでなければリセット)。これで、 クリッ
クせずにツールチップを取得できます — Hover で十分
です。

簡単に言うと

実際の散布図。各点はトレーニン

グ実行です。詳細ツールチップ用

に Hover。

W22 ツールチップ (Hover 詳細)

場所

チャートの下、Hover 時に表示。

技術詳細

水平スタック: シーン名 (Headline)、Strategy タ
グ (Caption)、区切り線、 次に PSNR/SSIM/LPIPS/Gs/
Time メトリックがそれぞれ小さな垂直グループ (ラ
ベル + monospace 値) に。Mip が有効化されていた
場合、アクセント色の追加の「Mip」 Capsule タグも。
背景は半透明 Blur、8 pt 半径の角丸長方形。マウスが
実際にポイント上に ある場合にのみ表示。離れると自
動的に消えます。

簡単に言うと

マウスをポイント上に置くと、下

に詳細カードが表示されます。す

べての 品質メトリックと実行構成
を一度に表示。
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Holdout Analysis (W23〜W29)

図 22:  Holdout Analysis — transforms.json をロードする前の空状態

「Open transforms.json…」コールトゥアクション付き空状態と空状態。NeRF Studio と 
Instant-NGP 形式を受け入れます。

空状態 (最初に開いた後) — カメラマーカーは transforms.json  がロードされる とすぐに
表示されます。次のショット参照。

図 23:  100 NeRF-Blender Mic カメラ、5 fold × 20 カメラ、Angular 戦略 アクティブの Holdout 
Globe

画像で見えるもの  ヘッダーはロードされた ファイル (transforms_​train.json) と Cam カウン
ト (「100 cameras」) を表示 します。左サイドバー: 2 つのオプションを持つ Strategy ピッ
カー — アクティブな Angular (longitudinal) (Fold を球体上の経度/緯度セクターに合わ
せます。各 Test fold が幾何学的に密になるように) vs Linear (round-robin) (順序ベース、 
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すべての k 番目のフレームを Test セットとして)。k-Folds スライダーは 5、Test Fold ピッ
カーは Fold 1。Export ボタンは Nerfstudio/Instant-NGP 用の fold-assignment.json を生
成します。中央パネル: 全 100 カメラの 3D グローブ 投影 — 緑のポイント = Train、赤のポ
イント = 現在の Test fold (20 カメラの Fold 1)。右サイドバー (Angular Correlation): Fold 
あたり 20 Cams + Mean Nearest Angle (Fold 1: 7.9°、Fold 2: 7.8°、Fold 3: 7.7°、Fold 4: 
7.0°、Fold 5: 6.3°) — 小さい値は、この Fold 内のカメラが互いに密接に位置していること
を意味します。 つまり、Holdout 分割は空間的にコヒーレントです。

何か: クロス検証ロジックを備えたカメラ配置の 3D ビジュアライザー。 transforms.json  
(カメラポーズ用の Nerfstudio / Instant-NGP の標準形式) を ロードし、アプリはすべてのカ
メラを読み取り、視線方向を単位球に投影し、仮想 グローブ上の小さな球マーカー
として表示します。次に、カメラを k  Fold (選択された 戦略: angular または linear) に分
割し、トレーニング部分を緑、テスト部分 (Holdout) を 赤でマークし、Fold ごとに Angular 
Correlation スコアを計算します。これは、 Test fold が視線空間でトレーニング fold からど
れだけ離れているかを示します。

いつ開くか  Holdout 評価を行いたいとき — つまり: モデルは未見の 視点にどれだけ良く一般
化するか？トレーニングの標準は「8 番目ごとのビューを Holdout として」(Mip-NeRF360 
規約) ですが、これは非常に線形な分割です。例えば 画像が時間的にクラスター化されてい
る場合 (まずオブジェクトの一方の側、次に もう一方)、「8 番目ごと」は代表的ではあり
ません — ランダムなシーケンス位置が Test に着地しますが、すべての隣接が Training にあ
ります。それは簡単すぎます。 「angular」では代わりに視線空間にわたって層別化されま
す: 各 Fold には Orbit の すべての領域からのカメラが含まれるため、Test は本当に一般化
ギャップをテストします。

どのように解釈  Angular vs Linear: - Angular (標準): カメラを Longitudinal 角度 (Y 軸周りの 
φ 座標) で k  個の等しいセクターに分割します。Fold 0 は φ ∈ [0°、 360/k°) のカメラ、
Fold 1 は次のなど。利点: 各 Fold が Orbit の一部をカバーします。 Test fold は空間的にコ
ンパクトですが、ワールドデータセット全体に広く分布しています。 古典的なオービット撮
影に良い。- Linear (Round-Robin): Fold インデックス = (image_index modulo k)。これは
シンプルな「k 番目ごと」分割。画像の順序に空間バイアスが ない (例えばランダムにソー
トされたドローン撮影) 場合に機能します。画像が時間的に クラスター化される場合、うま
く機能しません。

3D グローブで、すぐに見えます: 緑のポイント (Training) と赤のポイント (Test)。 赤の
ポイントがすべて角にクラスター化されている場合、Holdout は悪いです (良い 一般化テ
ストではありません)。緑の間に均等に位置している場合、それは良いです。 Fold ごとの 
Angular Correlation スコア (右サイドバー、度数) はさらに、より小さい 値 = Test がトレー
ニングに近い (各 Test カメラに近いトレーニングカメラがある、 簡単なテスト) を伝えます。
より大きい値 = Test がトレーニングから離れている (より難しい一般化)。

ワークフロー例  Truck シーンを 251 枚の画像で撮影し、メニュー項目 M33 (Export SfM 
transforms.json) 経由で nerfstudio ファイルをエクスポートします。 Holdout ウィンドウ 
(⇧⌘H) を開き、「Open transforms.json…」経由で JSON を ロードし、グローブを見ます。
k=5 (デフォルト) は 5 Fold を提供します。「Fold 3」を クリック — 赤のマーカーがある程
度均一かを確認します。はいの場合: 「Export fold-assignment.json」で、エクスポートさ
れたファイルを Reports フォルダに配置し、 --benchmark  (または対応する Inspector 設
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定) を使用した次のトレーニング実行で、 標準の「8 番目ごと」の代わりに正確にこの Fold 
分割が Test Holdout として 使用されます。

W23 ボタン「Open transforms.json…」

場所

左上のツールバー。

技術詳細

JSON ファイルに制限されたファイル選択ダイアログ
を開きます。確認後、 Holdout モジュールはファイル
をロードします。ローダーは、nerfstudio 形式 (カメラ 
内部パラメータと画像パスと変換マトリクスを持つフ

レームのリスト) と instant-ngp 形式 (同じ構造) の両
方を解析します。フレームごとに、視線方向が変換マ

トリクスから 抽出され (カメラローカル基底の z 軸)、
保存されます。解析が失敗した場合、Status 領域にエ
ラーメッセージが表示されます。

CLI 経由でも: --holdout-file /​path/​to/​
transforms.json は、ロード済みのファイルで 直接
ウィンドウを開始します。

簡単に言うと

カメラポーズ JSON をロー
ドします。標準は Nerfstudio 
と Instant-NGP エクスポート
です。RadianceKit 自体は、メ
ニュー → Export → SfM 経由で 
transforms.json をエクスポート
できます。

W24 ピッカー「Strategy」 (angular/linear)

場所

左サイドバー、上部。

技術詳細

2 つのオプションを持つラジオピッカー: Angular と 
Linear。戦略の切り替えは、 fold の自動再計算をトリ
ガーします。視線方向は球面上の 3D 単位ベクトルの
リスト です。Angular 戦略はそれらを Longitudinal 角
度 φ に投影してソートし、Linear 戦略はフレームイン
デックスにわたって単にモジュロ分割を行います。

簡単に言うと

均等な Orbit 撮影には Angular (標
準、安全)、画像が空間的にクラ
スター 化されない場合にのみ 
Linear。
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W25 スライダー「k Folds」

場所

左サイドバー、中央。

技術詳細

3 から 10 までのスライダー、ステップ幅 1。変更
時、Fold 計算が自動的に 再トリガーされ、Folds リス
ト、Training/Test インデックス、Fold ごとのスコアが 
すぐに再計算されます。選択された値は、ラベルの右

側に monospace 数字テキストとして 表示されます。

経験則: k=5 が標準 (Fold ごとに 20% のテストを提
供、これがクロス検証の標準) です。 非常に多くの
データがあり、統計的有意性のためにより多くの Fold 
が必要な場合は k=10。データが少ない場合は k=3。

簡単に言うと

いくつの Fold を分割に。5 が標準
で、ほぼ常に適合します。

W26 ピッカー「Test Fold」

場所

左サイドバー、k スライダーの下。

技術詳細

メニューピッカー。オプションは動的に 0..<k、ラベル
「Fold 1」から 「Fold N」(つまり UI で 1-indexed、内
部では 0-indexed)。以前に選択されたインデックスが 
k 以上の場合 (例えば k を 10 から 5 に減らしたため)、
自動的に 0 にリセットされます。 選択された Test 
fold はグローブで赤で表示され、他のすべては緑です。

簡単に言うと

どの Fold が現在 Test fold か。ク
リックして、グローブで各 Fold 
が どのように見えるかを確認でき
ます。
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W27 ボタン「Export fold-assignment.json」

場所

左サイドバー、下部。

技術詳細

デフォルトファイル名 fold-assignment.json を持つ
保存ダイアログを開きます。 確認後、Holdout モ
ジュールは現在の分割を JSON スキーマ (フレームご
との Fold 割り当て + Strategy メタブロック) にエ
ンコードします。このファイルは、 --benchmark  を
使用した次のトレーニングに渡すことができ、同じ 
Holdout が最終メトリック評価に 使用されます。書き
込みエラーはエラーテキストとして表示されます。成

功は緑のテキストで 「Saved to (filename)」として。

簡単に言うと

現在の Train/Test 分割を JSON と
して保存します。このファイルを 
トレーニング時に直接渡すと、同

じ Test セットが再度使用されま
す。

W28 SCNView (3D Camera Globe)

場所

Holdout ウィンドウの中央パネル。

技術詳細

SceneKit グローブビュー。シーンは: ワイヤフレーム
球 (半径 1.0、36 セグメント、 暗いグレー)、3 つの色
付き軸スタブ (X/Y/Z 用の赤/緑/青、それぞれ 1.2 長)、
対応する 視線方向位置の単位球上のカメラごとの小さ
なマーカー球 (半径 0.03) (ワイヤフレーム 球内に消え
ないように、わずかに外側) で構成されます。マーカー
は Fold 変更ごとに 再構築されません — 再構築は、フ
レームリストが変更されたとき (つまり、新しい JSON 
がロードされたとき) にのみ必要です。代わりに、更新
ごとにマテリアル色の インプレース更新が実行され
ます: Test インデックスには赤、Training には緑、ど
ちらでも ない場合は明るいグレー。これにより、N > 
1000 カメラでもスライダーティックがパフォーマンス
を 維持します。

カメラコントロールが有効化されています — マウスで
グローブを回転、ズーム、パン できます。照明により、
マーカーが平らに見えないようにします。背景は暗い

グレーです。

簡単に言うと

カメラ位置を持つ 3D グローブ。
緑 = Training、赤 = Test、明るいグ
レー = 未割り当て (発生しません、
すべてのカメラがどこかに属しま

す)。マウスで、グローブを 回転
およびズームできます。
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W29 FoldCard (タップで Fold を選択)

場所

右サイドバー、「Angular Correlation」セクション。

技術詳細

Fold ごとに 1 つのカードビュー — 6 pt 半径の角丸長
方形、パディング 10、 2 行の垂直レイアウト (上
「Fold N」+ カメラ数、下「Mean nearest angle:」+ 
度数値)。 背景色は条件付き: アクティブな Fold = アク
セント色半透明、非アクティブ = 中立的な 標準マテリ
アル。タップで Fold を選択し、グローブはライブで再
着色します。

「Mean nearest angle」スコアは、Test カメラごとの
最も近いトレーニングカメラまでの 平均最小角度です 
(内部的にラジアンで計算され、UI では度数で表示)。

簡単に言うと

Fold ごとに、右側にカメラ数と次
のトレーニングカメラまでの平均

距離を 持つ小さなカード。それ
をクリックすると、この Fold が 
Test として選択されます。

BayesOpt Console (W30〜W39)

図 24:  BayesOpt コンソール — 試行開始前の空状態

Search-Space ピッカー (RadianceKit defaults (6-dim))、Trial-Budget スライダー (デ
フォルト 40)、Random Seed (42)、Convergence チャート、Trial Log、Search-Space パ
ラメータリスト用の 3 つの空パネルを持つ空状態。

空状態 (最初に開いた後) — Convergence チャートと Trial テーブルは、実行が 開始される
とすぐに埋まります。次のショット参照。
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図 25:  40 試行後の BayesOpt コンソール — Convergence チャートは試行 15 まで 急上昇、
Best Value 0.9943、init/bo/restart タグ付き Trial Log

画像で見えるもの  右上のステータス「Finished — best 0.9943 after 40 trials」。左サイドバー: 
Search-Space ピッカーは RadianceKit defaults (6-dim)、Trial Budget 40、Random 
Seed 42。Parameter リスト は、値範囲を持つチューニングする 6 つのハイパーパラメータ
を表示します: mipSmoothing3DScale [0.05, 0.5]、mipFilter2DVariance [0.1, 0.6]、 
densifyGradThreshold [5e-07, 5e-06]、ssimWeight [0.05, 0.5]、 mcmcNoiseScale 
[1e-05, 0.0001]、mcmcRelocationInterval [50, 200]。中央: Convergence チャート (X 
= Trial インデックス 1〜40、Y = Objective Value 0〜1) — グレーポイント = 初期サンプ
ル (LHS)、青ポイント = BayesOpt 取得、オレンジポイント = Restart 試行 (#22 と #31)。
Best Value 線は試行 ~7 まで急上昇し、その後試行 15 まで わずかな改善のみ、それからフ
ラットなプラトーが 0.99+。右サイドバー: スコア + タグ (init/bo/restart) 付き Trial Log 
#1〜#34。右上の Save Best Config ボタンは bayesopt-best.json  を書き込みます。

何か: ハイパーパラメータ検索用のベイズ最適化コンソール。Bayes-Opt は、 できる
だけ少ない実験で未知の関数の最適点を見つけようとする自動プロセスです — 通常: 
「mcmcMaxGaussians、capMultiplier、ssimWeight、gradThreshold のどの組み合わせが 
私のシーンクラスに最良の PSNR を提供するか?」6^4 = 1296 試行のグリッドの代わりに、 
Bayes-Opt は約 40〜100 の情報を持つ試行を試し、それで最適に近づきます。

重要: アプリで提供される現在のバージョンは、実際のトレーニング実行に対して 最
適化を実行しません (数日かかる)。代わりに合成デモオブジェクティブに対して 実行
します — Hill-Climbing 特性と軽いノイズを持つマルチモーダルランドスケープ。 これ
は意図的: ウィンドウは Optimizer の動作 (収束進行、サンプルポイント、Best So Far) を示
し、Search Space 定義を理解させる必要があります。実際のトレーニング駆動の BayesOpt 
実行 (Phase Q7 で Scene-Class プリセット用に実行されたように) には、 別のオフライン 
CLI ワークフローが使用されます。ウィンドウはライブ UI バリアントです。

いつ開くか  3 つのユースケース: 1. BayesOpt がどのように動作するかを 理解したい — そう
したらデモ実行を開始し、Convergence チャートを観察します。
2. 組み込みの 10 プリセットが完全に適合しない新しいシーンクラス (「アクアリウム」や

「アンティーク家具」など) を計画しています。検索空間を心理的に定義し、ここで 「Bowl 
demo」や「Densify」プリセットでテストし、Best Config を JSON としてエクスポート
し、 実際のトレーニング実行の出発点として使用します。3. RKBayesOpt パッケージで定義 
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されたデフォルト Search Space (Mip サブセット、RadianceKit デフォルト) を検査 したい 
— これらは左サイドバーの Parameter パネルにリストされます。

どのように解釈  - Convergence チャート (中央列): Y = これまで 最高達成された Objective 
Function 値。X = Trial インデックス。最初は急上昇 (BayesOpt は初期サンプルをランダム
に試し、一部は幸運)、次第に平坦になります。 最適に近い領域が使い果たされたため
です。線が 20+ 試行にわたって平坦なままの場合、 実行を停止できます — さらなる試行は
何ももたらしません。チャート内の個々の点は 個々の Trial 値 (つまり、「これまで最良」で
はない) で、フェーズによって色付け: グレー = 初期サンプル、青 = bayesopt 取得、オレン

ジ = restart。- Trial テーブル (右列): #1、#2、#3、… それぞれ値と Phase タグ。これまで
最良の Trial は黄色の星でマークされます。テーブルから Best Trial を識別し、そのパラメー

タ 値を後でエクスポート時に見られます。- Search Space インスペクター (左サイド
バー): 選択されたプリセットのすべてのパラメータ名とその検索範囲 [lo, hi]  を表示しま
す。「RadianceKit defaults (6-dim)」プリセットの場合、例えば 「densifyGradThreshold 
[5e-7、5e-6]」— つまりこれら 2 つの値の間の log-uniform が表示されます。

ワークフロー例  プリセット「RadianceKit defaults (6-dim)」、Trial Budget 40、Seed 42 を
選択。「Start」をクリック。観察: 最初の 8 試行はグレー (初期サンプル、 LHS Latin-
Hypercube)、続く青 (BayesOpt 取得)。Convergence チャートは試行 ~15 まで 急で、その
後平坦になります。試行 ~30〜40 で Best Value が安定します。「Save Best Config」をク
リック — プリセット名、Trial インデックス、値、デコードされたパラメータ 値を含む 
bayesopt-best.json  が保存されます。この JSON を、手動でプリセット定義に 引き継げ
ます。

W30 ボタン「Start」

場所

Idle/Finished 状態の左ツールバー。

技術詳細

Trial リストをリセットし、Running 状態に切り替
え、新しい Run ID を生成 (複数 Start クリックで
の Stale 検出用) し、新しい Pause ゲートを生成し
ます。 次に、Optimizer を非同期ストリームとして実
行するバックグラウンドタスクが開始されます。 初
期サンプルサイズは min(8, budget /​ 4 + 1) から
導出されます — つまり、Budget ≥ 28 で通常 8 Latin-
Hypercube サンプル、小さい Budget でより少ない。
Trial 更新は 増分的に受信され、リストに追加されま
す。Stale Run 保護: 2 番目の Start クリックが その間
に Run ID を新しく設定する場合、古い実行からの更新
は破棄されます。

目立つボタンの外観用の Primary Action スタイル。

簡単に言うと

現在の検索空間、Budget、Seed で
新しい最適化実行を開始します。
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W31 ボタン「Pause」

場所

Running 状態の左ツールバー。

技術詳細

Pause ゲートをアクティブに設定し、Paused 状態に
切り替えます。実際の効果: ランナーは次の Objective 
関数を評価する前に 50 ms ポーリングループで待機し
ます。 これは、現在実行中の Trial が完了することを
意味します (合成でマイクロ秒のみ続く) が、それ以上
の Trial は開始されません。Resume が実行されるとす
ぐに、停止した場所から 続行されます。

簡単に言うと

実行を停止します。現在の計算は

まだ完了し、その後一時停止しま

す。

W32 ボタン「Stop」

場所

Running と Paused 状態の左ツールバー。

技術詳細

ランナータスクを中止し、参照をクリアし、Pause 
ゲートを解除 (まだ paused だった場合) し、Finished 
状態 (Trial が存在する場合) または Idle 状態 (存在しな
い場合) に切り替えます。すでに計算された Trial は
リストで表示されたまま です — Stop は削除しません。
破壊的なボタンの役割は、ボタンを赤で示します。 実
行を中止するためです。

簡単に言うと

実行を最終的に中止します。Trial 
は表示されたままで、Best Config 
を それでもエクスポートできま
す。

W33 ボタン「Resume」

場所

Paused 状態の左ツールバー。

技術詳細

Pause ゲートを解除し、Running 状態に戻します。ラ
ンナータスクはすでに 実行中 (ポーリングループで待
機中)。ループが Pause が解除されたことに気付くとす
ぐに、 継続して次の Trial を開始します。

簡単に言うと

一時停止した実行を続行します。
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W34 ボタン「Save Best Config」

場所

右ツールバー、常に表示 (ただし bestTrial が存在しな
い場合は無効)。

技術詳細

JSON に制限された、デフォルトファイル名 
bayesopt-best.json  を持つ 保存ダイアログを開き
ます。確認後、Payload Dictionary が構築されます: プ
リセット名、 Trial インデックス、値 (Objective スコ
ア)、Parameter (デコードされたパラメータ名 → 値の 
Dictionary)。デコーディングは、正規化された検索空
間座標を [0,1]^d で元の 値範囲に戻し投影します (そ
れに応じて log-uniform/linear/integer スケール付き)。 
JSON 出力は pretty-print されており、キーがソート
されています。書き込みエラー時 (現在のデモバージョ
ン) は静かに無視されます — これがデモパスであるた
め、エラー UI はありません。

Trial が実行されていない限り、ボタンはグレーのまま
です。

簡単に言うと

これまで最良の Trial のパラメー
タ値を JSON として保存します。
次に これらの値をプリセット構成
に手動で引き継げます。

W35 ピッカー「Search Space」プリセット

場所

左サイドバー、上部。

技術詳細

4 つのプリセットオプションを持つメニューピッカー: 
- 「RadianceKit defaults (6-dim)」— すべての Q7 ハ
イパーパラメータを持つ完全な標準検索空間。- 「Mip 
subset (2-dim)」— mipSmoothing3DScale [0.05、
0.5] log-uniform と mipFilter2DVariance [0.1、0.6] 
linear のみ。シーンクラス用に Mip-Splatting を 
チューニングしたい場合に便利。- 「densify-until 
+ ssim-weight + grad-thresh」— 3 つの Densify 関
連パラメータ (densifyGradThreshold log-uniform、
ssimWeight  linear、 densifyUntilIter  integer)。- 
「Bowl demo (1-dim)」— 「BayesOpt は こう動作す
る」デモ用の教育的シングルパラメータ検索空間。

実行がアクティブな間、検索空間は切り替えられませ

ん (Optimizer を混乱させます)。

簡単に言うと

BayesOpt がどのハイパーパラ
メータ検索空間を検索するか。

標準は 「RadianceKit defaults」。
Mip 特定のチューニング試行には
「Mip subset」。 BayesOpt の動作
を理解するには「Bowl demo」。
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W36 スライダー「Trial Budget」

場所

左サイドバー、Search Space ピッカーの下。

技術詳細

10 から 200 までのスライダー、ステップ幅 5。デフォ
ルト 40。それが 意味するもの: BayesOpt は最大 N 
Trial を行うことができます。そのうちの最初のいく
つかは 初期サンプル (Latin-Hypercube) で、残りは実
際の BayesOpt Trial です。実践用の 経験則: d 次元を
持つ検索空間は、良い最適化のために約 10d から 20d 
Trial を 必要とします。6-dim Defaults では 60〜120、
2-dim Mip サブセットでは 20〜40、 1-dim Bowl デモ
では 10〜20。

実行中、スライダーは無効化されています。

簡単に言うと

最大いくつの最適化試行。試行が

多いほど = より良いソリューショ
ンだが 時間がかかる。40 はデモ
オブジェクティブ用の良いデフォ

ルト。

W37 スライダー「Random Seed」

場所

左サイドバー、Budget スライダーの下。

技術詳細

1 から 100 までのスライダー、ステップ幅 1。デフォル
ト 42。Seed は、 初期 Latin-Hypercube サンプルと
デモオブジェクティブの Noise コンポーネントの両
方に 渡されます。再現性: 同じ Seed + 同じ検索空間 + 
同じ Budget は、まったく同じ Trial シーケンスを提供
します。「同僚全員がデモを再構築すると同じ実行を取

得する?」に 役立ちます。実行中は無効化。

簡単に言うと

乱数生成器を制御します。同じ 
Seed = 同じ実行 — 再現用。
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W38 チャート (Convergence)

場所

ウィンドウの中央列。

技術詳細

2 つのレイヤーを持つ Swift Charts ダイアグラム: 1. 
Trial ごとの 「best-value-so-far」用の線 — アクセン
ト色の単調増加または一定の曲線。2. Trial ごとに 個
別の Objective 値を持つポイント、フェーズによっ
て色付け。Symbol サイズ 40。 3 つのフェーズラベル: 
「init」(グレー)、「bo」(青)、「restart」(オレンジ)。

小さな凡例が左上に Phase の色を表示します。Trial リ
ストが空の場合 (最初の Start 前)、チャートアイコン
とヒント「Press Start to begin a BayesOpt run.」を
持つ空状態 表示が代わりに表示されます。

簡単に言うと

進捗チャート。実線は「これまで

見つかった最良のソリューショ

ン」、 ポイントは個々の試行。
線が長い間平坦なままの場合、

BayesOpt は最適を見つけました。

W39 テーブル (Trial Log)

場所

ウィンドウの右列。

技術詳細

Lazy にスタックされた Trial 行を持つスクロール領域。
行ごとに水平スタック: Trial 番号 (3 桁 monospace、
左)、値 (monospace、右揃え、70 pt 幅)、Phase タ
グ (Capsule、Phase 色で 25% 透明度で塗りつぶし)、
この Trial が現在最良の場合は オプションで黄色の星。
Auto-Scroll メカニズムは、新しい Trial が追加される
とすぐに、 自動的に最後にジャンプします — 自分で
スクロールすることなく、ライブ進行を画面 下部で読
み取れます。

簡単に言うと

すべての試行のテーブル。値、

フェーズ、最良の星。新しい Trial 
は下に 表示され、自動的にスク
ロールします。

メインウィンドウ: Loss 進行と Gaussian Count (I39〜I41、クロスリ

ファレンス)

メインウィンドウの 3 つの Inspector 表示には独自の説明が必要です。実行中の トレーニン
グ中に常に表示され、進行が健全に見えるかの重要な経験則があるためです。 表示は 
Inspector の「Loss Chart」セクション (第 2 章 — Inspector 参照) にあり、 上の補助ウィ
ンドウからの Holdout 分析を補完します。
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Loss 曲線はいつ健全か? 健全な Loss 曲線は 3 つのフェーズを示します: (1) Warmup — 最
初の 200〜500 反復で、Loss は高 (シーンに応じて L1+SSIM 結合で通常 0.15〜0.25) から
約半分に急落します。Loss がこのフェーズで 落ちない場合、通常入力が間違っています 
(画像が破損、SfM ポーズが悪い、初期 Gaussian の数が少なすぎる)。(2) Densification — 
~500 から densifyUntilIteration (古典的に 15K、MCMC で 20K または 25K まで) の間で 
Loss は さらに落ちます。Densify 操作が新しい Gaussian を挿入し、Optimizer がそれを利
用すると、 しばしば小さな下方ジャンプが発生します。Gaussian カウントはこのフェーズ
で上昇します。 (3) Refinement — その後、Loss はより平坦な Tail に入ります。典型的な 
終値: P4 Quality の Tanks-&-Temples Truck は L1 ≈ 0.023、Full Classic V546 の Horse は 
L1 ≈ 0.0230、Outdoor Mip-NeRF360 シーンはしばしばより悪い (0.04〜0.07)。

プラトーは何を意味するか? プラトー (Loss 曲線が数千の反復にわたって 水平に走る) は 
2 つの解釈を持ちます: (a) モデルが収束しました、それ以上のトレーニングは 何ももたらし
ません — それが良いケースです。(b) モデルがスタックしています (ローカル最小値、悪い勾
配情報、バッファ制限のキャップ) — 悪いケース。両方とも チャートで同じに見えま
す。区別: Gaussian カウントを見ます。それも平坦で MCMC キャップに 近い場合 (例え
ば .fullMCMC  で 150K のうち 150K)、限界にいます — キャップを 上げるかプラトーを受
け入れます。Gaussian カウントがまだ成長しているが Loss が 落ちない場合、スタックして
います。

中止 vs 続行のタイミングは? 経験則: Min-Loss の改善なしで 10K 反復 → 中止、さらな
る反復は無駄です。その前: 境界改善が見える場合、Cmd+T (Training メニュー → Continue 
Training → +5K 反復) 経由で延長を追加できます。注意: MCMC ではプラトーは しばしば本
物です — キャップは自然な制限です。

Gaussian カウントプラトーは「完了」信号ではありません。 MCMC がキャップに 達した
か、Classic Densification が使い果たされたことを意味するだけです。実際の 「完了」質問
は Holdout 分析でのみ尋ねられます — Holdout ウィンドウ (W23〜W29) や --benchmark  
フラグで評価された独立したテストセットでの PSNR/SSIM/LPIPS。

PSNR/Holdout は真実、Loss はプロキシのみ。 Loss は相対メトリックです: モデルがト
レーニングビューに適応する間に落ちます。しかし、低い Loss は自動的に 良いモデルを意
味しません — モデルがトレーニング画像を暗記した (オーバーフィッティング) 場合、Loss 
は小さいですが、未見ビュー (Holdout) での PSNR は悪いでしょう。 したがって: 最終品質
評価では常に Holdout メトリックを見て、End-Loss だけを 見ません。

経験則ボックス

• User Guide と Keyboard Shortcuts は静的ヘルプ — キーワード質問には速い、 深さには
ここにあるマニュアルを使用してください。

• ディスクが 10% 未満の空き容量に落ちるとすぐに Manage Storage を開きます。 ログと
インポートステージングが通常の罪人です。

• Pareto Dashboard は、少なくとも 3〜4 のトレーニングレポートを取得した後にのみ 意
味があります。X 軸 = コスト (Time / Gs)、Y 軸 = 品質 (PSNR / SSIM)。Pareto Front は
効率的な組み合わせを示します。
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• 他者と PSNR ベンチマークを公開する前に Holdout Analysis を使用してください — テス
トセットが本当に代表的であることを保証します。

• BayesOpt Console は主に Search Space 定義の学習および検査ツールです。実際の ト
レーニング駆動のハイパーパラメータチューニングには、オフライン CLI ワークフローを 
使用してください。

• Loss プラトーと Gaussian カウントプラトーは別々に解釈する必要があります。Cap 制限
は「完了」信号ではありません。実際の品質は Holdout PSNR のみが測定します。

• Min-Loss の改善なしで 10K 反復 → トレーニングを停止します。
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章

第 6章 — トレーニング構成

図 26:  JSON としてエクスポートされ TextEdit で表示された Preview プリセッ
ト — フィールド id/name/category/version/createdAt/description、すべての関連 パラ

メータを持つ trainingConfig (maxIterations 5000、 densifyUntilIteration 3500、ssimWeight 
0.20、renderScale 0.50、 strategy classic、cameraAlignment applePhotogrammetry、 

densifyGradThreshold 2.0e-06、opacityResetInterval 3000、minOpacity 0.005、6 つの Bool 
トグル)

画像で見えるもの  典型的なプリセット JSON エクスポート。トップレベルフィールド: id  
(UUID)、 name 、(classic | mcmc | sceneClass | custom)、(スキーマバージョン)、(タイム
スタンプ)、 (フリーテキスト)。ネストされたオブジェクトには、再現性に重要な パラメー
タが含まれます — インポート時、ブロック全体が TrainingConfig  構造体にデシリアライ
ズされ、アプリバージョンからのデフォルトが JSON に 欠けているフィールド (例えばアプ
リ更新後) を埋めます。プリセットを別の Mac に 渡す場合、単にこの JSON ファイルを送
ります。

TrainingConfig  構造体は RadianceKit の各トレーニング実行の核です。 トレーニング
に影響するすべてのパラメータを集めます — 最大反復数から 8 つの 学習率、MCMC、Mip-
Splatting、Curriculum、scene-aware Cap ロジックの専用 フィールドまで。サイドバー

110 / 227



R A D I A N C E K I T 第 6章 — トレーニング構成

のトレーニング構成セクション (エキスパートビュー) で 編集し、プリセットとして保存する
か、JSON エクスポートとして別の Mac に渡します。 トレーニング時、このオブジェクト
が正確に固定され、GPU バックエンドに渡されます。

この章は、パワーユーザーとスクリプト作成者向けのリファレンス資料です。すべての 81 の
パブリックフィールド、9 つの静的プリセット、1 つのパブリックメソッドを リストします。
ソースファイルは TrainingConfig.swift — 疑問があれば、 そこに保存されている Doc コ
メントと Initializer デフォルトが Source-of-Truth として有効です。

注意  ·  U I  V S .  P R E S E T/ C L I

81 フィールドのうち、Inspector (Sandbox App Store ビルド) に直接スライダー、 ト

グル、ピッカーを持つのは 12 個だけです: T1、T2、T17、T20、T22、T38、 T56〜

T58、T60、T61、T73。残りの 69 フィールドは選択された プリセット (第 7 章) で

設定され、CLI フラグ (第 5 章参照) 経由でのみ直接上書き できます。この分離は意図
的です: デフォルトは安定し、本番テスト済みで、 パワーユーザーには依然として脱
出口があります。フィールドが特に興味深い場合は: まず第 2 章 (Inspector) と第 5 章 
(CLI) で、JSON 操作なしで到達できるかを 確認してください。

目次:

1. 反復 (T1〜T2)
2. Learning Rate (T3〜T10)
3. Densification — Classic (T11〜T16)
4. Loss (T17〜T20)
5. SH 次数進行 (T21)
6. パフォーマンス (T22〜T25)
7. 診断と点群準備 (T26〜T30)
8. 正則化 (T31〜T37)
9. Refinement (T38〜T44)

10. Sky-Dome (T45〜T48)
11. Adam + LR スケジュール (T49〜T55)
12. ポスト処理 + Apple AI (T56〜T60)
13. MCMC Densification (T61〜T73)
14. Mip-Splatting (Q1.5) (T74〜T76)
15. 適応 Densification (Q5) (T77〜T79)
16. Curriculum (Q6) (T80〜T81)
17. 静的プリセット (TP1〜TP9)
18. メソッド:
19. どのフィールドが何のためか? (チートシート)
20. 危険なフィールド
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反復 (T1〜T2)

T1 maxIterations

詳細

デフォルト: 30 000 (Initializer)、35 000 ( .full )、

200 000 ( .fullMCMC ) 範囲: 1 000 – 500 000 (UI ス

ライダー)、ロジック内に ハード上限なし 定義場所:

技術詳細

バックエンドが実行するトレーニング反復の総

数。1 反復は、単一の トレーニングカメラの順
方向レンダリング、すべての Loss コンポーネン
ト (L1 + SSIM + オプションの正則化 + Sky マ
スク) にわたる逆方向パス、Adam Optimizer ス
テップを意味します。この数値は他のスケジュー

ルに直接影響します: Position Learning Rate は 
Cosine Annealing 曲線に従い 0 から T1  自体、
または T49 positionLRScheduleEndIteration まで。
Densification は T2 densifyUntilIteration で 停止。
MCMC Noise Decay は T69 mcmcNoiseDecayEnd で終
了。SH Degree アップグレードは T21  で定義された 
3 つのマークで発生します。クラシック Densification 
では、経験的に決定されたスイートスポットは 20 
000〜35 000 反復 (Sessions 1〜32、V546 テスト)、
MCMC では 60 000〜200 000 (V534)。プリセット
に 保存された値を大幅に超える増加は、めったに追加
の品質をもたらしません — Adam Momentum が飽和
し、LR Decay の終了がないと Loss が停滞します。逆
に、 ~5 000 を下回ると、不完全に収束したジオメト
リになります (Density Control が クローン/分割の時
間が足りない)。

簡単に言うと

アプリの計算時間。反復が多い

ほど = より良い結果ですが、あ
る時点から それ以上の改善は感
じられず、はるかに長くなりま

す。プリセットは考えずに良い

値を 持つように選択されてい
ます: Quick 1 000、Preview 5 000、
Balanced 20 000、 Quality 35 000、
MCMC Quality 200 000。自分で
調整する場合: MCMC では高くし
ても 構いません (100 000〜200 
000)、Classic では 40 000 を超え
ないでください — それ以上は何
ももたらしません。
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T2 densifyUntilIteration

詳細

デフォルト: 15 000 (Initializer)、5 000 ( .full )、

160 000 ( .fullMCMC ) 範囲: 0 – 定義場所:

技術詳細

Densification が終了する反復。ここまで Gaussian は 
T11〜T16  (Classic) または T67〜T70  (MCMC) でパ
ラメータ化されたルールでクローン、分割、Prune 
され、 その後 Gaussian 数は一定のままで、位置、
回転、スケール、Opacity、SH 係数のみが 最適化
されます (Refinement フェーズ)。3DGS オリジナ
ル論文では値は T1  の 50% ですが、RadianceKit 
.full  プリセットでは ~14% (35 000 のうち 5 

000) — V310/V338 実験の結果、5 000 反復後のさら
なる Densification は結果を悪化させる (より多くの 
Floater、より多くのメモリ要件、品質向上なし) と
示されました。MCMC は 対照的に Relocation を T1  
の 80% (V504b) まで実行します。MCMC が有害な 
Floater を 生成しないためです。 T2  を小さすぎる (< 
1 000) と Gaussian が少なすぎ、 Classic で大きすぎ
る (> T1  の 50%) と Overgrowth と RGB 飽和外れ値
になります (Outdoor 過剰トレーニング所見参照)。

簡単に言うと

アプリがいつまで新しい 
Gaussian を作成できるか。その
後は、すでにある ものを洗練す
るだけです。35 000 反復のクラ
シックトレーニングでは、ここ

で 5 000 が 正しい値です — そ
れ以上はシーンをよりぼかしま

す。MCMC では総反復の 80% (つ
まり 200 000 実行で 160 000)。
Quality プリセットを変更する場
合、このフィールドは そのままに
しておく方が良いです。
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Learning Rate (T3〜T10)

T3 positionLearningRate

詳細

デフォルト: 0.00016 範囲: 1e-7 – 1e-3 (推奨) 定義場

所:

技術詳細

トレーニング開始時 (反復 0) の各 Gaussian の XYZ 位
置用の Adam 学習率。 Cosine Annealing 曲線に従い、
トレーニング中に T4 positionLearningRateFinal に 
低下します。デフォルト 0.00016 は 3DGS オリ
ジナル論文 (Kerbl et al. 2023) からの ものです。
RadianceKit では、画像解像度を増加させても、ピク
セル空間ではなく世界 座標系で Gaussian が移動する
ため、スケーリングしません。著しい増加 (> 0.0005) 
は Gaussian が長距離をジャンプし、Loss が不安
定になります。それを大幅に下回る値 (< 0.00005) 
は、誤って初期化された点群が決して位置を見つけ

ないことを意味します。 V414 は初期値の倍化をテ
スト → 16.8% 悪い L1 Loss。V544a チューニング
は Paper デフォルトを最適として確認しました。注意: 
.fullMCMC  では、この値を意図的に デフォルトのま
まにします — MCMC は Relocation ロジックのために
一定の学習率を 必要とするため、ここでのチューニン
グは何ももたらしません。

簡単に言うと

Splat 点が空間でどれだけ速く移
動できるか。標準値は非常によく

調整されており、 基本的に変更は
不要です。画像内で Splat が「揺
れ動く」、または何も動かないた

め 全体の角が欠けている場合の
み、学習率が調整すべき点になり

ます — しかし、その時には 通常、
他の何か (カメラポーズ、初期点
群) がすでに間違っています。
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T4 positionLearningRateFinal

詳細

デフォルト: 0.0000016 (Initializer + Paper)、

0.000016 ( .full 、 .fullMCMC  — 10× 高い) 範囲: 

0 – 定義場所:

技術詳細

Position LR Cosine Annealing 曲線の終値。
T1 maxIterations  で、または 設定されている場合
は T49 positionLRScheduleEndIteration で達成され
ます。 RadianceKit .full  プリセットは 0.000016 
— Paper デフォルト 0.0000016 の 10× を 使用し
ます。V420 実験は、Final 値の 0.5× (0.000008) が 
Loss を 6.4% 悪化させると 示しました。V414 は、初
期値の 2× が 16.8% 悪化させると示しました。高
い Final 値は トレードオフではなく意図的な選択: 強す
ぎる Decay では、Refinement フェーズ中に 新しく追
加された Densification 候補に Gaussian が適応する能
力を失います。 V431/V433 拡張により、スケジュール
フェーズを短縮 ( T49 < T1 ) し、 T4  がトレーニング 
終了前に達成され、トレーニングの残りが一定の Mini-
LR で実行されます — 典型的な構成: T49 = 20 000 、
T1 = 35 000 、つまり Refinement は 15 000 反復に 
わたって 0.000016 で実行。

簡単に言うと

トレーニング終了時に Position 学
習率がどれだけ遅くなるか。意図

的に オリジナル論文より積極的で
ない設定にしました — Splat は最
後まで少し揺れることが でき、そ
れがより鮮明にします。これを調

整する場合: 高い = 終了時の Splat 
がより 不安定、低い = 新しい 
Splat が現れたときに Splat が適
応できない。
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T5 shDCLearningRate

詳細

デフォルト: 0.0025 (Initializer + Paper)、0.005 

( .full  と すべての MCMC プリセット — 2×) 範囲: 

0.0001 – 0.05 定義場所:

技術詳細

球面調和色の DC 部分 (degree 0、つまり一定アルベ
ド) 用の Adam 学習率。 SH-DC は Gaussian の方向に
依存しない基本トーンに対応します。いわば「基本色」

です。 V176 と V188 実験は Paper デフォルトの 2× 
が最適であると見つけました — より速い 色収束、特
に短いトレーニング (、5 000 反復) では SH-DC が形
にならない からです。幾何学的 LR とは異なり、SH-
DC には Decay がありません。学習率はすべての 反復
で一定のまま (またはオプションの T51  拡張フェーズ 
Decay のみに従う)。 V416 は 0.01 への 4 倍をテスト 
→ beta2=0.99-Adam で 6.4% 悪い Loss。

簡単に言うと

各 Splat の基本色がどれだけ速く
適応するか。値はほとんど自分で

変更 しません — プリセットは正
しい値を持ちます。高くすればよ

り速いですが、不安定な 色になる
可能性があります。

T6 shRestLearningRate

詳細

デフォルト: 0.000125 (Initializer + Paper)、0.00025 

( .full  と MCMC — 2×) 範囲: 0.000001 – 0.005 定

義場所:

技術詳細

高次 SH 係数 (Degree 1、2、3 — つまり、ハイラ
イト、反射、ソフト シェーディングを引き起こす 
view 方向依存色部分) 用の Adam 学習率。Paper 規
約に 従い T5  より 20× 小さい。これらの係数は
数で 2 次的に成長し (Degree 1 で 3、 Degree 2 
で 5、Degree 3 で 7 → 合計 Gaussian あたり 15 
Float)、小さい学習率なしでは 画像を過飽和させます。
T21 shDegreeUpgradeIterations の最初のマークまで 
Degree 0 のみがアクティブ (つまり T5  のみ)、その
後 1、後で 2、最後に 3。ここでの低い値は、 拡散照
明の多いシーンで特に重要です。非常に光沢のある表

面 (車のペイント、水) では、 調整は価値がありません 
— SH 表現自体が制限されています。

簡単に言うと

方向依存の色効果 (反射、光沢) が
どれだけ速く学習するか。標準で

は非常に 小さい。そうでなければ
すべてが光ります。値はそのまま

にしておいた方が良いです — ハ
イライトをより良く取得したい人

は、この LR よりも MCMC と長い
トレーニング時間に よってより良
くサービスされます。
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T7 opacityLearningRate

詳細

デフォルト: 0.05 (Initializer + Paper)、0.1 ( .full 、

MCMC — 2×) 範囲: 0.001 – 1.0 定義場所:

技術詳細

各 Gaussian の logit Opacity 用の Adam 学習率。ア
プリは Opacity を 制約のない Float 値として保存
し、Sigmoid で [0, 1] に変換します。LR は logit 空間
で 動作します。Paper デフォルト 0.05 は V50 テ
スト (Best Single-Run L1 0.1664) 後に 復元されまし
た。V71 は V67 の 0.025 を元に戻しました。V188 の 
0.1 への倍化は Pruning をより効率的にします — 死ん
だ Gaussian は T14 pruneOpacityThreshold の 下に
より速く落ちます。V418 は: 0.05 with beta2=0.99-
Adam は 0.1 より 7.1% 悪い — Adam 構成との相互作
用は自明ではありません。低い値 (< 0.01) は「死ん
だ」Gaussian が 永遠に存在しメモリを消費すること
を意味します。高すぎる値 (> 0.5) は Opacity 爆発
を 引き起こす可能性があるため、logit 値が Optimizer 
で [−15、3] にクランプされます (CLAUDE.md の
「Opacity Explosion Prevention」注参照)。

簡単に言うと

Splat がどれだけ速く透明または
不透明になるか。クリーンアップ

に重要 — 何も寄与しない Splat は
ベールが形成されないようにすぐ

に消える必要があります。 標準
値は適切で、プロのみが変更しま

す。

T8 opacityLearningRateFinal

詳細

デフォルト: 0.0 (= 「Decay なし」) 範囲: 0 または 

0.001 – 定義場所:

技術詳細

Opacity LR 用のオプションの Cosine Decay 終値 
(V427)。0.0 の場合、Decay は 無効化され、Opacity 
LR は全トレーニングにわたって T7  で一定のまま
です。V427 は Decay 0.1 → 0.01 をテスト — 結果 
11.5% 悪い Loss。元に戻され、デフォルトは 「オ
フ」。フィールドの仮説: Refinement フェーズで、一定
の Opacity LR は振動を 引き起こす可能性があり、す
でに正しい透明度に達した Splat がランダムな勾配
変動で 再び移動される。経験的に確認されません — 
Logit クランプロジックがすでに それをキャプチャし
ます。フィールドは将来の実験のために使用可能なま

まで、非常に 長い MCMC 実行 (> 500K 反復) もこれ
から利益を得られる可能性があります。

簡単に言うと

Opacity 学習率を終了に向けて小
さくするかどうか。標準: いいえ。 
試しましたが悪かったので、無効

のままにします。0 のままにして
ください。
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T9 scaleLearningRate

詳細

デフォルト: 0.005 (Initializer + Paper)、0.01 

( .full 、MCMC — 2×) 範囲: 0.0001 – 0.1 定義場所:

技術詳細

対数空間 (RadianceKit は log(scale) を保存し、ス
ケールを正に保ちます) で 各 Gaussian の 3 つの
スケールコンポーネント用の Adam 学習率。Paper 
デフォルト 0.005、RadianceKit では 0.01 に倍化され
ており、最適化された学習率構成での より良いス
ケール収束のため。V423 実験: beta2=0.99-Adam で 
0.005 → 18.7% 悪い Loss と 目に見えて少なすぎ
る Gaussian (スケール更新が遅すぎたため Density 
Control が クローンできなかった)。スケールは各 
Gaussian の範囲を制御します — 学習が速すぎる と
「ニードル」Gaussian (非常に長い細い Splat、T34 

scaleRatioPruneThreshold 参照) に なり、学習が遅
すぎると Splat がコンパクトすぎるままで Density 
Control が頻繁に 分割しなければなりません。

簡単に言うと

Splat の形がどれだけ速く適応す
るか。標準は良好。高くすると、

「ニードル」 Splat — 画像を浮遊
させる極端に長い細いしずく — 
が得られる可能性があります。

T10 rotationLearningRate

詳細

デフォルト: 0.001 (Initializer + Paper)、0.002 

( .full 、MCMC — 2×) 範囲: 0.0001 – 0.05 定義場

所:

技術詳細

各 Gaussian の 4 つのクォータニオンコンポーネント
用の Adam 学習率。 クォータニオンは各 Optimizer ス
テップで Adam 更新後に再正規化されます (L2 ノルム 
= 1) — そうでなければ共分散マトリクスが退化します。
RadianceKit は Quality プリセットで Paper デフォル
トを倍化します。回転はスケール/位置と比較してより
小さな絶対勾配 マグニチュードを持ち (単位球面で各
ステップは短いまま)、2× なしでは回転は 35 000 反
復ウィンドウで著しく収束不足になります。V188 文書
化。NeRF-Blender シーン (Lego、Chair) では、回転
は特に影響します — オブジェクトのエッジは 5 000〜 
10 000 反復後に初めて正しく整列します。

簡単に言うと

Splat がどれだけ速く回転を学習
するか — つまり、オブジェクト
の表面で 正しい方向に来るか。
標準は適切です。言い換えると、

Splat が表面に密着するのではな
く 歪んだブロックのように見える
場合、トレーニング時間が短すぎ

るのであって、この学習率が 低す
ぎるのではありません。
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Densification — Classic (T11〜T16)

T11 densifyGradThreshold

詳細

デフォルト: 0.000002 (Initializer、0.5× 解像度用に
キャリブレート)、 0.0000011 ( .full 、1.0× 用に
キャリブレート)、0.000004 ( .quickTest 、0.25× 
用に キャリブレート)、2e-7 ( .fullClassicPaper ) 

範囲: 1e-8 – 1e-3 (解像度依存) 定義場所:

技術詳細

画面空間投影された勾配 dMean2D  の L2 ノルムの
閾値で、これを超えると Gaussian がクローンまたは
分割の対象としてマークされます。絶対値はトレー

ニング解像度に 直接依存します — dMean2D  は約 1/解
像度² のようにスケーリングします (より多くの ピクセ
ル = より小さいピクセルごとの勾配)。したがって、各 
T22 trainingRenderScale レベルにはキャリブレート
された閾値が必要です: 0.25× → 4e-6、0.5× → 2e-6、 
1.0× → 5e-8 … 1.1e-6 ( .full )。Paper デフォルト 
0.0002 は NDC 正規化されており、 RadianceKit の世
界空間パイプラインで直接比較可能ではありません。

V440 で追加された T52 adaptiveDensifyThreshold 
フラグでランタイムで現在の勾配分布の p98 から値を 
計算できます — しかし V440 はそれを実際のシーンで
テストして 63 K Gaussian を 生成しました (壊滅的な 
Pruning 損失)。フラグはオフのままです。Q5 (T77〜
T79) は rolling median 経由の代替適応ロジックを提

供します。このフィールドは 無害ではありません — 半
分にすると 2〜4× の Gaussian (メモリ圧、OOM リス
ク)、 2 倍にするとシーンが過小 Densify される可能性
があります。

簡単に言うと

Splat が表示不足で複製されるべ
きかを決定する際のアプリの感

度。低い値 = より敏感 = より多
くの Splat。高い = より少ない 
Splat。これは最も危険な値の 1 つ
です: 低すぎると Mac が数百万の 
Splat でメモリがいっぱいになり、
おそらくクラッシュします。 この
フィールドはそのままにしておく

か、10% のステップでのみ変更し
てください。
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T12 densifyFromIteration

詳細

デフォルト: 500 範囲: 100 – 5 000 定義場所:

技術詳細

Densification がアクティブになる最初の反復。それ以
前は、新しい Gaussian が 作成されることなく、初
期 SfM 点群での「裸の」学習のみが行われます。デ
フォルト 500 は 3DGS 論文からのもので、初期化に安
定する時間を与えます — 反復 0 から Densify される
と、 誤って配置された SfM 点が、正しい位置を見つけ
る前に何度もクローンされます。V349 は 1000 をテス
ト → わずかに悪い Loss。デフォルトが最適です。

簡単に言うと

アプリが Splat のクローンを初め
て開始するとき。それ以前は、既

存の点のみを 学習します。500 が
標準値です — アプリが繰り返す
前に最初に方向付けるのに十分な 
時間を与えます。

T13 densifyInterval

詳細

デフォルト: 100 (Initializer、MCMC)、200 ( .full ) 

範囲: 50 – 1 000 定義場所:

技術詳細

2 つの Densification ステップ間にある反復の数。
Paper デフォルト 100 — 100 反復ごとに densify 
候補のリストが評価され、クローン/分割され、同
時に prune 候補のリスト (sigmoid(opacity) < T14 
pruneOpacityThreshold) が削除されます。 V112 テス
トは 200 を .full  に最適と発見 — 再編成パス
が少ないため GPU が 軽減され、クローンアクショ
ン後に各 Gaussian に安定する時間がより長く与え
られます。 V417 は beta2=0.99 で 100 をテスト 
→ 5.8% 悪い (957 K Gaussian、過剰 Densification)。 
MCMC では同じフィールドが Relocation 間隔とし
て解釈されます。MCMC 固有のロジックは T67 
mcmcRelocationInterval を参照してください。

簡単に言うと

アプリがどれくらいの頻度で新

しい Splat を探すか。100 = しば
しば、200 = 中程度。高いほど: 各 
Splat が再度複製される前に、配
置する時間が長くなります。それ

は 良いことです。50 に下げると、
GPU が顕著に良くなることなく永
続的に占有される 可能性がありま
す。
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T14 pruneOpacityThreshold

詳細

デフォルト: 0.005 (Initializer、Paper、MCMC)、

0.001 ( .full ) 範囲: 0.0001 – 0.1 定義場所:

技術詳細

次の Densification ステップで Gaussian が削除され
る Sigmoid Opacity 閾値。T7 opacityLearningRate 
と Optimizer の Logit クランプロジックと連携して 動
作します。V393 は .full  でデフォルトを 0.005 か
ら 0.001 に下げました — 結果: エキゾチックな視
点でのみ役割を果たす Splat はより長く残り、SH ディ
テールに 寄与します。V394 は 0.0001 をテスト → わ
ずかに悪い (Prune が少なすぎ、メモリが 無駄)。重
要: Density Control は他の対策ですでにバッファ容
量がいっぱいでも、 常に Prune する必要があり
ます (CLAUDE.md の「Density Control Must Always 
Prune」 参照) — そうでなければ死んだ Gaussian が
蓄積し、カウントが凍結します。

簡単に言うと

Splat が削除されるのに十分「透
明」と見なされるとき。0.005 が 
Paper 標準で、Quality では 0.001 
— つまり、Splat により長いチャ
ンスを与えます。これにより ソ
フトライトと弱いシャドウがより

良く表現可能になります。より高

く (0.01 以上) 設定 すると、Splat 
数が急速に減少 — メモリ不足の
場合に意味があるかもしれません

が、 ディテールが犠牲になりま
す。

T15 opacityResetInterval

詳細

デフォルト: 3 000 (Initializer + Paper)、100 000 
( .full  = 事実上無効化)、200 000 ( .fullMCMC  = 

無効化) 範囲: 1 000 – 100 000+ 定義場所:

技術詳細

反復ごとに、すべての Gaussian の Opacity が低い
値 (~0.01) にリセット されます — 「凍結」Splat 
を再評価するための 3DGS 論文の措置。V194 は 
RadianceKit の Warmup + Stochastic Training Setup 
+ 2× 学習率では、Opacity Reset が 5.5% の品質を コ
ストし、Logit クランプが Reset 機能をすでにカバー
していることを示しました。 したがって .full  で
は事実上無効化 (100 000 > 35 000 = 決してトリ
ガーされない)。 V421 は beta2=0.99 で 3 000 ごと
の Reset をテスト → 4.9% 悪い。元に戻されました。 
.fullClassicPaper  (Q1.5-A、Paper 忠実テスト) で
は、意図的に再び 3 000 に 設定されています — これ
は Paper マグニチュード Gaussian バジェットに到達
する ためのレバーの 1 つでした。

簡単に言うと

反復ごとに、アプリがすべての 
Splat の可視性を「ほぼ見えない」
にリセット — Opacity のリセット
ボタンの一種。私たちでは無効化 
(値が非常に高いため発生しない)。 
他のメカニズムがこれを不必要に

するためです。Paper 忠実な実験
でのみ有効にして ください。
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T16 maxScreenSize

詳細

デフォルト: 0.0 (= 無効化) 範囲: 0 (オフ) または > 0 

定義場所:

技術詳細

Gaussian が強制的に分割される前に達成できる最大画
面空間サイズ (投影ピクセル単位)。値は 0 に設定 
(V48 はテストして元に戻しました) — RadianceKit の 
Density Control は代わりに dMean2D  ロジックから
世界空間スケール 閾値を使用します。Mip-Splatting 
(T74〜T76) やシーン固有の Splatting 戦略を持つ 将
来の実験がこれから利益を得る可能性があるため、

フィールドカタログに残ります。 有効化 (値 > 0、例え
ば 20) は、画面上で非常に大きくなった Splat を強制
的に分割します — 単一の巨大な Splat がディテールを
提供しない大きな滑らかな壁面に関連します。

簡単に言うと

単一の Splat が画面でどれだけ大
きくなれるかの制限。私たちでは

オフ。 有効にすると、巨大なフ
ラットな Splat (例えば壁) を強制
的に複数の小さなものに 分解しま
す。実験する場合を除いてオフの

ままにしてください。

122 / 227



R A D I A N C E K I T 第 6章 — トレーニング構成

Loss (T17〜T20)

T17 ssimWeight

詳細

デフォルト: 0.2 (Initializer + Paper + .full )、0.05 

(すべての MCMC プリセット) 範囲: 0.0 – 1.0 定義

場所:

技術詳細

loss = (1 - λ) * L1 + λ * D-SSIM の結合 Loss 
関数の D-SSIM 部分の重み、 ここで λ = T17 。3DGS 
Paper デフォルト 0.2 は Classic Densification に最
適 — V383 は 0.3 をテスト → 28.9% 悪い、V373b 
は 0.2 を sweet spot として確認しました。 MCMC 
については V521b/V534 で独立して: 0.05 が最適
と判明、MCMC は確率的探索を通じて より強力
な L1 信号部分を必要とするため — 高い SSIM 重
みは Relocation 決定を 希釈します。SSIM は L1 より
計算がはるかに高価です (画像全体のローカル 11×11 
ウィンドウ)。RadianceKit は MPS 加速実装を使用し、
1080p 画像あたり 1 ms 未満です。 Q7 BayesOpt ス
イープは、0.05 ( .outdoorPreset : 0.082) から 0.171 
( .indoorPreset ) の 間でシーン固有の最適化を見つ
けました。

簡単に言うと

アプリが「各ピクセルが正しい」

に加えて「構造が似ている」をど

れだけ重要 視するか。0.2 が標準
で、良い画像を提供します。低い 
= ピクセル正確だが、より柔らか
い 遷移になる可能性があります。
高い = より構造的に類似していま
すが、ディテールが 柔らかくなり
ます。プリセットに決定させてく

ださい。
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T18 ssimWeightRefinement

詳細

デフォルト: 0.0 (= 「切り替えなし、ssimWeight を保

持」) 範囲: 0 または 0 – 1.0 定義場所:

技術詳細

T2 densifyUntilIteration 後の Refinement フェー
ズ用のオプション SSIM 値。V428 はテスト 0.2 → 
Refinement で 0.3 → 16% 悪い Loss (L1 と SSIM の両
方が 悪化)。元に戻されたためデフォルト 0.0。フィー
ルドの仮説は、Densification 後 — 新しい Gaussian 
がもう作成されない場合 — より強い SSIM 部分が構造
的シャープネスを 最大化するでしょう。経験的に間違
い: SSIM 重みを増やすことは間接的に L1 重みを 下げ
ることを意味し、L1 は最終 Refinement フェーズで著
しくより意味のある信号です。 フィールドは知覚 Loss 
(T60) やエッジ Loss (T19) を使用した将来の実験で利
用可能なまま で、そこで Refinement 固有の Loss 構
成が意味を持つ可能性があります。

簡単に言うと

トレーニングの第 2 フェーズ 
(Splat 複製後の Refinement) の特
別な設定。 0.0: 前と同じ SSIM 重
み付け。経験的に調整は何ももた

らしません、したがってオフ。

T19 edgeLossWeight

詳細

デフォルト: 0.0 (= 無効化) 範囲: 0 または 0.001 – 1.0 

定義場所:

技術詳細

V437 実験的 Loss: 画像エッジを直接比較する Sobel 
勾配ドメイン L1 Loss の 重み (Ground-Truth Sobel 
vs Render Sobel) を L1+SSIM に加えて。仮説: エッ
ジ情報は 画像品質の知覚的礎石で、明示的な項は 
Gaussian にエッジをより良くヒットさせるよう 奨励
するべきです。テスト結果: 重み 0.1 → 11% 悪い Loss、
0.01 → 品質ニュートラルだが 10% 遅い。Sobel パス
は Ground Truth と Render での追加 MPS 順方向をコ
ストします。 したがって永続的に無効化。将来のユー
スケース: 硬い人工エッジを持つシーン (建築、 家具、
レンダリング) が利益を得る可能性 — Q7 Scene-Class 
プリセットはそれを ピックアップしませんでしたが、
代わりに SSIM 重みをスケーリングしました。

簡単に言うと

エッジを特に重要視する実験的追

加。経験的に何ももたらしませ

ん。オフの ままです。
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T20 skyMaskingEnabled

詳細

デフォルト: false (Initializer とすべてのプリセット) 範

囲: boolean 定義場所:

技術詳細

Sky マスキングをオンにしま
す。各画像で Apple Vision Framework 
(VNGenerateForegroundInstanceMaskRequest) 経由で 
Sky 領域がマスクアウトされ、 この領域の Loss が
ゼロに設定されます。意味: 屋外シーンは、青/灰色/白
の Sky ピクセルがアプリにそこに Gaussian を配置さ
せることでしばしば苦しみます — 「Floater」として認
識されます。Sky マスクなしでは、この領域の Loss は
ゼロに なりません。空が画像内でわずかに変化し、ア
プリは Splat でそれを再構築しようと 永遠に試み
るためです。Vision マスクはトレーニング前にカメ
ラごとに 1 回計算され、 RAM に保持されます。通
常は T45 skyDomeEnabled  と一緒に有効化されます 
(Settings View の UI ロジック)。屋内シーンや合成レ
ンダリングでは無効のままにします — マスクは天井や
壁を誤って「Sky」として認識します。

簡単に言うと

屋外撮影用の特別モードをオンに

します: トレーニング中に空が無
視され、 Splat で再構築されませ
ん。すべての屋外シーンに推奨。

屋内や Blender からの 3D レンダ
リングではオフのままにします。
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SH 次数進行 (T21)

T21 shDegreeUpgradeIterations

詳細

デフォルト: [1_​000, 2_​000, 3_​000] (Initializer)、 
[2_​000, 5_​000, 8_​000] ( .full 、MCMC)、
[1_000, 2_000]  ( .preview  — Degree 3 スキップ) 

範囲: [Int] 、各値が [0, maxIterations]  に、単

調増加 定義場所:

技術詳細

アクティブな SH Degree が 0→1、1→2、2→3 に上昇
する反復。最初のマークの前は DC コンポーネン
トのみアクティブ (つまり T5 shDCLearningRate)、最
初のマーク後は DC + 3 つの Degree-1 係数、2 番
目のマーク後は + 5 つの Degree-2 係数、3 番目
の マーク後はすべての 15 係数。Gaussian あたりのメ
モリ需要は段階的に成長 — 4 Float → 16 Float → 36 
Float → 64 Float。Quality プリセットは、ジオメトリ
が最初に安定して から、より高い周波数で色の詳細
が来るように、Initializer デフォルトに対してアップ ス
テップを遅延させます (V228)。V384 は .full  で 
[1K, 2K, 3K]  をテスト → 9.3% 悪い — 遅延を確認。
.preview  は Degree 2 でキャップします、Degree 3 
が 5 000 反復で収束せず Optimizer 容量を消費するた
めです。Q6 (T80〜T81) は、このリストを 動的に上書
きする代替 Curriculum ロジックを提供します。

簡単に言うと

トレーニングのどの時点でアプリ

が、色が異なる視点から異なって

見えること (ハイライト、反射) を
学ぶか。後半に — まず形が正し
く、次に色。プリセットの値は う
まく機能するように設定されてい

ます。正確に理由を知らない限

り、変更しないでください。
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パフォーマンス (T22〜T25)

T22 trainingRenderScale

詳細

デフォルト: 1.0 (Initializer、 .full 、

MCMC、Scene-Class)、0.5 ( .preview )、0.25 

( .quickTest ) 範囲: 0.05 – 2.0 (典型 0.25、0.5、1.0) 

定義場所:

技術詳細

トレーニング画像のオリジナル解像度に対するトレー

ニング時のレンダリング 解像度。0.5 では各画像が 
50% 幅 × 50% 高さ (つまりピクセルの 25%) に縮小
され、 Gaussian レンダリングはこの小さい解像度で
行われます。メモリと計算量の両方を 2 次 減少させま
す。重要: T11 densifyGradThreshold は選択された解
像度に一致する必要が あります — 勾配マグニチュード
は 1/解像度² でスケーリングするため、 .quickTest  
(0.25×) は .full  (1.0×、1.1e-6) よりはるかに高い閾
値 (4e-6) を持ちます。 RadianceKit は非常に大きな
画像で警告し、自動的に調整します — 3 MP ターゲッ
ト 解像度。極端な 4K 入力画像では、0.5 または 0.25 
でも意味があります。そうでなければ どの Mac も 
CPU Compaction でのみ実行されます。

簡単に言うと

トレーニング時の画像の大きさ。

1.0 = オリジナル、0.5 = 半分の大
きさ。 半分のサイズ = 4 倍速いで
すが、最細部のディテールが欠落

します。プリセットは正しい 値
を選択します。非常に大きな入力

画像 (12 メガピクセル以上) では、
アプリが自動的に ダウンスケール
します。
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T23 resolutionWarmupScale

詳細

デフォルト: 0.0 (= 無効化) 範囲: 0 または 0.1 – 定義

場所:

技術詳細

V133 最適化: Densification フェーズ (Iter 0 から T2  
まで) を Refinement フェーズより低い解像度でトレー
ニング。V308 は .full  で再びオフにしました — 
T22 = 1.0  と Cosine Annealing で時間勝利が最小で
あり、品質がわずかに苦しんだ ため。4K 入力と長
いトレーニング実行で再び意味を持つ可能性があるた

め、フィールド カタログに残ります — Q6 Curriculum 
(T80) は同様のロジックを採用しましたが、 そこで
は LR スケジュールに結合されています。アクティブで 
T80 curriculumResolutionRamp も true の場合、Q6 
が勝ち、この値を上書きします。

簡単に言うと

特別機能: 最初のトレーニング半
分でより小さい画像で、2 番目で
大きい画像で 学習。時間を節約。
オフ、新しい Q6 バリアントがこ
れをより良く解決するためです。

T24 tileSize

詳細

デフォルト: 16 範囲: 8、16、32 定義場所:

技術詳細

ピクセル単位のラスタライゼーションタイルのサイズ。

Gaussian Splatting レンダリングはタイルベース: 画像
は 16×16 ピクセルのタイルに分割され、各タイルは 関
連する Gaussian を収集し、深度でソートし、ブレ
ンドします。16 は実質的にすべての 3DGS 実装で使用
される標準で、RadianceKit Metal カーネルにハード
コードされています。 この値の変更はシェーダーの再
コンパイルを必要とし、現在の状態では有効ではあり

ません。 将来のエンジンバージョンがタイルサイズを
動的にサポートする場合のフィールドとして 残ります。

簡単に言うと

内部レンダリングパラメータ。標

準 16、変更しないでください。
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T25 throttleDelayMs

詳細

デフォルト: 0 (Initializer、 .full 、MCMC、Scene-

Class)、0 ( .preview ) 範囲: 0 – 100 定義場所:

技術詳細

ミリ秒単位のトレーニング反復間の人工遅延。0 = 
フル速度 (標準)。高い値は GPU/CPU が定期的に休
息を得ることでトレーニング中の Mac を「より使いや
すく」します — 他のアプリの使用感が上がります
が、トレーニング時間は遅延と線形に。典型値: 1〜
2 ms (「軽い」スロットリング、+5% トレーニン
グ時間、Mac がより反応的に感じる)、 5 ms (「中
程度」、+15% トレーニング時間)、10+ ms (「Eco」、
潜在的に倍のトレーニング 時間)。Inspector の
「Performance」で提供されますが、標準ビューにはあ
りません — Expert View から削除することを提案する 
dev_ux-backlog.md  バックログ参照。誤解 すると、
トレーニング時間が劇的に延長されるためです。

簡単に言うと

トレーニングステップ間のアプリ

の一時停止のミリ秒数。0 = 一時
停止なし、 できるだけ速く。高
い値は、トレーニング中の Mac を
より使いやすくしますが、トレー

ニング 時間もより長くなります。
M3 Ultra または Mac Studio では 
0 のままにできます。 MacBook 
Air では 2 または 5 が良い値で
しょう。
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診断と点群準備 (T26〜T30)

T26 depthDistortionWeight

詳細

デフォルト: 0.0 (= 無効化) 範囲: 0 または 0.0001 – 

0.05 定義場所:

技術詳細

V366 実験: 深度歪み正則化 Loss の重み。レンダリン
グ光線に沿って深く ステージされていますが概念的に
同じ表面に属する Gaussian にペナルティを与えます 
— 集中した深度分布を奨励し、Floater を減らします。
テスト: 0.01 → 4.5% 悪い、 0.001 → 8.1% 悪い。理
論的な利点 — マルチビュー一貫性の改善 — は L1 Loss 
に 反映されません。仮説は暗黙的に SfM ジオメトリ
が正しく、Gaussian は「スタック」 するだけでよい
と仮定するためです。実際には、SfM 点群は通常最も
弱いコンポーネントで、 スタッキングではありませ
ん。特にクリーンなポーズを持つマルチビューデータ

セット (合成、Mip-NeRF 360 with Ground Truth) の
ために使用可能なままです。

簡単に言うと

同じ場所で連続した複数の Splat 
を避けるための実験機能。テスト

が何も もたらさなかったため、有
効化されません。

T27 singleViewOverfit

詳細

デフォルト: false 範囲: boolean 定義場所:

技術詳細

診断フラグ: true の場合、Camera プールからランダム
に選択する代わりに、 各トレーニング反復で Camera 
Index 0 が強制的に使用されます。意味: モデルが単
一の ビューさえオーバーフィットできない場合 (つま
り、View 0 の Loss が 10 000 反復後も ゼロに近づか
ない)、順方向/逆方向パスに根本的なバグがあります。
このスイッチは Metal シェーダーと微分可能ラスタラ
イザーカーネルの開発中に集中的に使用されました — 
V42〜V47 フェーズ。今日では、誰かがバックエンド
コードを変更してリグレッションテストを 実行したい
場合のサニティチェックとしてのみ利用可能。CLI 経
由で --single-view 。

簡単に言うと

開発者向けのテストモード。アプ

リが 1 つの画像から学習できるか
どうかを 確認するために使用で
きます。通常のユーザーには無関

係、常にオフのままにしてくださ

い。
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T28 maxCameras

詳細

デフォルト: 0 (= 「すべてのカメラを使用」) 範囲: 0 

または 1 – N 定義場所:

技術詳細

V43 からの診断制限: 最初の N カメラのみでトレーニ
ングし、それ以上は 無視します。元の意味: 多すぎる
カメラが勾配競合を生成する (同じ Gaussian に対する 
矛盾する Loss 信号が多すぎる) という仮説をテスト。
テスト結果: 人工的な制限による 体系的な利点なし — 
より多くのフレームは事実上常により多くの品質をも

たらします。 ターゲットを絞った実験のために CLI フ
ラグ ( --max-cameras N ) として残ります。 例えば「1 
500 画像ドローン飛行の最初の 100 画像でトレーニン
グは機能するか?」UI に 公開されていません。

簡単に言うと

開発者用診断フィールド — 最
初の N 画像のみを使用し、残
りを無視。通常の ユーザー
には不要、値 0 = すべての画
像。より多くの画像 = より良い
結果 (feedback_​more-frames-
better.md 参照)。

T29 maxInitialPoints

詳細

デフォルト: 0 (= 「すべての SfM 点を使用」) 範囲: 0 

または 1 000 – 200 000+ 定義場所:

技術詳細

V54 セーフガード: トレーニングを開始する初期 SfM 
点の数を制限します。 密な COLMAP 再構築は > 
60 000 点を生成でき、大きな初期スケールではピクセ
ル オーバーラップあたり 200〜300 Gaussian になり
ます — これは「霧の場」を作り、 トレーニングが
収束しません。~16 000 点へのサブサンプリング (ト
レーニングエンジンの Hard-cap ロジック) は、初期密
度をリファレンス 3DGS が使用するレベルに引き上
げ、 オーバーラップを劇的に減らします。非常に
密な SfM では自動的に設定されます。 CLI 経由で 
--max-points N 。

簡単に言うと

カメラ再構築から使用される開

始点の数。非常に密な再構築 (60 
000 を超える) では、アプリは自
動的に 16 000 に制限します — そ
うでなければ最初に霧が多すぎ ま
す。これを設定する必要はありま

せん。アプリが処理します。
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T30 cameraClusterOutlierMultiplier

詳細

デフォルト: 10.0 (すべてのプリセット — 決して上書き

されない) 範囲: 1.0 – 100.0 定義場所:

技術詳細

Phase 3.10 A.1 で導入された Camera Cluster Outlier 
Filter の Multiplier。 トレーニング前に、トレーニング
エンジンはすべてのカメラ位置の重心とカメラから 重
心までの最大距離を計算します。重心からの距離が 
multiplier × maxCameraDistance を 超える SfM 点
は Outlier として破棄されます。デフォルト 10× は 
Phase 3.10 前の動作を 維持します。微妙なバグ: タ
イトな SfM (カメラがより近い) → 小さい → 小さい閾
値 → より多くの点が Outlier として破棄される。緩
い SfM → より大きい閾値 → より少ない 点が破棄され
る。これは Phase 3.9 Funnel-vs-Training 反相関の原
因の 1 つです: より 良い SfM はより多くの初期点が殺
されるため、ダウンストリームでより悪いトレーニン

グに つながる可能性があります。フィールドは A.3 
スイープ用の CLI オーバーライド (--camera-cluster-
outlier-multiplier) として配置されています。UI に
公開 されていません。5 未満の値は通常制限的すぎ、
20 を超える値は効果がありません。

簡単に言うと

カメラ雲から遠く離れた点を破棄

する特別なフィルター。10 = アプ
リは 寛大で、ほぼすべてを保持し
ます。遠方の点 (遠くの山) が浮遊
する小さな塊のように 画像で見
える場合、増加することは意味が

あります。緊急時のみ低く設定 — 
遠くの ディテールを失います。
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正則化 (T31〜T37)

T31 coarseToFineBlurRadius

詳細

デフォルト: 0 (= 無効化) 範囲: 0 または 1 – 10 定義場

所:

技術詳細

V369 実験: Densification フェーズの開始時に Ground 
Truth 画像に適用され、 Densification ( T2 ) の終わ
りまで線形に 0 に減少する Box Blur 半径。仮説: 
Coarse-to-Fine トレーニング — 最初に粗い構造を学
び、次にディテール — はより安定したジオメトリを
提供するべきです。テスト: r=3 → 9.6% 悪い、r=1 → 
5.1% 悪い。 失敗の理由: Densification は画像ドメイ
ン勾配に基づいて決定し、Blur は「ここで クローンす
る必要がある」に重要な信号を正確に減らします。他

の Density Control スキームを使用した将来のテスト
用にフィールドカタログに残ります。

簡単に言うと

実験的「最初に粗く、次にディ

テール」モード。何ももたらしま

せんでした、 オフのままです。

T32 scaleRegWeight

詳細

デフォルト: 0.0 (= 無効化) 範囲: 0 または 0.0001 – 

0.05 定義場所:

技術詳細

V370 実験: 世界空間スケールでの L1 正則化。大き
くなりすぎる Gaussian に ペナルティを与え — 1 つ
の Gaussian で壁全体をカバーする「メガ Splat」を
防ぎます。 テスト: 0.01 → 200% 悪い Loss (2 M 
Gaussian、全爆発)、0.001 → 214% 悪い。理由: ス
ケール正則化は Density Control と競合します — より
小さいスケールは、より多くの Gaussian が必要に
なることを意味し、Density Control はより頻繁に分割
し、それが さらに多くの勾配作業を意味します。無効
化、ただし Mip-Splatting 実験 (T74) のために 文書化
されています: この文脈では、スケール下限が意味を持
つ可能性があります。

簡単に言うと

Splat を小さく保つことを強制す
る正則化。テストで Splat 爆発 
(数百万の Splat) を引き起こしま
した。有効にしないでください。
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T33 anisotropyRegWeight

詳細

デフォルト: 0.0 (= 無効化) 範囲: 0 または 0.0001 – 

0.05 定義場所:

技術詳細

V445 実験: max(scale)/min(scale) 比率へのペナル
ティ、Floater として認識 される極端に細長い「ニード
ル」Gaussian を防ぐべきです。テスト: 0.01 → 69% 
悪い、 0.001 → 15% 悪い。理由: 正則化は Splat 
を「丸い」形に強制しますが、平らな表面 (壁、テーブ
ル、床) ではまさに間違っています — そこではフラッ
トで広い Gaussian が 球形よりも効率的です。無効化。
V549f は T34 scaleRatioPruneThreshold で代替の 
ターゲットを絞ったアプローチを提供しましたが、そ

れも元に戻されました。

簡単に言うと

長すぎる細い Splat にペナルティ
を与える正則化。意味があるよう

に聞こえますが、 テストでは悪
かったです。オフ。

T34 scaleRatioPruneThreshold

詳細

デフォルト: 0.0 (= 無効化) 範囲: 0 または 5.0 – 100.0 

(典型 10.0 – 30.0) 定義場所:

技術詳細

実験的ポストトレーニング Pruning、max(scale)/
min(scale) 比率がここで設定 された線形閾値を超える
各 Gaussian を削除します。正則化だけでは排除でき
ない極端に 細長い「ニードル/ディスク」Floater を
ターゲットにします。テストでは Pruning は期待 通り 
Floater を削除しましたが、同時に壁や床の意味のある
フラット Splat も削除 しました — 画像はより穴が
あきました。したがってデフォルトでオフ、CLI フラグ 
(--scale-ratio-prune N) は対象を絞った実験のため
に利用可能です。それでもテスト したい場合の推奨値: 
30 (非常に保守的、極端な外れ値のみを削除)、10 (積
極的、 ディテールをコスト)。

簡単に言うと

トレーニング後に非常に細長い 
Splat をフィルタリングする試み。
テストで ネットネガティブでした 
— Floater は除去されましたが、
ディテールも除去されました。 オ
フ。
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T35 opacityRegWeight

詳細

デフォルト: 0.0 (= 無効化) 範囲: 0 または 0.0001 – 

0.05 定義場所:

技術詳細

V446 実験: Opacity を 0 または 1 に引き寄せる 
Binary-Cross-Entropy ペナルティ (つまり「半透明」
から離れる)。仮説: より鋭い Opacity 分布は画像の
明瞭さを 改善するべきです。T33 と組み合わせた
テスト → 正則化が品質をコスト、両方無効化。 無
効化。注意: 1.4.3 ベータで、このフィールドが Default 
値の変更 (Initializer = 0.01) で正確にあるバグが現れ、
Gaussian カウントの Mass-Extinction (1 反復で 460 
K → 5) になりました。1.4.4 以降、デフォルトとして 
0.0 に固定。

簡単に言うと

Splat を完全に透明または完全
に固体にする正則化。何ももた

らしません。 危険になる可能
性もあります (1.4.3 バグ Mass-
Extinction)。0 のままにしてくだ
さい。

T36 opacityDecayFactor

詳細

デフォルト: 0.0 (Initializer = 無効化)、0.9995 

( .full 、 .classicBalanced  — HTGS 標準) 範囲: 0 

(オフ) または 0.95 – 1.0 定義場所:

技術詳細

HTGS スキームの V546 実装 (Hierarchical 
Time-Gating、Eurographics 2025): すべての T37 
opacityDecayInterval 反復で、各 Gaussian の 
Sigmoid Opacity に この係数が掛けられます。100 回
適用で 0.9995 × は Densification フェーズあたり 
~95% 残存をもたらします — すべての Opacity に
対するわずかだが持続的な下方圧力で、 弱く寄与
する Gaussian を確実に T14 pruneOpacityThreshold 
の下に下げます。結果: Decay なしの V438 と比
較して Horse Full (3 試行平均 V546) で 14% 良
い L1 Loss。 Densification フェーズ中のみアクティ
ブ ( T2  まで)、その後トレーニングは Decay なし
で続行され、Refinement で確立された Opacity が
安定したままになります。MCMC では使用されま
せん (MCMC は T67 mcmcRelocationInterval + T68 
mcmcDeadOpacityThreshold 経由で独自のメカニズム
を持ちます)。

簡単に言うと

トレーニング時間にわたるすべて

の Splat の「ソフトフェード」。非
アクティブに なった Splat をより
速く透明にし、クリーンアップで

削除されるようにします。これ

は V546 更新の最も重要な品質レ
バーでした: 14% 良い。Quality プ
リセットに組み込まれて います。
正確に調整されているため、自分

で調整することはお勧めしませ

ん。
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T37 opacityDecayInterval

詳細

デフォルト: 50 範囲: 10 – 500 定義場所:

技術詳細

T36 opacityDecayFactor が適用される反復間隔。
HTGS Paper デフォルト 50、 .full  で維持。長い間
隔 (>200) は効果を部分的に取り消します。2 つの適用
の間で十分な 勾配更新が発生し、Opacity が再び上昇
するためです。より短い間隔 (<20) は Decay を 積
極的すぎにします。Densification フェーズでのみアク
ティブ。

簡単に言うと

「フェード」が適用される頻度。

50 = 50 反復ごとに少しフェード
ステップ。 適切です。

Refinement (T38〜T44)

T38 gradientAccumulationSteps

詳細

デフォルト: 1 (= 「Adam ステップごとに 1 ビュー」) 

範囲: 1 – 8 定義場所:

技術詳細

V424 機能: Adam 更新が実行される前に勾配が蓄
積されるビューの数。 > 1  の 場合、アプリは別
の「unfused」逆方向プロジェクトパスで実行され、
勾配を別のバッファに 集計します。最終適用は 1/
N でスケールしてマグニチュードを一定に保ちま
す。V424 は 2 ビューをテスト → 品質ニュートラルだ
が 10% 遅い (unfused パスが fused パスより 高価な
ため)。 .full  では元に戻されましたが、MCMC では
意図的に使用 — .fullMCMC  は で実行されますが、
V544a テストは Classic への品質ギャップが (11% の
代わりに) 5% に 縮小すると示しました。Initializer デ
フォルト 1、現在のプリセットで 1、CLI フラグ 
( --accum-steps N ) として残ります。

簡単に言うと

アプリが Splat を調整する前に見
る画像の数。1 = 各画像個別。高
い = 複数の画像を同時に見て、平
均を適用。標準ケースでは何もも

たらしません。MCMC では 2 が少
し役立つ可能性があります。
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T39 testViewIndices

詳細

デフォルト: []  (= 空、すべてのビューがトレーニン

グに使用) 範囲: Set<Int> 、Camera インデックスの

任意のサブセット 定義場所:

技術詳細

V546 機能: トレーニングに使用されず、PSNR/
SSIM/LPIPS 評価のための Holdout として節約され
る Camera インデックスのセット。 --benchmark  CLI 
フラグがアクティブな 場合に自動的に設定されま
す: その場合、インデックス 0 から始まる 8 番目ご
とのビュー (LLFF 標準、Mip-NeRF 360 および 3DGS 
論文規約と同一)。Benchmark なしでは空 — トレー

ニングはすべてのビューを使用します。注意: イン
デックスを理解せずに このフィールドを手動で設
定すると、Benchmark が使用不可になる可能性があり
ます (例えば N より上のすべてのインデックスを設
定するが、N-50 ビューしかない場合 → Holdout なし 
→ 評価なし)。独自のプリセットエクスポートでは、
testViewIndices は シーン依存で、異なるデータセッ
ト間で意味のない値を残すため、永続化されません。

簡単に言うと

後の品質測定のためにトレーニ

ング時に「保留」される画像。

これを自分で 設定しません。
--benchmark  フラグが自動的
に行います (8 番目ごとの画像が
テスト)。 独自のインデックスを
設定する場合: 危険、Benchmark 
を歪める可能性があります。

T40 refinementPruneInterval

詳細

デフォルト: 0 (= 無効化) 範囲: 0 または 100 – 5 000 

定義場所:

技術詳細

V425 機能: Refinement フェーズ中 ( T2  後) 
の N 反復ごとに、 sigmoid(opacity) < T41 
refinementPruneOpacityThreshold の Gaussian を削
除する 追加の Prune パスが実行されます。意味: 
Densification 中は定期的な Density Control コールが
あり、その後はありません — Opacity がさらに低下す
る Gaussian はバッファに 残ります。V425 はテス
トして元に戻しました: 追加の Pruning は V426 (Two-
Phase Densification、これも 0 Gaussian カスケード
失敗で中止) と相関しました。無効化。 実験用 CLI フ
ラグ利用可能。有効化された場合、1 000 または 2 
000 が意味のある値です。

簡単に言うと

Refinement フェーズ中の追加の
クリーンアップ。何ももたらしま

せん、オフの ままです。
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T41 refinementPruneOpacityThreshold

詳細

デフォルト: 0.0 (= 「 T14  を使用」) 範囲: 0 または 

0.001 – 0.1 定義場所:

技術詳細

V425b: Refinement Pruning 用の別の Opacity 閾値。
Densification 後、ほとんどの Gaussian は著しく高
い Opacity (> 0.001) に達しているため、標準 T14 
pruneOpacityThreshold は緩すぎます。 T40  がアク
ティブな場合、このフィールドが 独自の閾値を決定し
ます。0.0 では T14  が引き続き使用されます。T40 > 
0 の場合のみ 関連します。

簡単に言うと

追加の Refinement クリーンアッ
プの閾値 (T40 参照)。両フィール
ド非アクティブ、 したがって無関
係。

T42 midTrainingCompactificationIterations

詳細

デフォルト: []  (= 無効化) 範囲: [Int] 、 

(densifyUntilIteration, maxIterations) の値 定義

場所:

技術詳細

V549 機能: Refinement フェーズ中の明示的な反復
ポイントで、Compactification パスが実行されます 
(sigmoid(opacity) < 0.01 + 外れ値スケール Gaussian 
を削除、 T56 postTrainingCompactification と同
じロジック)。意味: 長い Refinement フェーズは 
Confetti/Floater 蓄積を示す可能性があり、その SH は
ビュー固有のアーティファクトに オーバーフィット
します。有効化された場合の典型的な構成: [10000, 

20000, 30000] for 40K Classic。しかし: V549 A/
B テストは Family データセットで、すべての 構
成でより悪い L1 を示しました: [10K,20K,30K]@0.01  
→ −48% カウントだが +36% L1。 [20K,30K]@0.005  
→ −44% カウントだが +45% L1。 [20K,30K]@0.001  
→ −17% カウント だが +87% L1。したがって無効
化。CLI フラグ --mid-compact "10000,20000" が利
用 可能、視覚的 Floater トレードオフ (Viewport で 
Confetti が少ない) を Loss リグレッションよりも優先
する場合に。

簡単に言うと

トレーニング中の中間クリーン

アップアクション。テストでは、

クリーンアップが 最終結果を悪
化させました (Floater は少ない
が、ディテールも少ない)。オフ、
Floater が 少しぼやけた画像より
も気になる場合は CLI 経由で有効
にできます。
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T43 frustumCullEnabled

詳細

デフォルト: false 範囲: boolean 定義場所:

技術詳細

V549b 機能: トレーニング後、すべてのトレーニ
ングカメラ Frusta の Union の 外側にあるすべて
の Gaussian が削除されます。そのような Gaussian は 
Loss 信号に よって決して制約されず、常に Floater で
す。Novel View がカメラパスの後ろまたは 横にある
シーン (例えば線形ドローン飛行の裏側) に特に効果的
です — そこの Floater はトレーニングフェーズで決し
て見えませんが、後で 3D ビューアで動くときに 非
常に見えます。V549b A/B はドローン飛行で肯定的な
結果、したがって Opt-In として 利用可能。デフォル
ト false。完全なオービットカバレッジを持つ Object 
キャプチャでは Frustum Union がシーン全体を含み、
機能が何も削除しないため — Settings の 「Floater 
Reduction」で提供され、Q9 Outdoor プリセットで 
T44 frustumCullExpansion 経由で 暗黙的にテストさ
れます (Q7 BayesOpt はそれをアクティブにしません
でした。 Outdoor Sky-Dome が同じ問題をより良く解
決するため)。

簡単に言うと

ドローン飛行や線形撮影用の特別

フィルター: トレーニング後、ど
のカメラ にも「見られていない」
Splat が削除されます。Settings 
でオプションでオン可能。 単純な
オブジェクト撮影では不要。

T44 frustumCullExpansion

詳細

デフォルト: 1.1 範囲: 1.0 – 2.0 定義場所:

技術詳細

T43 frustumCullEnabled の NDC マージン。1.0 は画
像境界で正確に切断し、 ぼやけた Splat を境界で切
り詰めすぎます。1.1 = 正確なカメラフレーミングを
超えた 10% パディング — わずかにオフセットされた 
Novel View で見える可能性のある境界 ピクセルに対す
る許容範囲を与えます。> 1.2 の値は Cull を実質的に
無効にします。 拡張された Frustum がはるかに多くの
空間をカバーするためです。

簡単に言うと

上記のフィルターがどれだけ厳密

にトリミングするか。1.1 = 画像境
界への わずかな安全マージン。値
はそのままに。
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Sky-Dome (T45〜T48)

T45 skyDomeEnabled

詳細

デフォルト: false (Initializer + P9 Outdoor を除くすべ

ての プリセット) 範囲: boolean 定義場所:

技術詳細

V549e 機能: トレーニング開始前、球状点群が生成さ
れ (Fibonacci sphere、 T46  Sample 点)、シーン中
心の周りの T47 skyDomeRadiusMultiplier × scene_​
extent の 半径に配置され、すべてのトレーニング
カメラの Sky マスクされたピクセルからの色 (T20 
skyMaskingEnabled 参照) で初期化されます。これら
の Sky-Dome Gaussian は Gaussian バッファの先頭
に挿入され、トレーニング中に「凍結」されます 
(Position/ Scale/Rotation 勾配 = 0、SH と Opacity の
み最適化可能)。効果: 遠くの黒い「Confetti」 領域
の代わりに、Novel View で実際の空が表示されます。
V549e MVP はドローンと風景 シーンで非常にうま
く機能します。P9 Outdoor プリセットでデフォルトオ
ン。室内シーンでは オフのまま — 球は部屋の外に意味
なくぶら下がります。

簡単に言うと

シーン周りの人工「Sky Dome」
をオンにします。屋外撮影をはる

かに美しくします: 画像の境界の
黒い小さな塊の代わりに、アプリ

は実際の空を表示します。ドロー

ン飛行と 風景には必須、室内では
意味がありません。

T46 skyDomeSampleCount

詳細

デフォルト: 5 000 範囲: 1 000 – 50 000 (典型 2 000 

– 10 000) 定義場所:

技術詳細

Sky-Dome 球面上の Fibonacci Sphere Sample 点の
数。高い値 → より密な Sky-Dome (大きな解像度と多
くの可視天空でより良い) ですが、より多くのメモリ需
要。 5 000 は 4K レンダリング用のスイートスポッ
ト。低い解像度では 2 000〜3 000 で十分。 点は各ト
レーニングカメラ View ベクトルへの Cosine Distance 
によって、対応する Sky マスクされたピクセルで初
期化されます — View Cone がカメラを見ない Sample 
点は 低い Opacity 初期値で背景に残ります、しかしト
レーニングで変更されません (凍結)。

簡単に言うと

人工的な空がどれだけ密か。5 
000 点で通常十分です。より多い 
= 遠くからの より良い遷移、ただ
し少しメモリをコスト。
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T47 skyDomeRadiusMultiplier

詳細

デフォルト: 30.0 (Initializer + ほとんどのプリセット)、

59.0 (P9 Outdoor、Q7 BayesOpt 最適化) 範囲: 5.0 – 

200.0 定義場所:

技術詳細

シーン範囲 (= カメラ位置間の平均距離) に対する Sky-
Dome 球の半径。30 = 球は カメラ雲の直径の 30 倍を
持ちます。小さすぎる (< 5) → Sky-Dome はシーン自
体と干渉 します (例えば Sky-Dome Splat が前景に着
地)。大きすぎる (> 100) → Sky-Dome 位置で float32 
精度損失、遠くでレンダリンググリッチを引き起こし

ます。Q7 BayesOpt on Bicycle (Mip-NeRF 360) は屋
外用のシーン固有最適化として 59.0 を見つけました — 
これは標準 30.0 が深い風景に小さすぎ、Sky-Dome 
ピクセルが画像境界領域で「壁」 として見えるように
レンダリングされることを示唆しています。

簡単に言うと

人工 Sky Dome がどれだけ遠くに
あるべきか。30 = かなり遠い。大
きな風景 では 50〜60 がより良い 
(Outdoor プリセットは自動的にそ
れを行います)。小さすぎる こと
は、レンズの直前に塊があるよう

なものです。

T48 frozenGaussianCount

詳細

デフォルト: 0 (= 凍結された Gaussian なし) 範囲: 0 

または 1 – T46  定義場所:

技術詳細

Optimizer で Position/Scale/Rotation 勾配がゼロに設
定される、バッファの 先頭にある Gaussian の数 — 全
トレーニングにわたって空間的に固定されたままで

す。 Density Control はそれらをクローン、分割、ま
たは Prune してはいけません。 Sky-Dome 注入用 
( T45  参照): Sky-Dome がオンの場合、このフィール
ドは自動的に T46 skyDomeSampleCount に設定されま
す。手動設定は可能 (例えば LiDAR スキャンから 事前
配置された点群を凍結) ですが、UI から直接アクセス
できません。重要: バッファの 最初の N Gaussian は常
に frozen — バッファ内の順序が決定し、明示的なイン
デックスでは ありません。

簡単に言うと

開始時に固定で動けない Splat の
数。Sky-Dome がオンのとき、自
動的に Sky-Dome カウントに設定
されます。自分で調整する必要は

ありません。

141 / 227



R A D I A N C E K I T 第 6章 — トレーニング構成

Adam + LR スケジュール (T49〜T55)

T49 adamResetIteration

詳細

デフォルト: 0 (= 無効化) 範囲: 0 または 100 – 定義場

所:

技術詳細

V430 機能: Adam Optimizer Momentum アキュム
レータ (m1、m2) がゼロにリセット される反復。そ
の後のバイアス修正は iter  の代わりに (iter - 
adamResetIteration) で実行されます。V430 は 5 
000 (Densification 終了 後) でリセットをテスト → 
12.8% 悪い Loss。理由: Densification 中に蓄積された 
Adam Momentum は典型的な勾配マグニチュードに関
する情報を運び、Refinement フェーズを 加速します。
それを捨てることは Refinement の最初の ~500 反復
の収束をコストします。 無効化。研究実験用 CLI フラ
グとして残ります。

簡単に言うと

内部 Adam Optimizer「メモリ」
のリセットボタン。テストで害を

及ぼしました、 オフのままです。

T50 positionLRScheduleEndIteration

詳細

デフォルト: 0 (Initializer = 「maxIterations を使
用」)、20 000 ( .full  — Cosine が maxIter=35K 
にもかかわらず 20K で終了)、30 000 

( .fullClassicPaper ) 範囲: 0 または 1 000 – 定義場

所:

技術詳細

V431 機能: Position LR の Cosine Annealing 曲線が最
小に達する反復。0 の 場合、 T1 maxIterations  と
同じです。> 0 の場合、スケジュールはこの値まで実行
され、 その後 T4 positionLearningRateFinal で一定
のままです。これにより、最小だが 一定の学習率を
持つ「拡張された Refinement フェーズ」が可能に
なり、新しい Decay なしで位置をゆっくり洗練しま
す。 .full  はこれを行います (Schedule End at 20K、 
Training runs until 35K)、V434c/V434d は確認しま
した: 15K と 25K の両方が約等しく、 20K がわずかに
最適。 T51  と組み合わせて使用​​され、拡張フェーズの
非位置 LR も 修正します。

簡単に言うと

アプリが Position 学習率の低下を
止めるとき。最大反復より低い

場合、その後は 一定の Mini レー
トで実行されます — 非常に遅
いが非常に安定して洗練します。

Quality プリセットに組み込まれ
ているため、調整する必要はあり

ません。

142 / 227



R A D I A N C E K I T 第 6章 — トレーニング構成

T51 extendedPhaseLRDecay

詳細

デフォルト: 0.0 (= 無効化、一定の LR) 範囲: 0 または 

0.01 – 1.0 定義場所:

技術詳細

V433 機能: 「拡張フェーズ」での非 Position LR (ス
ケール、回転、Opacity、 SH) の最小乗数 — つまり: 
T50  に達した後、Position LR がすでに T4  の場合。 

0.1 の場合、スケール/回転/Opacity/SH は、それぞれ 
1.0 (= 標準 LR) からその標準の 0.1× に Cosine Decay 
されます。0.0 (デフォルト) では、それらは一定のまま
です。 V457 は完全な Decay (0.0 = ゼロへの Decay) 
を no-Decay に対してテストし、見つけました: 平
均 0.0400 (2 実行) = V438 と同じ Loss、Decay な
し。Decay でよりクリーンな 動作ですが、測定可能
により良くありません。したがって無効化。CLI に --
nonpos-lr-scale F として残ります。

簡単に言うと

後半の Refinement フェーズでも
色と形の学習率を小さくする。ト

レーニングを 「より安定」にしま
すが、経験的により良くありませ

ん。オフ。

T52 adaptiveDensifyThreshold

詳細

デフォルト: false 範囲: boolean 定義場所:

技術詳細

V440 実験: true の場合、アプリは各 Densification ス
テップで現在の勾配 分布の p98 を計算し、それを動的
閾値として使用します ( T11  の設定値の少なくとも 
0.5× にクランプ、あまり外れないように)。仮説: 現在
のシーンフェーズへの自動調整は、 Density Control を
より堅牢にします — 例えば最初は厳密な Pruning、後
で緩い、 または逆。V440 はテストして元に戻しま
した: 63 K Gaussian (Mass-Pruning) への 壊滅的なド
ロップ、最初の反復で p98 が非常に高く、その後ほ
とんど何も閾値を超えない ためです。固定閾値はすで
によくキャリブレートされており、動的調整は害より

も害が 多いです。Q5 (T77) は問題を回避する rolling 
median 経由の代替適応ロジックを 提供します。

簡単に言うと

Densify 閾値の適応バージョン。
テストで壊滅的でした (Splat 数が 
63K に クラッシュ)。オフ。Q5 は
そのより良いバリアントを持って

います。
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T53 mergeAfterDensification

詳細

デフォルト: false (Initializer)、true ( .full 、 

.classicBalanced 、 .fullClassicPaper ) 範囲: 

boolean 定義場所:

技術詳細

V438 機能: Densification フェーズの終わり (Iter T2 ) 
で、類似の スケールと色を持つ近接 Gaussian を
結合する 1 回限りの Merge パスが実行されます。 
Gaussian 数を視覚的品質損失なしで通常 5〜15% 削
減します。意味: 集中的なクローニング後、 何も新し
いものを寄与しない準同一の Gaussian のクラスタが
形成されます — マージは 他の領域のための Optimizer 
容量を解放します。Classic Quality プリセットで標準。 
MCMC では使用されません。MCMC は Relocation ロ
ジックを通じてそのようなクラスタを 最初から形成さ
せないためです。

簡単に言うと

Splat 複製フェーズの終わりに、
ほぼ同一のクローンを結合しま

す。視覚的 効果なしでデータ量を
削減します。Quality プリセット
でデフォルトオン。

T54 densifyPhase2FromIteration

詳細

デフォルト: 0 (= 無効化) 範囲: 0 または T2  – T1  定

義場所:

技術詳細

V426 実験: Refinement 休止後にこの反復から開始
し、 T55  まで実行する 2 番目の Densification フェー
ズを有効にします。仮説: Refinement フェーズ後、勾
配 アキュムレータはより安定したマグニチュード
を持ち、どの領域がまだ追加の Gaussian を 必要
とするかをより正確に伝えることができます。V426 は
テストして元に戻しました: Two-Phase Densification 
は 0 Gaussian カスケード失敗に陥りました (V425 
Refinement Pruning と組み合わせるとバッファを破
壊)。無効化。実験用 CLI フラグ利用可能。

簡単に言うと

休止後の 2 回目の複製ラウンド。
テストで Splat 在庫を破壊しまし
た。 オフ。
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T55 densifyPhase2UntilIteration

詳細

デフォルト: 0 範囲: 0 または T54  – T1  定義場所:

技術詳細

V426 Two-Phase Densification の終了。 T54 > 0  の
場合のみ関連。両フィールド 一緒に無効化。

簡単に言うと

2 回目の複製ラウンドの終了 (T54 
参照)。両方オフ。

ポスト処理 + Apple AI (T56〜T60)

T56 postTrainingCompactification

詳細

デフォルト: true (すべての Production プリセット)、

false ( .quickTest 、 .preview ) 範囲: boolean 定義

場所:

技術詳細

V443 機能: トレーニング終了後、sigmoid(opacity) < 
0.01 の Gaussian が ハード除去されます (実質的に
画像にもう寄与しません)。Gaussian カウントを通
常 58%、 エクスポートファイルサイズを 55% 視覚的
品質損失なしで削減します。Production プリセット
でデフォルトアクティブ — 最終結果はできるだけコ
ンパクトに配信できる べきです。 .quickTest  ではオ
フ、診断実行はとにかくエクスポートされないためで

す。 T42 midTrainingCompactificationIterations 
(V549) とは異なり、Compactification は 終了時の
み行われます — Refinement はそれまですべての 
Gaussian を使用できます。

簡単に言うと

トレーニング後のクリーンアップ: 
ほぼ見えない Splat が削除されま
す。 エクスポートファイルを品質
損失なしで約半分のサイズにしま

す。必須機能、診断実行 でのみオ
フにします。
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T57 metalFXUpscaling

詳細

デフォルト: false 範囲: boolean 定義場所:

技術詳細

V444 機能: 3D ビューア出力のバイリニア補間の代
わりに Apple の MetalFX Spatial Upscaler を有効化し
ます。トレーニング解像度 < Viewport サイズ (例えば 
0.5× でトレーニング、フル解像度で Viewport 表示) の
場合、MetalFX は著しく鮮明な 画像を提供できます。
Viewport でライブに変更され、再トレーニング不要。 
T58 mpsLanczosScaling と相互排他 — MetalFX が優
先。推奨: 期待される ディテールと比較して Viewer の
画像が「ぼやけて」見える場合は、オンにします。

簡単に言うと

3D Viewer での Apple-ML ベース
の画像シャープニング。より低い

解像度で トレーニングして結果を
フルスクリーンで表示する場合に

役立ちます。ライブトグル、 試し
てください。

T58 mpsLanczosScaling

詳細

デフォルト: false 範囲: boolean 定義場所:

技術詳細

V444 機能: Viewport スケーリング用のバイリニア補
間の代わりに MPSImageLanczosScale。Lanczos は
古典的な Sinc ベースのリサンプリング手順で、 バイリ
ニアより著しく鮮明な結果を最小オーバーヘッドで提

供します。ライブトグル。 両方がオンの場合、 T57  
で上書きされます。

簡単に言うと

3D Viewer 用の古典的なシャープ
ニング手順 (Lanczos)。MetalFX 
(T57) は ML ベースで通常より良い
ですが、Lanczos はあまり積極的
でない代替手段です。

146 / 227



R A D I A N C E K I T 第 6章 — トレーニング構成

T59 livePreviewInterval

詳細

デフォルト: 50 (Initializer とほとんどのプリセット) 範

囲: 0 (オフ) または 10 – 5 000 定義場所:

技術詳細

トレーニング中に 3D Viewer が現在の Gaussian で更
新される頻度。50 = 50 反復ごとに Viewer の新しい
レンダリング — 進行を観察するのに十分良く、トレー
ニング を遅くしません。0 = Viewer はまったく更新さ
れません (バックグラウンドトレーニング、 最大速度)。
典型的な調整: .quickTest  で 10 まで下げる (各ス
テップを見たい)、長い MCMC 実行で 500〜2000 ま
で上げる (合計の更新オーバーヘッドが顕著)。

簡単に言うと

トレーニング中に 3D プレビュー
がどれくらいの頻度で更新され

るか。50 = 50 反復ごと。高いほ
ど = 頻度が少ない = やや速いです
が、進行を見る頻度が少なくなり

ます。 0 = プレビューなし (最大
速度)。

T60 perceptualLossWeight

詳細

デフォルト: 0.0 (= 無効化) 範囲: 0 または 0.001 – 0.5 

定義場所:

技術詳細

V444 将来機能: MPSGraph 経由の知覚 Loss 項の重
み (VGG ライクな小さな ネットワーク)。L1+SSIM よ
り高いセマンティックレベルで構造的およびテクス

チャ 類似性をキャプチャします — 通常、研究パイ
プラインで、「ピクセルパーフェクト」が 「リアルに
見える」より重要でない場合。実装はまだ保留中 (コー
ドスタブは存在しますが、 順方向パスは実装されて
いません)。デフォルト 0.0。将来のアクティベーショ
ン用に フィールドカタログに残ります。CLI フラグ 
--percep-weight F  予約。

簡単に言うと

「ピクセル正確」の代わりに「自

然に見える」を目指す AI 支援機能
の計画。 まだ完全に実装されてい
ません。
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MCMC Densification (T61〜T73)

T61 densificationStrategy

詳細

デフォルト: .classic  (Initializer + Classic プリセッ
ト)、 .mcmc  (すべての MCMC プリセット + Scene-

Class) 範囲: .classic  または .mcmc  定義場所:

技術詳細

Classic Densification (Clone/Split/Prune、Kerbl et 
al. 2023) と MCMC Densification (Stochastic 
Gradient Langevin Dynamics with Relocation、 
Kheradmand et al. NeurIPS 2024) の間で選択します。
.classic  では T11〜T16  が 評価され、 .mcmc  で
は T62〜T73  が評価されます。切り替え時の注意: 
Classic デフォルトと MCMC デフォルトは完全に異
なってキャリブレートされています — Expert View で
ピッカーをフリップして、適切なプリセットをロー

ドしない場合、 1.4.3 バグスタイルの Mass-Extinction 
を冒険します (1 反復で 460 K → 5、 MCMC 
OpacityReg 0.01 が Classic Opacity を殺すため)。し
たがって、MCMC Init デフォルトは意図的に「ソフト
化」されています (すべての Reg 値 0.0)。

簡単に言うと

Splat を増やすのにどのアルゴリ
ズムが使用されるか。Classic = 
元の方法 (速い、多くの Splat)。
MCMC = 新しい方法 (遅い、はる
かに少ない Splat、その代わり より
コンパクト)。プリセットは正し
いものを選択します。適切なプリ

セット (P5〜P7 または P8〜P10) 
もロードする場合のみ、自分で切

り替えてください。
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T62 mcmcMaxGaussians

詳細

デフォルト: 150 000 (Initializer + .fullMCMC  
+ .mcmcBalanced )、 100 000 ( .mcmcPreview )、
1 500 000 ( .fullMCMCMip  — Mip-Splatting バ
リアント with 10× バジェット)、1.19 
M ( .renderPreset )、1.25 M ( .outdoorPreset )、 

670 K ( .indoorPreset ) 範囲: 0 (= 「バッファ容量を

使用」) または 10 000 – 5 000 000 定義場所:

技術詳細

MCMC 戦略での Gaussian 数のハード上限。数は
キャップに達するまで Relocation ステップごとに 
T70 mcmcGrowthRate  (通常 5%) で徐々に増加しま
す。V473/V531 は 150 K をスイートスポットと見つけ
ました — 200 K を超えると Splat 品質が薄まり (小さ
く冗長な Gaussian が多すぎる)、100 K 未満ではシー
ンが過小 Densify されたまま。 非常に大きなシーン 
(例えば 1 545 枚のドローン飛行で 158 K SfM-init) で
は 150 K が 低すぎる — したがって 1.4.5 拡張 T72 
mcmcCapMultiplier + T73 mcmcAutoScaleByScene。
Q7 BayesOpt はシーン固有最適化を 670 K (Indoor) 
から 1.25 M (Outdoor) の間で見つけました。値 0 で
は、エンジンは完全なバッファ容量を キャップとして
使用します。

簡単に言うと

MCMC での最大 Splat 数。150 
000 が標準で、ほとんどのシーン
に十分です。 Outdoor と Render 
プリセット (P8、P9) はより詳細な
シーンのために 1 百万以上に なり
ます。高く設定するとディテール

がもたらされますが、メモリをコ

スト。下に設定 することはむしろ
緊急ブレーキです。
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T63 mcmcNoiseScale

詳細

デフォルト: 0.00005 (5e-5 = Paper デフォルト) 範

囲: 1e-6 – 1e-3 定義場所:

技術詳細

各 MCMC 反復で各 Gaussian の位置に追加されるガウ
スノイズの乗数 (SGLD ロジック)。高い = より多くの
探索 (Gaussian がより放浪し、潜在的により良い場所
を 見つける)、低い = より多くの活用 (Gaussian がす
でに良い場所に留まる)。V467 と V536 は 5e-5 を最
適と確認 — 1e-5/2e-5 探索が少なすぎ、1e-4 多すぎ 
(Splat が 流れる)。トレーニング時間にわたって T69 
mcmcNoiseDecayEnd まで Cosine Decay されます — 
Decay 範囲の終わりでノイズは事実上 0 で、Gaussian 
は収束します。

簡単に言うと

アプリが Splat に許可するランダ
ムな「揺れ」の量、Splat 自身が
最適な場所を 見つけられるよう
に。標準値は最適にテストされて

います。これを上げると、Splat 
が 落ち着かなくなります。

T64 mcmcOpacityRegWeight

詳細

デフォルト: 0.0 (= RadianceKit デフォルトで無効化、

Paper: 0.01) 範囲: 0 または 0.001 – 0.05 定義場所:

技術詳細

Opacity 用の MCMC 固有 L1 ペナルティ。Paper 
デフォルト 0.01 (未使用の Gaussian をゼロに押
し、Relocation 用に利用可能にします)。しかし 
V464b は示しました: Reg なしでは RadianceKit で
測定可能により良い (Session 28 確認)。理由: T68 
mcmcDeadOpacityThreshold で定義された Pruning 基
準は単独で十分 — 追加の L1 ペナルティは、貴重で
低 Opacity の Gaussian も死亡させます。したがって

デフォルト 0。注意: 1.4.3 ベータビルドでは Initializer 
デフォルトが誤って 0.01 で、 Mass-Extinction バグが
発生しました (T61 説明参照)。1.4.4 以降 0.0 に固定。

簡単に言うと

MCMC 特別正則化。他の MCMC 
メカニズム (T68 の閾値) がすでに
カバーする ため、オフ。0 のまま
に。
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T65 mcmcScaleRegWeight

詳細

デフォルト: 0.0 (= 無効化、Paper: 0.01) 範囲: 0 また

は 0.001 – 0.05 定義場所:

技術詳細

スケール固有値用の MCMC 固有 L1 ペナルティ。
Paper デフォルト 0.01。V464b: Reg なしでより良い、
T64 と同じ理由。すべての RadianceKit MCMC プリ
セットで無効化。 T64 と同様の注意: 1.4.3 バグ。

簡単に言うと

T64 のように、しかし Splat サイ
ズ用。オフ。

T66 mcmcRelocationInterval

詳細

デフォルト: 100 (Initializer + すべての MCMC プ
リセット、Paper 標準)、155 (P9 Outdoor — Q7 

BayesOpt 最適化) 範囲: 50 – 500 定義場所:

技術詳細

MCMC が死んだ Gaussian (sigmoid(opacity) < T68 
mcmcDeadOpacityThreshold) を 新しい位置に再配置す
る反復間隔。V537 は 50 (混乱しすぎ、Loss 変動) 
と 200 (わずかに 悪い、MCMC が反応性を失う) をテ
スト。100 が最適。Q7 BayesOpt on Bicycle はシーン 
固有最適化として 155 を見つけました — やや長い間
隔は、次の Reloc イベントが それらを圧力下に置く前
に、Adam に新しく配置された Gaussian を統合する
時間をより 多く与えます。

簡単に言うと

MCMC が死んだ Splat をどこかに
移動する反復ごとに。100 が標
準。自分で 調整する必要はありま
せん — Outdoor プリセットはす
でに最適値を持っています。
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T67 mcmcWarmupIterations

詳細

デフォルト: 500 範囲: 100 – 5 000 定義場所:

技術詳細

MCMC Relocation がまだ発生しない初期反復の数。
この Warmup 後、Reloc ロジックが開始されます。意
味: 最初の反復では、Opacity 値はまだ落ち着いていま
せん — すぐに Reloc で開始されると、Gaussian は間
違った場所に配置され、すぐに再び移動 される必要が
あり、Adam Momentum を破壊します。Paper デフォ
ルト 500。RadianceKit は この値を引き継ぎます、
V464b がそれが堅牢であることを示したためです。

簡単に言うと

MCMC が Splat の再配置を開始
する前に「到着」できる反復数。

500 が標準で 適切です。

T68 mcmcDeadOpacityThreshold

詳細

デフォルト: 0.005 (Initializer、Paper 標準)、0.01 
( .fullMCMC  と すべての MCMC プリセット — V535 

最適化) 範囲: 0.001 – 0.05 定義場所:

技術詳細

Gaussian が「死んだ」とみなされ Relocation の対象
となる sigmoid(Opacity) 閾値。V535 は 0.01 を最適
と発見 (0.005 わずか、0.02 悪い)。高い = より積極的
な Reloc (より多くの Gaussian が移動)、低い = より
慎重。0.01 はおおよそ「0.5% 視覚的 可視性」に相
当します。P10 Indoor は Q7 BayesOpt 経由で 0.0142 
を最適として使用 します。

簡単に言うと

Splat が MCMC によってどこかに
移動される「死亡」とみなされる

透明度。 0.01 は私たちのテスト
で最適です。自分で調整する必要

はありません。
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T69 mcmcNoiseDecayEnd

詳細

デフォルト: 0 (Initializer = 「Decay なし」)、
160 000 ( .fullMCMC  = 200K の 80%)、96 
000 ( .mcmcBalanced  = 120K の 80%)、40 000 

( .mcmcPreview ) 範囲: 0 または 1 000 – 定義場所:

技術詳細

T63 mcmcNoiseScale  ノイズが完全にゼロに減衰さ
れる反復 (Iter 0 から ここまでの Cosine Decay)。
V497c/V502 は maxIterations の 80% を最適と発見 
— MCMC に十分な探索時間を与え、最後の 20% をノ
イズなしでの収束に残します。0 = すべての 反復にわ
たって一定のノイズ (まれに意味があり、MCMC は収
束できません)。

簡単に言うと

Splat のランダムな「揺れ」がい
つ止まるか。MCMC プリセットで
は総反復の 80% で — 最初に探
索、次に収束。値はそのままに。

T70 mcmcGrowthRate

詳細

デフォルト: 0.05 (Paper 標準 = 5%) 範囲: 0.01 – 0.2 

定義場所:

技術詳細

Relocation ステップごとの MCMC 人口ターゲット
の成長率。ロジック: 各 Reloc イベントで、ターゲット
人口サイズが T62 mcmcMaxGaussians (または T72/​T73 
経由で スケールされたバリアント) に達するまで 
(1 + growthRate)  で増加されます。V512/V522 は 

0.05 を最適と発見 — 高い値は速すぎる成長になりま
す (Adam Momentum が統合する前に Gaussian が挿
入される)、低い値は終了時にシーンが過小 Densify さ
れたままに なります。

簡単に言うと

MCMC で Splat 数がどれだけ速く
成長するか。ステップあたり 5% 
が最適。値は そのままに。
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T71 mcmcSigmoidK

詳細

デフォルト: 100.0 範囲: 10.0 – 500.0 定義場所:

技術詳細

MCMC Noise 減衰用の Sigmoid Sharpness パラメー
タ。SGLD ステップでは、 Gaussian あたりのノイズが 
で減衰されます — 高 Opacity Gaussian (Logit が正) 
は、 低 Opacity よりも指数的に少ないノイズを受け取
ります。K = 100 は鋭く、つまり 「フルノイズ」か
ら「ノイズなし」への遷移は Opacity 0.5 周辺で非常
に速く発生します。 V484〜V487 は K = 100 を最適と
発見 — 小さい値 (10〜50) は高 Opacity Gaussian も 
揺らがせます (収束した Gaussian を破壊)、大きい (> 
500) は遷移を人工的に硬くし、 死んだ Gaussian がも
う移動されません。

簡単に言うと

MCMC が「移動するのに十分透
明」と「固体、触らないで」をど

れだけ鋭く 区別するかを決定する
特別パラメータ。標準値が最適で

す。調整しないでください。

T72 mcmcCapMultiplier

詳細

デフォルト: 3.0 (Initializer + .fullMCMC )、2.0 
( .mcmcPreview )、 2.5 ( .mcmcBalanced )、2.98 (P8 

Render)、5.32 (P9 Outdoor)、1.76 (P10 Indoor) 範

囲: 0 (= 無効化) または 1.0 – 10.0 定義場所:

技術詳細

1.4.5 機能: シーン適応 Cap スケーリング。T73 

mcmcAutoScaleByScene が true の場合、実効 Cap は 
(バッファ容量にクランプ) として計算されます。 背
景: 大きなシーン (例えば 1 545 枚のドローン飛
行 → 158 K SfM-init) では T62 = 150 000  が低すぎ
る — Density Control はまったく成長できません。 
Multiplier 3.0 で、この例では Cap が 474 K にス
ケーリングされます (158 K × 3.0)。 Q7 BayesOpt 
はシーン固有の最適化を見つけました: Outdoor は
高 Multiplier (5.32 → ~830 K Cap at 156 K bicycle-
init)、Indoor は 1.76 で満足 (壁がより早く飽和)。 完
全な Cap 解決はメソッド参照。

簡単に言うと

Splat Cap をシーンサイズに自動
的に適応させる Multiplier。大き
なシーン = より多くの開始点 = 高
い Cap。標準 3× はほとんどの
シーンに適合します。Outdoor プ
リセットは 5× (大きな奥行き範
囲)、Indoor は 1.76× (壁が制限) に
なります。
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T73 mcmcAutoScaleByScene

詳細

デフォルト: true (Initializer + すべての MCMC プリ

セット) 範囲: boolean 定義場所:

技術詳細

1.4.5 機能: scene-aware Cap ロジック (T72 + 参
照) のマスタースイッチ。 false の場合、T62 

mcmcMaxGaussians のみが Cap として使用されます 
(1.4.4 動作に 戻る)。デフォルトでオン、1.4.3 から大
きなシーンでの Mass-Extinction 問題がそれ なしで再
発するためです。明示的にハード Cap を設定したい場
合のみ手動で無効化 — 例えば最終サイズが計画可能な 
150 K バリアントをトレーニングするため。

簡単に言うと

Splat Cap をシーンサイズに自動
的に適応させるオン。デフォルト

でオン。 特定の Splat 数を正確に
持ちたい場合のみオフにします。

Mip-Splatting (Q1.5) (T74〜T76)

ステータス: Q1.5 は 2026-05-25 に、14 の自律反復 + Overnight 1.5M Confidence 
Check の後、「closed no-win」として破棄されました (max Δ@2× = +0.27 dB、 オリ
ジナルゲートは 0.5×/2× にわたる平均 ≥ +1.5 dB を要求、11 ペアシーンの 0/11 で 
FAIL)。フィールドは研究実験用に opt-in のままです。すべての Production プリセット
は持ちます。判定参照: docs/​plans/​2026-05-25-phase-q1.5-final-verdict.md。
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T74 useMipSplatting

詳細

デフォルト: false (すべての Production プリセット)、

true ( .fullMCMCMip  — 研究兄弟) 範囲: boolean 定義

場所:

技術詳細

Mip-Splatting を有効化 (Yu et al. CVPR 2024): 3D 
Smoothing Filter + 2D Filter + α 補償、Gaussian あ
たりの周波数を最も密なトレーニングカメラ サンプ
リングレートの Nyquist 制限に制限します。理論的な
目標: トレーニング外 スケール (0.5× または 2× の
トレーニング解像度) でのレンダリングでのエイリア
シングの 除去。Preprocess と Backward Projection 
シェーダーで有効化、Q1.5-D テストで機能的に 正し
いと検証されました。しかし: オリジナル受け入れ
ゲート (Δ@1× ≥ +0.3 dB かつ avg(Δ@0.5×、Δ@2×) ≥ 
+1.5 dB) は 11 ペアシーンのどれでも達成されませんで
した。 観測された最大値: family 750K classic Δ@2× 
= +0.270 dB。屋外シーン (Truck、 Flowers) は 1× と 
0.5× で悪化さえ示しました。仮説: 3D Smoothing は 
high-Gs で MCMC Relocation と競合します。フィー
ルドは正しい Mip-NeRF-360 方法論を持つ将来の 
Multi-Scale Re-Eval のために残ります (Benchmark 
パスの O3 バックログ参照)。

簡単に言うと

2024 年の論文からのエイリアシ
ングフィルター。理論的には素晴

らしいが、 実際には私たちのテ
ストで何ももたらさず、時には害

さえもたらしました。実験者向け

に 利用可能なままですが、お勧め
しません。オフのままにしてくだ

さい。

T75 mipSmoothing3DScale

詳細

デフォルト: 0.2 (Paper デフォルト) 範囲: 0.05 – 1.0 

定義場所:

技術詳細

3D Smoothing スケールパラメータ (Yu et al. §3.3、
Paper デフォルト 0.2)。 大きい = Gaussian あたりの
世界空間スムージングが多い (= より多くのアンチエイ
リアシング、 しかしデフォルトスケールでより多くの
ブラー)、小さい = より鮮明だがエイリアシングに 影
響を受けやすい。T74 useMipSplatting = true の場
合のみ参照されます。Q1.5 テストで さらに最適化され
ませんでした — A/B ゲートはすでに Paper デフォルト 
0.2 で失敗、 さらなるスイープは無駄でしょう。

簡単に言うと

。Mip をオンにしていない場合、
無関係。
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T76 mipFilter2DVariance

詳細

デフォルト: 0.3 (= 正確に V242 レガシー動作) 範囲: 

0.1 – 1.0 定義場所:

技術詳細

Σ_2D 対角に追加される 2D Mip Filter 分散 (分散直接、
平方ではない)。0.3 は Mip-Splatting 前にカーネルに
ハードコードされていた正確な V242 レガシー値です。 
T74 useMipSplatting = false の場合、カーネルはこ
の値を完全に無視し、ハードコード された 0.3 を書き
ます — ベースラインが回帰できないように (Codex 
Round 1 S3-1 保証)。の場合、ここで設定された値が
使用されます。Mip スイープ用に フィールドカタログ
に残ります。

簡単に言うと

別の Mip-Splatting パラメータ。
Mip オフ: 無関係。

適応 Densification (Q5) (T77〜T79)

T77 adaptiveDensification

詳細

デフォルト: false 範囲: boolean 定義場所:

技術詳細

Q5 機能: 固定 T11 densifyGradThreshold への
代替としての rolling-median トラッカー。true 
の場合、各 Densify ステップで現在の閾
値が median(last N avgGrad samples) × T79 
adaptiveDensifyMultiplier で上書きされます。 N 
= T78 adaptiveWindow 。V440 p98 (壊滅的な 63 K 
Pruning トラップ) より厳密、 median + 2× は定常
状態の勾配分布の約 p70〜p80 に座ります。Q5 テ
スト: 単独で 3 シーンの 0 FAIL、しかし Q6 (T80/
T81 参照) と一緒に 3 シーンの 1 PASS — Q5+Q6 
バンドルは 2026-05-25 に opt-in としてパスし、CLI 
--adaptive-densify  経由で 有効化可能です。Q6 は
そこで品質向上の「キャリア」で、Q5 はむしろ安定性
に貢献します。

簡単に言うと

自己学習 Densify 閾値。固定の感
度の代わりに、アプリがシーンに

適応します。 単独でテストして
もより良くありませんが、Q6 の 
Curriculum と一緒なら良い。両
方一緒に オンにするか、両方オフ
にします。
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T78 adaptiveWindow

詳細

デフォルト: 1 000 範囲: 100 – 10 000 定義場所:

技術詳細

Densification イベント内の Rolling Median Window 
(反復ではない — 各 T13 densifyInterval ステップが 
1 サンプルを提供します)。デフォルト 1 000 — これ
は、過去 100 000 のトレーニング反復が中央値に寄与
することを意味し、つまり 通常ここまでのトレーニ
ング履歴全体。早期フェーズ (T78 サンプル前): トラッ
カーは nil を返します → 固定閾値 T11  にフォール
バック。アクティブな場合のみ関連。

簡単に言うと

いくつの古い Densify ステップが 
T77 用の中央値に流れ込むか。標
準 1000 が 良い。Q5 Adaptive オ
ンの場合のみ関連。

T79 adaptiveDensifyMultiplier

詳細

デフォルト: 2.0 範囲: 1.0 – 4.0 定義場所:

技術詳細

適応閾値用の Rolling Median の Multiplier。デフォル
ト 2.0 はおおよそ 典型的な勾配分布の p70〜p80 に相
当します。低い = より積極的な成長 (より多くの ク
ローン)、高い = より厳密 (より少ないクローン)。Q5 
テスト範囲 1.5〜3.0 — 2.0 最高デフォルト。アクティ
ブな場合のみ関連。

簡単に言うと

T77/T78 用の係数。標準 2.0 = 典
型的な中央値より厳密。調整しな

いで ください。
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Curriculum (Q6) (T80〜T81)

T80 curriculumResolutionRamp

詳細

デフォルト: false 範囲: boolean 定義場所:

技術詳細

Q6 機能: トレーニング解像度は 0.5× で開始し、 T50 
positionLRScheduleEndIteration /​ 2 (または T50 
が設定されていない場合は T1 maxIterations /​ 2) で 
T22 trainingRenderScale に切り替わります。Q1.5.1 
で 開発された resize/​restoreImageBuffers インフラ
ストラクチャを使用します。 有効化された場合、
T23 resolutionWarmupScale を上書きします。Q6 は 
Q5+Q6 バンドル (T77 参照) で「品質向上のキャリ
ア」としてパス — 段階的な解像度増加は、 アプリ
に低い解像度で粗いジオメトリを見つける時間を与

え、その後細かい詳細作業に 移行します。CLI 経由: --
curriculum-resolution。

簡単に言うと

トレーニング解像度用の「最初に

粗く、次に細かく」。最初の半分

で半分の 解像度、その後フル解像
度。特定のシーンでは役立ち、他

では役立たない — T81 と 一緒に
オンにすることをお勧めします。

T81 curriculumSHProgression

詳細

デフォルト: false 範囲: boolean 定義場所:

技術詳細

Q6 機能: T21 shDegreeUpgradeIterations を 
[maxIter/​4, maxIter/​2, maxIter*3/​4] で上書き、
SH アップグレードを front-load する代わりにトレー
ニング時間にわたって均等に分散します。仮説: 安定
したジオメトリは カラーディテール爆発の前に確立
され、View-Direction 依存の光沢効果がより正確に 配
置されます。Q5+Q6 一緒に 3 シーンの 1 PASS、
Q6 が利益のキャリア (Q5 単独 FAIL)。 CLI 経由: 
--curriculum-sh 。

簡単に言うと

「最初に形、次に色」— 光沢効果
はトレーニング後半でのみリリー

スされる ため、Splat は最初に位
置とサイズを見つけます。T80 と
一緒にオン可能。単独ではそれほ

ど もたらしません。

静的プリセット (TP1〜TP9)

ここでは Initializer デフォルトとの構造的な違いのみ。11 個の UI プリセット P1〜P11 の 完
全なマーケティング説明は第 7 章にあります。
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TP1 .preview

詳細

≥ 10 GB RAM のシステム用の診断/プレビュープリセッ
ト。Initializer に対する オーバーライド: - 30 000 → 
5 000 - 15 000 → 3 500 (maxIter の 70%) - 1.6e-6 
→ 1.6e-5 (10× 高い、あまり積極的でない Decay) 
-、、、、それぞれ 2× (V176) - 3 000 → 100 000 (事実
上オフ、V172: Reset が短いトレーニングを破壊) - 
[1K, 2K, 3K]  → [1K, 2K]  (V182: Degree 3 が 2K 

Iter で収束しない) - 1.0 → 0.5

簡単に言うと

新しくインポートされた画像シー

ケンスの初期評価 — 2〜3 分の待
ち時間、 その後結果はバイナリ
質問「Quality 実行は価値がある
か?」に十分です。

TP2 .full

詳細

Production-Quality Classic。オーバーライド: - 30 
000 → 35 000 (V550: 40K テスト Truck 過剰トレー
ニング Gs で +10.7%、L1 で −1.3%) - 15 000 → 5 
000 (V310 スイートスポット、V338 7K 悪い) - す
べての LR 2× (V188) - 1.6e-6 → 1.6e-5 (V45 10×) - 
2e-6 → 1.1e-6 (V335) - 100 → 200 (V112) - 0.005 
→ 0.001 (V393) - 3 000 → 100 000 (V194 無効
化、V421 確認) - [1K, 2K, 3K]  → [2K, 5K, 8K]  
(V228 遅延) - 0.0 → 0.9995 (V546 HTGS、14% 改
善) - 50 (変更なし、V546) - false → true (V438) - 
0 → 20 000 (V431) - true (V443、すでに .full  の 
Initializer デフォルト)

簡単に言うと

< 500 画像での各標準写真撮影 
(オブジェクト、小さな部屋、彫
刻)。 V546 で発表された V438 に
対する 14% Loss 改善は、Horse 
Full で 3 試行平均 確認されまし
た。

TP3 .fullClassicPaper

詳細

TP2 の Q1.5-A テスト兄弟、paper 忠実な Classic。
TP2 に対するオーバーライド: - 35 000 → 30 000 
(Paper 標準) - 5 000 → 15 000 (Paper: maxIter 
の 50%) - 1.6e-5 → 1.6e-6 (Paper デフォルト) 
-、、 Paper デフォルトに戻す (0.05、0.005、0.001) - 
1.1e-6 → 2e-7 (Bicycle で ~1-2M Gs 用にキャリブ
レート) - 200 → 100 (Paper) - 0.001 → 0.005 (Paper 
デフォルト) - 100 000 → 3 000 (Paper §5.2、危険 — 
V194 リグレッションをトリガーする可能性) - 0.9995 
→ 0.0 (Paper には Decay なし) - 20 000 → 30 000 
(cosine は maxIter の 100% で実行)

簡単に言うと

Q1.5 研究実験、Mip-Splatting テ
スト用に Paper マグニチュード 
Gaussian バジェット (1〜2 M) を
必要とします。Q1.5「closed no-
win」評決後、プリセットは 上級
ユーザーがアクセス可能なままで

すが、Production 推奨ではありま
せん。
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TP4 .fullMCMC

詳細

Production-Quality MCMC。Initializer に対するオー
バーライド: - 30 000 → 200 000 (V534、MCMC は 
Classic より 5× 多くの Iter が必要) - 15 000 → 
160 000 (V504b maxIter の 80%) - 1.6e-6 → 1.6e-5 
- LR スケジュール TP2 と同じ (すべて 2×) - 0.2 
→ 0.05 (V521b/V534: MCMC はより強い L1 信号が必
要) - [1K, 2K, 3K]  → [2K, 5K, 8K]  - .classic  
→ .mcmc  - 150 000 (Initializer ですでに、プリ
セットで確認) - 5e-5 (V467/V536 最適) - 0.005 
→ 0.01 (V535 最適) - 0 → 160 000 (maxIter の 
80%、V497c/V502) - 3.0 (Initializer ですでに) - true 
(Initializer ですでに) - 3 000 → 200 000 (事実上オ
フ、MCMC は Reset の代わりに Reloc を使用)

簡単に言うと

Web 配信、ディテール要求のある
オブジェクトキャプチャ、ドロー

ン飛行 (P9 Outdoor がさらに良
い場合でも)。同等の L1 で Classic 
より 71% 少ない Gaussian。

TP5 .fullMCMCMip

詳細

TP4 の Q1.5-D テスト兄弟、Mip-Splatting + Paper 
マグニチュード MCMC バジェット付き。TP4 に
対するオーバーライド: - mcmcMaxGaussians 150 
000 → 1 500 000 (10×、Paper マグニチュード) - 
useMipSplatting false → true (Mip オン)

簡単に言うと

他のすべてのフィールドは TP4 
と同じ。2026-05-24 Bicycle で 
Q1.5 D-PASS (12-Iter Multi-Scale 
FAIL ストリークを破る)。Q1.5 最
終判決 2026-05-25 でも closed-
no-win — Mip-Splatting 利益は 11 
ペアシーンにわたって再現できま

せん。 プリセットは opt-in のま
まです。

TP6 .classicBalanced

詳細

Mid-Tier Classic。TP2 に対するオーバーライド: - 35 
000 → 20 000 (V149: 20K = 30K で 33% 少ない時
間) - 20 000 → 0 (Cosine が maxIter = 20K で実行、 
拡張フェーズなし)

簡単に言うと

短い待ち時間の標準ケース。V149 
をスイートスポットとして識別。
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TP7 .mcmcPreview

詳細

MCMC 診断。TP4 に対するオーバーライド: - 200 
000 → 60 000 (V494b) - 160 000 → 48 000 (80%) 
- 150 000 → 100 000 (V473b) - 160 000 → 40 000 
(V494b) - 3.0 → 2.0 (1.4.5: Preview = より軽いス
ケーリング)

簡単に言うと

TP4 または Scene-Class プリセッ
トが価値があるかを判断するため

に、素早く MCMC 結果を見ます。

TP8 .mcmcBalanced

詳細

Mid-Tier MCMC。TP4 に対するオーバーライド: - 
200 000 → 120 000 (V518) - 160 000 → 96 000 
(80%) - 160 000 → 96 000 (80%) - 3.0 → 2.5 
(Preview 2.0 と Full 3.0 の間)

簡単に言うと

完全な 200K 実行なしの MCMC。
~120 K 反復は品質と待ち時間の良
い妥協です。

TP9 .quickTest

詳細

純粋な機能テスト。Initializer に対するオーバーライド: 
- 30 000 → 1 000 - 15 000 → 500 - 2e-6 → 4e-6 
(0.25× 解像度用にキャリブレート) - 100 → 50 - 3 
000 → 100 000 (オフ、はるかに短すぎるため) - 1.0 
→ 0.25

簡単に言うと

サニティチェック「トレーニング

はまったく意味を持って開始する

か?」。M3 Ultra で < 30 秒の期間。
間違いなくぼやけて見えます。

メソッド:

シグネチャ: public func resolveMcmcMaxGaussians(initialPointCount: Int, 

bufferCapacity: Int) -> Int 定義場所:

技術詳細  「MCMC が最大どれだけの Gaussian を成長させられるか?」の質問への 唯
一の Source-of-Truth。3 つの入力から計算: 構成された T62 mcmcMaxGaussians (0 の
場合 Mass-Extinction Floor 150 000 付き)、 (SfM 初期点の数)、 (事前割り当てされた 
Gaussian バッファサイズ)。ロジック:

1. base = T62 > 0 ? T62: 150_​000 (Mass-Extinction Floor は 1.4.3 Mass-Extinction 事
故などの Initializer デフォルトバグを防ぎます)

2. T73 mcmcAutoScaleByScene && initialPointCount > 0 && T72 mcmcCapMultiplier 

> 0 の 場合: - scaled = max(base, ceil(initialPointCount × T72)) そうでなければ
3. bufferCapacity > 0  の場合: return min(scaled, bufferCapacity)
4. そうでなければ return scaled
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例: Bicycle (Mip-NeRF 360、194 写真フレーム) → SfM-init ~156 K 点、 T62 = 150 000 、
T72 = 5.32 、、バッファ容量 8 M。Resolved Cap = min(8M, max(150K, ceil(156K × 
5.32))) = min(8M, 830K) = 830 K。これが MCMC Relocation ロジックが従う実効成長 
Cap です。

簡単に言うと  MCMC での実際の最大 Splat 数を計算します。設定を取り、シーンが最初にど
れだけの点を持つかを見て、 自動調整がオンの場合は Multiplier  でスケーリングします。
これにより、小さなシーンと 巨大なシーンに同じ値を強制する代わりに、Cap がシーンに
適応します。メソッドを自分で 呼び出す必要はありません — トレーニングが内部で使用し
ます。

どのフィールドが何のためか? (チートシート)

目的 調整するフィールド

遠くでより多くの

ディテール

T62 mcmcMaxGaussians 高、 T72 mcmcCapMultiplier 5+

一般的により多

くのディテール 
(Classic)

T1 maxIterations  高 (≤ 40K)、 T2 densifyUntilIteration T1 
の ≤ 14%

ドローン飛行で 
Floater を削減

T43 frustumCullEnabled オン、 T20 skyMaskingEnabled オン、
T45 skyDomeEnabled  オン

屋外シーンの美しい

空

T45 skyDomeEnabled  オン、 T47 skyDomeRadiusMultiplier 
30〜60

小さいエクスポート

ファイル

戦略 .mcmc  (T61)、 T56 postTrainingCompactification オン、
T62 mcmcMaxGaussians ≤ 200K

より速いトレーニン

グ

T22 trainingRenderScale 0.5、 T1 maxIterations  半分 — ただ
し両方ではない!

より良いハイライト T21 shDegreeUpgradeIterations を [2K, 5K, 8K]  (early-front-
load なし)、MCMC + 200K iter

Mac を応答可能に
保つ

T25 throttleDelayMs 5〜10 (~15% のトレーニング時間をコスト)

より頻繁なライブプ

レビュー

T59 livePreviewInterval 10〜20 に下げる

シャドウでより柔ら

かい遷移

T17 ssimWeight  少し高く (0.15〜0.25)、ただし 0.3 を超えない

室内をコンパクトに

保つ

P10 Indoor プリセット (、 T72 = 1.76 )
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危険なフィールド

これらのフィールドは、誤って構成された場合、OOM、アプリクラッシュ、Gaussian の 
Mass-Extinction、または使用できないベンチマークデータにつながる可能性があります。 
慎重に扱ってください:

• T11 densifyGradThreshold — 半分にすると 2〜4× の Gaussian を生成し、 GPU メモリ
を急速に圧迫する可能性があります。また注意: T22 trainingRenderScale に 一致する必
要があります (1.0× → 1e-6、0.5× → 2e-6、0.25× → 4e-6)。

• T72 mcmcCapMultiplier — > 200 K の SfM-init 点と Multiplier > 5 を持つ大きなシーン
では、数百万の Gaussian の Resolved Cap が形成されます。 36 GB RAM Mac では 
OOM の可能性。Outdoor プリセット 5.32 は Mip-NeRF-360-Bicycle が 156 K init 点を
持つためにのみ機能 → 830 K Cap。

• T39 testViewIndices — 手動設定はベンチマークを使用不可にする可能性 があります (す
べてのインデックス > N → Holdout なし)。 --benchmark  フラグに 設定させてください。

• T64 mcmcOpacityRegWeight および T65 mcmcScaleRegWeight — 1.4.3 ベータでは 0.01 に
設定され、Mass-Extinction (1 反復で 460 K → 5 Gaussian) に つながりました。1.4.4 以
降 0.0 に固定されていますが、手動で増加させると問題を 再現できます。

• T15 opacityResetInterval — 100 000+ (事実上オフ) でなく、トレーニング が 10 000 
反復より短い場合、Reset が収束を破壊します。 .preview  は maxIterations = 5 000 
にもかかわらず、そのため 100 000 を持ちます。

• T54/​T55 densifyPhase2* — Two-Phase Densification はテストで 0 Gaussian カスケー
ドで中止されました。両方を 0 のままにします。

• T74 useMipSplatting — Q1.5 closed-no-win 2026-05-25、一部の屋外 シーンで PSNR 
を悪化させることさえあります。デフォルトオフ、研究のみの opt-in。

このリストにあるフィールドを変更したい場合は、事前に現在のプリセットのバックアップ

を 作成 (JSON としてエクスポート) し、結果を再現可能に測定できるかを検討してください 
— そうしないと、後で改善または悪化を取得したかどうかわかりません。
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章

第 7章 — 内蔵品質プリセット

図 27:  4 つのグループがすべて展開されたプリセットセクション — CAPTURE CLASS (4 プ
リセット: Drone/Aerial、360° Walkaround、360° Walkaround (High Detail)、Photo/Object)、

CLASSIC (5 プリセット: Quick/Preview/Balanced/Quality/Ultra Detail)、MCMC (3 プリセット、
注記 「閾値チューニング不要」)、HYBRID (1 プリセット: Balanced (Hybrid))

画像で見えるもの  Inspector のプリセット セクションで、4 つのグループがすべて展開されてい
ます。CAPTURE CLASS には 4 つのキュレーションされた実世界プリセット (Drone / 
Aerial、360° Walkaround、 360° Walkaround (High Detail)、Photo / Object) が並びます 
— これがプライマリ グループで、Simple モードで唯一表示されるものです。CLASSIC に
は Quick (1K 反復)、Preview (5K 反復、青いチェックマークでアクティブ選択)、 Balanced 
(20K 反復)、Quality (35K 反復)、Ultra Detail (35K 反復) が 並びます。MCMC には
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副題「閾値チューニング不要」が付きます — MCMC では Densify-Until 閾値は不要
です: Preview (60K 反復、100K ガウシアン)、 Balanced (120K、150K)、Quality (200K、
150K)。HYBRID には Balanced (Hybrid) (20K 反復、150K ガウシアン) があります。フッ
ターの アクション行: Save…、Export…、Import…

プリセットとは、トレーニング用に準備された設定のことです。RadianceKit には 4 つの
グループに分かれた 13 個の内蔵プリセットが付属しています — 4 つの Capture-Class プ
リセット (P9〜P12) — 実際の コミュニティ素材で目視検証された、実世界の撮影タイプ (ド
ローン、360° ウォークアラウンド、写真オブジェクト) 向けのキュレーションされたレシピ
で、 v1.6 以降のプライマリ軸です —、5 つの Classic プリセット (P1〜P5: Quick/Preview/
Balanced/Quality/Ultra Detail)、3 つの MCMC プリセット (P6〜P8)、そして Classic 戦略
と MCMC 戦略を組み合わせた 1 つの ハイブリッドプリセット (P13) です。以前の「Scene-
Class」プリセット (Render/3D、Outdoor、Indoor。Phase Q7 で Mip-NeRF-360 シーンと 
NeRF-Blender シーンに対して学術的にチューニング) は、v1.6 で可視グループ として撤
回されました — 実素材で目視検証された Capture-Class が 現在のプライマリ軸であり、Q7 

チューニング済み構成は内部にのみ保持されます。 これらはサイドバーの プリセット 領域、
または Simple モードの インポート時に選択できます。 +  ボタンで独自プリセットを並べ
て作成する ダイアログが開きます — 13 個の内蔵プリセットは削除できませんが、 複製は可
能です。

エキスパートビューでは、プリセットは撮影タイプと戦略 (Capture Class / Classic / 
MCMC / Hybrid) ごとにグループ化されて表示されます。 項目をクリックすると、保存され
ているトレーニング構成が現在の状態に 書き込まれます。これはスナップショットではない
ので、その後スライダーを 動かすと状態は変化しますが、プリセット自体は変更されません。
カラフルな ヒントが「modified」と表示されます。

どのプリセットがいつ正しいかは、主にシーンタイプとハードウェアに依存します。 章末の 
3 つの表形式の概要にまとめてあります。
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P1 — Quick

場所

Inspector → プリセットセクション → 「Classic」グ
ループ → 「Quick」項目。UUID 接尾辞 …001 。

技術詳細

1 000 反復、クラシック (適応的) Densification 戦略、
トレーニング 解像度スケーリング 0.25× (入力画像
はトレーニング前に 25 % に縮小) を使用する 診断
用プリセット。シーンを納品するためのものではな

く、セットアップ (カメラポーズ、 点群、画像シー
ケンス) が Loss 値に意味のある動きをもたらすかど
うかを素早く確認する ためのものです。M3 Ultra では 
50〜200 枚の画像で通常 30 秒未満。低解像度では 実
際の画像品質はわかりませんが、メモリ消費とレンダ

リング負荷は非常に低く保たれます。 システムの RAM 
が 10 GB 未満の場合、初回起動時に自動的にデフォル
トとして 選択されます。

簡単に言うと

素早い動作テスト。画像を投入

し、30 秒弱待ち、シーンの大ま
かな輪郭が 表示されるかを確認し
ます。ビューワーの画像がぼやけ

た塊のように見えたら — それで
正常です。それに対して、暗い点

だけが見える、または完全に歪ん

だ形が 見える場合、おそらくカメ
ラポーズが間違っています (第 9 
章参照)。見せられる 結果を得る
には、その後最低でも P2 か P3 が
必要です。

P2 — Preview (Classic)

場所

Inspector → プリセットセクション → 「Classic」グ
ループ → 「Preview」項目。UUID 接尾辞 …002 。

技術詳細

5 000 反復の Classic Densification、0.5× 解像度
スケーリング、 標準に対して 2 倍の学習率。
Densification (クローン + 分割) は最初の 2 500 反復
で アクティブで、その後は Pruning のみです。RAM ≥ 
10 GB のシステム用デフォルト プリセット。M3 Ultra 
では 200 枚の画像シーンで通常 90 秒〜3 分。形状と
カメラ ポーズの使える印象を提供しますが、テクス
チャは目に見えてぼやけます — 0.5× レンダリング解像
度は、後で P3 や P4 で再トレーニングしても直接回避
できません。 なぜなら学習率が半解像度に合わせて調
整されているからです。

簡単に言うと

「ちょっと見るだけ」の標準。新

しい画像をインポートしてシーン

が そもそも再構築可能かを見た
い場合、これが正しいレベルで

す。約 2〜3 分待ち、 その後 3D 
ビューワーで回転させて、追加の

トレーニング実行を投資する価値

があるかを 判断できます。プレ
ビュー結果がすでに良く見えてか

ら初めて、Balanced や Quality を
行う価値があります。
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P3 — Balanced (Classic)

場所

Inspector → プリセットセクション → 「Classic」グ
ループ → 「Balanced」項目。UUID 接尾辞 …005 。

技術詳細

フル画像解像度で 20 000 反復の Classic 
Densification。 Densification は最初の 15 000 反復
で実行され、Iter 3 000 から Densify 間隔 100 で 実
行されます。記録されたトレーニングセッションで

の経験的「スイートスポット」: Horse Full と Truck で
のクラシック Densification では、L1 Loss は Iter 18 
000〜 22 000 で安定し、より長いトレーニングは 
Quality (P4) 未満で大きな改善をもたらしません。 M3 
Ultra では 200 枚の画像で通常 30〜60 秒、1 000+ 枚
の画像で 5〜8 分。

簡単に言うと

「良い妥協点」。ほとんどのシー

ンはこれですでに良く見え、1 時
間 待つ必要はありません。最終結
果をどこかに見せたい場合 (ソー
シャルメディア、 ウェブサイト、
顧客デモ) には、しばしばこれで
十分です。Splat モデルにズーム
インしたい、 または表面テクス
チャの詳細が必要な場合に初め

て、P4 Quality または P7 MCMC 
への ジャンプが価値を持ちます。

P4 — Quality (Classic)

場所

Inspector → プリセットセクション → 「Classic」グ
ループ → 「Quality」項目。UUID 接尾辞 …003 。

技術詳細

V546「Opacity Decay」(HTGS、Eurographics 
2025) を使用した 35 000 反復の Classic 
Densification: 各 Densify サイクル後、すべての既存 
Gaussian の Opacity に < 1.0 の係数が掛けられ、これ
により非アクティブになった Gaussian が Pruning で
確実に削除され、同じ反復数で従来の 35 000 反復
より 14 % 良い L1 Loss を達成します。SSIM Loss が
有効化されています ( ssimWeight=0.05 )。M3 Ultra 
では 200 枚の画像で通常 2〜4 分。NeRF-Blender 
(Lego、Chair、Drums) で最終 L1 ≈ 0.023 を提供 — 
560+ の記録済み実験で 最高の Classic バリアント。
注意: 約 3〜5 GB の GPU メモリが必要。8GB システ
ムでは P3 が安全な選択です。

簡単に言うと

最高のクラシックバリアント。鋭

いテクスチャと細かい形状を提

供します。 特にオブジェクト撮
影 (彫刻、椅子、花瓶) に向いてい
ます。一方、大きな屋外シーンや 
部屋では、Balanced との違いは
ほとんど感じられません — そこ
では MCMC プリセット (P6〜P8) 
または Capture-Class プリセット 
(P9〜P12) への切り替えが、P3 か
ら P4 への ジャンプより価値が
あります。Classic ファミリーの
絶対的な最大値が欲しい場合は、 
P5 Ultra Detail を選びます。
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P5 — Ultra Detail (Classic)

場所

Inspector → プリセットセクション → 「Classic」グ
ループ → 「Ultra Detail」項目。UUID 接尾辞 …008 。

技術詳細

約 35 000 反復の Classic Densification — 品質マト
リクスの Held-out 実行 (2026-06-10) の勝者。テス
トした 3 つの Mip-NeRF-360 シーンすべてで、 Ultra 
Detail は同等のウォールクロック時間で内蔵 MCMC
「Quality」プリセット (P8) を 約 +0.94 dB PSNR 上回
ります。これにより、Classic グループで最も強力な 
Quality プリセットであり、RadianceKit が提供する最
もシャープな Classic バリアントとなっています。M3 
Ultra では P4 Quality と同じ時間枠 (200 枚の画像で 
2〜5 分) ですが、やや多くの GPU メモリが必要です。
8GB システムでは P3 が安全な選択のままです。

簡単に言うと

最もシャープな Classic レベル
であり、品質テストの Held-
out 勝者です: 実シーンで MCMC
「Quality」バリアントより約 1 
デシベル良く — 同程度の待ち
時間で。 実績あるクラシック 
Densification で最大の細部忠実
度が欲しく、十分な GPU メモリ
が あるなら、これが第一選択で
す。メモリが足りない、またはで

きるだけ小さい エクスポートファ
イルが必要な場合は、P4 Quality 
または MCMC プリセットに 留
まってください。

P6 — Preview (MCMC)

場所

Inspector → プリセットセクション → 「MCMC」グ
ループ → 「Preview」項目。UUID 接尾辞 …006 。

技術詳細

60 000 反復の MCMC Densification (3DGS-MCMC、
NeurIPS 2024)、 Gaussian 上限 100 000。MCMC は
ヒューリスティックなクローン/分割ロジックを マル
コフ連鎖モンテカルロ再配置に置き換えます: 死んだ 
Gaussian は Sigmoid 重み付き サンプリング深度を介
して再配置され、制御された再現可能な数の Gaussian 
が 得られます。上限は最大数を 100K で強くキャップ
します — これによりメモリと レンダリング時間が節約
されますが、細部が失われます。M3 Ultra では 200 枚
の画像で 通常 5〜8 分。「MCMC 機能テスト」として
適しています — Classic から MCMC への 切り替えが
意味があるかを判断するのに役立ちます。P7 や P8 に
時間を投資する前に。

簡単に言うと

P2 Preview と同じですが、新し
い MCMC 手法を使用しています。 
Classic バリアントよりもしばし
ばよりコンパクトで均等に分布

した Splat 雲を 提供します。シー
ンの最初の評価には、5〜8 分で
ほとんどの場合十分です。 プレ
ビュー結果が気に入ったら、次の

ステップは P7 (Balanced) または
直接 P8 (Quality MCMC) です。
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P7 — Balanced (MCMC)

場所

Inspector → プリセットセクション → 「MCMC」グ
ループ → 「Balanced」項目。UUID 接尾辞 …007 。

技術詳細

120 000 反復の MCMC、Gaussian 上限 150 000。中
間 MCMC レベル — P8 Quality とほぼ同じ最終 
Gaussian 数ですが、反復回数は 60 % のみ。記録さ
れた トレーニングセッションでは、Horse Full での L1 
Loss は経験的に 0.026〜0.028 で、 P8 の 0.0246 と
比較して約 7 % 高く、その代わり待ち時間は半分です。
M3 Ultra では 200 枚の画像で通常 8〜15 分。実効的
な Gaussian 上限を入力 SfM 点群の点密度に スケーリ
ングする手法を使用します (第 6 章 T75 参照)。

簡単に言うと

P8 の長い完全実行なしで、適度
な細部の MCMC。ほとんどのシー
ンでは これで十分です。特に 
MCMC 実行を昼休みの時間枠に収
めたい場合に。メモリが 不足して
いる場合 (例えば 16 GB のみの M 
プロセッサ) は、ここに留まって
ください — P8 はより多くの GPU 
メモリが必要です。

P8 — Quality (MCMC)

場所

Inspector → プリセットセクション → 「MCMC」グ
ループ → 「Quality」項目。UUID 接尾辞 …004 。

技術詳細

200 000 反復の MCMC、Gaussian 上限 150 000、
SSIM Loss 0.05、 反復の 80 % にわたる MCMC ノ
イズ減衰。560+ 実験での最良単独実行 L1: Horse Full 
で 0.0238、3 試行平均で 0.0246 (同じシーンで P4 
0.0230 に対して)。 MCMC は 71 % 少ない Gaussian 
(150K 対 約 524K) を提供します — これは、結果を 
ウェブで配信したい場合に決定的です。なぜなら、よ

り小さな雲は大幅に小さい エクスポートファイルを
生成するからです。M3 Ultra でのトレーニング時間
は 200 枚の画像で通常 20〜35 分。1 000+ 枚の画像
セットでは 1〜2 時間程度。 最小の最終サイズで最大
の画像品質が必要な場合の最良の選択。

簡単に言うと

最高の MCMC バリアント。非常に
クリーンでコンパクトな Splat 雲
を 提供します — 結果を後で Web 
3D ビューワーに埋め込んだり、
ファイルとして 送信したい場合に
理想的です (ファイルは同等の視
覚品質で P4 Quality より小さい)。 
しかし、忍耐が必要です — 大き
な撮影では 1 時間以上の待ち時
間。 「夜通しの実行」として計画
してください。
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図 28:  CAPTURE CLASS グループが展開され、4 つのキュレーションされた実世界 プリ
セットすべて — Drone / Aerial (MCMC、40K 反復、上限 1.5 M)、 360° Walkaround (MCMC、
40K、上限 1.5 M)、360° Walkaround (High Detail) (Hybrid、40K、上限 1.5 M、オプトイン)、
Photo / Object (Hybrid、40K、 上限 1.5 M)。このグループは一番上にあり、Simple モードで唯

一表示される ものです。

画像で見えるもの  CAPTURE CLASS グループが 展開された Inspector — v1.6 以降のプライマ
リプリセットグループで、Simple モードで唯一表示されるものです。各項目は、特定の撮影
タイプ (ドローン、360° ウォークアラウンド、写真オブジェクト) 向けに実際のコミュニ
ティ素材で目視 検証されたレシピであり、学術的なテストセットに対して最適化された値で
は ありません。クリックで選択すると、保存されているトレーニング構成が 現在の状態に
書き込まれます。

171 / 227



R A D I A N C E K I T 第 7章 — 内蔵品質プリセット

P9 — Drone / Aerial

場所

Inspector → プリセットセクション → 「Capture 
Class」グループ → 「Drone / Aerial」項目。UUID 接
尾辞 …010 。

技術詳細

建物や風景の空撮・ドローンオービット用の Capture-
Class プリセット。 MCMC Densifier、40 000 反
復、上限 150 万 Gaussian、SSIM Loss 0.5 に加え
て Edge-Aware 項 0.1。決定的なのは、比率閾値 6 で
重み 0.003 の異方性ペナルティです — ドローン素材が
生成する典型的な針状アーティファクトに対する「ス

パゲッティ キラー」です。Pensford 高架橋上の実際の 
DJI 4K ドローン飛行で検証済み (計量的だけでなく目
視でも確認)。

簡単に言うと

空からの撮影用 — 建物の周りの
ドローン飛行、風景上、ファサー

ドに 沿って。強力な異方性ペナ
ルティが、ドローン素材がよく生

成する針状・スパゲッティ 状の
アーティファクトを取り除きま

す。素材が地上から撮影されてい

る場合は、 Photo / Object または 
Classic プリセットの方が適して
います。

P10 — 360° Walkaround

場所

Inspector → プリセットセクション → 「Capture 
Class」グループ → 「360° Walkaround」項目。UUID 
接尾辞 …011 。

技術詳細

360° ウォークアラウンド動画用の Capture-Class プ
リセット。 MCMC Densifier、40 000 反復、上限 150 
万 Gaussian、SSIM Loss 0.5 に加えて Edge-Aware 項 
0.1、穏やかな異方性ペナルティ (比率閾値 15 で重
み 0.001)。 人物マスクと空マスクが有効です。このプ
リセットは 360° の equirect 動画を 想定しており、ト
レーニング開始前に内部で約 90° 幅の透視クロップに
再投影されます。 セルフィースティックでの 8K 360° 
ウォークアラウンド (Monument シーン、目視で確認) 
で 検証済み。

簡単に言うと

360° ウォークアラウンド動画
用 — 360° カメラやセルフィー
スティックを 持って部屋の中や
オブジェクトの周りを歩きます。

RadianceKit は球面パノラマを 自
身で通常の視点に分解し、通行人

や空をマスクで除去します。同じ

素材で最大の シャープさを得るに
は、追加で High-Detail バリアン
ト (P11) を試してください。
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P11 — 360° Walkaround (High Detail)

場所

Inspector → プリセットセクション → 「Capture 
Class」グループ → 「360° Walkaround (High 
Detail)」項目。UUID 接尾辞 …013  (オプトイン)。

技術詳細

最大の細部を持つ 360° ウォークアラウンド動画
用のオプトイン Capture-Class プリセット。Hybrid 
Densifier (クラシックな Abs 勾配の クローン/分
割 + MCMC ノイズ + 再配置)、40 000 反復、上限 
150 万 Gaussian、 比率閾値 15 で異方性ペナルティ 
0.0015、SSIM Loss 0.2、Edge-Aware 項 0 — ロック
された「r50」スクリーン分割レシピ。360° 素材では、
標準 MCMC プリセット 「360° Walkaround」(P10) 
を PSNR、LPIPS、目視のコンフェッティで上回り、し
かも Splat 数は約 3 分の 1 です。より多くのシーンで
検証されるまで、標準 360 プリセットの 隣に 意図的
にオプトインとして配置されています。

簡単に言うと

標準 360 プリセット (P10) のより
シャープな代替: より多くの細部、 
より少ないコンフェッティ、大幅

に小さいファイル。置き換えるの

ではなく意図的に 並べて配置さ
れています — これまでに数える
ほどのシーンで確認されました。 
360° ウォークアラウンドがきれ
いに撮影されているなら、まずこ

のプリセットを 試して、結果を 
P10 と比較してください。

P12 — Photo / Object

場所

Inspector → プリセットセクション → 「Capture 
Class」グループ → 「Photo / Object」項目。UUID 接
尾辞 …012 。

技術詳細

シャープな単独写真 (動画ではない) からのオブ
ジェクトオービット用の Capture-Class プリセット。
Hybrid-t1 Densifier (再配置あり)、40 000 反復、 上
限 150 万 Gaussian、SSIM Loss 0.5 に加えて Edge-
Aware 項 0.1、穏やかな 異方性ペナルティ (比率閾
値 15 で重み 0.001)、50 反復ごとの Opacity Decay 

0.9995、 マスキング なし。骨格の 163 枚の高解像度 
41MP 写真 (目視で確認) で検証済み。 少数のビュー 
(約 600 まで) は Hybrid 崩壊閾値を下回ったままです。

簡単に言うと

シャープな単独写真からのオブ

ジェクト撮影用 — 彫刻、模型、
製品を カメラで一周し、動画では
なく写真を撮ります。シャープな

写真は通常きれいな背景を 持つた
め、マスキングなし。動画ソース

には代わりに 360° または Drone 
プリセットを 使ってください。
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P13 — バランス（ハイブリッド）

場所

Inspector → プリセットセクション → 「ハイブリッ
ド」グループ → 「バランス（ハイブリッド）」項目。
UUID 接尾辞 …009 。

技術詳細

20 000 反復のハイブリッド Densification 戦略: 古
典的な勾配駆動のクローン/分割が Loss の必要とす
る場所に容量を配置し、 MCMC SGLD ノイズが探
索を続け、死んだ Gaussian はプルーニングで失わ
れる 代わりに再配置されます。Opacity Decay (V546) 
が Opacity リセットを 置き換え、異方性ペナルティ 
(重み 0.001、比率閾値 15) が針状の Splat を 抑制しま
す。Gaussian 上限はシーンに応じてスケーリングさ
れます (ベース 150K、シーン認識 ×3.0)。同じ予算
の純粋な MCMC に対して 5 つのシーンで検証済み: 平
均で +0.45 dB PSNR、Gaussian は 20〜30 % 少なく
なります (stonehenge +1.23、family +0.82、garden 
+0.47 dB)。 M3 Ultra では 200 枚の画像で通常 5〜10 
分。

簡単に言うと

最終結果のための強力な第一選択: 
MCMC プリセットよりシャープな
細部を 同程度にコンパクトなファ
イルで、しかも P8 のトレーニン
グ時間のほんの一部で 提供しま
す。品質実行に使える時間が 1 回
分しかなく、どの Capture クラス
も 明確に当てはまらない場合は、
ここから始めてください。素早い

テストには引き続き Classic プリ
セットが優れており、シーンがこ

れらの撮影タイプのいずれかに

明確に 一致する場合は Capture-
Class プリセット (P9〜P12) が第
一選択です。
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どのプリセットをいつ？

シナリオ 初期テスト メイン実行

新規画像の動作テスト、< 
30 秒

P1 Quick —

シャープな単独写真からの

オブジェクトオービット

P2 Preview P12 Photo / Object

単独オブジェクトスキャン 
(動画)、< 500 枚

P2 Preview P4 Quality または P8 
Quality MCMC

360° ウォークアラウンド
動画

P6 Preview MCMC P10 360° Walkaround 
(シャープ: P11 High Detail)

空撮/ドローンオービット、
風景

P6 Preview MCMC P9 Drone / Aerial

Web 配信 (小型、コンパク
ト)

P2 P8 Quality MCMC (フル品質
で最小ファイル)

短時間でシャープな細部、

コンパクトなエクスポート

P2 または P6 P13 バランス（ハイブリッド）

最大の細部忠実度、

Classic 戦略
P3 または P6 P5 Ultra Detail

印刷、マーケティング、フ

ルディテール

P3 または P6 P4 Quality (Classic) または 
P5 Ultra Detail
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クイック比較

プリ

セッ

ト

戦略 反

復

最大 
Gs

レンダ

リング 
Scale

典型 時間 (200 枚、M3 Ultra) Q-Sweep

P1 Quick Classic 1 000 ∞ 0.25× ~30 秒 —

P2 Preview Classic 5 000 ∞ 0.5× 2–3 分 —

P3 BalancedClassic20 000 ∞ 1.0× 30–60 秒 —

P4 Quality Classic35 000 ∞ 1.0× 2–4 分 V546 
HTGS

P5 Ultra 
Detail

Classic ~35 
000

∞ 1.0× 2–5 分 Matrix 
Δ+0.94 

dB

P6 Preview 
MCMC

MCMC60 000 100 
K

1.0× 5–8 分 —

P7 Balanced 
MCMC

MCMC 120 
000

150 
K

1.0× 8–15 分 —

P8 Quality 
MCMC

MCMC 200 
000

150 
K

1.0× 20–35 分 V544a

P9 Drone / 
Aerial

MCMC40 000 1.5 
M

1.0× 10–25 分 目

視 / Viadukt

P10 360° 
Walkaround

MCMC40 000 1.5 
M

1.0× 10–25 分 目

視 / Monument

P11 360° 
Walkaround 

(High 
Detail)

Hybrid40 000 1.5 
M

1.0× 10–25 分 目視 
(オプ
トイ

ン)

P12 Photo / 
Object

Hybrid40 000 1.5 
M

1.0× 10–25 分 目

視 / 
骨格

P13 
バラ

ンス

（ハ

イブ

リッ

ド）

Hybrid 20 000 150 
K

1.0× 5–10 分 Matrix 
Δ+0.45 

dB
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独自プリセット

プリセットセクション (第 2 章の I1) の Save… ボタンを介して、 現在のトレーニング構成
を独自プリセットとして保存します。独自プリセットは 「Built-in」ではなく、名前変更、
エクスポート (JSON として)、ドラッグ＆ドロップで 共有、複製、削除が可能です。13 個の
内蔵プリセット P1〜P13 は削除ボタンの 影響を受けません。

経験則: プリセットで変更したい要素を将来も使いたい場合 — Sky-Dome オン、特定のシー
ンクラス用の高い SSIM 重み、異なる反復数 — そのバリアントを独自プリセットとして保存
してください。そうすれば、次回の実行で すぐに、標準と異なる構成であることがわかり
ます。
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章

第 8章 — エクスポート形式

図 29:  Simple モードでのエクスポート形式選択 — 6 つの形式カード

図 30:  flowers ブーケで 5K 反復トレーニング後のライブエクスポート形式グリッド — 6 つ
すべてのカードに動的サイズ計算 (PLY 742 KB 選択、SPZ 74 KB、 glTF 708 KB、.splat 96 

KB、Orbit Video ~Zero KB、Web Viewer 133 KB)、 右側のエクスポート履歴にすでに保存され
た PLY

画像で見えるもの (2 991 Gaussian、SH degree 3、Bjoern の合成 Blender ブーケを IP 

クリーンテストセットとして): 各形式カードの下のサイズ表示は、 現在の Gaussian カウン
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トと形式オーバーヘッドからライブで計算されます — ハードコードではありません。
2 991 Gaussian (SH degree 3) から、742 KB PLY、 74 KB SPZ (量子化により約 10 倍小
さい)、708 KB glTF (KHR_​gaussian_​splatting 拡張により、ほぼ PLY 相当)、96 KB .splat 
(圧縮された Gaussian あたり 24 バイト形式) が生成されます。Orbit Video は、サイ
ズが MP4 エンコーディング後にのみ判明するため「~Zero KB」と表示されます。Web 
Viewer (133 KB) は、組み込み WebGL ビューアーと圧縮された Splat データを含む独
立した HTML ファイルをバンドルします — ビューアーオーバーヘッドのため、純粋な .splat 
より大きくなります。右側のエクスポート履歴には、すでに完了した PLY エクスポー
ト (「training_20260527T211321Z.ply、743 KB、23:13」) と形式ピル、 Finder で開くア
クションがリストされます。

完了したトレーニングは Gaussian Cloud を生成します — シーンを再構築する数十万 か
ら数百万の 3D ガウス分布のコレクションです。RadianceKit は、この Cloud を ディスクに
書き込む 10 通りの方法を知っています。そのうち 6 つは純粋な 3D データ 形式 (PLY、
Compressed PLY、SPZ、SOG、glTF、.splat)、1 つは Cloud を完成した HTML ビューアー
とともにバンドル (Web Viewer)、1 つは Orbit カメラ走行から MP4 ファイルを レンダリン
グ (Orbit Video)、2 つは Gaussian コンテンツをエクスポートせず、他の トレーニングパイ
プラインで再利用するための SfM 結果 (カメラポーズと粗い点群) のみを エクスポートしま
す (transforms.json + COLMAP Workspace)。

どの形式がいつ正しいかは、目的によって異なります。品質損失なしのフルデータ アーカイ
ブには PLY を使用します。自分のサイトの Web ビューアーには、通常 .splat または組み込
み Web Viewer で十分です。ファイルが最小である必要がある場合は、SPZ または SOG が
価値があります。Nerfstudio、Postshot、または Brush で SfM 結果を 再利用するには、
transforms.json と COLMAP Workspace が正しい方法です。

すべてのエクスポート機能は「Export」メニューと、Simple モードの最後のウィザード ス
テップにあります。ほとんどの形式は完全に Sandbox 準拠で、App Store バージョンで 動
作します。SOG のみ、App Store ビルドには必ずしも存在しない外部バイナリ ( cwebp ) が
必要です — 詳細は E4 を参照してください。
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E1 — PLY (.ply)

場所

メニューバー → Export → 3D Formats → Export 
PLY… (⌘E)。 Simple モード: ウィザードステップ 

Export → 形式カード「PLY」。 サイズ: 通常 100 % 

(基準値)。互換性: SuperSplat、PolyCam、すべての 
3DGS ビューアー。

技術詳細

PLY は 3D Gaussian Splatting の標準保存形式です。
RadianceKit は 標準化された 3DGS プロパティレイア
ウトを持つバイナリリトルエンディアン ファイルを
書き込みます: Gaussian あたり 3 成分の位置、常にゼ
ロに設定される 3 つの法線、基本 RGB 色用の 3 つ
の DC SH 係数 ( f_dc_0..2 )、続いて Kerbl 2023 論
文で定義された転置チャンネルメジャー配置で最大 
45 個の追加 SH 係数 ( f_rest_0..44 ) (まず R チャ
ンネル係数すべて、次に G、次に B)、続いて logit 
opacity (生の pre-sigmoid 値)、3 つの対数空間スケー
ル、wxyz クォータニオン 回転。最大エクスポート 
SH 次数は、ユーザー希望と実際に学習された次数の最
小値に クランプされます。デフォルトは 3 (45 個の 
Rest 係数)。書き込み前に、非常に 大きな Cloud での
オーバーフローを検出するため、ペイロードサイズが 
64 ビット 整数で計算されます。ファイルはアトミック
に書き込まれるため、大きな Cloud では ディスク容量
を一時的に倍占有します。

簡単に言うと

これは「オリジナルファイル」

です。最大ファイル、最高互換

性、損失なし。 どの形式を選ぶ
べきか分からない場合は、PLY を
選んでください — ほぼすべての 
3DGS ツールで開けます。100 万 
Gaussian の場合、SH 次数に応じ
て 200 から 800 MB になります。
ファイルが大きすぎる場合は、E2 
(圧縮 PLY) または E3 (SPZ) を ご覧
ください。
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E2 — Compressed PLY (.ply)

場所

メニューバー → Export → 3D Formats → Export 
Compressed PLY…。 Simple モード: 形式カード

「Compressed PLY」。 サイズ: PLY に対して約 10〜

20 % (5〜10 倍の圧縮)。 互換性: SuperSplat、
PlayCanvas エンジン、ウェブベースのビューアー。

技術詳細

チャンクごとの量子化を持つ PLY 形式の PlayCanvas 
バリアント。 Gaussian は 256 個のチャンクにグルー
プ化されます。チャンクごとに、位置、スケール、 色
の Min/Max 境界がヘッダーに個別に保存されます。
個々の Gaussian はこれらの 境界に対する値を参照し、
それぞれ 32 ビットに圧縮されます: 位置とスケールは 
11-10-11 ビットパッキング、回転は 2-10-10-10 ビッ
ト「Smallest-Three」 クォータニオン、色は 8-8-8-8 
RGBA。より高い SH 係数は、コンポーネントあた
り 8 ビットのみで量子化されます (Gaussian あた
り shCoeffCount * 3  uchar)。 形式自体は依然とし
て ASCII ヘッダー PLY であるため、PLY ツールで基本
的に検証 可能ですが、頂点プロパティは uint  フィー
ルドとして宣言されます。SH 次数は 圧縮を最大化す
るためデフォルトで 0 (Rest 係数なし) です — より高
い SH 次数を 明示的に選択できます。

簡単に言うと

スペース節約 PLY バリアント。通
常の PLY と同じエンジン互換性
ですが、 5〜10 倍小さいです。
SuperSplat と PlayCanvas はネイ
ティブに読み込みます。 Web デ
プロイには、通常の PLY よりほぼ
常に優れています。量子化による

品質損失は、 シーンが極端に高周
波の詳細を含まない限り、通常視

覚的に認識できません。
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E3 — SPZ (.spz)

場所

メニューバー → Export → 3D Formats → Export 

SPZ…。 Simple モード: 形式カード「SPZ」。 サイズ: 

PLY に対して約 10 % (90 % 小さい)。 互換性: Niantic 
Scaniverse、Niantic Spatial Fields、MetalSplatter。

技術詳細

Niantic の SPZ v2 形式。位置は 24 ビット固定小数点
としてパックされます (約 0.25 mm の解像度)、スケー
ルは対数空間で 8 ビット量子化、回転は 8 ビット 
Smallest-Three (v2 では xyz のみが保存され、w は 
Decoder でクォータニオン ノルムから導出される)、
Opacity はシグモイド化された 8 ビット値。DC SH は 
SPZ 固有のパック式 (dc_​raw * 0.15 * 255 + 0.5 * 
255) で保存され、より高い SH バンドは係数あたり 5 
ビット (Band 1) または 4 ビット (Band 2-3) で保存 さ
れます。全パックされたバイナリブロブは、標準 gzip 
(RFC 1952) で圧縮され、 Magic Bytes 1f 8b  を持つ 
gzipped コンテナ形式が生成されます。Apple の組み
込み zlib API が独自の Apple フレーミングを生成し、
Spatial Fields や MetalSplatter の SPZ リーダーと互
換性がないため、RadianceKit はシステム gzip  を呼
び出します。 システム gzip  は macOS Sandbox 内
でも spawn 可能です。

簡単に言うと

最小の標準ファイル。Niantic の 
Scaniverse を知っている場合 — 
これはそのアプリが使用する形

式です。非常に小さく、モバイ

ルアプリにとって ロードフレン
ドリーです。Niantic 独自のクラ
ウドビューアー (Spatial Fields) で 
直接使用可能です。同じデータの 
PLY より約 90 % 小さく、ほとん
どのシーンで 視覚的にほとんど区
別できません。
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E4 — SOG (.sog)

場所

メニューバー → Export → 3D Formats → Export 

SOG…。 Simple モード: 形式カード「SOG」。 サイズ: 
PLY に対して約 5〜6 % (15〜20 倍圧縮 — 最小のオプ

ション)。 互換性: PlayCanvas エンジン、SuperSplat 
エディター。

技術詳細

「Spatially Ordered Gaussians」— Cloud を複数の 
Lossless WebP 画像で GPU ready に保存する 
PlayCanvas 形式です。まず、すべての Gaussian が 
3D Morton コード (30 ビット Z-Order、軸あたり 
10 ビット) で空間的にソートされ、 画像にレンダ
ラーでの後のキャッシュ局所性が与えられます。次

に、位置は対称対数変換 (より良いダイナミックレ
ンジのため) で 16 ビット値に量子化され、2 つ
の RGBA 画像に分割されます ( means_l.webp  は下
位 8 ビット、 means_u.webp  は上位)。 回転は、3×8 
ビット + 2 ビットモードを持つ Smallest-Three と
して RGBA 画像に エンコードされます (モードは
アルファに 252 + largest  として配置されます)。 ス
ケールと DC SH は、それぞれ 256 エントリのコー
ドブック (パーセンタイル ベースですべての値にわたっ
て分散) で量子化され、インデックスは scales.webp  
と sh0.webp  に配置されます。5 つの画像とコード
ブックと境界を含む meta.json  は、 ZIP ファイル 
(Sandbox がシステム zip  をブロックするためカスタ
ムエンコーダー) に パックされ、拡張子 .sog  で保存
されます。

Sandbox 注意: SOG は、外部バイナリを必要とする唯
一の形式オプションです。 WebP エンコーダーステー
ジは、/​usr/​local/​bin/​cwebp または /​opt/​homebrew/​
bin/​cwebp から cwebp  を呼び出します。cwebp バイ
ナリが見つから ない場合、コードは生の PNG エン
コーディングにフォールバックします — しかし: PNG 

フォールバックは SuperSplat で動作しません。 App 
Store バージョンでは、ビルドバリアントに基づい
て可用性を評価します。 Developer バリアントでは、
cwebp を Homebrew 経由でインストールする必要が
あります ( brew install webp )。

簡単に言うと

SPZ よりかなり小さい、最小の 
3DGS 形式。しかし: RadianceKit 
自体が すべての画像形式を生成
できないため、Mac 上に cwebp  
ツールが必要です。 Homebrew 
で一度インストールすれば、す

べて動作します。App Store バー
ジョンでは 完全に機能しない可
能性があります — エクスポー
ト時に WebP の代わりに PNG 
が 出力される場合、ファイル
を SuperSplat で直接開けません。
Homebrew なしで作業する 場合
は、代わりに SPZ (E3) を使用して
ください。
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E5 — glTF (.glb)

場所

メニューバー → Export → 3D Formats → Export 

glTF…。 Simple モード: 形式カード「glTF」。 サイズ: 

PLY と同等。互換性: KHR_​gaussian_​splatting 拡張 
(Khronos ドラフト標準) を持つ glTF ビューアー。

技術詳細

KHR_​gaussian_​splatting 拡張仕様に従って、自己完
結型の .glb  バイナリ ファイル (別の bin ファイ
ル添付なし) を書き込みます。位置は通常の glTF 
POSITION  頂点データ (float3) として保存され、他の
すべての属性 (回転は float4、 スケールは float3、
Opacity は float、SH 係数は float3 × shCoeffCount) 
は追加の 頂点属性に配置され、拡張経由で参照さ
れます。重要: glTF は右手座標系 Y-up を 使用し、
COLMAP/3DGS は Y-down/Z-forward で動作します。
そのため、エクスポーターは X 軸周りの 180 度回転を
適用します — 位置は (x, -y, -z)  で書き換えられ、 
クォータニオンは (w, x, -y, -z)  に調整されます。
これにより、glTF ビューアーで 幾何学的に正しく、右
手 (鏡像ではない) 表現が得られます。GLB 標準で要求
される通り、 JSON とバイナリチャンクは 4 バイトア
ラインメントにパディングされます。

簡単に言うと

Khronos の 3D データ用公式標
準形式で、Gaussian Splat 用の
新しい拡張 付きです。利点: 
glTF はすべての主要な 3D エ
ンジン (Babylon.js、Three.js、Unity、 
Unreal) に普及しています。欠点: 
2026 年時点で拡張はまだドラフ
ト段階で、多くの ビューアーがま
だ対応していません。特に既存の 
glTF パイプラインに Splat データ
を 統合する、またはすでに glTF 
対応のビューアーを書く場合に有

用です。
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E6 — Splat (.splat)

場所

メニューバー → Export → 3D Formats → 
Export .splat…。 Simple モード: 形式カード

「.splat」。 サイズ: Gaussian あたり正確に 32 バ

イト。互換性: gsplat.js、ウェブベースのビューアー 
(antimatter15 リファレンス)、ほとんどの ブラウザ 
3DGS デモ。

技術詳細

antimatter15 .splat  形式 — Gaussian あたり 32 バ
イト、ヘッダーなし、 間接化なし。エントリごとの
レイアウト: 3 × float32 位置 (世界座標)、 3 × float32 
スケール (内部バッファの対数空間から exp 変換)、4 
× uint8 RGBA 色 (DC SH 係数を SH_C0 = 0.282...  
でスケーリングし、[0,255] にクランプ)、 4 × uint8 
クォータニオン (w,x,y,z、正規化して 128 + 128*q  
でバイト範囲に エンコード)。DC SH のみが保存さ
れます — より高い SH バンドは破棄されます。 これに
より形式は非常にコンパクトになりますが、反射や鏡

面ハイライトで発生する ビュー依存の色変化が失わ
れます。書き込み順序は Cloud のインデックス順序
と 正確に同じ (空間ソートなし) で、 gsplat.js  のよ
うな Web ビューアーはそれに 基づいてレンダリングし
ます。

簡単に言うと

gsplat.js  を使用して自分の 
Web ビューアーで Splat を表示し
たい場合の 最適な形式。非常にコ
ンパクト (Gaussian あたり 32 バ
イト) ですが、より高い SH 次数は 
ありません — したがって、視点
に応じた光沢のある反射や微妙な

色の変化はありません。 ほとんど
の Web アプリケーションでは問
題ありません。なぜなら、DC 色
で十分であり、 ビュー依存の欠如
はほとんど目立たないからです。
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図 31:  Firefox で開かれた Web Viewer — Bjoern のブーケ Splat が周囲の カメラマーカー球と
ともにレンダリングされ、上部にブラウザのタブバーが 表示され、CDN/サーバーセットアップ
は不要。スタンドアロンの flowers-01.html  が Finder からデフォルトブラウザでダブルク
リックして 直接開かれました — 組み込みの WebGL2 プログラムは、ネットワークや サーバーな
しですぐに Gaussian Cloud をレンダリングします。ブーケの 周りの黒いマーカーはトレーニング

カメラで、オプションで表示できます。 マウスドラッグで回転、スクロールでズーム。
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E7 — Web Viewer (.html)

場所

メニューバー → Export → Media → Export Web 
Viewer…。 Simple モード: 形式カード「Web 

Viewer」。 サイズ: base64 エンコードされた Splat 
データ (≈ 4/3 オーバーヘッド) + 約 5 KB HTML/JS 

シェル。互換性: WebGL2 対応のすべての最新ブラウ
ザ (すべてのデスクトップ、iOS 15+、Android 5+)。

技術詳細

Gaussian Cloud を完全にインラインで書かれた 
WebGL2 レンダラーと一緒に、 単一の .html  ファイ
ルにバンドルします。CDN 依存性、WASM、2 番目
のファイルは ありません。Cloud は内部的に最初
に .splat  バイナリ (E6 と同じ 32 バイト ロジッ
ク) としてエンコードされ、次に base64 で埋め込ま
れ、ブラウザで atob  で デコードされます。組み込み
レンダラーは独自の WebGL2 ソート、マウスオービッ
ト 制御、フレームごとの CPU ソートを実行しま
す。すべての JS コード (シェーダー、 数学、ルー
プ) は出力 HTML で表示されます。ストレージとレン
ダラーの境界での 軸規約は E5 と完全に同じです: 位置 
(x, -y, -z) 、クォータニオン (w, x, -y, -z) 。 
オプションで、ブランディングオーバーレイを表示で

きます (Free Tier スイッチ)。 すべてがインラインなの
で、ファイルは file:/​/​ プロトコルから直接動作しま
す — テストにローカル Web サーバーは不要です。

簡単に言うと

誰かにメールで送ったり、ウェブ

サイトに埋め込んだりできる単一

の HTML ファイルです。Finder で
ダブルクリックすると、ブラウザ

がマウス回転でシーンを 表示しま
す。クラウドへのアップロード不

要、2 番目のファイル不要、サー
バー不要。 顧客プレゼンテーショ
ン、ポートフォリオ、メール添

付に最適です。欠点: base64 エン
コーディングによりファイルは純

粋な .splat  より約 1/3 大きく
なります — そのため、非常に大
きなシーンでは、 .splat  ファ
イルを標準ビューアーと一緒に 
別々にホスティングする方が価値

があります。
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図 32:  flowers-01.mp4 から抽出された単一フレーム — Bjoern のブーケの プロファイルレンダ
リング、カメラマーカー付きの白いプラットフォームが見え、 黒い背景 (デフォルトのビューポー
ト背景、設定で変更可能)。カメラは パラメトリックパスでシーンを周回 (仰角 + 距離は固定、

Yaw は回転)、 通常 30 または 60 fps で 6〜10 秒の長さ。フレーム解像度は VideoPreset 経由
で 480p から 8K までスケーラブル。
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E8 — Orbit Video (.mp4/.mov)

場所

メニューバー → Viewport → Record Turntable Video 
または メニューバー → Export → Media → Export 
Orbit Video…。Simple モード: 形式カード「Orbit 

Video」、Duration スライダー 3〜30 秒。 サイズ: 長

さ、解像度、ビットレートに依存。 互換性: すべての
プラットフォーム (H.264 と HEVC は Apple 標準)。

技術詳細

パラメトリック Orbit カメラ走行に沿って Gaussian 
Cloud をレンダリングし、 AVAssetWriter 経由で各フ
レームを MP4 または MOV ファイルにエンコードしま
す。 Orbit 構成は、回転数 (公転)、距離、仰角、FOV、
長さ、Ease-In/Out 係数を制御します。 Orbit ビデオ
エクスポートは RadianceKit 独自の ForwardPass を
完全な SH 評価とともに 通過します — アプリ内ビュー
ポートとピクセル単位で同一 (WYSIWYG) です。 フ
レームごとに、世界調整マトリクス (レンダラーで計算
され、内部座標を Y-up Orbit 世界に回転させる) が
カメラと乗算され、続いてカメラ規約の反転 (camFlip: 
Orbit Y-up → COLMAP Y-down) が適用されます。オ
フスクリーン レンダーターゲットは、IOSurface 経由
でエンコーダー用の CVPixelBuffer に引かれます。エ
ンコーダーは H.264 と HEVC、構成可能なビットレー
ト、 480p から 8K までの解像度をサポートします。
最初のフレームの前に、レンダラーは 初期 Splat ソー
トが完了するように 200 ms 待機します。このエクス
ポートは GPU バウンドです — 8K と数百万 Gaussian 
では、フレームあたりのレンダリング時間が 数秒にな
り、6 秒のビデオで合計 10〜30 分のレンダリング時
間になることもあります。

簡単に言うと

シーンの回転を持つ完成した MP4 
ファイル。ソーシャルメディ

ア、 マーケティング、プレゼ
ンテーションに最適です。長さ 
(3〜30 秒)、回転方向、速度を 設定
できます。ファイルは YouTube、
Instagram、PowerPoint、その他の
場所に直接 埋め込めます。アプ
リは各フレームを完全にレンダリ

ングする必要があるため、 時々
遅くなります — 8K ビデオでは、
Gaussian の数に応じて 5〜30 分
を予定して ください。
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E9 — SfM Transforms (transforms.json)

場所

メニューバー → Export → Photogrammetry → 

Export SfM (transforms.json)…。 サイズ: 通常 1〜
10 KB (ポーズと内部パラメータのみ、画像なし、 

Gaussian なし)。互換性: nerfstudio、Brush、gsplat、
OpenSplat、Meshroom、 すべての最新フィードフォ
ワード 3DGS トレーナー。

技術詳細

カメラポーズリストと共有内部パラメータを持つ 
nerfstudio transforms.json  形式を書き込みます。
カメラごとに、ビューマトリクス (RadianceKit 内部: 
COLMAP 規約での World-to-Camera) が反転され、
次にカメラ ローカル Y と Z 基底ベクトルが反転され
て nerfstudio 規約 (OpenGL スタイル、 カメラは -Z  
方向を見る、 +Y  が上) に変換されます。最終 4×4 
マトリクスは、 各フレームの transform_matrix  
フィールドに double の行優先ネストされた配列と
して 配置されます。内部パラメータはトップレベ
ルに保存されます (焦点距離 x/y、主点 x/y、 画像
幅/高さ、camera_​model = "OPENCV"、加えて歪み係数 
k1, k2, p1, p2 ) — ただし、エクスポーターが複数
の異なる内部パラメータセットを検出する場合は、 フ
レームごとに書き込まれます。画像パスは JSON ファ
イルに対して相対的に images/​<filename> として書き
込まれます。ユーザーは、トレーニング写真を含む 兄
弟 images/​ フォルダを作成する必要があります。

簡単に言うと

この JSON ファイルは、各写真に
ついて、カメラがどこにあって、

どこを 見ていたかを記述します。
ファイル自体は小さく役に立たな

いものです — フォルダ内で オ
リジナル画像と一緒に使用されま

す。Nerfstudio、Brush、その他のト
レーナーは まさにこの形式を読み
込み、これを使って RadianceKit 
SfM 結果を別のツールに渡す こと
ができ、そこでカメラ再構築を再

計算する必要はありません。大き

なシーンで 時間を節約します。
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E10 — COLMAP Workspace (sparse/0/)

場所

メニューバー → Export → Photogrammetry → Export 

SfM (COLMAP Workspace)…。 サイズ: 3 つのバイ
ナリファイル合計通常 4〜8 MB — points3D.bin  
が支配的 (スパース Cloud の 3D 点ごとに 1 
行)、 images.bin  と cameras.bin  はそれぞれ 

100 KB を大きく下回ります。 互換性: COLMAP 
自体、Nerfstudio、Postshot、Meshroom、COLMAP 
sparse/​ ディレクトリを期待するすべてのツール。

技術詳細

3 つのバイナリファイルを持つ標準 COLMAP sparse/​
0/​ レイアウトを 書き込みます: cameras.bin 、
images.bin 、 points3D.bin 。形式リファレンスは 
公式 COLMAP ドキュメントです。 cameras.bin  に
は、重複排除された内部パラメータ リストが含ま
れます (同じ内部パラメータと画像サイズを持つカ
メラは、単一の エントリにまとめられます)。使用され
るカメラモデルは OPENCV  (Model 4) で、 fx/fy/cx/cy 
と 4 つの歪み係数 k1/k2/p1/p2。 images.bin  は、画
像ごとに wxyz  クォータニオンとしてのポーズ、続
いて translation、カメラ ID、ファイル名を リストし
ます。2D-3D 対応は保存されません。 points3D.bin  
には、位置、色 (0-255 RGB)、再投影と Track 長のデ
フォルト値を持つ SfM 点群が含まれます。 すべて
リトルエンディアンで書き込まれます。RadianceKit へ
の再インポートは File メニュー → 「Import COLMAP/
Metashape Workspace…」(SfM バックエンド章の 
Q3 参照) で機能します。

簡単に言うと

公式 COLMAP 形式。Postshot、
Nerfstudio、または他の COLMAP 
対応 ソフトウェアでトレーニ
ングを続行したい場合、これが

方法です。3 つの小さなファイ
ル プラスオリジナル画像、そ
してターゲットプログラムは、

COLMAP 自体がソース プログラム
であったかのように受け入れま

す。transforms.json 形式 (E9) よ
り多くの プログラムがこれを理解
しますが、テキストベースではな

くバイナリのため、少し 扱いにく
いです。
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どの形式をいつ？

目的 形式

自分のサイトの Web ビューアー E7 Web Viewer (.html)

gsplat.js  を使用した Web ビュー
アー

E6 Splat (.splat)

Postshot / Nerfstudio でのパイプライ
ン再利用

E9 transforms.json + E10 COLMAP Workspace

SuperSplat 編集 E1 PLY または E2 Compressed PLY

Niantic Scaniverse / Spatial Fields E3 SPZ

最大圧縮 E4 SOG (cwebp 必須)

マーケティング/ソーシャルビデオ E8 Orbit Video
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クイック比較

形式 拡張子 Sandbox サイズ (1M Gauss) 最適用途

E1 PLY .ply はい ~250 MB アーカイブ、

最高 互換性

E2 Compressed 
PLY

.ply はい ~40 MB Web + 
SuperSplat

E3 SPZ .spz はい (gzip 
spawn)

~40 MB Niantic + モ
バイル

E4 SOG .sog 条件付き 
(cwebp)

~20 MB 最大 圧縮

E5 glTF .glb はい ~250 MB Khronos パ
イプライン

E6 Splat .splat はい ~32 MB gsplat.js 
Web ビュー
アー

E7 Web 
Viewer

.html はい ~45 MB スタンドア

ロン ブラウ
ザファイル

E8 Orbit 
Video

.mp4 / .mov はい 可変 ソーシャル/
マーケティ

ング

E9 SfM Transforms .json はい ~5 KB ポーズ受け渡

し

E10 
COLMAP Workspace

ディレクトリ はい ~4–8 MB ポーズ受け渡

しバイナリ

サイズ列は SH 次数 3 で 100 万 Gaussian の大まかな目安です。実際の値はシーンの 圧縮性
によって異なります。SH 次数 0 では PLY/glTF が 4 倍縮小します。
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章

第 9章 — SfM バックエンド

図 33:  Inspector の Camera Alignment ピッカー付きエキスパートモード (Apple 
Photogrammetry / Native (Beta))

図 34:  Native (Beta) がアクティブな Inspector — Camera Alignment ピッカーで 2 番目のオプ
ションが選択され、他のトレーニング構成パラメータは すべて変更なし

画像で見えるもの  Inspector の Camera Alignment ピッカーは、2 つのオプションを持つセ
グメンテッドコントロールです — Apple Photogrammetry (App Store ビルドのデフォルト、
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完全に Sandbox 準拠) と Native (Beta) (RadianceKit 独自の FAST+BRIEF+GLOMAP パイ
プラインバックエンド、 Phase 3.8/3.9 で開発、2026-05 時点)。Native (Beta) はオービッ
ト専用に検証され、 ≥1 000 フレームで Apple Photogrammetry より高速ですが、Phase 3 
§5 品質ゲート (finalLoss ≤ 0.0115) はまだ満たしていません — そのため Beta タグが付いて
います。 Metashape、COLMAP、または他のフォトグラメトリーソフトウェアからの外部 
SfM 結果は、 追加で File メニュー (Q3 COLMAP テキスト形式、Q6 Workspace インポー
ト) から インポートできます — ピッカーは切り替わりませんが、インポートされたポーズが 
SfM 結果を置き換えます。

SfM は Structure from Motion の略です。重複する写真群から、ソフトウェアは 各画像に
ついて、共有の 3D 座標系内のカメラの位置と視線方向を再構築します。 その過程で粗い 
3D 点群が生成され、これが Gaussian Splatting のトレーニングを 初期化します。SfM 結果
は実際のトレーニングの入力であり、後の画像品質を 決定的に左右します。

RadianceKit は 5 つの SfM 経路を提供します: アプリに組み込まれた 2 つのバックエン
ド (Q1 Apple Photogrammetry、Q4/Q5 Native)、外部ツールからの 2 つのインポート経路 
(Q3 COLMAP テキスト形式、Q6 バイナリ Workspace インポート)、および Q2 COLMAP 
バイナリ (App Store 外の Developer ビルドでのみ利用可能)。どれが正しいかは シーンタ
イプ (オブジェクトの周りのオービット、室内、ドローン飛行) と、外部 ソフトウェアがすで
に再構築を提供しているかどうかによって異なります。

Q1 — Apple Photogrammetry

場所

Expert View → Inspector → トレーニング構成 
→ Camera Alignment ピッカー、項目「Apple 
Photogrammetry」。

技術詳細

もともと Object Capture 用に開発された Apple の組
み込み フォトグラメトリーフレームワークをラップし
ます。Apple は内部的に独自パイプライン (手順は公開
されていません) で特徴を抽出し、マルチビューマッ
チングで検証し、 Apple Silicon Neural Engine + GPU 
上でバンドル調整を解きます。バックエンドは 完全に 
App Store 準拠 (外部バイナリなし、Sandbox=true、
オンデバイス) ですが、 カメラポーズと粗い点群のみ
を提供します — トラック長や再投影誤差などの診断 
メトリックはありません。Apple の推奨に従って数百
枚の画像までスケーリングします。 直線的なドローン
飛行や大規模な屋外シーンで ~500 フレームを超える
と、再現性のある クラッシュや個々のカメラの静かな
破棄が観察されています。

簡単に言うと

これが最もシンプルな方法です。

画像を入れ、アプリが計算しま

す。 古典的なオブジェクトスキャ
ンに非常に適しています — 家具
や彫刻の周りを歩いて 50〜200 
枚の写真を撮る場合。風景上の

ドローン飛行や非常に多くの画

像 (500 枚超) では、Apple の手法
は不安定になりがちです。その

ようなシーンでは Native バック
エンド (Q4/Q5) をテストするか、
カメラを Metashape で計算して 
Workspace インポート (Q6) 経由
で読み込んでください。
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パワーユーザー

Q2 COLMAP バイナリ — 外部 COLMAP プログラムをサブプロセスとして起動す

るため、 App Store バージョン (Sandbox) では 利用できません。App Store 外
の Developer ビルドでのみ動作します。COLMAP が提供する品質を得るには、 App 
Store バージョンでは Workspace インポート (Q3 または Q6) があります: SfM を外部
で COLMAP や Metashape で計算し、結果を読み込んでください。

Q3 — COLMAP テキスト形式 (Metashape / ETH3D)

場所

メニュー「File → Import COLMAP / Metashape 
Workspace…」 (Cmd+⇧+I) または sparse/​0/​
cameras.txt を含むフォルダのドラッグ＆ドロップ。

技術詳細

標準化された COLMAP テキストエクスポートを読
み込みます — sparse/​0/​ サブフォルダ内の 3 つ
のテキストファイル cameras.txt 、 images.txt 、 
points3D.txt  — そして内部の SfM 結果モデルに
変換します。COLMAP バイナリ エクスポートと同
じ形式定義で、バイナリの代わりに ASCII で記述
されています。 Agisoft Metashape、RealityCapture、
PolyCam、ETH3D ベンチマークがまさにこの レイ
アウトで出力します。パーサーはバイナリパーサー

とカメラモデル検出を共有します (すべての一般的
なモデル: SIMPLE_PINHOLE、PINHOLE、OPENCV、
OPENCV_FISHEYE、 FULL_OPENCV)。コメント行と
空行に対して堅牢。テストで ~1 400 カメラ (ETH3D 
Tunnel) まで問題なくスケーリングします。

簡単に言うと

すでに Metashape、
RealityCapture、または他の商用写
真 3D ソフトウェアで 作業し、結
果をエクスポートしている場合 — 
そのエクスポートをアプリ自体が

再計算する ことなく RadianceKit 
に直接読み込めます。これで何時

間もの待ち時間が節約できます。 
File メニュー経由でフォルダ全体
を読み込むか、ウィンドウにド

ラッグしてください。
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Q4 — Native SfM (インクリメンタル)

場所

Expert View → Inspector → トレーニング構成 → 
Camera Alignment ピッカー、項目「Native (Beta)」。
インクリメンタルがこのバックエンドの デフォルト
モード — Inspector には別のマッパーピッカーはあり
ません。CLI 経由で モードを明示的に設定するには 
--native-sfm  または --sfm-mapper incremental を 
使用します。

技術詳細

GPU 加速された SfM パイプライン全体の独自実
装: FAST+BRIEF 特徴量、または CoreML 経由の 
SuperPoint+LightGlue ( --coreml-features  付き)、
続いて Hamming-KNN マッチング、RANSAC 基礎行
列、 トラック構築、初期ペア選択、2 視点ブートスト
ラップ (F→E プラス DLT)、PnP 登録と マルチビュー
三角測量を用いる greedy インクリメンタルマッパー、
最後に Huber Loss と 解析的ヤコビアンを Cholesky 
Solve で用いる Schur 簡約 Levenberg-Marquardt に
よる バンドル調整。完全に App Store 準拠: 外部バ
イナリなし、Sandbox=true。Phase 3.10 で 提供され
た R2 崩壊検出器付き: アプリが入力フレームの 60 % 
未満しか登録しない、 またはカメラあたりの点数が 13 
を下回ると、自動的にグローバルマッパー (Q5) に 
フォールバックします。経験的にオービット/ターン
テーブルシーンでクリーン。より 一般的な動き (ドロー
ン飛行、複雑な形状の室内空間) では成功率は低くなり
ます — ただし、検出器がこれらのケースをキャッチし
ます。~200 カメラまで確実にスケーリングし、 それ
以上は実行時間が大幅に長くなります。

簡単に言うと

Apple の強み (App Store 互換、
オービットで高速) に追加の診
断値を加えた ものです。Object 
Capture のように被写体の周りを
歩く場合に特に適しています。 よ
り複雑な録画 (ドローン飛行やリ
ビングルーム) では、RadianceKit 
は自動的にこれが うまくいかな
いことを検出し、グローバルプ

ロセスに切り替えます。「Beta」
と マークされているのはまだテ
スト中だからです — 標準推奨
は依然として、シンプルな オ
ブジェクトスキャンには Apple 
Photogrammetry、要求の厳しい屋
外セットには Workspace イン
ポート (Q3 または Q6) です。
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Q5 — Native SfM (グローバル)

場所

インクリメンタルマッパー (Q4) が崩壊検出器をト
リガーした場合 (入力フレームの 60 % 未満が登録され
る、またはカメラあたりの点数が 13 を下回る)、 自動
的に呼び出されます。CLI --sfm-mapper global 経由
でのみ手動で強制可能。 Inspector では、グローバル
手法は別のピッカーからアクセスできません — アプリ
が切り替えるタイミングを自分で決定します。

技術詳細

ネイティブパイプラインのグローバルバリアント。ま

ず Q4 と同じく 特徴抽出 + マッチング、続いてすべて
の検証済みペアの相対ポーズ推定、その後 回転平均
化 (世界座標系内のすべてのカメラ回転を同期) と平行
移動平均化 (大きなカメラ数での整数オーバーフロー
を避けるため、行列フリーのスパース 定式化に基づく 
LSQR)。原則として ~5 000 カメラまでスケーリング
しますが、 実際には数百カメラを超えると品質が低下
します — K-1351 での Phase 3.8 §5 受け入れゲート測
定では、目標の 0.0115 ではなく finalLoss 0.07 が得ら
れました。 「フォールバックティア」として扱われま
す: インクリメンタルマッパーが退化したときに 登場
しますが、それ自体は品質を再チェックされません。

簡単に言うと

ネイティブエンジンのプラン B 経
路。より高速なインクリメンタ

ル経路が 失敗した場合に自動的
に呼び出されます。使える結果

を提供しますが、非常に大きい、 
または難しいシーンでは、通常 
Metashape や外部 COLMAP イン
ストールから得られるものほど 正
確ではありません。Native が標準
ワークフローになる場合、そのよ

うなケースでは Workspace イン
ポート (Q3 または Q6) 経由の迂回
が価値があります。
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Q6 — Metashape / COLMAP テキスト Workspace インポート (Phase 
Q7)

場所

File メニュー → 「Import COLMAP / Metashape 
Workspace…」 (Cmd+⇧+I)。sparse/​0/​cameras.

{bin,txt} と images/​ を含むフォルダの ドラッグ＆ド
ロップ。

技術詳細

ドラッグ＆ドロップまたは Open パネルで選択され
たフォルダが、 3 つの COLMAP Workspace レイア
ウト (sparse/​0/​、sparse/​、またはルート) の いず
れかに一致するかどうか、および再構築がバイナリ 
( cameras.bin ) かテキスト ( cameras.txt ) かを自動
検出します。バイナリパスは COLMAP バイナリパー
サーを 使用し、テキストパスは ETH3D ローダーを
使用します — どちらも同じ SfM 結果 モデルを生成し、
パイプラインの残り (画像をインポートし、MCMC ト
レーニングを開始) は ソースに依存しません。画像は
アプリ Sandbox ブックマークシステム経由で セキュ
リティスコープで開かれるため、インポートは App 
Store バージョンでも 動作します。特に「Metashape 
エクスポートを再構築なしで再計算」のケースを 意図
しています。File メニュー項目で言及されている検出
は、選択されたフォルダが 認識可能な Workspace で
ない場合、アプリログで警告します。

簡単に言うと

特に Metashape ユーザー向
けの機能。Metashape または 
RealityCapture の ライセンスを
持っていて、そこでカメラ再構築

を行った場合、エクスポートフォ

ルダを ここに簡単にドラッグし
て、すぐにトレーニングを開始で

きます。RadianceKit が SfM 自体
を実行しないため、大きなシーン

で数時間の計算時間を節約しま

す。

199 / 227



R A D I A N C E K I T 第 9章 — SfM バックエンド

どのバックエンドをいつ？

シナリオ 推奨バックエンド

オブジェクトスキャン、50–
200 枚

Q1 Apple Photogrammetry

大規模屋外 / ドローン / 
>500 枚

Q6 Workspace インポート (Metashape または COLMAP で計
算してから読み込み)

Metashape/RealityCapture 
エクスポートあり

Q6 インポート (SfM 不要)

ETH3D / 学術 COLMAP テ
キストセット

Q3 COLMAP テキストインポート

厳密な App Store 準拠 + 
オービットシーン

Q4 Native インクリメンタル

Q4 が失敗 Q5 Native グローバル (自動)

ETH3D ベンチマークデータ Q3 (autotest precomputed)
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クイック比較

バックエ

ンド

App Store Sandbox 外部 バイナリ 最適用途 最大 
~Cams

Q1 Apple 
PG

✅ ✅ — Orbit-
Object

~300

Q2 
COLMAP 

Binary

❌ 
(Developer 
ビルドのみ)

— colmap/glomap Outdoor 
large

~5 000

Q3 
COLMAP 
テキスト

インポー

ト

✅ ✅ — Bench rigs ~1 500

Q4 
Native イ
ンクリメ

ンタル

✅ ✅ — Orbit-
Object

~200

Q5 
Native グ
ローバル

✅ ✅ — Q4 フォー
ルバック

~1 351

Q6 Workspace 
インポー

ト

✅ ✅ — Metashape 
再利用

ソース 毎
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章

第 10章 — 初心者モード

初心者モード (英語 Simple Mode、Cmd+1) は、3D Gaussian Splatting シーンを初めて 再
構築する人向けのガイド付きワークフローです。Inspector フィールドでいっぱいの サイド
バーを表示する代わりに、アプリは 4 つのステップを案内します: まず画像や ビデオをイン
ポートして品質プリセットを選択し、次に処理 (SfM + トレーニング) が 実行され、完成し
たシーンを 3D プレビューで確認でき、最後に希望の形式に エクスポートします。ウィンド
ウ上部の細い進捗バーは、現在どのステップにいるかを 常に示します。

すべての操作要素を同時に表示する Expert モード (Cmd+2) と比較して、初心者モードは 未
使用のオプションを非表示にし、画像が少なすぎる場合や悪い場合に検証警告を提供し、 
各ステップで現在の状態で意味のあるボタンのみを提供します。初心者モードと Expert モー
ドの間でいつでも切り替え可能 (Cmd+1 / Cmd+2)、すべての状態 — インポートされた画像、
選択されたプリセット、現在実行中のトレーニング、完成した 点群 — は保持され、もう一
方のモードですぐに利用できます。

Z1 — インポート (画像とプリセットの選択)

図 35:  Simple モードステップ 1 — 画像インポート前の空のドロップゾーン、 上部の Crumb 
Trail (Import → Frame Quality → Cameras → Training → Preview → Export)、Format Pills 

JPG/PNG/TIFF/HEIC/MP4/MOV/PLY/SPZ/SPLAT/SCENE/COLMAP

画像で見えるもの  Crumb Trail (Import アクティブ) は 4 ステップワークフローを示します。3 
つの CTA を持つ左のドロップ ゾーン: 「Browse Files」(NSOpenPanel)、「Try Sample 
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Scene」(バンドルされたデモ)、 「Download Sample Photos (~427 MB)」(Mip-NeRF360 
flowers サブセット)。下の Format Pills は受け入れられるすべてのファイルタイプをリスト
します。右側には 「Imported Files」、カウンター「0 images」、空状態「No files imported 
yet」。 下部の品質ピッカー (デフォルト: Preview) と「Start Processing」(画像がない限り 
無効)。

最初のステップは、アプリに画像素材を提供することです。中央の大きな破線フィールド

への ドラッグ＆ドロップ、「Browse Files」ボタン、または同梱の Sample シーンをクリック 
することで。右側には、解像度とファイルサイズを持つすべてのインポートされた画像の リ
ストが表示されます。下のフローティングツールバーで品質プリセットを選択し、 「Start 
Processing」でパイプラインを開始します。検証警告 (< 3 または < 10 画像で 赤、10〜19 
でオレンジ) は、アプリが意味のある再構築を期待するかどうかを示します。

C-01 ProgressIndicator (ステップ表示)

場所

ワークフローの上、常に表示。

技術詳細

Stage 割り当て付きのパイプライン全体 (Frame 
Quality → SfM → Training) に わたる水平進捗バーを
表示します: Frame Quality は 0〜5% (Phase 3.11、非
常に短い)、 SfM はバーの 0〜30%、Training 30〜
100% を占めます。横には Status Text と Phase 名付
きパーセント表示 (「SfM 41%」、「Training 12 500/20 
000」) があり、 ユーザーが見かけ上の逆行「41% 
SfM → 25% Training」をエラーとして読まないように 
— バーはパイプライン全体の進捗を示し、サブステー
ジではありません。ETA 計算は、 十分なトレーニ
ング速度が測定されるとすぐに開始されます (通常、最
初の 100 反復後)。 同じ表示が Expert モードでも 
Inspector の上に使用されます。

簡単に言うと

一番上の細いバーは、ワークフ

ロー全体を通したあなたの地図で

す。アプリが 現在何をしている
か (カメラ整列、トレーニング実
行中、…) だけでなく、全体でど
れだけ 進んだかも伝えます。意
図的に、カメラ計算がバーの最初

の 1/3 を占め、実際のトレーニ
ング が後ろの 2/3 を占めるように
分割されています — そうでなけ
れば、SfM 後に突然進捗が ゼロに
戻ったように見えます。リラック

スして、バーを見るだけで大まか

なステージを 確認できます。横の
テキストは SfM ステージ (例えば
「SfM 41%」) かトレーニング (例
えば「Training 12 500/20 000」) 
かを伝え、数字が混乱を引き起こ

さないように します。ETA が表示
されない場合、トレーニングがま

だ若すぎるだけです — アプリは 
十分な速度を測定してから推定し

ます。
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C-03 DropZoneView (ドラッグ＆ドロップ領域)

場所

Import ステップの左側、シンボル付き大きな破線長
方形。初心者モードでは ラベル「Drop photos or a 
video here」で表示されます。

技術詳細

シンボルが短く跳ね、Drag アイテムがフィール
ド上に浮かぶとすぐに背景を 着色するドロップ
領域。JPG、PNG、TIFF、HEIC、MP4、MOV、PLY、
SPZ、.splat、 .radiancescene バンドル、ディレクト
リを受け入れます。タイプ別の Drop Routing: 画像は
収集され、ソートされて渡される、ビデオは Frame 
Sampling パスをトリガー、 Splat ファイルは直接プレ
ビューを開く、Scene バンドルは読み込まれる。 ディ
レクトリは列挙され、含まれるすべての画像がイン

ポートされます。Sandbox 準拠 アクセス用の Security 
Scoped Bookmarks が正しく取得および解放されま
す。 サポートされていない拡張子は 5 秒間警告バナー
として表示されます。

簡単に言うと

大きな破線フィールドが最初のス

テップのメイン操作です。写真や

ビデオ、 またはフォルダ全体を
単にドラッグします — アプリは
知っているすべてを受け入れ、 残
りを無視します。フィールドが青

くなり、シンボルが短く跳ねた場

合、アプリは Drag を認識しまし
た。離すと、すぐにインポート

が開始されます: 画像は右側のリ
ストに 入り、ビデオは自動的に 
Frame Sampling ステップをトリ
ガーし、すでにトレーニング され
た .ply / .spz / .splat  ファ
イルは直接プレビューを開きま

す。形式がまったく 適合しない場
合 (PDF や BMP など)、上端に短い
ヒントが表示されます — アプリ
は 未知の素材を黙って飲み込みま
せん。

C-05 Browse Files ボタン

場所

Drop ゾーン内、目立つボタン。

技術詳細

複数選択と、ファイルタイプ JPG、PNG、TIFF、
MP4、MOV、フォルダ、アプリ 独自の Scene 形式を
持つ macOS ファイルダイアログを開くボタン。結果 
URL は Security Scoped で、Drag and Drop と同じイ
ンポートパス経由で転送されます。ユーザーが フォル
ダを選択すると、再帰的に画像が列挙されます。

簡単に言うと

Drag and Drop が不便な場合
は、このボタンをクリックして 
macOS ファイル ダイアログで写
真に移動するだけです。複数の

ファイルを同時に選択 (個々の画
像で Cmd-Click) するか、フォル
ダ全体を選択できます — アプリ
はフォルダをサポートされる すべ
ての画像タイプについて再帰的に

検索します。撮影がサブフォルダ

にネストされて いる場合 (例えば
「shoot-day1/」、「shoot-day2/」) 
に特に実用的です — メインフォ
ルダのクリックで十分。機能的に

は、このボタンは Drag and Drop 
と同じことを 行います。便利な方
法を選択してください。
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C-06 Try Sample Scene ボタン

場所

Drop ゾーン内、アプリバンドルに Sample Scene が含
まれ、まだ画像/Splat が インポートされていない場合
のみ表示。

技術詳細

次の場合にのみ表示されます: (a) 
sample-scene.splat 、 .spz 、または .ply  が ア
プリバンドルに存在する、かつ (b) まだ画像/ビデオ
がインポートされておらず、 点群もない場合。クリッ
クすると、完成した点群がロードされ (最小の形式を優
先 — .splat  ~3 MB、 .spz  ~1.4 MB、フォールバッ
ク .ply )、400 ms 後に Flowers シーンのオリジナル
メタデータからのハードコードされたカメラ値を、審

美的に意味の ある入力視点として設定します。

簡単に言うと

アプリを初めて起動して、最後に

何が出てくるか単に見たい場合 — 
ここをクリック。これにより、す

ぐに回転およびエクスポートでき

る、完成した トレーニング済み花
のシーンが開き、アプリは計算す

る必要がありません。カメラは 審
美的に意味のある入力視点に事前

設定されているため、すぐに何か

美しいものが 見えます。自分の
撮影に取り組む前に、3D コント
ロールとエクスポートステップを 
リスクなしで試すのに最適です。

自分の画像をインポートするとす

ぐに、ボタンは 自動的に消えます 
— プロジェクトが完全に空である
限りのみ表示されます。

C-07 Download Sample Photos ボタン

場所

Drop ゾーン内、「Try Sample Scene」の隣。同じ可視
性条件。

技術詳細

約 427 MB の 960 のフル解像度フレームをロー
ドしてアプリに入力する ダウンロード (リポ
ジトリ github.com/​bkindler/​radiancekit-sample-
photos) を トリガーします。ダウンロード中、ボタ
ンは無効化されます。進捗は上部の Progress Bar に 
「Downloading X%」として、独自のステージに表示さ
れます。このステージは独自の 0〜100% スケールを保
持し、後の SfM ステージと重ならないためです。

簡単に言うと

Sample シーンとまったく同じで
すが、完成した結果の代わりに

ソース写真で。 これにより、パ
イプライン全体を自分で 1 回実行
し、SfM とトレーニングが Mac で
実際に どれくらいかかるかを確認
できます。ダウンロードは大きい 
(DVD の約半分 = 427 MB) ですが、 
1 回だけです — その後、写真は
ローカルで、異なるプリセットで

パイプラインを 何度でも再起動で
きます。ダウンロード中、上部の

進捗バーは現在のダウンロード状

態を パーセントで表示し、開始す
るタイミングを推定できます。ヒ

ント: 高速 Wi-Fi または 有線ネッ
トワークを使用してください — 
427 MB はそうでないと引き伸ば
されます。
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C-09 Quality Presets ピッカー

場所

Import オーバーレイのフローティング下部ツールバー、
Start ボタンの左側。

技術詳細

ラベル「Quality」付きの操作要素が、利用可能なプリ
セットをカテゴリ別 (Classic / MCMC / Custom) にグ
ループ化します。組み込みプリセットはカテゴリ別に 
グループ化されます。セクションヘッダーはハードコー

ドされています。Custom プリセットは存在する場合
のみ表示されます。ロック状態: Free リスト (Quick 
+ Preview) にないプリセットは、ユーザーが購入して

いない場合、名前に「🔒」接尾辞が 付きます。選択
時、ピッカーは Preview に戻り、自動的に Purchase 
Sheet を開きます。 選択時、プリセットが適用され、
トレーニング構成全体が置き換えられます。

簡単に言うと

ここで、アプリがどれだけ正確

に、どれだけ長く計算すべき

かを選択します。 「Quick」と
「Preview」は購入なしで使用可能
で、数分で最初の結果を提供し

ます — 画像が意味があるかどう
かをテストするのに理想的です。

「Balanced」と「Quality」は フル
バージョンが必要で、はるかに鮮

明なモデルを提供しますが、分で

はなく時間が かかります。MCMC 
は、より少ない Gauss Splat で十
分な異なる戦略です — モデルを 
後でコンパクトにエクスポート

したり Web に置きたい場合に良
い。Premium プリセットは 名前
の小さな鍵シンボルで識別できま

す。ライセンスなしでタップする

と、ピッカーは Preview に戻り、
Purchase Sheet が自動的に開き
ます。経験則: 常に Preview で 開
始し、結果を見て、それから長い

実行が価値があるかどうかを決定

します。

C-10 Start Processing ボタン

場所

Import オーバーレイのフローティング下部ツールバー、
プリセットピッカーの右側。

技術詳細

画像もビデオもインポートされていない限り、グレー

のままのボタン。クリックで パイプラインが開始さ
れ、Stage マシンが Frame Quality → SfM → Training 
の順序に 切り替わります。ボタン自体には他のステー
タスはありません。実行中の処理は代わりに 別の処理
画面として表示されます。

簡単に言うと

「開始」ボタン。グレーのままの

間は、入力画像またはビデオがま

だありません。 写真をドラッグす
ると、アクティブになり、それを

クリックして SfM とトレーニング
を 順次開始します。それ以降、ア
プリが全プロセスを引き継ぎ、処

理画面 (Z2) に自動的に 着地しま
す。何もクリックする必要はあり

ません — トレーニング終了後、
アプリは プレビュー (Z3) に再び
切り替わります。考え直した場

合、その後もいつでも Cancel で 
中止できます。
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C-11 Video Sampling スライダー

場所

右の画像リスト、画像ではなくビデオがインポートさ

れた場合のみ表示。

技術詳細

0.5 fps – 30 fps、0.5 ステップのスライダー。変更時、
フレーム密度が 更新され、密度とビデオ長から計算
されたターゲットフレーム数 (最小 10) も追加で 更
新されます。リスト要素がスライダーからマウスイベ

ントをブロックするため、 スライダーは画像リスト
の外に配置されています。スライダーの下に、計算さ

れた ターゲットフレーム (「247 frames」) とビデオ
長 (「1m23s video」) があります。 ツールチップが警
告します: 「密度を 2 倍にするとフレーム数が 2 倍に
なり、SfM 時間が ~100% 増加します。」

簡単に言うと

写真の代わりにビデオをインポー

トした場合、このスライダーは、

アプリが ビデオからどれだけの
単一画像を抽出するかを決定しま

す。より多くの画像 = より良い 品
質、しかし線形により多くの計算

時間。30 秒の Orbit ビデオでは、
5 fps (150 画像) が 良い開始点で
す。1 分の撮影では、3 fps で十分
なことが多い。スライダーの下、

アプリは 現在の設定でどれだけの
フレームが出てくるかをライブで

表示します — これにより、 意味
のある約 100〜300 画像の範囲を
ヒットしているかどうかすぐに見

えます。結果が悪い 場合、スラ
イダーを右に動かして再試行しま

す。フレームレートを 2 倍にする
と、SfM 期間もおおまかに 2 倍に
なります。

C-12 Clear All ボタン

場所

右の画像リスト、右下、画像がインポートされた場合

のみ表示。

技術詳細

赤いボタン。クリックは、タイトル「Clear all 
imported files?」と メッセージ「N images will be 
removed.」で確認ダイアログを開きます。確認は、 す
べてのインポートされた画像/ビデオ、ステージング
ディレクトリ、点群、トレーニング ステータス、SfM 
結果、すべてのキャッシュを消去します。ステージは 
Import に戻ります。 Cancel ですべてが保持されます。
ダイアログは非破壊的なデフォルトパスとして構成 さ
れています (破壊的ボタンは赤でマーク)。

簡単に言うと

完全に新規開始したい場合、ここ

をクリック。確認質問は、削除

が、すでに 計算されたカメラとト
レーニング結果を含む現在のイン

ポートをすべて破棄するため 表示
されます — 元に戻せません。選
択した画像素材を完全に置き換え

たい、または 新しいプロジェクト
を開始する前に古いプロジェクト

を取り除きたい場合に意味があり

ます。 注意: 単一の画像を削除す
ることは、右側のリストを介して 
(次の項目参照) 行います。 この
ボタンを介してではありません。

ディスク上のファイルは削除され

ません — アプリは 参照を忘れる
だけです。
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C-13 File List ForEach (単一画像の削除)

場所

右の画像リスト、各エントリ。

技術詳細

スワイプで削除付きのインポートされた画像のリスト。

画像ごとに、アイコン、 ファイル名、解像度 (「1920 
× 1080」)、ファイルサイズ (フォーマット KB/MB) を 
持つ行。解像度はメタデータキャッシュから取得され、

UI がブロックされないように、 画像ヘッダーから非同
期で埋められます。削除アクションは macOS 風のス
ワイプ削除 (行でのトラックパッド左スワイプ) と、選
択された行での Delete キーボードを提供します。 注
意: 明示的なマイナスボタン、Backspace、Cmd-Z に
よる Undo を持つ拡張画像削除パスは、 Expert モー
ドのみ の Project Navigator で追加されました — 初心
者モードでは スワイプ削除のままです。

簡単に言うと

右側のリストは、各インポートさ

れた画像を解像度とファイルサイ

ズと ともに表示します — 高解
像度と低解像度の素材を混ぜ合わ

せたかどうかを一目で 確認する
のに実用的です。単一の画像を削

除するには、iOS Mail のように — 
トラック パッドで 2 本の指で左に
スワイプするか、それを選択し

て Delete を押します。アプリは 
ファイル自体を削除しません。そ

れを現在のプロジェクトから単に

削除するだけです。 適切なマイ
ナスボタンや Cmd-Z Undo が必要
な場合、Expert モード (Cmd+2) 
に 切り替えてください。そこには 
Project Navigator にあります。初
心者モードでは、 シンプルなスワ
イプパターンが意図的にそのまま

残ります。
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C-15 Validation Warnings (3 段階ティア)

場所

画像リストの下、Clear All ボタンの上。

技術詳細

インポートされた画像の数に基づく 3 つの連続した
閾値 (画像が存在し、 ビデオがない場合のみアクティ
ブ): - < 3 画像: 赤バナー (red octagon)、テキスト 
「At least 3 images are required. Camera alignment 
cannot be computed from fewer images.」- 3〜9 画
像: 赤バナー、テキスト「With fewer than 10 images, 
SfM often fails and the trained scene tends to 
overfit […]. 15–20 images minimum recommended; 
30+ for object captures.」- 10〜19 画像: オレンジ
バナー (warning triangle)、テキスト「Workable, but 
quality usually improves with 20+ images and good 
coverage around the scene.」

20 画像から、バナーは消えます。閾値はハードコード
されており、経験的な 560+ トレーニング実験に基づ
いています。

簡単に言うと

アプリは、どれだけ多くの画像を

インポートしたかを見て、色付き

の評価を 提供します。赤は意味
します: これは高い確率で何もな
らないだろう — SfM が カメラを
計算できないか、トレーニングが

少なすぎる素材にオーバーフィッ

トします。 オレンジは意味しま
す: 機能する可能性があります
が、アルゴリズムが画像間のオー

バー ラップをほとんど見つけない
ため、トップ品質を期待しないで

ください。バナーなしは 意味しま
す: 良い前提条件、十分な素材が
あります。本当にクリーンなモデ

ルが欲しい 場合、被写体の周りで
均等に分布した少なくとも 30〜
50 ショットを目指します — 屋外
シーンや大きな部屋ではさらに多

くてもかまいません。警告にもか

かわらず開始 できますが、SfM が
コメントなしで中止したり、モデ

ルが穴があいているように見えて

も 驚かないでください。
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C-16 COLMAP Workspace 検出

場所

フォルダのドロップ時 — 可視のボタンではなく、検出
ロジック。

技術詳細

ディレクトリのドロップ時、3 つの正規 Workspace レ
イアウトのいずれかが 含まれているかチェックされま
す: sparse/​0/​cameras.bin、sparse/​cameras.bin、ま

たは 直接 Root に cameras.bin 。それが該当する
場合、標準画像列挙が中止され、代わりに モーダ
ルアラートが開かれ、ユーザーに既存の再構築を

使用するか、画像を Apple Photogrammetry で新しく
実行するかを尋ねます。テキスト形式 Workspace 
(cameras.txt) と ETH3D エクスポートでも同じパス。
詳細は第 9 章 Backend Q6 参照。初心者モードでも 
Expert モードと同じように動作します。

簡単に言うと

Metashape、RealityCapture、また
は COLMAP ですでに作業し、そ
こでカメラ 計算を実行した場
合、エクスポートフォルダを

ここに単純にドラッグできま

す。 RadianceKit は内容から自
動的にそれが COLMAP Workspace 
であることを認識し (sparse/​0/​、
cameras.bin  などをチェック
します)、完成した計算を引き継ぐ
か 自分で再計算するかを尋ねま
す。引き継ぐと、SfM が完全にス
キップされ、トレーニングが す
ぐに開始されるため、大きなシー

ンで数時間の待ち時間を節約し

ます。テキスト形式 Workspace 
(cameras.txt) と ETH3D エクス
ポートも認識されます。この機能

は初心者 モードでも Expert モー
ドと同じように利用可能です。詳

細は第 9 章 Backend Q6 に ありま
す。

次のステップへいつ?

(a) 少なくとも 1 つの画像またはビデオがインポートされ、(b) 検証バナーがオレンジまたは 
消えるとすぐに、Start Processing をクリックできます。赤バナーでもアプリは 開始させま
すが、高い確率で処理をすぐに再び中止できます。推奨: 少なくとも 20 画像、 鮮明、連続
したショット間で明確なオーバーラップを持つ、被写体までほぼ同じ距離からの すべて。開
始前に時間予算に合うプリセットを選択します — 30 画像と Quick プリセットでは 数分以
内に完了し、Quality では 1〜2 時間かかります。
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Z2 — 処理 (SfM + トレーニング)

図 36:  Z2 SfM フェーズ — Stage アイコン「Structure from Motion」、大きな 円の中で 41%、
上部ステータスバーは「SfM 25%」、右下に Cancel ボタン

SfM フェーズ (カメラが整列されています): 大きな進捗円は、サブステージ進捗 (ここで
は実行中の Apple Photogrammetry セッションの 41%) を表示します。左上の Status Text
「Aligning cameras…」。Crumb Trail は「Cameras」をアクティブステージと してマークし
ます。上部ステータスバーはパイプライン全体の進捗 (25%) を表示 — SfM はバーの最初の
半分を占めます。背景のフローティングワイヤフレームカメラは、 ポーズが推定されている
ことを示唆します。

図 37:  Z2 トレーニングフェーズ — Stage アイコン「Training Gaussians」で 6%、 上部のラ
イブメトリック (Training: 400/5000 — Loss: 0.1642 — 138.7 it/s)、ETA 33s、下部に Pause/

Cancel

トレーニングフェーズ (Gaussian が最適化されています): サブステージ アイコンが
「Training Gaussians」に切り替わり、パーセントが選択されたプリセットから 反復をカウ
ントします (ここでは Preview プリセットで 400 / 5 000 = ステージの 8%)。 ライブメト
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リック行は、Loss 値 (0.1642)、秒あたり反復 (138.7 it/s)、ETA (33 秒) を 表示します。パ
イプライン全体の進捗は、このフェーズ中に 50% から 100% に上昇します。 SfM フェー
ズの Cancel のみとは異なり、Pause ボタンは後で Resume を可能にします。 Cancel はト
レーニング結果を破棄し、Z1 に戻ります。

パイプラインが実行されるとすぐに、アプリは Import オーバーレイを隠し、フルスクリーン 
処理画面を表示します。中央には、Stage アイコン、Status Text、パーセント数値を持つ 大
きな進捗円 (220 × 220 ピクセル) が走ります。背景では、控えめな Splat アニメーションが 
実行中の計算を象徴的に視覚化します。左上には、トレーニングと SfM からのライブ メト
リックを表示する情報パネルを表示できます。下には、Pause/Resume、Cancel、 エラーの
場合は Retry ボタンがあります。

C-18 SplatTrainingView (背景アニメーション)

場所

Progress 円の後ろのフルスクリーン背景、中止または
エラーで非表示。

技術詳細

パイプライン進捗 (0…1) に応じて増加する数の小さ
なアニメーション化された Splat 粒子をレンダリン
グする装飾アニメーション。ソースは、SfM フェーズ
を 0〜0.2 に、Training を 0.2〜1.0 に (Frame Quality 
を 0〜0.05 に) マッピングする 計算された進捗値です。
これにより、トレーニング中に Splat が見えて「構築」
されます。 純粋に装飾的 — 表示は現在のトレーニング
の実際の中間結果を示しません (それは Expert モード
のライブプレビューでしょう)。Cancel や Failure では
非表示になり、 Status 円のみが見えます。

簡単に言うと

背景では、計算中に画面がそれほ

ど空に見えないように、ダンスす

る点の 小さなアニメーションが実
行されます。これは実際の 3D モ
デルではありません — ステップ 
Z3 のトレーニング後にのみ見え
ます。ただし、アニメーションは

同じトーンを 持っているため、お
およその密度から、トレーニング

がどれくらい進んでいるかを 読
み取れます。最初は少数の点のみ

が見え、終わりには背景がはるか

に密に満たされます — 円のパー
セント表示に加えての美しい視覚

的インジケータ。アニメーション

が気になる場合 (例えばバックグ
ラウンドで並行して作業したいた

め)、Expert モードに切り替えると 
そこでは消えます。
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C-19 大きな Progress 円

場所

処理画面の中央、220 × 220 ピクセル。

技術詳細

2 つの重ねられたリング: 外側にミュートされた Track 
リング、内側に Accent または Red Stroke (エラー
で赤) を持つ塗りつぶされた Progress リング。 円
の中には、Stage アイコン (Training 用脳、SfM 用
カメラ、Video Frame Extraction 用 フィルム、Frame 
Quality 用 Sparkles)、Stage タイトル、32 ポイント 
Rounded フォントで ライブアニメーション化され
たパーセント数値。アイコンは処理がアクティブな

限り 柔らかく脈打ちます。表示は 30 Hz タイマー
で現在の実際の進捗の方向に滑らかに補間 されます 
— Constant-Creep (0.0003/フレーム) + Proportional 
Anteil (ギャップの 4%)、 次の予想されるマイルストー
ンの 80% に設定する Soft Ceiling (SfM ではハード
コードされた マイルストーンテーブルから)。これによ
り、実際の SfM 更新が数秒ごとにしか入っても、 進捗
が流動的に感じられます。

簡単に言うと

中央の大きな円は、アプリが計算

している間のメイン表示です。実

際の計算 更新が数秒ごとにしか
入っても柔らかく満たされ — こ
れにより、フリーズしたパーセン

トに 何分間も凝視する代わりに、
何かが起こっているように感じさ

せます。中央のシンボルは、 現
在フレームが抽出されているか 
(フィルムアイコン)、カメラが整列
されているか (カメラアイコン)、ま
たは Gaussian がトレーニングさ
れているか (脳アイコン) によって 
切り替わります。パーセント数値

は現在のサブステップを指します 
— 全パイプラインは 一番上の細
いバーで見えます。エラー時、リ

ングは青ではなく赤になり、アイ

コンは 脈打たなくなるため、何か
問題が発生したことがすぐにわか

ります。

C-22 Info ボタン (メトリック表示)

場所

処理画面の左上、32 × 32 ピクセル。

技術詳細

Material 背景を持つシンプルなボタン。Info パネルを
オンまたはオフに切り替え ます。アクティブ時、ア
イコンは Info Circle Outline と Info Circle Filled の間
で 切り替わります。柔らかいフェードインアニメー
ション。ツールチップは 「Show detailed processing 
metrics」。

簡単に言うと

デフォルトでは、画面は意図的に

整然としています — 大きな進捗
円だけ、 それ以上は最初は見え
ません。技術的に興味のあるユー

ザーとして、何が起こっているか 
(どの反復、Loss の高さ、いくつ
の Gaussian) をより正確に知りた
い場合は、左上の i シンボルをク
リックします。下に小さなパネル

が開き、すべてのライブ値が表示

されます。 再度クリックすると非
表示になります。設定は永続的で

はありません — 各新しい トレー
ニング実行で、パネルは最初再び

非表示になり、これは初心者を驚

かせないように 意図的に選択され
ています。
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C-23 Info Panel (ライブメトリック)

場所

処理画面の左下、showProcessingInfo == true の場
合のみ表示。

技術詳細

Ultra-Thin Material 背景を持つ 2 カラムパネル。左カ
ラム: ステージ固有の 情報行 — SfM 用は Status Text 
とパーセント、Training 用は Iteration、結合 Loss、 
L1 Loss、D-SSIM Loss、Gaussian カウント (オレン
ジ色)、Speed (it/s)、経過時間、 計算された ETA、SH 
Degree、学習率。右カラム: Status Text、Time Info 
文字列、 インライン Loss チャート (C-28 参照)、
Discoverability Nudge (C-32 参照)。すべての 値はト
レーニングステータスから読み取られ、各トレーニン

グ Tick で更新されます。

簡単に言うと

Info Panel は、Expert モードで 
Inspector サイドバーに永続的に
あるであろう すべてのライブ値
を表示します: 現在の反復、Loss 
値 (小さい = 良い)、Gaussian の数、 
速度、推定残り時間、SH Degree、
学習率。右側では、追加で小さな 
Loss 曲線が実行され、 トレーニ
ングが正しい方向に進んでいるか

を一目で伝えます。トレーニング

が鈍く感じる 場合、ここを見ると
役立ちます — もう落ちない Loss、
もう下がらない ETA は問題を 示
唆します。Loss が爆発する (突然
巨大になる) または NaN を表示す
る場合、トレーニングが 不安定に
なり、Cancel + Retry または別の
プリセットへの切り替えが意味が

あります。

C-25 Pause/Resume ボタン

場所

下部ナビゲーションバー、トレーニングステージ中の

み表示 (SfM 中は NOT)、 処理が実行されている限り。

技術詳細

Bordered Button。ステータスに応じて Pause また
は Resume を呼び出します。 ラベルは「Pause」
(Pause アイコン付き) と「Resume」(Play アイコン) 
の間で切り替わります。 SfM ステップ中、Apple 
Photogrammetry に Pause セマンティクスがないた
め、ボタンは 表示されません。Pause 状態は、反復、
Gaussian ステータス、Optimizer Momentum を 完全
に保持 — Resume は中断したところから続行します。

簡単に言うと

トレーニングが実行されている

間、いつでも一時停止して後で

続行できます。 Mac で GPU を多
く必要とする他のことを行いた

い場合に意味があります — 例え
ば ビデオ編集、ゲームテスト、
別のアプリからのレンダリング

エクスポート。Pause を クリック
し、自分のことをして、Resume 
をクリックすると、トレーニング

はまさにそこで 続行されます。
反復カウンター、Gaussian 数、
Optimizer Momentum は完全に保
持され、 Pause 状態は品質を犠
牲にしません。SfM フェーズ中、
Pause は利用できません — Apple 
Photogrammetry は Pause 機能を
知らないため、緊急時には Cancel 
で作業 する必要があります。
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C-26 Cancel ボタン

場所

下部ナビゲーションバー、処理が実行されている間 
(SfM またはトレーニング) に表示。

技術詳細

赤い Bordered Button。タイトル「Stop and discard 
progress?」、ボタン 「Discard Progress」(破壊的) と
「Keep Running」(Cancel) で確認ダイアログを開きま
す。 確認で、Cancel フラグが設定され、トレーニング
タスクが終了され、必要に応じて SfM サブプロセ
スが終了され、中止ステータスを持つ Summary 行
が JSONL ログに 書き込まれます。Pause とは異なり、
トレーニングバッファとステータスは破棄されます。

簡単に言うと

中止ボタン。Pause と異なり、こ
れは最終的です — 後で再起動す
る場合、 処理は最初から実行さ
れ、すでにトレーニングされたす

べての反復が失われます。プリ

セットを 間違えた、トレーニン
グがあまりに遅い、またはアプリ

が明らかにごみの結果を生成 し
て待ちたくない場合に意味があり

ます。実際の中止前に、誤って数

時間の計算時間を 失わないよう
に、アプリは確認ダイアログで再

度尋ねます。短期間だけ中断した

い場合は、 Pause を使用してくだ
さい。

C-27 Retry ボタン

場所

下部ナビゲーションバー、パイプラインが失敗した場

合に表示 (SfM ステータスが 「SfM failed」で始まる
か、トレーニングがエラー状態の場合)。

技術詳細

Accent Button。パイプライン全体を再起動します。開
始前に、まだインポート された画像/ビデオが存在する
かチェックされます。以前のエラーログは JSONL ディ
レクトリに残ります。新しい実行は、現在のタイムス

タンプを持つ新しい Log ファイルを書き込みます。

簡単に言うと

SfM またはトレーニングがエラー
メッセージで中止された場合、こ

こで再試行 できます。多くのス
テップ (RANSAC、Densification) に
ランダム部分があり、最初が 失敗
したところで 2 回目の試行が成功
する可能性があるため、時々これ

が役立ちます。 パイプライン全体
が新しいフレッシュな JSONL ロ
グファイルで最初から実行されま

す — SfM とトレーニング。2 回目
の試行も失敗する場合、ほとんど

の場合、入力画像が問題です (少
なすぎる、オーバーラップが少

なすぎる、ブレ、悪い光)。その
場合 Back で戻り、 素材を交換
してください。ヒント: 並行して
トレーニングログ (Help → Open 
Training Logs) を見てください。
そこには、具体的にどこで詰まっ

たかがより詳細に記載されて いま
す。
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C-28 インライン Loss チャート

場所

Info Panel 内、右カラム、非空履歴を持つトレーニン
グ中のみ表示。

技術詳細

コンパクトな描画領域 (40 ピクセル高)、Loss History 
をアクセント色の 1 ピクセル線として描画します。
データは有限値にフィルタリングされます (不安定
な トレーニング用 NaN 保護)。Min/Max は全履歴にわ
たって計算されます — チャートは 値範囲に自動ズーム
します。最後の Loss 値はチャートの右上にあります。
履歴自体は 各トレーニング Tick (通常 100 反復ごと) 
でアプリ状態に構築されます。

簡単に言うと

トレーニングが「収束」(線が右
に落ちる) しているか、詰まって
いるか 爆発している (線が平らま
たは上昇) かを一目で示す小さな 
Loss 曲線。健康な トレーニング
では、線は最初は急に落ち、その

後平坦になります — これは予想
される 進行で、半減曲線に似てい
ます。チャートは現在の値範囲に

自動的にズームするため、 トレー
ニング終了時の小さな改善も表示

されたままです。線が突然上に飛

んだり、 フリーズしたりすると、
何か問題が発生しているという良

い兆候です — 素材に 問題がある
か、別のプリセットがより適して

いるかのどちらかです。チャート

は、左上の i シンボルで表示する 
Info Panel にあります。

C-32 Discoverability Nudge (Expert モードヒント)

場所

Info Panel 内、右カラムの下部、トレーニング中かつ
初心者モードでのみ表示。

技術詳細

目アイコンと Caption テキスト「Switch to Expert 
Mode (⌘2) for live splat preview」を持つ小さな行、
控えめなトーンと 10 ポイントフォントで。インタラ
クティブ 要素ではなく、単なるヒント。クリックに反
応しません — ユーザーは実際に Cmd+2 を 押すか、メ
ニュー Mode → Expert Mode をクリックする必要があ
ります。

簡単に言うと

Expert モードでトレーニング中
に、3D モデルの現在の中間バー
ジョンが Viewport でライブに見
えることを示す控えめなヒント。

初心者モードでは、インター フェ
イスを落ち着いた状態に保つため

に意図的に非表示にされています 
— しかし 多くのユーザーはこの
機能があることをまったく知らな

いため、ここで穏やかに指摘 し
ます。Cmd+2 を押すと、トレー
ニングはバックグラウンドで続行

され、目の前で モデルが組み立
てられるのを見ることができま

す。これは、数千の反復後にすで

に結果が 価値があるかを推定する
か、中止して新規開始するための

良いツールでもあります。 Cmd+1 
はいつでも初心者ビューに戻しま

す。
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次のステップへいつ?

トレーニングが正常に完了するとすぐに、アプリは自動的に Z3 (プレビュー) に切り替わり
ます — 何もクリックする必要はありません。下部ナビゲーションバーは Pause/Cancel から 
Back ボタン (Import に戻る) と Export ボタン (Export に進む) に切り替わります。エラー
の 場合 (赤いエラーメッセージ、Stage アイコンは X)、代わりに Retry が表示され、再度開
始 するか、Back で Import に戻って画像素材を変更するかを決定する必要があります。

Z3 — プレビュー (3D モデルを回転)

図 38:  3D Viewer 付き Simple モードプレビューステップ

図 39:  トレーニング完了後の Z3 プレビュー — Bjoern の Blender ブーケが 再構築され、ヘッ
ダーは「Training complete — 3,022 Gaussians in 13s」を表示、下部に Back と Export ボタン
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画像で見えるもの  Crumb Trail は「Preview」を アクティブステージとしてマークします。フル
スクリーン 3D Viewport は完成した ブーケシーンをレンダリングします (Bjoern の
合成 Blender テストセット、960 半球 カメラから 60 フレームサブセット)。ヘッダーステー
タスバー: 「Training complete — 3 022 Gaussians in 13 s」— 最終 Gaussian 数とトレー
ニング時間を提供。Viewport の Drag はカメラを回転 (Yaw/Pitch)。Scroll Wheel は View 
Direction に沿ってズーム。 「Back」ボタン (左下) は Resume または Re-Run のために Z2 
に戻ります。「Export」 ボタン (右下、Primary) は Z4 に進みます。

トレーニング完了後、アプリは自動的にプレビューに着地します。ここでは完成し

た Gaussian Splatting モデルをフルスクリーン Metal ビューで見て、マウスとトラックパッ
ドで 回転、ズーム、パンできます。Viewport の上面には、カメラコントロールと情報を持
つ 小さなオーバーレイがあります — Auto Rotation、トレーニング統計、Reset ボタン。 次
のステップ (Export) の前に、再構築がクリーンであることを確認するために、モデルを さま
ざまな角度から確認することをお勧めします。

C-36 SplatViewportView (3D メインビュー)

場所

プレビューステップのフルスクリーン背景。

技術詳細

完成した点群をレンダリングする Metal ベース
の 3D Viewport。レンダラーは RadianceKit 独自の 
ForwardPass ラスタライザー — トレーニング中にすで
に Splat を レンダリングしているのとまったく同じも
の — であるため、真の WYSIWYG です (トレーニング
されたものがそのまま表示され、エクスポートされま

す)。 Order-Independent Transparency を持つタイル
ベースのレンダリングパイプライン。 レンダラーが初
期化できない場合 (例えば Metal がシステムで利用で
きない)、代わりに 「Metal not available」テキスト付
きの黒い背景が表示されます。ビューは Safe Area を 
無視するため、モデルはウィンドウ端に達します。

簡単に言うと

メイン Viewport。ここでは、写
真から再構築された完成した 3D 
モデルを、 GPU でリアルタイム
にレンダリングして見ることが

できます。左マウスボタンでク

リック してドラッグして回転。
スクロールホイールまたは 2 本
指のトラックパッドジェスチャ

で ズーム。右マウスボタンま
たは Cmd+ドラッグでパン。モ
デルは数万の半透明 3D 楕円体 
(「Gaussian」) で構成され、シー
ンをフォトリアルに再構築します 
— 各々はトレーニング が学習し
た位置、方向、形状、色を持ちま

す。Mac が Metal をサポートしな
いまれな場合、 代わりにヒント
メッセージ付きの黒い背景が見え

ます — RadianceKit には Metal 対
応 GPU が 強制的に必要です。

218 / 227



R A D I A N C E K I T 第 10章 — 初心者モード

C-37 CameraControlsOverlay (コントロールオーバーレイ)

場所

Viewport の上、フローティング。

技術詳細

Auto Rotation (Turntable)、Reset Camera、
Background 選択 (Gray/Black/White)、 Save 
Screenshot、Toggle Info Panel 用のボタンを持つコ
ンパクト UI オーバーレイ。 カメラパラメータ (距離、
Azimuth、Elevation、Target、FOV) にバインドし、
Auto Turntable を 制御します。トレーニング中 (ユー
ザーが Expert モードで Viewport が実行されるのを 見
たい場合)、オーバーレイはさらにコンパクトなトレー
ニングステータス行を表示します。

簡単に言うと

モデル上の小さなフローティング

バー。ここで Auto Rotation を開
始 (モデルは自動的に回転、スク
リーンショットと短いデモに適し

ています)、Reset で カメラを開始
位置にリセット (迷子になった場
合)、背景を変更 (中立用グレー、最
大 コントラスト用黒、明るいモデ
ル用白)、 /Pictures に保存されるス
クリーンショットを 直接撮影でき
ます。モデル全体をエクスポート

せずに、特定の詳細を特定の角度

から 示したい場合に実用的です。
Auto Rotation は、モデルがすべ
ての側面から同様に良く 見える
か、撮影が欠けているために「汚

い側」があるかを確認する良いテ

ストでもあります。

C-38 Export ボタン (ナビゲーションバー)

場所

Z3 の下部ナビゲーションバー。

技術詳細

ラベル「Export」と Share アイコン付き Accent 
Button。クリックは Z4 への 切り替えをトリガーしま
す。事前に、親ビューはフルバージョンがアンロック

されているかを チェックします — そうでない場合、
Export ステージの代わりにロックビューが 表示されま
す (U-06 参照)。

簡単に言うと

結果に満足したら、Export をク
リックすると、形式を選択して保

存する最後の ステップに着地しま
す。購入されたフルバージョンが

ない場合、代わりに Unlock ヒン
トと 購入ボタンを持つ画面ロッ
クに着地します — アプリはフル
バージョンを押し付けたく あり
ませんが、Export は Premium 機
能の 1 つです。購入を完了する
と、アプリは アンロック状態で
直接続行され、お馴染みの Export 
ステージに着地します。考え直し

た 場合、Back ボタン経由で再び
プレビューに戻り、モデルを回転

し続けることができます。

次のステップへいつ?

エクスポート前にモデルを一度完全に回転し、確認します: 入力画像でカバーされたすべての 
領域が存在するか? 浮遊する「Floater」(空中に浮かぶ自由な Gauss Splat 雲) はあるか? 背
景/空はクリーンに見えるか、それともぼやけているか? 重大な問題は、再トレーニングで の
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み修正できます — より多くの画像、別のプリセット、または Expert モードでの Floater 
Reduction 設定で。

Z4 — Export (形式選択 & 保存)

図 40:  形式カード付き Simple モード Export ステップ

図 41:  Z4 Export カード — 6 形式 (PLY 742 KB 選択、SPZ 74 KB、glTF 708 KB、 .splat 96 
KB、Orbit Video、Web Viewer 133 KB)、右側のすでにエクスポート された PLY を持つ Export 

履歴サイドバー

画像で見えるもの  Crumb Trail は「Export」を アクティブステージとしてマークします。左の
カードグリッド「Choose Export Format」と、 6 つのオプションすべて: PLY (標準 3DGS、
742 KB、完全な SH 係数 — ここでは青い チェックマークで事前選択)、SPZ (圧縮 3DGS 
形式、PLY より ~90% 小さい、74 KB)、 glTF (KHR_​gaussian_​splatting Extension 付き、
708 KB)、.splat (antimatter15 経由の Web Viewer 互換、96 KB)、Orbit Video (シーンの 
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360° MP4、ライブ サイズ計算)、Web Viewer (組み込み 3D Viewer 付きの独立した 
HTML、133 KB)。サイズは 現在の Gaussian カウントと形式オーバーヘッドからライブで
計算されます。右の「Export History」は、完了したエクスポートを形式ピル、ファイル名、
タイムスタンプとともに リストします — クリックで Finder で表示。左下の Primary CTA: 
「Export PLY (3DGS Standard)」と Gaussian Subtitle「2,991 Gaussians · SH degree 3」。

最後のステップで、2 カラムカードグリッド経由で 6 のエクスポート形式 (PLY、SPZ、 
glTF、.splat、Orbit Video、Web Viewer) から選択し、Export をクリックして macOS ダイ
アログで保存場所を選択します。右側で、これまでのすべてのエクスポートの履歴が 実
行されます — カード選択で、各カードの下にすぐに推定ファイルサイズが表示 されるた
め、例えば Web に行きたい場合は SPZ を優先 (小さい)、別のソフトウェア (SuperSplat、
Postshot、Plugin 経由の Blender) にインポートしたい場合は PLY を 優先 (大きく完全) し
ます。

C-39 2 カラム形式グリッド

場所

Export ステップの左メインページ。

技術詳細

2 つの柔軟なカラムと 12 ポイント間隔のカードラ
スター。初心者モードで 提供される形式を反復処理 — 
最も重要な 6 形式のみを含むフル形式リストの フィル
タリングされたサブセット: PLY、SPZ、glTF、.splat、
Orbit Video、Web Viewer。 Compressed PLY と 
SOG は Expert モードでのみ提供されます。

簡単に言うと

初心者モードで関連する 6 形式
を持つカードラスター: PLY (他の 
3D ツール用 標準形式)、SPZ (Web 
用圧縮バリアント)、glTF (公式 
Web3D 標準)、.splat (antimatter15 
Web Viewer 用)、Orbit Video (展示
用完成 MP4)、Web Viewer (組み込
み 3D プレーヤー付き独立 HTML 
ファイル)。これにより、ユー
スケースの 90% をカバー しま
す。あまり一般的でない形式の 
1 つが必要な場合 (極端な圧縮用
の Compressed PLY または SOG)、
Expert モードに切り替えます。そ
こではすべての 8 形式が利用可能
です。 初心者が多様性に圧倒され
ないように、ここのコンパクトな

選択は意図的です。
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C-40 Format Card ボタン

場所

グリッド内の各カード。

技術詳細

カードレイアウト付きのシンプルなボタン: アイコ
ン (例えば PLY 用 Document Zipper、SPZ 用 Archive 
Box、Orbit Video 用 Video アイコン) が上、Format 
Name が Headline、Description Caption (2 行切り詰
め)、下に推定ファイルサイズ (形式、 Gaussian カウ
ント、SH Degree からライブ計算され、KB/MB とし
てフォーマット)。 クリックで形式が選択されます。選
択されたカードは Accent 背景、Accent Border、 右
上にチェックマークアイコンを取得します。ツール

チップは Format Description です。

簡単に言うと

形式ごとに 1 つのカード。1 つ
をクリックすると、Accent 色と
チェック マークで強調表示さ
れ、下の Export ボタンがテキス
トを調整します (「Export PLY」、 
「Export SPZ」など)。各カード
は、適切なシンボル、名前、2 行
の短い説明、現在の トレーニン
グ結果での推定ファイルサイズを

表示します。サイズは賢明に選ぶ

のに役立ち ます — 結果をメー
ルで送りたい場合は、最小バリア

ントを取ります (通常 SPZ また
は .splat)。別の 3D ソフトウェア
で作業を続けたい場合は、最良の

互換性を持つもの (通常 PLY) を
取ります。カード上にホバーする

と、ツールチップは形式間の違い

が 不明確な場合に、より詳細な説
明を表示します。

C-41 Video Duration スライダー

場所

形式グリッドの下、ビデオ形式が選択されている場合

のみ表示 (Orbit Video または Social Video)。

技術詳細

3〜30 秒のスライダー、1 秒ステップ、アプリ状態のビ
デオ長にバインド。最大 幅 300 ピクセル。ビデオ形式
が選択されている場合のみ表示。非ビデオ形式では、 
スライダーはビューから完全に削除されます — デッド
スペースなし。

簡単に言うと

Orbit ビデオをエクスポートとし
て選択すると、ここで長さを決

定できます。 3 秒 = 非常に速い回
転、30 秒 = モデル周りの遅く落
ち着いた回転。ソーシャルメディ

ア リール (Instagram、TikTok) に
は、通常 6〜10 秒が理想的です — 
モデルを表示するのに 十分長く、
視聴者が離れないように十分短

い。プレゼンテーションやポート

フォリオ ビデオには、15〜20 秒
で良いでしょう。スライダーはビ

デオ形式が選択されている場合 の
み表示されます。PLY や SPZ のよ
うなファイル形式では意味がな

く、非表示になります。
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C-42 Export ボタン

場所

形式グリッドの下 (およびビデオが選択されている場合
は Duration スライダーの下)。

技術詳細

大きな Accent Button。ラベル: 「Export {Format-
Name}」、Share アイコン。 クリックで、形式に適し
た拡張子と Default ファイル名「scene.{ext}」を持
つ macOS 保存ダイアログが開きます。確認で、エクス
ポートが選択された URL に書き込まれます。 トレーニ
ング結果がない、またはエクスポートがすでに実行中

の場合は無効。

簡単に言うと

クリック、macOS ダイアログ
で保存場所を選択、完了 — ア
プリは選択された 形式のファ
イルを選択された場所に書き

込みます。Default 名は「scene.
{Endung}」(例えば 「scene.ply」
または「scene.spz」) で、保存前
にダイアログで自由に変更できま

す。 ボタンは、トレーニング結果
がまだない (Export ステップに到
達しないため、ここでは 決して
発生しません) または別のエクス
ポートがすでに実行中の限り、グ

レーです。 エクスポートが実行さ
れるとすぐに、その下に進捗表示

が表示されます。アプリは操作可

能な ままで、次のエクスポートを
すでに準備できます。

C-43 Export Progress Bar

場所

Export ボタンの下、エクスポートが実行されている間
のみ表示。

技術詳細

最大幅 300 ピクセルの進捗表示、下に Caption
「Exporting… N%」。値は 0 から 1 まで実行され、書き
込み中に更新されます — PLY では 10 000 Gaussian 
のチャンクで、 SPZ では量子化後に 1 回、Orbit 
Video ではフレーム間隔で。

簡単に言うと

エクスポートが実行されている

間、ここで進捗が細いバーとパー

セント表示 として見えます。PLY 
はほとんどの場合数秒以内に完了

します。ファイルが単にバイナリ

で 書き出されるためです。SPZ 
は、データがその過程で量子化お

よび圧縮されるため、 やや長くか
かります。Orbit Video は最も時
間のかかるエクスポートです — 
ここでは 各個別フレームが新し
くレンダリングされます。解像度

と長さに応じて、1 分以上 かか
ることがあります。エクスポート

中、アプリは操作可能なままで、

次の形式をすでに 準備したり、
Viewport で操作を続けたりでき
ます。
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C-44 Export Error Display

場所

Progress Bar の下、最後のエクスポートでエラーが発
生した場合のみ表示。

技術詳細

Warning アイコンとエラーテキスト付き赤い行。赤の 
8% 背景 Opacity、角丸。 最大幅 400 ピクセル。一般
的なエラー原因: SOG はシステム PATH に cwebp  を
期待 (App Store 準拠ではない)。フルディスクスペース
での書き込みエラー。許可された 領域外の保存ター
ゲットでの Sandbox エラー。

簡単に言うと

エクスポートが失敗した場合、こ

こに赤色で問題の短いクリアテキ

スト説明が 表示されます。ほとん
どの場合、原因は明らかです — 
ディスクにスペースがない、 ター
ゲットフォルダの書き込み権限

がない、または Sandbox 許可エ
リア外のターゲット。 特に SOG 
形式では、システムに cwebp  
がない場合があります。この場

合、SOG は使用 できず、SPZ に
切り替える必要があります。エ

ラーメッセージが不明確な場合、

Log ディレクトリ (Help → Open 
Training Logs) を見てください。
そこに何が間違ったかが より詳細
に記載されています。疑わしい場

合は、別の保存場所を選択するだ

けで役立ちます — 例えばデスク
トップ。

C-46 Export 履歴リスト

場所

Export ステップの右側。

技術詳細

Export 履歴のリスト (UserDefaults に JSON として永
続的に保存、各成功した エクスポート後に保守)。各行
は Format Badge (小さい、Accent 色)、Timestamp 
(HH:mm)、ファイル名 (1 行切り詰め)、フォーマット
されたファイルサイズを表示します。 行をクリック
すると、選択されたファイルで Finder を開きます。
Empty State: 「No exports yet」。

簡単に言うと

これまでのエクスポートのリスト 
— 形式、時間、ファイル名、サ
イズ、 時系列順。行をクリック
すると、フォルダを自分でナビ

ゲートすることなく、ファイルが 
Finder で強調表示されます。1 時
間後に最後のエクスポートが再度

必要で、どこに保存 したかわか
らなくなった場合に実用的 — 履
歴はそれを記憶します。まだ何も

エクスポート したことがない場
合、ここに親しみやすいヒント

「No exports yet」が表示されま
す。 リストは UserDefaults に保
存されるため、アプリの再起動を

生き残ります。
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C-48 History Context Menu (右クリック)

場所

History 行への右クリック。

技術詳細

各リストエントリのコンテキストメニュー、2 つのア
クション付き: 「Reveal in Finder」(シンプルクリック
のように、選択されたファイルで Finder を開く) と 
「Copy Path」(完全なファイルパスをテキストとしてク
リップボードに配置)。後者は、 他のアプリへの Drag 
and Drop やコマンドラインへの転送に便利です。

簡単に言うと

History エントリへの右クリック
は、2 つのアクションを持つ小さ
なメニューを 開きます。「Reveal 
in Finder」は通常のクリックと同
じことを行います — 選択され
た ファイルで Finder を開き、す
ぐに表示できます。「Copy Path」
は、Terminal コマンド、 他のア
プリ、メモなどに貼り付けられる

ように、完全なファイルパスをク

リップボードに 配置します。エ
クスポートを誰かに渡したい場合

や、パス入力で動作する別のプロ

グラム で開きたい場合に特に実用
的。Mac 風の操作パターンに依存
する小さいが役立つ詳細です。

ワークフローはいつ完了したか?

成功したエクスポート後、3D モデルをディスクにファイルとして持ち、履歴は新しい エ
ントリを表示します。「Done」ボタンはありません — 再トレーニングなしで、 さまざまな形
式で任意の数のエクスポートを追加できます。プレビューに戻りたい場合 (例えば別のカメ
ラパースペクティブを確認するため)、下部ナビゲーションバーの Back ボタンを使用します。
完全に新しいシーンを開始したい場合は、Back 経由で Z1 まで 行き、そこで Clear All を使
用するか、File → New Project (Cmd+⇧+N) を使用します。

Expert モードへの切り替え

いつでも Cmd+2 を押すか、Mode → Expert Mode ( M8 ) を選択します。すべての状態が 保
持されます: インポートされた画像、選択されたプリセット、実行中または完成した 
トレーニング、完成した点群、Export 履歴、現在のステージさえも。Expert モードでは、 4 
ステップステージの代わりに、すべての ~150 操作フィールドを持つフル Inspector サ
イドバーが表示されます。特に: Project Navigator (第 2 章参照) は拡張画像操作 (マイナス
ボタン、Backspace 削除、Cmd-Z Undo、Quick Look プレビュー)、トレーニング 中の 
Viewport でのライブプレビュー、すべての Loss、MCMC、Densification、 Mip-Splatting 
パラメータを提供します。Cmd+1 は初心者モードに戻します — それも 状態を失いません。

よくある質問

なぜ Start Processing ボタンがグレーのままですか?
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まだ画像もビデオもインポートされていません。少なくとも 1 つのファイルを Drop ゾーン
に ドラッグするか、「Browse Files」を使用してください。右側の画像リストに少なくとも 1 
つのエントリが含まれるとすぐに、ボタンがアクティブになります。(1〜2 画像だけでは 開
始しますが、SfM はエラーで直接中止します — 赤い検証バナー参照。)

なぜ Export ボタンがロックされていますか?

初心者モードには 2 つの段階があります: (a) トレーニングパイプラインがまだ完了 していな
い、または持っていない場合、ボタンは無効化されます — 最初に Z2 を 完了する必
要があります。(b) フルバージョンをまだ購入していない場合 (PurchaseManager.hasAccess 
== false)、Export ステージの代わりに鍵アイコンと 「Unlock Full Version」ボタンを持つ
ロックビューが表示され、Purchase Sheet を 開きます。Quick と Preview プリセットは無
料でトレーニングを許可しますが、Export は Premium です。

なぜプリセットを選択できないですか?

選択できます — しかし、購入されたフルバージョンなしで Premium プリセット (Balanced、
Quality、MCMC バリアント) をタップすると、ピッカーが自動的に Preview に 戻
り、Purchase Sheet が開きます。Quick と Preview は無料で使用可能な唯一の プリセット
です。

画像をドラッグしているのに、Drop ゾーンが空で破線グレーのままなのは なぜですか?

おそらく UTI タイプの不一致です。アプリは JPG、PNG、TIFF、HEIC、MP4、MOV、およ
び アプリ独自の Splat 形式を受け入れます。他の画像形式 (BMP、GIF、WebP、RAW 形式) 
は NOT 認識されます。画像タイプが含まれるべきだと確信している場合は、ファイル名 拡
張子を確認してください — アプリは主に拡張子で進み、ファイルコンテンツでは ありま
せん。

30 画像しかないのに、なぜ SfM がこんなに長くかかるのですか?

Apple Photogrammetry は線形にスケーリングしません — 一部の画像構成 (複雑な テ
クスチャを持つ室内、ブレ、悪い光) では、画像数が示唆するよりはるかに長くかかり ます。
SfM が 30 画像で 10+ 分後もまだスタックしている場合、中止して、より良い素材で 再試行
するか、Expert モードに切り替えて COLMAP/Native SfM (Cmd+2 → Inspector → Camera 
Alignment) を試してください。

トレーニングログはどこにありますか?

Help → Open Training Logs (Cmd+⇧+L)。これは ~/​Documents/​RadianceKit/​Logs/​ を 開
きます。各トレーニングセッションは、ファイル名にタイムスタンプ付きの独自の JSONL 
ファイルを書き込みます — 最初の行は構成、その後 100 反復ごとに Progress 行、 最後の
行は Final Loss と Success Flag を持つ Summary です。
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